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Preface 

While pupils and students have regular classes of “informatics,” few of them can 

create properly edited and formatted documents. On the other hand, countless 

books labeled as manual (or guidebook, stylebook, handbook, grammar book, text 

editing book, and design book) deal with punctuation, correct spelling, text editing 

and layout, as well as typographic style. 

All these books try to describe (present) and prescribe (regulate) correct typing 

and writing, but—after all—they all seem to be mere recommendations, unless 

strictly prescribed for publishing purposes created by journal and book publishers. 

The reality shows that people producing various texts either ignore these 

recommendations or use them at their whim. 

An author of a course on digital text handling is disgruntled, as would-be 

teachers lack minimal skills in this field, but thesis supervisors are no better, and 

in Csernoch’s view, a number of teachers cannot teach present-day pupils how to 

edit and format a document, offering documents full of various errors (Csernoch et 

al. 2023, 6–7). A further source explains that once we rely on desktop publishing, 

it is reasonable to know the basic rules of printed texts (Ármeán 2017, 129), 

although there are views that teaching typographic rules should be part of the 

education in the mother tongue, lest this knowledge be known only for the ones 

working in the field, such as printers, proofreaders, editors, writers, or journalists 

(Hargitai 2005, 134). 

The other side of the coin is that many of those who produce texts consider 

themselves experts, leading to the conclusion that “everybody is a typographer 

today” (Jury 2007, 8). Other scholars refer to this “syndrome” as typomania 

(Spiekermann 2013, 7), and those who suffer from this syndrome are typomaniacs 

(Spiekermann 2013, 55). The author has thus reached the conclusion that the 

typeface of the printed text is governed by three factors: “the content of the 

message, then the intended audience, and only lastly by technical constraints” 

(Spiekermann 2013, 75), as the reader should not “get sidetracked” while 

accessing the information. This entails that the text has to “look so normal” that 

readers should not even be aware of it, so ultimately text design is “invisible” 

(Spiekermann 2013, 15). While this statement should sound outrageous or at least 

illogical, we may discover that comics is “the invisible art” (McCloud 1994), 

proudly stated on the cover page, while Venuti’s book title is The Translator’s 

Invisibility (Venuti 2004), and there are views that the best movie subtitles are also 

invisible not to distract the viewer’s attention. What may be common in all these 

invisibilities is implementation. 
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As such, our aim is to offer certain guidelines to produce texts which draw 

the readers’ attention primarily on the content, which—in our view—might only 

be possible by following certain technical requirements, among which consistency 

is of utmost importance. As the Publication Manual of the American Psychological 

Association (APA) states, “[c]onsistency in the order, structure, and format of 

paper elements allows readers to focus on a paper’s content rather than its 

presentation” (APA 2020, 49). 

Having in mind consistency, we have tried to organize the book as follows: 
- the spelling used in this book is American English (AmE), except for direct 

quotations by authors using British English (BrE); 
- as a number of manuals have no identifiable authors or editors, these 

sources are referenced using established abbreviations (acronyms) in the 
main text, after their full title is given; however, a list of abbreviations is 
provided; 

- based on the Chicago Manual of Style (CMOS), file format abbreviations 
are provided in full capitals (PDF for Portable Document Format), while 
the form .pdf is used to refer to the type of extension (CMOS 2024, 472); 

- italic font style is used for book titles and linguistic examples; 
- bold font style is used for software menu items (CMOS 2024, 473–74), 

built-in features, and certain keywords; 
- key combinations or shortcuts available with the help of standard key-

board keys are bordered (All Borders), such as Esc, 3, Shift, or Fn, while 

keys on the Numeric Keypad (NumPad) are not bordered; a collection of 
discussed shortcuts is listed in Appendix 1; 

- Unicode values of symbols and signs are detailed in Section 1.4.2.; 
- the following terms are all labeled as Figure in captions: figure, illustra-

tion, image, photo, picture, or screenshot; 
- the term “click” refers to the left click of the mouse; whenever a right click 

is needed, it is specified as “right click”; when multiple clicks are in-
volved, it is always with the left click; 

- the reference section has been created with Zotero reference manager, us-
ing the CMOS style: Chicago Manual of Style 18th edition (author–date); 
properly installed, Zotero is displayed embedded in the LibreOffice 
Writer Toolbar, and a new tab is created in Microsoft Office Word, also 
visible among the add-ins, as shown in Figure 1: 
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Figure 1. Zotero add-in, Word 

Although books may contain a Glossary section, we tend to believe that 

checking any unfamiliar term on the internet is much more straightforward, so no 

Glossary is provided in this book. 

Ultimately, the present work will hopefully assure the successful writing of a 

thesis, including a structural, typographical, and editing point of view.





Chapter 1   

Operating Systems and Characters 

1.1. Prior to Breaking the Rules 

Books on typography present many rules and suggestions connected to text design 

and layout, but authors agree that at a certain point all these rules may and even 

should be broken (Ármeán 2017, 133; Jury 2007, 14). However, this is to be done 

“beautifully, deliberately and well” (Bringhurst 2004, 10), which is only possible 

after “good designers” (Spiekermann 2013, 41) learn the basic rules, which may 

sound a “a tired cliché,” but “it is nevertheless true.”1 

We also agree that knowing the rules first enables us to change them later, and 

the present book tries to offer those basic rules that are considered aesthetically 

necessary to produce a text. As our aim is not to teach the reader how to become a 

book designer or an expert in typography, we rely on relatively simple tips found 

in the most popular word processing or text editing software, Microsoft Office 

(MSO),2 occasionally mentioning alternatives, such as LibreOffice (LO), although 

it is considered to have “limited functionality” (Einsohn and Schwartz 2019, 4). It 

is also true that handling texts for the sake of desktop publishing is basically 

beyond the reach of a single person when quality is important (Ármeán 2017, 15), 

as while trying to read a text, we tend to skip minor mistakes aiming at 

understanding the message (Ármeán 2017, 85). 

Manuals and guidebooks on text editing, such as the American Medical 

Association’s (AMA) book entitled AMA Manual of Style: A Guide for Authors and 

Editors  (AMA 2020, 1114), typically offer rules for character/font choice, text 

format, titles, headings, paragraphs, the insertion of tables, figures or lists, 

quotations, reference citations, punctuation, and spelling. As such, other 

guidelines (Csernoch et al. 2023, 4) focus on how to avoid all sorts of errors 

connected to syntax (spelling, hyphenation), semantics (content), or typography 

(the printed/edited version), although these rules may be tailored to the specific 

needs or functions. 

It is our firm belief that producing near “error-free” documents needs no 

sophisticated software, as both MSO and the freely available LO contain enough 

features. These features (Ármeán 2017, 138) may belong to macrotypography 

 
1 https://www.thepunctuationguide.com/about-this-guide.html, June 5, 2023. 
2 Computer software mentioned “do not require citations” (APA 2020, 338), and they need not be 
italicized either. 

https://www.thepunctuationguide.com/about-this-guide.html
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(paragraphs, indentation, initials, layout), mezotypography (spaces between 

characters, lines), or microtypography (fonts, font size, color). As both software 

suites display their full potential while running on computers, the next section 

deals with operating systems (OS), basic skills, and filenames. 

1.2. OS and Keyboard Layouts 

At the quarter of the 21st century, one of these three major operating systems is 

running on all conceivable devices: Android (47.22%), Microsoft Windows 

(25.75%), and iOS (17.38%).3 However, we are more interested in desktop 

environment, in which case the market is clearly dominated by Microsoft 

Windows (73.41%), followed by OS X (14.14%), unknown (6.41%), and Linux 

(4.13%).4 

These operating systems have a default language, but further language packs 

may be downloaded and installed, which is important when multiple languages 

are used. A possibility to check the installed languages in a Microsoft Windows 

(in the following: Windows) setting is the following: 
- right click on the Windows logo on the Taskbar; 
- click on System; 
- type Language settings; 
- search for Preferred languages, which displays the already installed ones, 

and further ones may be added by selecting the Add a language button. 

Once various languages are installed, the default language may be changed, 

and various keyboard settings are also available. The active keyboard layout is 

typically shown in the taskbar either based on various International Organization 

for Standardization (ISO) language codes (two-letter or three-letter codes)5 or 

country flags (e.g., Linux Mint), enabling users to change keyboard layouts 

(different for each operating system).6 

Keys of the keyboard are referred to as provided by Microsoft,7 knowing that 

the standard US laptop keyboard layout contains 103 keys grouped as follows: 

1. function keys (F1–F12), which may contain secondary functions 

(triggered with the simultaneous pressing of the Fn key and a function 

key: multimedia (Volume Mute, Volume Down, Volume Up, Microphone 

On/Off), screen keys (related to brightness or connection to external 

monitors), Print Screen (PrtSc); 

2. modifier keys: Ctrl, Shift, Alt, Win, Command on MacBooks (cmd), Esc; 

 
3 https://gs.statcounter.com/os-market-share, January 14, 2025. 
4 https://gs.statcounter.com/os-market-share/desktop/worldwide, January 14, 2025. 
5 https://en.wikipedia.org/wiki/List_of_ISO_3166_country_codes, January 18, 2025. 
6 By default, the Windows logo key +Space (Windows, Linux) or the fn button (macOS), but they are 

customizable. 
7 https://tinyurl.com/4b66rhfv, January 14, 2025. 

https://gs.statcounter.com/os-market-share
https://gs.statcounter.com/os-market-share/desktop/worldwide
https://en.wikipedia.org/wiki/List_of_ISO_3166_country_codes
https://tinyurl.com/4b66rhfv
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3. special keys for navigation and modifying the text: Insert, Home, End, 

Delete, Enter, Tab, Backspace, Caps Lock (CapsLk), Scroll Lock, 

Pause/Break, Space bar, four arrow keys (˂, ˃, ˄, ˅, or ←, →, ↑, ↓ for Left, 

Right, Up, and Down), Page Up (PgUp) and Page Down (PgDn) keys; 

4. mathematical operations keys, brackets, and punctuation keys; 

5. certain keyboards have a numeric keypad, which may contain as many as 

21 keys: a numeric keypad (0–9), completed with mathematical operation 

keys (=, +, -, /, *, (, )), decimal/period key (.), Enter, Num Lock key, and 

a Backspace key; the active Num Lock key provides the number keys, 

while deactivating it offers other functions such as arrows (↑, →, ↓, ←), 

Home, PgUp, End, PgDn, Delete (Del), Insert (Ins), or the Calculator(🖩); 

6. keyboard combinations need two or more keys, which are joined with the 

plus sign, without space between them; the keys to be held down are 

bordered to be more visible, for instance Ctrl+B to change the font style 

to Bold. 

Switching keyboard layouts enables us to type language-specific characters as 

well, which might not be present on the actual keyboard. As explained, “expanded 

to its maximum dimensions, a standard keyboard will give direct access to 47 × 6 

= 282 glyphs,” which is “enough to handle all current European versions of the 

Latin alphabet” (Bringhurst 2004, 91). This is possible with various keyboard 

combinations, relying on the Alt, AltGr (right-hand side of the Space bar), Ctrl 

and Shift keys in Windows and Linux, or the Option and Command keys on 

MacBooks using macOS as well, by pressing one to four keys simultaneously. 

Showing the actual keyboard layout for a specific language is also possible by 

searching for the On-Screen Keyboard (Windows), Show Keyboard Viewer 

(macOS), or Virtual Keyboard / Onboard (Linux Mint). 

More recently, the AltGr button tends to be replaced with the Microsoft 

Copilot button,8 changing its functions as well: 

 

Figure 2. Windows copilot button replacing AltGr 

The importance of switching keyboard layouts even within a 

language/country is well reflected in the differences between the US (QWERTY)9 

and United States-International10 (QWERTY) variants: 

 
8 https://1000logos.net/download-image/, January 18, 2025. 
9 https://commons.wikimedia.org/wiki/File:KB_United_States-NoAltGr.svg#mw-jump-to-license, 
January 18, 2025. 
10 https://en.m.wikipedia.org/wiki/File:KB_US-International.svg, January 18, 2025. 

https://1000logos.net/download-image/
https://commons.wikimedia.org/wiki/File:KB_United_States-NoAltGr.svg#mw-jump-to-license
https://en.m.wikipedia.org/wiki/File:KB_US-International.svg
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Figure 3. US Standard Keyboard Layout 

 

Figure 4. US-International Keyboard Layout 

The differences between these two keyboard layouts are obvious: the 

international version enables us to type much more characters directly, by pressing 

either the AltGr key (right Alt key) or the Shift + AltGr key and one more key. 

However, the relevance of the following signs and symbols obtained this way is 

questionable (½, ¼, ¾,‘,’, ¤, ¶, ¢, ©, Æ, µ), as some of them are already on the 

standard keyboard (the opening and closing apostrophes) or might either be 

created by simply typing them, followed by a space (fractions ½, ¼, ¾), writing 

them in parentheses followed by a space (the copyright sign, © ), and other signs 

have very limited use or are outdated. 

Yet, the obvious gains seem to outweigh the previous remarks, as there are 

three superscript numbers (1, 2, 3), the £, €, ¥ currency signs, two standard 

mathematical operators (× and ÷), the guillemets (« and »), the paragraph mark (§), 

the degree sign (°), and a few language-specific characters as well (¡, ß, ø, Ø, ñ, Ñ, 

ç, ¿). Those who use these symbols a lot will appreciate the gain should they 

memorize the shortcuts. 

Switching between various input methods is possible once all desired 

keyboard layouts are set, as the OS displays the current keyboard layout in the 



1. Operating Systems and Characters  ◼  33 

taskbar. This is possible either by clicking on the specific area in the taskbar or by 

relying on shortcut keys, depending on the OS: 

 

Figure 5. Switching the input method, Windows 

For instance, the present-day Romanian keyboard layout11 displays the 

Romanian-specific characters correctly (Ș, ș, Ț, ț), which are with comma and not 

cedilla (letters S and T are separated from the glyph below them): 

 

Figure 6. Romanian standard keyboard layout 

Furthermore, the major difference between the standard Hungarian keyboard 

layout12 (QWERTZ) and the 101 variant13 is the switch between keys Z and Y, the 

relocated paragraph sign position, and a few punctuation-related signs: 

 
11 https://en.m.wikipedia.org/wiki/List_of_QWERTY_keyboard_language_variants#Romanian, 
January 18, 2025. 
12 https://en.wikipedia.org/wiki/File:KB_Hungary.svg, January 18, 2025. 
13 https://kbdlayout.info/KBDHU1/, January 18, 2025. 

https://en.m.wikipedia.org/wiki/List_of_QWERTY_keyboard_language_variants#Romanian
https://en.wikipedia.org/wiki/File:KB_Hungary.svg
https://kbdlayout.info/KBDHU1/
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Figure 7. QWERTZ Hungarian keyboard layout 

 

Figure 8. QWERTY Hungarian 101-key layout 

Typing any character properly should be a basic requirement, and while 

certain characters may also have specific shortcuts (so-called Alt codes by holding 

down the Alt key and typing a number on the NumPad), it might be more 

convenient to rely on the Character Map (Windows and Linux) or Finder, Edit, 

Emoji & Symbols (macOS): 
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Figure 9. Character map in Windows 

 

Figure 10. Character map, Linux Mint 
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Figure 11. Character viewer, macOS 

It is obvious that text editing might be substantially improved by inserting 

proper characters and never replacing them with some similar-looking ones (e.g., 

two apostrophes instead of the quotation marks). 

The operating systems must all be able to handle text-based documents, 

ranging from built-in software to paid office suites. As for their market share, all 

websites offering statistics agree that various Google applications are the most 

popular, followed by MSO, although the percentage of their market share is rather 

different with various sources. Irrespective of their estimated or tracked use, 

reality shows that the majority of people use either Google Workspace or MSO, or 

both. These office suites contain components dedicated to dealing with texts (e.g., 

Google Workspace, Docs), and our primary interest is MSO Word (from now on, 

simply Word), as this is arguably the most popular text editor taught in educational 

facilities, and editors “develop sufficient skill in this software to edit efficiently” 

(Einsohn and Schwartz 2019, 4). 

Nevertheless, it is known that Linux-based operating systems typically 

contain the open-source LO suite, which is also compatible with MSO, while 

macOS has Apple iWork (Pages, Numbers, and Keynote) as the alternative for a 

typical office suite. 
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Other notable software packages developed for word processing are 

AbiWord,14 Apache OpenOffice,15 OnlyOffice,16 Polaris Office,17 Scrivener,18 

Softmaker FreeOffice,19 or WPS Office.20 

These office suites make it possible for users to create and edit various text-

based documents, and they typically offer language-specific spelling options as 

well, which may be enabled or disabled (often with the F7 function button). While 

they spot the majority of typographical errors, including the “fat finger syndrome,” 

they can hardly detect “atomic” typos, which are words typed correctly but used 

in a wrong context. 

1.3. Skills to Organize Files 

Basic computer skills include effectively handling the tasks a person needs. This 

typically means creating, editing/modifying, saving, copying/pasting, and deleting 

various files, either one by one or in batches. 

As such, in our view, a basic skill would be to categorize documents according 

to a personal style system, which is in harmony with the operation system’s 

predefined categories. This means separate folders for documents, pictures, music, 

videos and further ones, such as downloads or templates, and with further 

subfolders as well to enable fast search when needed. This entails pre-set 

download locations for the chosen web browsers and default save locations for 

software within which new documents are created. 

Furthermore, the desktop should have no more than about a dozen shortcuts 

to the most frequent files and contain no files whatsoever. The Windows Taskbar 

may contain shortcuts to software, and a right click on them might show the most 

recent documents, some of which might even be pinned: 

 
14 https://abiword.net/, January 18, 2025. 
15 https://www.openoffice.org/, January 18, 2025. 
16 https://www.onlyoffice.com/, January 18, 2025. 
17 https://www.polarisoffice.com/en/, January 18, 2025. 
18 https://scrivener.app/, January 18, 2025. 
19 https://www.freeoffice.com/en/, January 18, 2025. 
20 https://www.wps.com/office/, January 18, 2025. 

https://abiword.net/
https://www.openoffice.org/
https://www.onlyoffice.com/
https://www.polarisoffice.com/en/
https://scrivener.app/
https://www.freeoffice.com/en/
https://www.wps.com/office
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Figure 12. Taskbar, most recent and pinned files 

1.4. Filenames 

An effective file management system saves a lot of time, especially when file 

names are designed having in mind productivity. 

1.4.1. Creating Files or Folders 

The first thing to do when creating a new file or folder is to name it properly. 

Ideally, this means a “reasonable length,” which means fewer than 31 characters,21 

yet a title reflecting its contents, meaning that every single file should be named 

to reveal its content without the need to open it. However, before offering further 

clues on file or folder name, certain terminology clarification is needed. 

As defined, a character may be “[a] letter, numeral, symbol, or punctuation 

mark” (AMA 2020, 1126), and a further definition is more comprehensive: “the 

smallest possible unit of arrangement: a space, letter, numeral, punctuation mark, 

or other symbol” (Wellisch 1999, 1). As such, letters are characters “used in 

writing to represent a speech sound and forming an element of an alphabet,” while 

 
21 https://support.promax.com/en/knowledge/special-characters, June 30, 2022. 

https://support.promax.com/en/knowledge/special-characters
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numerals (0–9) are characters “used in writing or print to represent a number” 

(Wellisch 1999, 2), although experts refer to them as digits. 

The letters and numbers are collectively referred to as alphanumeric 

characters, which may also be combined with all sorts of non-alphanumeric 

symbols, which are nevertheless characters, explained in the foreword (Wellisch 

1999), but when we have in mind filenames, letters containing diacritical signs are 

excluded. Due to various operating systems (Windows, macOS, or Linux), 

publishing on the web, and differences in file management systems, the safest way 

is to refrain from using any language-specific characters containing diacritical 

signs in filenames. 

Other special characters, signs, and symbols are also restricted;22 this category 

includes almost all the ones visible on a standard keyboard layout: forward slash 

(/), backslash (\), single or double quotation marks (‘…’, “…”), asterisk (*), 

ampersand (&), colon (:), semicolon (;), vertical bar or pipe (|), backtick (`), 

question mark (?), exclamation mark/point (!), left and right angle brackets (<, >), 

parentheses, curly brackets ({}), square brackets ([]), at sign (@), pound sign / 

number sign / hashtag (#), percent (%), tilde (~), currency signs ($, £, €), plus and 

equal signs (+, =). As such, this rule virtually refers to all signs and symbols except 

for three, listed below: 

1. period / dot (.), 

2. hyphen (-),23 

3. underscore (_). 

Although longer filenames and certain specific characters may cause less 

erroneous interpretation since the adoption of the Unicode Standard,24 major 

sources opt for the use of these three non-alphanumeric characters in filenames, 

also mentioning that blank space is not recommended either; underscore or 

hyphen should be used to separate words, while only one period should be used, 

which is before the extension type (e.g., filename_001.pdf). More than one period 

might also result in erroneous interpretation. 

1.4.2. The Unicode Standard 

The Unicode Standard offers more than 150,000 characters via shortcuts, and 

whenever the shortcut starts with a leading zero or two leading zeros, it is enough 

to type the rest and press the Alt + X combination. Furthermore, these shortcuts 

are not character sensitive, which means that both capital and small letters are 

acceptable. As such, the degree sign may be obtained by typing b0 only and 

 
22 https://blog.josephscott.org/2007/02/12/things-that-shouldnt-be-in-file-names-for-1000-alex/, June 
30, 2022. 
23 A hyphen is different from a dash, the latter being of various lengths, such as the en dash (used to 
express range) or em dash. 
24 https://records-express.blogs.archives.gov/2017/08/22/best-practices-for-file-naming/, June 30, 2022. 

https://blog.josephscott.org/2007/02/12/things-that-shouldnt-be-in-file-names-for-1000-alex/
https://records-express.blogs.archives.gov/2017/08/22/best-practices-for-file-naming/
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pressing Alt+X (Windows) or Ctrl+Shift+b0 (Linux), even if the “official” Unicode 

value is 00B0. 

Once the Unicode value is typed or the symbol is inserted, pressing the Alt+X 

combination multiple times swaps between the character code and the symbol. 

For instance, the Unicode value for the circled capital letter A is 24B6, thus typing 

the code and pressing the Alt+X combination will result in this glyph: Ⓐ. Placing 

the cursor at the end of the glyph and pressing Alt+X again will revert the glyph 

to the code. In various descriptions, the Unicode is marked with a leading U +, 

thus the Character Map of each font typeface starting with this combination can 

swap between the glyph and the character code. Occasionally, it is also referred to 

as Hex code. 

A possible issue is when the selected font typeface does not contain the 

Unicode character. In this case, typing the code and pressing the Alt+X may result 

in the desired glyph, but the text-editing software changes to a different font 

typeface, which may display: 
- the glyph correctly (e.g., in MS Gothic); 
- an empty box or the power On-Off glyph (⏼); 

- a box with a question mark or the power button ( ); 

- a slightly modified symbol (27FF is ⟿ in Segoe UI Symbol, but it is ⟿ in 
Cambria Math, which changes from TNR once U+27CC is typed); 

- a completely different symbol (U+27CC is an old Windows logo  in 
Wingdings). 

More than that, the Unicode combination for the power symbol is 23FB, but 

font typefaces cannot display it properly in Word (⏻), while LO Writer (from now 

on, simply Writer) renders it properly, which is not the case in LO Calc (from now 

on, simply Calc). Interestingly, the code 26D4 (No entry) displays ⛔ in Word, but 

the font typeface changes to Seqoe UI Emoji.25 

Certain glyphs are presented in various sections of this book, including their 

Unicode values and Alt codes (if available), offering descriptions and occasionally 

some remarks. It may happen that in case there are two Alt codes (e.g., Alt+20 or 

Alt+0182 for the paragraph sign), only the shorter one is provided. 

1.4.3. Uploading Files 

When having in mind uploading files on the internet, a hyphen should replace 

underscore to separate words in filenames, as this “will also improve your search 

engine rankings.”26 An additional restriction is that file or folder names should not 

start with any of these symbols. 

Interestingly, various sources restrict the use of further characters: 

 
25 An interesting online article discusses many aspects of Unicode: https://eev.ee/blog/2015/09/12/
dark-corners-of-unicode/, April 29, 2025. 
26 https://www.mtu.edu/umc/services/websites/writing/characters-avoid/, June 30, 2022. 

https://eev.ee/blog/2015/09/12/dark-corners-of-unicode/
https://eev.ee/blog/2015/09/12/dark-corners-of-unicode/
https://www.mtu.edu/umc/services/websites/writing/characters-avoid/
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1. uppercase letters (see Footnote 26); 

2. Roman numbers, as they will be interpreted as standard letters (Wellisch 

1999, 9). 

Thus, the logical conclusion is that filenames should only contain lowercase 

letters with no diacritical marks; these may be completed with numeric characters 

and three signs (underscore, hyphen, and period), with the restriction that these 

three signs may not start or end the filename. Respecting these suggestions enables 

both proper alphanumerical arrangement of files and effective archiving. 

When these rules are not respected, it may result in erroneous file and folder 

names (especially when they are zipped), illustrated in Figure 13: 

 

Figure 13. Diacritical marks in filenames 

In case the previously accepted three non-alphanumeric characters “compete” 

with alphanumeric characters for the supremacy of alphabetical arrangement in 

document names, the following outcome is to be expected, depending on the 

operating systems: 

 

Figure 14. Different filename arrangements in OS 

The table illustrates that when document names differ in only one character, 

non-letters take precedence over letters. While “alphabetization is language-

specific, and no two languages written in the Roman script have the same alphabet 

and orthographic rules” (Wellisch 1999, Foreword), respecting the filename-

related recommendations enables us to have the same filenames on all computers, 

irrespective of the operating system and language. Even if Wellisch states, 

“[s]ymbols other than numerals and letters do not have a universally known and 

agreed-upon order,” the above alphabetical order has been checked personally on 

all three operating systems. 
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A final suggestion is that in case we receive documents with different filenames 

than recommended, it is worth preserving their original names,27 especially when 

they are sent back or forwarded to others. Further details on filenames are available 

at various webpages: Wikipedia28 or language-related sites.29 

1.4.4. Changing File and Folder Names 

There are multiple options to change the names of files and folders. If there is a 

particular filename to be changed, selecting a file and a slightly slower click or 

selecting one and pressing the F2 function key30 usually enables us to do that. 

However, when multiple filenames or folder names need renaming, our suggestion 

is to use a versatile dual pane file manager such as FreeCommander.31 

When we wish to change multiple file names (i.e., to rename them according 

to the filename creating rules), on opening the folder containing the files in 

FreeCommander, the following steps might be necessary: 

1. select all the files; 

2. press Ctrl+M to modify them, upon which a new window (Multi rename) 

will be displayed; 

3. change [n] in the File name box to [nid] to eliminate all language-specific 

characters (diacritical marks); 

4. in the Case box, replace No change to All lowercase; 

5. place the cursor in the Search for box and press the Space bar once; this 

will look for all spaces in the names; 

6. then place the cursor in the Replace with box and type either a hyphen or 

an underscore; 

7. tick the Replace all occurrences box; 

8. press the Rename button. 

 
27 If we modify the document content, we can add our family name or initials with a hyphen or 
underscore at the end of the document, or in case of translation, the new language code may be added. 
28 https://en.wikipedia.org/wiki/Filename, June 30, 2022. 
29 https://style.mla.org/punctuation-with-titles/, June 30, 2022. 
30 Remember that notebook keyboard layouts might be set to multimedia functions rather than basic 

function keys (F1–F12), in which case an extra keystroke might be needed, such as Fn+F2. 
31 https://freecommander.com/en/summary/, June 30, 2022; while this is the one we actually use on 
Windows OS, there are good ones for macOS (Commander One) or Linux OS (Double Commander, 
which is also a cross-platform, available even on FreeBSD) as well. 

https://en.wikipedia.org/wiki/Filename
https://style.mla.org/punctuation-with-titles/
https://freecommander.com/en/summary/
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Figure 15. Multi-rename, FreeCommander 

These changes will correct many filename issues, although it may happen that 

further changes are needed: 
- in case the Modify window was closed, select all files again and press 

Ctrl+M again; if the window is still available, press Reload again; 

- place the cursor in the Search for box again and type the below signs one 
by one, leave the Replace with box empty and press Rename after each 
sign over and over again: 

1. Ampersand (&); 

2. Apostrophe (’); 

3. Opening and closing parentheses () and square brackets [], each symbol 

separately; 

4. Comma (,); 

5. Plus sign (+); 

6. Question mark (?); 

7. Exclamation mark / point (!); 

8. Reduce double or triple hyphens or periods to one by typing two/three 

hyphens or periods in the Search for box and typing only one of them in 

the Replace with box. 

FreeCommander is also useful when multiple files need to be numbered 

(check the Counter section in the Multi-rename window) or we wish to add a 
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similar string of characters at the beginning or end of each filename (in which case, 

type the desired string of characters after the [n] in the File name box). 

If everything goes wrong, do not close the Multi-rename window; go to 

Command and press Undo, which reverts the filename changes to the previous 

state. 

Another extra function offered by the software is that on selecting all 

filenames in FreeCommander (Ctrl+A), we can copy the list of names and paste 

this list in a separate file by holding down simultaneously the Alt+ Shift+Insert 

keys (or go to Edit, Copy to clipboard, Copy item name to clipboard). 

Organizing items is strongly encouraged by The Copyeditor’s Handbook as 

well, which suggests that everybody should folderize to be efficient (Preface by 

Einsohn and Schwartz 2019, xvi). 

The next stage might be the setup of documents to be created, which should 

follow some rules as well, detailed in the next chapter. 



Chapter 2   

Setup 

2.1. The Quick Access Toolbar 

Setup refers to operations which involve creating new text-based files, in our case 

mostly in Word or Writer. While these office suites come with certain predefined 

settings, these are constantly “under development” for the sake of productivity. 

However, productivity is different with every single user, and a few setup 

options are worth considering when using Word or Writer: 

1. customizing the Quick Access Toolbar; 

2. exporting to PDF file format; 

3. adding other software to enhance productivity. 

As default settings may not be “user-friendly” for everyone, it is worth 

considering minor adjustments. In the case of Word, the Quick Access Toolbar is 

on the very top an open document, and depending on the frequency of using 

certain commands, users may add some of them to this toolbar. 

There are five icons of the Quick Access Toolbar in Figure 16 below: 

 

Figure 16. Quick Access Toolbar, Word 

The first one is a Word logo (restores or minimizes the windows), followed by 

a Zotero icon (Add/Edit Citation), an Insert a Comment icon, an Insert Footnote 

icon, and a PDF or XPS icon. 

The last icon of this toolbar (similar to an arrow down button) can help in this 

respect, as clicking on it reveals certain options, including the possibility to add 

More Commands…: 



46  ◼   Basics of Word Processing for Thesis Writing 

 

Figure 17. Customizing Quick Access Toolbar, Word 

A click on More Commands will display a window, and the Popular 

Commands in the search box should be changed to All Commands. The list below 

All commands shows all the available options, and the illustration below reveals 

that we have added four new commands to the Quick Access Toolbar, as these 

commands are heavily used: 
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Figure 18. Commands added to Quick Access Toolbar, Word 

As Figure 18 shows, the newly added commands are Publish as PDF or XPS 

(we often export DOCX files to PDF files); Add/Edit Citation, which belongs to 

Zotero (a separate software which can be embedded into Word);32 Comment [Insert 

Comment], as this is often used when reviewing documents; finally, Footnote, 

which can add a footnote to the document with a single click. Although adding 

these commands to the Quick Access Toolbar requires a few steps, once set, it will 

be useful in the long run. 

However, when the same functionality is pursued in Writer,33 its main toolbar 

already contains an Export Directly as PDF icon, the Insert Footnote icon, and 

Insert Comment as well: 

 
32 Further details: https://www.zotero.org/support/word_processor_plugin_usage, August 20, 2025. 
33 Further details: https://www.zotero.org/support/word_processor_plugin_usage, August 20, 2025. 

https://www.zotero.org/support/word_processor_plugin_usage
https://www.zotero.org/support/word_processor_plugin_usage
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Figure 19. PDF icon, Writer 

 

Figure 20. Insert Footnote icon, Writer 

 

Figure 21. Insert comment, Writer 

Zotero makes it easy to create documents with references in Word, and there 

is no need to install Zotero separately for LO, as it is embedded automatically 

while installing it. After that, six command icons will appear at the beginning of 

the main toolbar, starting with the Add/Edit Citation command icon. 

Other users will surely find further useful commands, depending on the 

purpose of using any office suite, and once the most frequent ones are added, we 

should focus on how these suites open a new file, which is basically a new page 

in the case of Word and Writer. 

2.2. Page Setup 

Page setup is also predefined in the case of Word and Writer, although few users 

are happy with that, especially when it comes to printing the pages. 

All authors mention that various purposes require various typographical rules 

(Jury 2007, Virágvölgyi 2004), but in case we have in mind an average user, it is 

worth considering what is more readily available. In commerce, the most 

widespread paper size is A4 (210 × 297 mm or 8.3 × 11.7 inches), which means 

that the majority of text-based documents should have a similar size by default. 

This is commonly referred to as Layout, which is “the arrangement of all the 

elements of design and typography on the page or screen for optimal readability, 

taking into account the context and aesthetic requirements of the content” (AMA 

2020, 1118). The standard layout for page includes major settings, such as Margins, 

Orientation, and Size, and minor ones such as Columns, Breaks, Hyphenation, 

Indent, and Spacing. 
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2.3. Page Size (Format) and Margins 

Based on the previous section, the standard page size is A4, and neither Word nor 

Writer is set by default to this size. 

Resizing a page is not difficult if not many new documents are created, but 

otherwise it is worth creating a template (discussed later). Page size may be 

changed in Layout, Page Setup section, Size, A4 (Word) and Format, Page Style, 

Page, Format: A4 (Writer). 

 

Figure 22. Setting page size, Word 
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Further page setup in Word is found in the Layout section as well: standard 

Orientation is Portrait, while Margins should be set to Normal unless required 

otherwise (Custom Margins). As for Writer, Orientation is found below the 

previously mentioned Format, similarly to Margins: 

 

Figure 23. Default page style A4 format, Writer 

Bringhurst offers details regarding further recommended margins for various 

book types, including multiple columns (Bringhurst 2004, 161), having in mind 

“room for the readers thumbs,” but he concludes that a visually appealing page 

lies in the letterforms and in its margins (Bringhurst 2004, 165). However, the 

standard margin for all four sides (top, bottom, left, and right) is 2.54 cm, or 1 inch, 

but “[d]issertations and theses may have different requirements if they are to be 

bound” (APA 2020, 45). 

Further settings are also possible: a standard page typically has one column, 

but it can have more (Layout, Columns for Word; Format, Page Style, Columns for 

Writer). 
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2.3.1. Page View 

To enhance page visibility, there are two very useful possibilities, and one of them 

is to enable the paragraph mark (pilcrow sign). Word considers it “useful for 

advanced layout tasks” because it shows “paragraph marks and other hidden 

formatting symbols,” as well as non-printable characters: 

 

Figure 24. Show paragraph mark, Word 

Writer offers to enable/disable all formatting marks from the Menu bar (View, 

Formatting Marks), from the tabbed interface (Home, Toggle Formatting Marks), 

from the Toolbar (Formatting Marks with the paragraph symbol: ¶), or as a 

keyboard shortcut (Ctrl+F10). 

2.3.1.1. Crop Marks and Text Boundaries 

If we position the cursor over the paragraph mark in Word, it will display 

Show/Hide ¶, including its shortcut (Ctrl+*). However, the shortcut is not 

functional, but it works if we use the Ctrl+Shift+8 combination.34 Writer relies on 

the Ctlr+F10 shortcut, and the paragraph mark is labelled as Toggle Formatting 

Marks. 

When this is enabled, the document may also display the so-called crop 

marks in Word. By default, this option is not enabled, but it is easy to do that: File, 

Options, Advanced, Show document content and tick Show crop marks, which 

 
34 While various guides suggest Ctrl+Shift+*, this is only functional when the * sign is selected from 

the regular keyboard and not from the numeric keypad, so it is basically the shortcut mentioned above. 
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will be displayed in all four corners. The Writer version is View, and then tick 

Boundaries. The results are illustrated for Word and Writer in Figure 25 below: 

 

Figure 25. Displaying crop marks (Word) and text boundaries (Writer) 

2.3.1.2. Breaks—Page, Section, Column 

There are various breaks, which are also invisible unless the paragraph sign is 

enabled. 

Page break may break the page at specific parts, for instance at the beginning 

of a new heading or section or before/after an inserted table or illustration or when 

we simply wish to start a new idea on a different page. Inserting a page break in 

Word is possible either by Insert, Page Break or by Layout, Breaks, Page. Layout, 

Breaks offers further types of breaks, also explaining their use. Writer offers these 

options within Insert, Page Break, or More Breaks: 
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Figure 26. Breaks, Word 

 

Figure 27. Insert breaks, Writer 
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Figure 28. Insert page break, Writer 

As Figure 26, Figure 27, and Figure 28 illustrate, Page, Column, and Section 

Breaks might be needed for various purposes, some of which are listed below: 

1. separate ideas to start on a new page; 

2. page number should start only on a later page, not to number the title 

pages; 

3. non-continuous page numbering is required; 

4. odd/even pages are required; 

5.  the next page should have a different layout (Portrait to Landscape). 

The shortcut for Page Break is Ctrl+Enter,35 while Ctrl+Shift+Enter is the 

shortcut for Column Break. 

2.3.2. View 

The Menu bar contains View, which—by default—shows a certain Print Layout 

(Word) or Normal (Writer). This means that in case the page is printed, it should 

look the same as on screen, except for the non-printable formatting marks. 

 
35 Word uses Return for the Enter key. 
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The View in Word offers a Ruler, Gridlines, and a Navigation Pane. While 

enabling the Gridlines might be useful only in restricted cases, the other two seem 

to be more frequently needed. The One Page or Multiple Pages show either one 

page (like a scroll) or multiple pages (left–right) on the screen. In case the 

Navigation Pane is inactive, the Ctrl+F (find)36 will enable it, offering to show 

Headings (having in mind a table of contents), Pages (a mini-view of pages, also 

good for faster scrolling), and Results (searching for strings of characters or other 

items in the entire document, up to 100 instances): 

 

Figure 29. Navigation, Word 

The View in Writer enables us to activate the Rulers, Gridlines, various 

Boundaries, and further options as well. If we wish to search within the document 

for character strings, the Ctrl+F shortcut activates an extra bottom bar with various 

find functions (Find All, Match Case, search up/down). In order to see something 

similar to Headings in Word, we need to press the F5 function key to enable 

Navigator, which offers (among others) a complete list of all Headings, Tables, 

Images, Bookmarks, Sections, Hyperlinks, References, Indexes, Comments, 

Footnotes, and Endnotes, and this Navigator may be moved to any place on the 

screen: 

 
36 The Find and Replace option is available either as a shortcut (Ctrl + H) in both Word and Writer or 

via the button placed in the Home toolbar (Word) or the main toolbar (Writer). 



56  ◼   Basics of Word Processing for Thesis Writing 

 

Figure 30. Navigator, Writer 

Other views than Print Layout or Normal View may also be useful. Word 

offers Read Mode, Web Layout, Outline, and Draft views, while Writer only a Web 

View. 

2.3.3. Styles 

The importance of Styles is well reflected in Word. The Home tab dedicates a 

highly visible part to them, which offers the possibility to set special style 

templates for various sections. 

This setting option includes the Name, Style type, Formatting (font type, font 

size, Bold, Italic or Underline, font color), Alignment, Line and Paragraph spacing, 

Indentation, Tabs, Border, Language, Frame, Numbering, Shortcut key, and Text 

effects, referring to the selected text. Actually, there are a number of predefined 

styles, starting with the Normal text. 
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While various MSO editions have different Normal text style templates 

(Calibri font, 11-point font size for Office 2016 or 2019; Aptos font for Office 2021 

or 2024), there are also templates for headings, quotes, lists, captions, or tables, 

and all of them may be changed: 

 

Figure 31. Modifying styles, Word 
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Figure 32. Modifying styles, Writer 

Although the Style section of the Home Tab is rather extended, the 

Ctrl+Alt+Shift+S shortcut enables a sidebar on the right with the full list of Styles, 

with extra buttons to create new styles or further options as well: 
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Figure 33. Create new style, Word 

Writer offers a Styles tab on the main toolbar with similar options, and the 

shortcut for the Styles sidebar is F11. 

While it seems that all settings may be carried out with the ones discussed so 

far, there are three more in-depth settings referring to the entire text (Text 

Alignment), a specific paragraph setup or the line setup, detailed in the following 

sections. 
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2.3.4. Text Alignment 

As defined, the term align in text editing refers to how the text is organized on a 

page: “To place text and/or graphics to line up horizontally or vertically with 

related elements” (AMA 2020, 1123). 

Once the paper size is set to A4, text alignment is important to match both 

printer settings (full-width pages) and readability: “the content is easier to read 

when it is justified left/ragged right.”37 

Text Alignment may refer either to the entire document or just to a paragraph, 

which may be aligned left (Ctrl+L), center (Ctrl+E), right (Ctrl+R), or justified 

(Ctrl+J), and the shortcuts refer to both Word and Writer. Figure 34 below shows 

all four types of alignment: 

 

Figure 34. Text alignment, Writer 

As shown, the four alignment types visibly differ from each other, serving 

various purposes (e.g., breaking a monotonous text, poetry, title, maximizing 

printing space, etc.). While these are rather visible alignment types, there are three 

minor options which directly affect the layout of the text. 

2.3.4.1. Hyphenation 

Hyphenation is an option to break longer words in a text, directly affecting text 

layout,38 its use sparking heated arguments, mostly against it, although it is fully 

justified per se. 

Bringhurst prefers “ragged” texts “if ragged setting suits the text and the page,” 

which means no hyphenation is needed. He is also against justified texts, as “there 

is always a trade-off between evenness of spacing and frequency of hyphenation” 

(Bringhurst 2004, 27), also mentioning that enabled hyphenation might lead to a 

 
37 https://cuttingedgepr.com/best-body-type-alignment-in-printed-publications/, January 21, 2022. 
38 As for the hyphen as a punctuation character, see the chapter Punctuation and Spelling, Dashes, 
Hyphen. 

https://cuttingedgepr.com/best-body-type-alignment-in-printed-publications/
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number of “consecutive hyphenated line-ends,” which is nevertheless “better than 

sloppy spacing”, returning to the idea that “ragged setting is better yet” (2004, 10), 

eliminating the possibility of “outbreak of hyphenation.” Actually, there is even a 

nickname for “four or more hyphens that appear at the end of consecutive lines,” 

which is called a ladder (AMA 2020, 1136). 

Although Shaw accepts that “many contemporary graphic designers … do 

what they can to avoid it” and “minimize the number of hyphens in a row at the 

end of lines in justified text setting,” to avoid “wildly fluctuating line lengths”, he 

is also convinced that the hyphen is an “unprepossessing character” (Shaw 2018). 

Yet his conclusion is that “[h]yphens are not a necessary evil. If used with care 

and understanding, they are an aid, rather than a hindrance, to good typography” 

(Shaw 2018). Logically, this means that the text is set to “flush left”39 and “rag 

right,” a setting that is both the default and “it is preferred.” When hyphenation is 

required, Bringhurst explains that it should be in accordance with the 

“conventions of the language,” which means that, for instance, proper names are 

not to be separated, except for “as a last resort” (Bringhurst 2004, 43). 

A stricter manual explicitly states that “[a]uthors should make sure the 

hyphenation function on their word processor is turned off,” and—in their view—

only hyphens in compound forms are acceptable (CMOS 2024, 71), without being 

worried about the “extremely ragged” right-hand side, and manuscripts should 

never contain hyphenation. Another manual also warns us not to “use the 

hyphenation function to break words at the ends of lines” (APA 2020, 45). 

As Bringhurst explains, hyphens break the text so much that the reader is 

distracted, especially when they are combined with other distracting content such 

as illustrations (2004, 10). Although guidebooks argue that both parts of a 

hyphenated word should appear on the same page, there is so much rejection of 

hyphens overall that our recommendation is to disable this function. This is found 

in the Paragraph tab by clicking on the bottom right small arrow, which opens a 

new window (Word). Writer also has this option under Format, Paragraph, Text 

flow, and Hyphenation, offering interesting options as well (e.g., maximum 

consecutive hyphenated lines or minimum word length in characters): 

 
39 Flush left, as Shaw explains, is “alignment of the left side of the div, page, screen, or margin,” while 
the right side is not justified, becoming “ragged right” (Shaw 2018). 
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Figure 35. Hyphenation, Word 

 

Figure 36. Hyphenation, Writer 

Although the justified alignment might look more appealing visually, 

supported by a number of printed books, magazines, and newspapers, Shaw argues 

that in a postmodernist world this should be eliminated, together with the 

hyphens, which look outdated (Shaw 2018). Bringhurst also concludes that the 

ragged right “will lighten the page and decrease its stiffness” (2004, 10). 

2.3.4.2. Word Spacing 

As explained, “[f]or text set ragged right (unjustified), word spacing may be fixed 

and unchanging,” but if the text is justified, “more flexible” spacing is needed, 
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which is a “fourth of an em,” ranging from “a fifth of an em to half of an em” (AMA 

2020, 1117). 

While this is an important remark, the majority of users do not need to check 

that, as both Word and Writer are set automatically in this respect. An em refers to 

the length of an em dash.40 Unfortunately, less skilled text writers try to position 

text by holding down the Space bar multiple times, which is considered a grievous 

mistake, although it is not visible in printing. As such, it is hardly a typographical 

error, but it is a shameful layout mistake, easily detected by enabling the paragraph 

mark. The multiple use of Space bar should be replaced, for instance, by proper 

indentation, the use of tables or columns, or the Tab key (interpreted as 4 or 8 

white spaces), yet this last option is also discouraged (discussed in Section 2.4.2.). 

2.4. Paragraph Setup 

A full text may be split into paragraphs (chunks of a text), and thus “[a] paragraph 

is a cohesive group of sentences,” which elaborates an idea or “related thoughts” 

(AMA 2020, 1135). The typical length of a particular paragraph is a few lines in 

order to maintain the reader’s attention, so they should be neither too short nor 

too long (Ármeán 2017, 67). 

Setting up a paragraph may refer to multiple operations, as it involves the 

space before and after a paragraph, as well as the lines and the two sides of the 

paragraph. 

2.4.1. Paragraph Alignment 

Paragraph alignment is similar to text alignment, referring only to a particular 

paragraph. Thus, a paragraph should be set to flush left, ragged right, while 

justified is also frowned upon (APA 2020, 45). 

The use of justified paragraph without hyphenation is a clear sign of 

typographical illiteracy (Ármeán 2017, 93–94), and the author explains that center 

alignment is only recommended in the case of titles or special lines, while right 

alignment is recommended for table columns, list of numbers, mottos, or captions. 

Improper alignment within a paragraph or a text may result in a river, which 

is the name of a “streak of white space that runs down through lines of type, 

breaking up the even appearance of the page,” and, of course, it should “be 

avoided” (AMA 2020, 1142). This might be the only reason why words should be 

broken by hyphenation, as explained by Jan Tschichold, who considers that 

“breaking words is less harmful to the appearance of the page than too much space 

between words” (Shaw 2018). 

 
40 Em dash is discussed in Chapter 7: Punctuation and Spelling, Dashes, Em Dash. 
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Furthermore, the avoidance of rivers might involve other possibilities as well, 

such as non-breaking space and non‑breaking hyphen.41 

2.4.2. Paragraph Indentation 

Seeing the problems of alignment, some might think of manual handling, which is 

not recommended, whatever the case: “Do not manually divide words at the end 

of a line” (APA 2020, 45), and indentation might be a possible “replacement,” 

which means “[t]o set a line of type or paragraph in from the margin or margins” 

(AMA 2020, 1135). 

By default, the very first paragraph is flush left (Bringhurst 2004, 39), whereas 

the first line indentation of every subsequent paragraph is 1.27 cm, or 0.5 inches 

(from the left margin), knowing that the “most common paragraph indent is one 

em” (Bringhurst 2004, 40), and not smaller than “one en” (Bringhurst 2004, 39). 

Further lines of a paragraph “should be left-aligned” (APA 2020, 45), and this way 

the result will be a consistent paragraph look. 

Although the Tab key in word processor is typically set to this indentation, it 

should never be used to create a first line indentation this way (CMOS 2024, 73). 

However, the same paragraph states that an additional first-line paragraph indent 

may be applied “either with the Tab key or, preferably, with your word processor’s 

indentation feature.” A built-in shortcut in Word for paragraph indentation is 

Ctrl+M. 

Another type of indentation is Hanging indent, which indents all the lines in 

a paragraph, except for the first one. This might be useful in the case of a reference 

list (APA 2020, 46), index table, or a multiple-choice test layout, and the same 

warning applies in this case too: “never use tabs to achieve hanging indents” 

(CMOS 2024, 70), as tabs are only to be used in a paragraph only “after a number 

or symbol in a vertical list.” 

The APA Publication Manual offers a list of items indented differently. In 

their view, titles, bylines and affiliations, section labels, Level 1 headings, 

Appendix labels, and titles should be centered, while quotations “should be 

indented from the left margin 0.5 in.,” and in case quotations are longer than one 

paragraph, ”subsequent paragraphs of the block quotation should be indented 

another 0.5 in., such that those first lines are indented a total of 1 in.” (APA 2020, 

46). 

Although these manuals offer such meticulous guidelines, the competing 

publications seem to follow internal rules in this respect as well. Reality shows 

that having in mind the publication of a book or scientific paper, the author must 

follow the publication guidelines of a particular publishing house, which cannot 

 
41 See Chapter 6 on Dashes, Non-breaking Space and Non-breaking Hyphen. 
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cover as many cases as the most authoritative manuals. As such, several issues are 

left to the goodwill of the author, the proofreader, and ultimately the publisher. 

2.4.3. Paragraph Break and Keep Options 

As specified earlier, the Space bar is not designed to create breaks for paragraphs. 

It is the Return/Enter key in word processors which should serve this function, 

meaning that whenever the Return/Enter is pressed, a new paragraph is created. 

This is referred to as the “hard return,” resulting in a new paragraph with 

similar formatting as the previous one. Thus, the paragraph break refers to the 

visible distance in space between two consecutive paragraphs. As such, each 

paragraph should end with a punctuation mark, and in case a new one is needed, 

this is followed by a hard return (CMOS 2024, 70), displaying the paragraph mark 

(¶), provided the Show/Hide button in Word or the Formatting marks button in 

Writer is active. The distance between two paragraphs should be set to 6 points in 

Word or 0.06” in Writer, and the box below (Do not add space between paragraphs 

of the same style) should not be checked: 

 

Figure 37. Paragraph spacing before and after, Word 
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Figure 38. Paragraph spacing before and after, Writer 

Controlling the paragraph layout is also possible by managing the number of 

first/last lines of a paragraph, which either start or end a page. Accessing the Home 

tab in Word and clicking on the bottom-right small arrow of the Paragraph section 

displays a new window. More simply, a right-click on the paragraph enables a 

drop-down list, and selecting the Paragraph option enables the same window. The 

second tab (Line and Page Breaks) offers four Pagination options. In case the third 

box is ticked (Keep lines together), the paragraph which is spread over two pages 

will be displayed on one page only. 

The second option is Pagination (Keep with next), which keeps two 

consecutive paragraphs together. Similar functions are available in Writer as well 

if we access the Text Flow tab in Paragraph, which is also accessible by right 

clicking on the paragraph(s) in question: 

 

Figure 39. Keep lines together and Keep with next, Word 
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Figure 40. Keep lines together and Keep with next, Writer 

However, there is a “soft” Return/Enter in case we only wish to break the line 

(discussed in Section 2.5.3.). 

2.4.4. Widow/Orphan Control 

By default, word processors should automatically handle cases when the first or 

the last line of a paragraph would be on a different page and should keep the entire 

paragraph together. This is also found in the Pagination section (Word) or the Text 

Flow tab (Writer). 

The last line of a paragraph or column landing on the top of the second page 

is called widow, and it should be “avoided” (AMA 2020, 1147). Bringhurst refers 

to them as “stub-ends” which “look foreshortened and forlorn,” and typographical 

culture dictates “to give them one additional line for company” (2004, 44), so he 

warns us to “[n]ever begin a page with the last line of a multi-line paragraph” 

(2004, 43). 

The first line (or one or two short words) of a paragraph or a single line may 

start at the bottom of a page or column, which is called orphan42 (AMA 2020, 

1139). These single lines look “isolated … when paragraphs begin on the last line 

of a page” (Bringhurst 2004, 43), so this is also automatically adjusted by word 

processors. This way, a minimum of two lines belonging to the same paragraph or 

column should end or start a page. 

 
42 However, the typographic term for orphan is telling (Bringhurst 2004, 43). 
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2.5. Line Setup 

The previous sections already involved lines, as keeping the lines of a paragraph 

together was discussed, and possibilities with the first/last line of a paragraph or 

a column was needed. 

Nevertheless, there are further possible settings for lines: line spacing, line 

length, and line break. 

2.5.1. Line Spacing 

A very technical presentation of line spacing is that it “refers to the vertical 

distance between the base of 1 line of text and the base of the next line of text” 

(AMA 2020, 1117). 

There are various standards regarding the distance between two lines of a text, 

paragraph, section, or column. By default, Word uses 1.08 line spacing, which 

means that it adds 8 points of space between paragraphs separated by a hard 

Return/Enter, which, of course, may be changed (as discussed in Section 2.4.): 

 

 
Figure 41. Line spacing, Word 

 
Figure 42. Line spacing, Writer 
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Figure 41 and Figure 42 above show that line spacing is set to 1 in both Word 

and Writer, and there are pre-set spacing options. For instance, a standard A4 page 

uses Times New Roman fonts, font size 12, and 1.5 spacing between the lines to 

be able to estimate the number of characters per page (ranging from 1,800 to 3,700, 

largely depending on these settings). 

Line spacing may also be affected by other options such as underlined 

characters (which is very frowned upon by typographers and scholars), superscript 

(Ctrl+Shift++) or subscript (Ctrl+Shift+-) characters43 that go above or below the 

regular line space, and special symbols which simply do not fit into the standard 

spacing, such as circled letters and numbers. 

Certain publishing houses or scientific journals may require double space 

between the lines, and space requirements may include not only lines or 

paragraphs but illustrations, tables, lists, quotations as well, knowing that footnote 

lines are typically set single-spaced, and special texts (such as formulae or 

equations) should be visibly separated by the main texts with larger spacing. A 

potential guideline is detailed in the APA Manual (APA 2020, 45). 

2.5.2. Line Length 

There are various guidelines referring to the number of characters per line for the 

sake of readability, which should respect the previous recommendations as well, 

mostly referring to the ban of relying on hyphenation (thus excluding ladders or 

rivers). 

Naturally, line length is firstly affected by paper size, and an A4 paper might 

contain close to 100 characters per line (Times New Roman 12, the basic alphabet 

letters, and most common punctuation signs, including spaces). As explained, the 

best readability is associated with about “45 to 75 characters (including 

punctuation and spaces),” whereas scholarly journals consider that “40 to 50 

characters per line is ideal” (AMA 2020, 1116). The same numbers are 

recommended by other sources as well (Bringhurst 2004, 26), while best 

readability in the case of emails is similar: no more than 75 characters per line. 

Interestingly, the lowest recommended character number is very close to the 

number of characters per line in the case of subtitling as well, where dedicated 

applications signal the excess of 43 characters per line.44 

Moreover, character number per line may also be changed by expanding or 

condensing specific words45 by clicking on the bottom right-hand arrow of Fonts in 

Home tab (Word), then Advanced, Spacing and selecting Expanded or Condensed. 

 
43 Their shortcuts are functional only if the + and - signs are typed on the regular keyboard and not on 
the NumPad. 
44 For instance, Subtitle Edit. 
45 In this sentence, the words expanding and condensing were expanded and condensed, respectively. 
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In the case of Writer, this is possible via Format, Character and Position, leading 

to a window with Character spacing: 

 

Figure 43. Font or Character spacing, Word 

 

Figure 44. Font or Character spacing, Writer 
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Similarly, there used to be an ideal number of lines per page. As explained, 

“the perfection of the forty-two-line Bible; no longer was the typographic letter 

sacrosanct” after Zapf’s automatic letter scaling became widespread (Houston 

2013, 142), even if many scholars dislike it, including Bringhurst: “no typesetting 

software should be permitted to compress, expand or letterspace the text 

automatically and arbitrarily … [this] should be solved by creative design” 

(Bringhurst 2004, 42). 

A final suggestion is that “[w]hen the line is short, the text should be set 

ragged right” (Bringhurst 2004, 27), which is hardly respected in publications. 

2.5.3. Line Breaks 

Word processors can handle line breaks by default, which means that in case a line 

reaches the limit of characters, it is automatically broken and the “extra” characters 

will start a new line, depending on how Alignment is set: Left, Right, Center, or 

Justified. 

Default line break is carried out by automated space calculation between 

characters and words separated by space, although “[g]ood justification is 

calculated paragraph by paragraph instead of line by line” (Bringhurst 2004, 192), 

knowing that overall spacing between individual characters is technically referred 

to as kerning, and this might be changed as well. Ligatures, Number spacing, 

Number forms, and Stylistic sets may also affect line breaks in Word, while Pair 

kerning combined with Character spacing is available in Writer. 

A so-called “soft break” is possible by the Shift+Enter combination, which 

breaks the line within a paragraph and starts a new line, thus preserving the line 

spacing. This might be useful when multiple short lines form a unit such as the 

details of an address or creating a numbered or bulleted list, as the soft break 

creates a new line without a new number or bullet. These soft breaks are displayed 

as the Return/Enter or “carriage return arrow” (↵). 

Word offers a further option in this respect via the File tab, then selecting 

Advanced, Layout options and checking the box before Don’t expand character 

spaces on a line that ends with SHIFT+RETURN. Something similar may be set in 

Writer by going to Tools, Options, expanding the Writer options, and then 

selecting Compatibility: 
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Figure 45. Soft break options, Word 

 

Figure 46. Compatibility options, Writer 
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It may happen that extra-long lines are needed to offer a correct link to a 

Digital Object Identifier number (DOI) or a link to a webpage, in which case no 

manual break is recommended, as the link might not be valid anymore. Instead, 

automatic breaks by the word-processing programs “are permissible” (APA 2020, 

45). 

After having discussed page, paragraph, and line setup, the next step to secure 

a clear organization of longer texts is to set various heading styles. 

2.6. Style Setup 

While multiple-level styles are automatically provided by word processors, their 

use might constitute certain issues, for instance when numbering them. 

Although there is a possibility to use many levels of heading, there are only 

five possible ones according to the APA style (APA 2020, 48): 

 

Figure 47. Heading levels according to APA 

A further problem is the positioning of headings (titles), bylines, and various 

labels (captions), as some sources consider them best center aligned, in bold (APA 

2020, 46), while others opt for flush left (CMOS 2024, 73), so this setting seems to 

depend on the choice of publishing houses with the remark that levels 2 and 3 are 

typically in bold or bold italic. However, before discussing heading levels, the 

starting point is the Normal style, which provides the text body. 

2.6.1. Normal Style 

Setting the normal style may be considered the foundation of every document, as 

it is the most often used style, and every other form(at) is compared to this one. 

While the most standard normal style for drafting documents used to be the 

Paper Size A4, Orientation: Portrait, Font Times New Roman, Font Size 12, Line 
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spacing 1.5, flush left, this is no longer the case, and more recent releases of Word 

and Writer offer different font families and sizes. 

The normal style—which is understood as following a heading—usually 

differentiates the first line of the paragraph from the subsequent ones by 

indentation, although other than normal styles may use hanging indent. 

As the normal style is the most used one, setting a shortcut to apply this style 

is more than optional, for instance Alt+N. A right click on the Normal style in the 

Style gallery (Ctrl+Alt+Shift+S) offers the Modify option, which opens a new 

window, where this shortcut may be set. 

Further variants of the Normal style also need shortcuts such as the normal 

style following a table (e.g., Alt+T, see Section 6.4.) or a caption of a figure (e.g., 

Alt+C and Alt+P see Section 6.5.). 

2.6.2. Heading Styles 

Creating and formatting heading styles is vital to organize the information and to 

enable the automatic processing of the table of contents (see Section 6.16.1.). 

However, before offering a possible way to create numbered headings, it is 

important to discuss the capitalization of English titles, subtitles, or headings. 

2.6.2.1. Capitalization 

Capitalizing English titles, subtitles, or headings is often prescribed, although it 

seems to be only a recommendation, as publishing houses and journals often 

neglect these rules. 

According to the prescription (AMA 2020, 20), major words of titles and 

subtitles should be capitalized, including short verbs as well (Be, Am, Is, Do), 

while the following word categories should not be capitalized: 

1. the three articles (a, an, and the); 

2. shorter than four-letter prepositions (in, on, at, by, to); 

3. coordinating conjunctions (and, or, for, nor, but, per); 

4. the to particle in infinitives. 

While the list may seem logical, there are many counterexamples to these 

recommendations, leading to the conclusion that capitalization should be 

consistent within a document. 

2.6.2.2. Simple Heading Styles 

There are various tutorials explaining how headings are worth using, including 

their numbering,46 which signal that extra effort is needed to set heading styles 

properly. 

 
46 For instance: https://www.youtube.com/watch?v=GevZOS-nCuw&ab_channel=YoungCareerPros, 
June 25, 2025. 

https://www.youtube.com/watch?v=GevZOS-nCuw&ab_channel=YoungCareerPros
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However, the simplest option is to start from the default headings provided 

by Word and Writer. In the case of Word, heading styles are available once a new 

document is created, after which the Ctrl+Alt+Shift+S shortcut reveals the entire 

list of styles. 

A click on Heading 1 style offers the possibility to change the line to Heading 

1 (where the cursor blinks), and a right click on Heading 1 can modify its settings. 

As for the numbering, we have to access the drop-down arrow of the Multilevel 

List button on the Home tab, Paragraph group and select the Define New 

Multilevel List. The right side of the opening window offers the possibility to Link 

level to style, and Heading 1 should be selected. The Position should be aligned 

to 0, Text indent at also to 0, after which the Set for All Levels… button should be 

clicked on and all other values set to 0. Then changing the Follow number with 

line to Space is recommended, and the OK button finalizes the entire procedure. 

After these settings, Heading 1 is numbered and displayed in the left-side panel 

(Ctrl+F, Headings) properly. 

Further headings should be set similarly, except for Heading 2 must be linked 

as Heading 2, then Heading 3 as Heading 3, and so on. Figure 48 shows how 

Heading 1 is set as described above: 

 

Figure 48. Setting Heading 1, Word 
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In case all headings are displayed correctly and newly created ones fit into 

the list with proper numbering, no further action is necessary. However, there are 

more complex options to create headings, presented in the next sections. 

2.6.2.3. Heading Names and Numbering 

Successful titles, subtitles, and headings offer the summary of the content in the 

shortest possible way, as they should be “concise, specific, and informative and 

should contain the key points of the work” (AMA 2020, 14). 

Prior to creating heading styles, it is also important to mention that question 

forms should be avoided, which is characteristic to “more provocative, than 

research articles” (AMA 2020, 16). 

Before creating headings, the following icons are worth checking on the Main 

tab in Word: 

 

Figure 49. Multilevel list icon, Word 

 

Figure 50. Increase indent icon, Word 

A possible way to create new headings47 in Word is detailed below: 

1. place the cursor in the first empty line. Type the desired name for 

Heading 1 (e.g., A1); 

2. choose the drop-down arrow of Multilevel List in the Home tab, 

Paragraph group, then select List Library 3rd variant), triggering automatic 

numbering (1., 1.1., 1.1.1.), which replaces A1 with 1. A1, then press Enter 

for the second heading; 

3. the next numbered item is offered (2.), but select Increase Indent in the 

same Paragraph group, which changes 2. to 1.1. Type the name of 

Heading 2 (A2), then press Enter; 

 
47 This description is based on the courses of M. Csernoch, to whom I am indebted. 
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4. the next numbered item is offered (1.2.), but select Increase Indent, which 

changes 1.2. to 1.1.1. Type the name of Heading 3 (A3), then press Enter; 

5. the next numbered item is offered (1.1.2.), but select Increase Indent, 

which changes 1.1.2. to 1.1.1.1.; type the name of Heading 4 (A4), then 

press Enter; 

6. the next numbered item is offered (1.1.1.2.), but select Increase Indent, 

which changes 1.1.1.2. to 1.1.1.1.1.; type the name of Heading 5 (A5), then 

press Enter and the automatic numbering might be deleted; 

7. when ready, go back to Heading 1 (1. A1) and click on the Multilevel List 

again and choose Define New Multilevel List; it is recommended to set 

Text indent to 0, Aligned to 0, Follow number with: Space and Set for all 

levels; by pressing this button, a new window appears, where Additional 

indent for each level should also be set to 0. 

 

Figure 51. Multilevel list, Word 
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However, Word seems to fail the command Follow number with Space, thus 

each heading should be checked separately after the first one is set, by placing the 

cursor on the desired heading, clicking on the Multilevel List icon, and selecting 

the Define new Multilevel List option: 

 

Figure 52. Define new multilevel list. Set for all levels, Word 

2.6.2.4. Formatting Headings as Paragraphs 

The next challenge is to format each heading one by one. Place the cursor on 

Heading 1, and then fine-tune its settings by clicking on the southeast arrow in the 

right bottom corner of the Paragraph group. When ready, do the same for all 

subsequent headings (by placing the cursor on the desired heading name) as 

specified in the list below. 

The Paragraph tab offers the following options, within which possible values 

are provided. In the case of the Indents and Spacing tab, we should check these 

settings: 
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- Alignment: Left; 
- Outline level: Level 1 for A1, Level 2 for A2, Level 3 for A3, Level 4 for 

A4, and Level 5 for A5 (this step enables its visibility in the left-hand nav-

igation pane, which becomes visible by typing Ctrl+F, Headings); 

- Indentation: Left → 0, Right 0 for all headings; 
- Special: (none) for all headings; 
- Spacing: Before: 0 pt for A1, 12 pt for the subsequent headings; 
- Spacing: After: 24 pt for A1, 6 pt for the subsequent headings; 
- Line spacing: Single for all headings. 

 

Figure 53. Accessing paragraph settings, Word 

The Line and Page Breaks tab enables to check Pagination, where checks are 

needed for the boxes before Widow/Orphan control, Keep with next, and Keep 

lines together for each heading (1–5). The box preceding Page break before should 

be checked only for Heading 1 (A1). 
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2.6.2.5. Heading to Style Panel 

The next step is to activate the Style panel by clicking on the southeast arrow on 

the Styles tab or using the Ctrl+Shift+Alt+S combination. This offers the 

possibility to modify each heading style one by one by clicking on the New Style 

icon (left bottom corner, A+button): 

 

Figure 54. Styles panel, Word 

The Properties for each heading might be set individually the following way: 
- name → A1, A2, A3, A4, A5, respectively; 
- style for following paragraph: Normal; 
- check the Automatically update box for each heading. 

The Format tab (bottom left corner) enables us to set the Font (type, size, color) 

and check Paragraph settings (Indents, Spacing, Line and Space breaks): 
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Figure 55. Format style, Word 

In theory, formatting the headings should stem from the Golden Ratio 

Typography (GRT),48 which respects the √2:1 ratio (Ármeán 2017, 107); this means 

that the font sizes for five headings using Times New Roman fonts are 31, 25, 19, 

15, and 12, respectively, where the smallest one coincides with the size of Normal 

font size; additionally, we can change the font color of headings, knowing the 

typographer’s second color is red. In case there are no more than four headings, 

their font sizes might be 25, 19, 15, and 12. In case these sizes might look too large, 

it is recommended to have sizes at least 2 points difference from one another. 

The Format box offers further options as well (e.g., Tab or Border), whose 

default settings are acceptable, while the Language is already set to the language 

of the document, and the Numbering has been set earlier through the third option 

of the Library List. 

 
48 For instance, the GRT for Times New Roman is available here: https://grtcalculator.com/, March 9, 
2022. 

https://grtcalculator.com/
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Heading styles may be completed with setting proper shortcuts for all 

headings: a right click on the style in the Home tab, Style group offers the Modify 

option, which opens a new window: 

 

Figure 56. Modify style, Word 

 

The bottom left button is Format, which reveals the Shortcut Key option that 

may be set easily, having in mind to choose a shortcut that is not used for other 

functions. 

Headings 1–5 may have shortcuts relying on the combination of the left Alt 

key and number keys 1–5: 
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Figure 57. Adding shortcut keys to headings, Word 

Once the normal and the heading styles are set, further shortcuts are worth 

considering: a list style for bulleted lists (Alt+B), a further list style for numbered 

lists (Shift+Alt+3), figures (Alt+P), and at least one style for quotes (Alt+Q). 

After finalizing the setup for the page, paragraph, line, and styles, the 

document should be saved as a template (see Chapter 0), which should be used 

subsequently and attached to any newly created document. When triggering any 

change in the previously set parameters, there is the option to apply it either in the 

current document or in the template. 

2.7. Caption Style 

Sentence case is recommended for captions (CMOS 2024, 143), except for formal 

titles (titles of works). Latest recommendations also suggest that the caption type 

(figure, table, etc.) and number should be bold, while the title regular typeface. 
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This is possible with the help of Style Separator, which is not active by default in 

Word, although a shortcut can solve this: Ctrl+Alt+Return. 

 This shortcut makes sense when the caption style is already set in the first 

line, while the second line contains the description. Selecting both lines and 

applying the shortcut will join the two lines, preserving both formats. In case the 

Show/Hide button is enabled, a paragraph mark is visible between the two styles. 

Those favoring icons and buttons, the Style Separator may be added to the 

Home tab, for instance: File, Options, and Customize Ribbon. A New Group to 

Home should be added to prevent a warning, then the Popular Commands may be 

changed to All Commands, and the Style Separator will be shown: 

 

Figure 58. Adding Style Separator to the Home tab 

Once added to the previously activated New Group, it will result in a new 

icon among the Home tab icons: 
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Figure 59. Style Separator in the Home tab 

Unfortunately, Writer has no similar function, and copying text from Word 

formatted properly or saving a Word document (.docx) to .odt file format might not 

preserve the Style Separator. 

2.8. Summary (Shift+F1) 

A possible summary regarding the setup options is offered by a very useful 

shortcut: Shift+F1. 

This shortcut reveals all the formatting of the selected text in Word, including 

Fonts (Default font name, Font size, Language, Character spacing), Paragraph 

(Alignment, Indentation, Spacing, Line and Page breaks). 





Chapter 3   

Fonts, Characters, Letters 

3.1. Definitions 

Certain terms overlap due to their use by both professionals and laymen. This is 

also the case with font, character, and letter, whose definitions are worth 

clarifying. 

An online source admits that the term character is “a fairly fuzzy concept. 

Letters, numbers and punctuation are characters. But so are Braille and frogs and 

halves of flags. Basically, a thing in the Unicode table somewhere.”49 However, this 

enables us to state that letters, together with numbers and punctuation signs are 

subordinate categories of the much comprising term character. Yet, we should 

turn our attention to the definition of font, which is mostly used in typography. 

3.2. Typeface and Font 

The distinction between typeface and font is relevant, as they are not synonyms. 

As explained, “[a] typeface is a design for a set of characters (e.g., Times 

Roman, Arial)” (AMA 2020, 1114), whereas font comprises “[t]he complete 

assortment of qualities (e.g., size, pitch, and spacing) and styles (e.g., boldface, 

italic) of a particular typeface (AMA 2020, 1132). More simply, typeface refers to 

“letters and numbers in a particular design.”50 

Another source explains that the term font encapsulates all the glyphs or 

characters of a typeface, which is actually a character set (Virágvölgyi 2004, 22). 

Typefaces come in two forms, serif and sans serif, detailed in the next section. 

3.2.1. Serif and Sans Serif 

Typefaces may be differentiated whether they are serif or sans serif. 

Serif typefaces “have a short, light line” (AMA 2020, 1115) deriving from the 

main strokes, so these typefaces have a “finishing stroke, … in particular, the fine 

cross stroke at the top or bottom of a letter” (Parkes 1992, 307), and due to these 

extra strokes, the letters are thought to be more readable when larger texts are 

involved, as the lines offer a certain guidance for the eyes, making the distinction 

 
49 https://eev.ee/blog/2015/09/12/dark-corners-of-unicode/, April 29, 2025. 
50 https://dictionary.cambridge.org/dictionary/english/typeface, January 28, 2025. 

https://eev.ee/blog/2015/09/12/dark-corners-of-unicode/
https://dictionary.cambridge.org/dictionary/english/typeface
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between “individual letters and words” easier (AMA 2020, 1115). As such, serif is 

predominantly used for body text. 

On the other hand, sans serif typefaces have no extra strokes or “adornments” 

(AMA 2020, 1115), offering contrast to serif typefaces, and are mostly used for 

titles and headings to capture the reader’s attention. While it has been proved that 

electronic texts are better to have sans serif as text body, nowadays this is not 

entirely tenable, as “modern screen resolutions can typically accommodate either 

type of font, and people who use assistive technologies can adjust font settings to 

their preferences” (APA 2020, 44). 

Although personal preference may be acceptable for individual use, still 

certain rules apply when creating texts for others. A student paper may be created 

with Arial or Calibri typeface for titles and headings, and Times New Roman or 

Georgia for the text body, whereas texts designed for the larger public need ampler 

considerations. Whatever the case, it is recommended to “use the same font 

throughout the text of the paper” (APA 2020, 44), and the two typefaces seem to 

be enough even for “a print scholarly publication” (AMA 2020, 1118), in case font 

style is also taken into account (see Section 3.3.). 

3.2.2. Choosing Typeface 

Choosing a particular typeface for either the headings or the text body may be very 

simple (in case it is “prescribed” by the particular publishing house) or rather 

difficult, when the fonts should satisfy the text producer. 

A first suggestion to select a typeface is to consider the target language. While 

English contains no diacritical signs, other languages have a few special ones, and 

tend to use them rather frequently (e.g., Polish). As such, the chosen typeface 

should contain all the letters needed, and, alongside them, special ligatures, 

numbers, punctuation signs, and various styles as well (bold, italic, small capitals), 

as recommended by experts in the field (Ármeán 2017, 33), while others warn us 

that although a number of typefaces are embedded in various office suites and 

“software packages, … the stock fonts supplied … are the wrong fonts for many 

tasks and people, and most of them are missing essential parts” (Bringhurst 2004, 

117), particularly mentioning small capitals, text figures, ligatures, diacritics and 

non-alphabetic characters. 

Bringhurst also states, “[u]sing what there is to best advantage almost always 

means using less than what is available.” In his view, Baskerville, Helvetica, 

Palatino, and Times New Roman only offer “public disagreement” (Bringhurst 

2004, 96), which is a rather sobering remark, reminding us how disturbing it is 

when improper characters are seen in subtitles or any other print material or slide 

presentation with fonts belonging to different typefaces. The “Lorem ipsum” 

boilerplate text is hardly suitable in this respect. 
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There are dedicated sites where all the characters supported by a particular 

typeface are shown, and one of the most comprehensive ones is Arial Unicode 

MS.51 Other typefaces are famous for their well-designed numerals (Palatino, 

Pontifex, Trump Medieval, and Zapf International) or matching phonetics (Stone 

Serif and Sans, Lucida Sans, and Times New Roman)—as suggested by Bringhurst 

(2004, 95–96), who also recommends to check an extended family type, such as 

Lucida, and we can extend this list with Liberation or Linux as well. 

While checking the typeface first involves individual characters, the next step 

is to check how they are combined into words, leading us to font spacing. 

3.2.3. Font Spacing—Kerning 

As the present work aims at the basics of text editing, acceptable or usable default 

settings are favored in the case of word processors. Thus, even if we accept that 

font spacing is important, the default settings in Word and Writer suit the majority 

of cases, supporting Spiekermann’s statement: “There is no bad type.” 

(Spiekermann 2013, 195). At a more advanced level, the default attitude is “Don’t 

let your font software kern for you,” as Creger suggests.52 

The more technical term for font spacing is kerning, which includes the 

“[m]odification of spacing between characters, usually to bring letters closer 

together, to improve overall appearance” (AMA 2020, 1136), because the larger the 

space between the letters, the more difficult it is to distinguish the words and 

thoughts of a text (Spiekermann 2013, 139). Thus, a kern is “part of a letter that 

extends into the space of another” (Bringhurst 2004, 327), so kerning reduces the 

space between the characters, offering a visually more appealing text. It might be 

set to automatic, or the author can adjust it manually (Ármeán 2017, 43), but more 

experienced text producers know that tracking and leading should precede 

kerning,53 which is beyond the range of our interest. 

There are specific kerning tables which involve standard letter combinations, 

such as capital letters A, L, T, V, W, Y followed by non-capital letters, except for 

b, h, k or l (Bringhurst 2004, 33), but the most frequent kerning probably involves 

doubling letter f and the combination of letters f, i, and j, often resulting in 

improper conversion (especially the italic style) when optical character 

recognition is involved (OCR). Kerning may be accessed in Word via the Font 

section on the Home tab and via the main toolbar in Writer (Format, Character): 

 
51 http://zuga.net/articles/unicode-all-characters-supported-by-the-font-arial-unicode-ms/, January 28, 
2025. 
52 https://99designs.com/blog/tips/11-kerning-tips/, January 28, 2025. 
53 Tracking refers to “overall spacing between groups of letters, while leading refers to the “vertical 
spacing between lines”; see Footnote 52. 

http://zuga.net/articles/unicode-all-characters-supported-by-the-font-arial-unicode-ms/
https://99designs.com/blog/tips/11-kerning-tips/


90  ◼   Basics of Word Processing for Thesis Writing 

 

Figure 60. Accessing kerning, Word 
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Figure 61. Accessing kerning, Writer 

How serif and sans serif typefaces handle kerning is illustrated below: 

 

Figure 62. Kerning letters 

It is important to remember that “numbers often need more kerning [than] 

letters do,” although they are rarely found in kerning tables. To illustrate this, we 

have typed the whole set and a special combination: 

 

Figure 63. Kerning numerals 
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Hopefully, these illustrations demonstrate the advantages of kerning: the 

proportional spacing between fonts is less tiresome for the eyes, the text takes up 

less space, as certain characters “invade” the space of other ones, and these 

consistent overlaps offer an improved layout. 

While the age of typewriters meant monospaced fonts for obvious reasons, 

there are no more than three justified situations to return to that visual aspect, as 

Spiekermann explains: when writing plain emails and codes and imitating the 

look of typewriters (Spiekermann 2013, 137). 

A final idea is that disregarding the possibilities of kerning is better than 

setting it in only certain parts of a consistent text, as “inconsistent kerning is worse 

than none” (Bringhurst 2004, 33). 

3.2.4. Glyphs 

A glyph is “a visual representation of some symbol, provided by a font.”54 This 

“graphic symbol … provides the appearance for a character.”55 While a glyph 

stands for a character in the majority of cases, there are exceptions. Consequently, 

their total number may only be estimated, which is presumably more than a 

thousand (Bringhurst 2004, 179). 

3.2.4.1. ASCII and Unicode 

There are alphabetic, numeric, and symbol glyphs, and the most widespread 

character encoding set is the American Standard Code for Information Interchange 

(ASCII), which contained only 128 characters, without containing enough 

diacritical characters and being criticized for focusing on English language and 

punctuation symbols.56 

These seven-bit characters were extended to eight-bit characters, doubling the 

number of slots for glyphs, but the 256 slots were still not enough to comprise the 

multitude of diacritics of all written languages and the special needs for further 

symbols related to sciences and arts (cf. Bringhurst 2004, 180), so a new system 

was created: Unicode. This set—in theory– contains all the characters (137,374), 

and there is even more space for further slots, with the daring vision to create the 

possibility “to store every symbol, ever.”57 Thus, all the glyphs or codes (as 

algorithm creators refer to them) may be correctly displayed in case we know the 

proper shortcut or the exact name/description of a particular glyph. 

The most typical encoding is the Unicode Transformation Format, more 

precisely UTF-8, although UTF-16 or UTF-32 is also possible. The majority of 

 
54 https://eev.ee/blog/2015/09/12/dark-corners-of-unicode/, April 29, 2025. 
55 https://www.techtarget.com/whatis/definition/glyph, January 29, 2025. 
56 https://eev.ee/blog/2015/09/12/dark-corners-of-unicode/, April 29, 2025. 
57 https://blog.hubspot.com/website/what-is-utf-8, January 29, 2025. 

https://eev.ee/blog/2015/09/12/dark-corners-of-unicode/
https://www.techtarget.com/whatis/definition/glyph
https://eev.ee/blog/2015/09/12/dark-corners-of-unicode/
https://blog.hubspot.com/website/what-is-utf-8
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webpages are stored in UTF-8, which is also used elsewhere such as subtitling. 

The UTF-8 encoding table may be checked online,58 as displaying all of them in 

printed form would be pointless, containing all the collected symbols of all 

languages. Video subtitles might display language-specific characters incorrectly, 

in which case it can be corrected when the .srt file format is opened in Word and 

saved in UTF-8. If this does not solve the problem, a last resort would be to open 

it in SubtitleEdit59 and save it in UTF8 with BOM format. 

3.2.5. Diacritics 

We already mentioned the importance of diacritical marks, starting from selecting 

the proper typeface. These might be language-specific characters or “accented 

letters” (APA 2020, 44) and diacritical marks and signs/symbols. A diacritic is 

basically “a glyph added to a letter.”60 

Since the appearance of Unicode, using proper diacritical marks should be a 

basic requirement, starting from typing foreign names “correctly” (as in the source 

language), all foreign words should be preserved in their original way of spelling. 

However, as recommended earlier (see 1.4.), electronic filenames are an exception 

to the rule, as well as cases when creating a humorous text is intended: e.g., 

spelling tasks with deliberately erroneous meaning due to misplaced, missing, or 

improper diacritical signs. Although various commercials tend to overlook the 

importance of diacritical marks (trying to look smart or trendy), we cannot agree 

with this approach. 

Diacritical marks may have various names, the most commonly used ones in 

Europe being listed below, collected from various sources61 and the Character 

Map: 

Table 1. Diacritical marks with examples 

Name Symbol Example 

accent acute á, é resumé 

accent grave à, è, ì, ò, ù dernière 

angstrom (circle/ring 

above) 
å Bokmål 

bar (stroke) ł, Ł ładny 

breve ă, ŏ, ŭ artă 

caron, wedge č, ř, ž háček 

 
58 For instance, here: https://www.utf8-chartable.de/, January 29, 2025. 
59 https://www.nikse.dk/subtitleedit, August 19, 2025. 
60 https://en.wikipedia.org/wiki/Diacritic, January 29, 2025. 
61 https://www.businessballs.com/glossaries-and-terminology/accents-and-diacritical-marks/, June 30, 
2022; AMA 2020, 553. 

https://www.utf8-chartable.de/
https://www.nikse.dk/subtitleedit
https://en.wikipedia.org/wiki/Diacritic
https://www.businessballs.com/glossaries-and-terminology/accents-and-diacritical-marks/
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Name Symbol Example 

cedilla ç, ş, ţ Beşiktaş 

circumflex (caret) â, ê, î, ô, û côte 

comma below62 ș, ț ședință 

dot above (overdot) ċ vaikystė 

double acute ő, ű őrtűz 

macron ā, ē, ō, ū infrastruktūros 

ogonek ą, ę wąż 

slash, stroke, virgule 

(streg) 
ø Rømø 

tilde ã, ñ, õ vulcões 

umlaut (diaeresis) ä, ë, ï, ö, ü, ÿ Lÿre 

 

The table contains only a very limited set of letters combined with glyphs. 

Furthermore, it may happen that two letters are combined, discussed in the next 

section. 

3.2.6. Ligatures (ligs) 

As explained, a ligature (or lig) refers to the combination of “two or more letters” 

(AMA 2020, 1137). 

However, this is a simplistic term, as there are lexical ligatures, which are 

letter combinations “defined by lexicographers and grammarians” (Bringhurst 

2004, 188), but there are also typographic ligatures, discussed earlier (see kerning, 

Section 3.2.3.). 

The most common lexical ligatures that may come to our minds are the aesc 

(æ, Æ as in Lætitia, Ælfred: U+00E6 and U+00C6), the combination of o and e, 

resulting in œ or Œ (as in hors d’œuvre and Hœrdt: U+0153 and U+0152), and the 

eszett, sharp s or double s (ß as in groß: U+00DF). On the other hand, typographic 

ligatures are applied to reduce space by overlapping letters, although Bringhurst 

warns us that this distinction is “by no means absolute” (2004, 50). 

As recommended by the CMOS, the lexical ligatures æ (a + e) and œ Œ (o + e) 

“should not be used in Latin or transliterated Greek words,” and they might only 

be used “for spelling Old English words in an Old English context” (CMOS 2024, 

454). Interestingly, there is a macOS shortcut for œ (Option+Q). 

 
62 While ș and ț (comma below) are the correct diacritical marks in Romanian, the widespread incorrect 
variants for Romanian are with cedilla (ş and ţ) due to missing official glyphs before 2007. However, 
the cedilla versions referring to the same sound are correct in Turkish, French, or Albanian: 
https://stiisascrii.wordpress.com/2014/07/16/diacritica/, January 29, 2025. 

https://stiisascrii.wordpress.com/2014/07/16/diacritica/
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3.3. Font Contrast 

Contrasting fonts break the monotonous continuity of texts, and there are certain 

techniques to do that. 

A basic rule is not to change more than “one parameter at a time” (Bringhurst 

2004, 60) so as not to obtain a visually too cumbersome text layout. Basic font 

contrast options include the following: 

1. change the typeface (serif to sans serif); this may be useful when 

dictionary entries require the mixture of “unserifed and serifed fonts on 

the same line” (Bringhurst 2004, 105); 

2. change the font family (Times New Roman to Arial); 

3. increase or decrease font size; 

4. change the letter case (uppercase, lowercase, capitalize first letter, small 

capitals); 

5. apply font styles (bold, italic, underline). 

Whatever type of font contrast we opt for, we are not to use more than one 

typeface or font within the same word (Ármeán 2017, 70; Gyurgyák 2005, 79–80), 

although Gyurgyák makes it explicit that contrasting or highlighting rules are not 

set in stone, except for that they should be consistently applied within the same 

publication. If the restriction mentioned above is accepted, languages with suffixes 

have to apply the same contrast to the entire word, including the suffix (Ármeán 

2017, 67; Laczkó and Mártonfi 2025, 289), a rule which is not always respected. 

Font contrast may be applied to various parts of the text, and, most commonly, 

titles, headings, captions, foreign words, and words with special meanings 

(metaphoric, head-word, etc.) are highlighted, knowing that too much contrast is 

not very effective. 

3.3.1. Capitalization 

Capitalization is the simplest type of font contrast within the same typeface. While 

it is common knowledge that sentence-start words are capitalized (and this is 

implemented in word processors as well), there are certain issues: 

1. both English and non-English words and phrases are to be capitalized 

“according to that language’s standard of correctness” (AMA 2020, 552); 

2. words that are brand names but start with lowercase letter followed by 

capital letters (iPhone, eBay)63 or statistical terms (p value) should not start 

the sentence, so rewording is necessary (AMA 2020, 504; APA 2020, 165) 

to avoid their sentence-start position; 

3. intercapped words starting with a capital letter may start the sentence 

(PubMed); intercapped or midcapped trademark spelling should always 

be preserved (Einsohn and Schwartz 2019, 182); 

 
63 These words are “intercapped compounds” (AMA 2020, 504). 
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4. the first word after a colon is not capitalized as explained by the manual 

of the American Society of Agronomy, Crop Science Society of America 

and Soil Science Society of America (from now on, ASA et al.) unless it 

starts a quotation or a direct question (ASA et al. 2024, 2–04); 

5. names of languages, nationalities, ethnicities, tribes, political parties, 

religions, religious denominations, days of the week, and months of the 

year are capitalized in English. 

The capitalization of particular words in English may be broken down to 

further subsections presented in the following. 

3.3.1.1. Titles of Works 

Stemming from the previous rules, titles, subtitles, or headings—referred to as title 

case (versus sentence case)—start with a capitalized word. 

This includes books, journal articles, table columns, albums, songs, plays, 

radio and TV programs, paintings, software programs, websites, blogs, names of 

historical and special events (Declaration of Helsinki), historical periods (Civil 

War), awards (Purple Heart), holidays (Fourth of July, New Year’s Eve), or 

monuments. 

As these are special texts, further rules apply, described by various sources 

(APA 2020, 165; AMA 2020, 495–501): 

1. title case refers to all the words of the title, which contain at least four 

letters, including With; 

2. two- or three-letter verbs are also capitalized (Am, Is, Are, Was, Do, Did, 

Has); 

3. shorter than four-letter conjunctions or prepositions are not capitalized 

(but); 

4. words following a colon or an em dash are capitalized (Joker Laughs—As 

Expected). 

5. in case the second word of a hyphenated compound is a major word, it 

should be capitalized (Pre-Requisite); 

6. in case numerals of lowercase Greek letters start the word, the following 

word is capitalized; 

7. labels (designators) of tables, figures, sections, chapters followed by numbers 

and the first word of row headings should also be capitalized (Table 1, Figure 

2, Supplement A, Illustration, Photo, Chapter 3, Section 5);64 

 
64 The following words are not capitalized: numeral, letter, page, paragraph + a numeral (APA 2020, 
168); similarly, equator, north pole and universe are not “strictly proper names,” although “some people 
choose to capitalize them anyway,” which is “not recommended” (cf. https://www.sussex.ac.uk/
informatics/punctuation/capsandabbr/caps, February 4, 2025. 

https://www.sussex.ac.uk/informatics/punctuation/capsandabbr/caps
https://www.sussex.ac.uk/informatics/punctuation/capsandabbr/caps
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8. technical descriptions, mathematical formulae often contain isolated letters, 

which are capitalized (APA 2020, 168), as they denote grades, or place 

names, and their plural form is constructed without an apostrophe (Xs); 

9. letters representing various shapes (a C-Curve, a P-shaped bath) “are 

capitalized and set in Roman type” (CMOS 2024, 467). 

Although titles of books and articles are used in the text according to these 

rules, when they appear in reference lists (bibliography), they are used according 

to the particular style required by the publishing house; this is typically mixed 

capitals and lowercase for book titles and sentence case for articles, except for the 

capitalized first word (AMA 2020, 1118). 

While these rules seem to be “prescribed” by manuals and guidebooks, they 

might not always be respected, which is also due to the Toggle Case function of 

word processors (press Shift+F3 in Word or Writer repeatedly to check the effect). 

3.3.1.2. Titles and Degrees of Persons 

Job titles, positions, and academic degrees of people have two variants: 

1. capitalized before names (Chair, President, Head) and sentence case after 

names (APA 2020, 166); it is noted that newspapers and magazines tend 

to use capitalized titles (“up style”), while book publishers use “down 

style,” without capitalizing (Einsohn and Schwartz 2019, 173); 

2. titles without names are not capitalized (ASA et al. 2024, 2–04); 

Interestingly, academic degrees are not capitalized unless abbreviated: John 

Smith, MA. 

3.3.1.3. Computer and Technology Terms 

Computer terms are technology-related words that have been on the rise for 

decades, and certain rules should be followed when using them: 

1. keyboard keys of letters should always be capitalized; 

2. named keys should also be capitalized, even if some of them are 

abbreviated: 

Esc or FnLock 

F1–F12 

Insert, Home, End, Delete, Backspace, Tab, Option, Command, 

CapsLock, Shift, Ctrl, Fn, Alt, Enter, AltGr, PgUp, PgDn, PrtSc, 

NumLock; 

3. initial capitals for each word are used to refer to functions provided by 

various software programs: Layout, Help, View, Font, Paragraph, Select 

Recipients, Start Mail Merge; 

4. it is suggested that “abbreviations for file formats are rendered in full 

capitals unless expressed as extensions” (CMOS 2024, 472), so there are 
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PDF, DOCX, and ODT files, but when referring to extensions, the .pdf, 

.docx, and .odt forms should be used; 

5. combinations of keys are used either with the plus or hyphen sign, 

without spaces between them: Ctrl+Shift+Home (Windows) or 

Command+Q (macOS), and in case the shortcut might be ambiguous 

(punctuation symbols or with or without Space), it should be spelled out 

(CMOS 2024, 472–473). 

While newly created terms were used with initial capitals, some have become 

so common that they are no longer capitalized: internet, intranet, wireless network, 

mobile or cellular network, web, email, unless they start the sentence or refer to a 

trademark such as Ethernet (CMOS 2024, 474). 

3.3.1.4. Capitalized Abbreviations 

There are various types of abbreviations. We should distinguish single-word 

abbreviations, such as p. for page, or multiple-word abbreviations such as MD for 

medical doctor. Depending on their type, they might be shortened to the initial 

letter, contracted (Bld. for Boulevard), clipped, or truncated: teach for teacher, flu 

for influenza, burger for hamburger (Imre 2022a, 379). 

Multi-word phrases are often abbreviated with capital letters and are either 

acronyms (letters pronounced as words such as POTUS for the President of the 

United Sates) or initialisms (letters pronounced as letters such as BBC for British 

Broadcasting Corporation) (Imre 2022a, 380). Blends come into being by “melting 

at least two words together” by preserving some of the letters, and these are often 

capitalized in case the original term was also capitalized (Interpol for International 

Police). 

The overwhelming majority of acronyms and initialisms are fully capitalized 

(although the letters might or might not be separated by periods), as they derive 

from various institutions, company names, political parties, trademark, 

geographical terms, etc.: UN, DNA, DOD, NSA, FEMA, GOP, CNN, US/U.S., 

DC/D.C., LA/L.A., or NASA. Acronyms created from non-capitalized medical 

terms are also capitalized: CBC for complete blood count or PET for positron 

emission tomography. 

A number of computer-related terms are also turned into abbreviations: NFC 

(Near Field Communication), LAN (wired local area network), IT (Information 

Technology). 

Famous people might also be referred to via an initialism, especially in the 

USA: JFK, RFK, FDR, MLK, and LBJ. In a local context, people’s names may also be 

abbreviated with their initials (Mr. X., Miss G),65 and in this case a period “usually” 

follows the single initial (CMOS 2024, 467), the same source mentioning that a 

 
65 As it is used in the movie Freedom Writers (2007). 
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concealed name may start with a capital letter “followed by a 2-em dash and no 

period”: Mrs. A—— is the victim. 

However, there are non-capitalized abbreviations as well, most notably 

connected to time (AMA 2020, 933); the first column contains standard 

abbreviations, while the next three ones are abbreviations used for localized 

settings (Windows) and the online Google Calendar: 

Table 2. Time abbreviations 

Abbreviation 
Short 

Abbreviation 

Long 

Abbreviation 

Google 

Calendar 
Term 

y yy, yyyy yyyy Y year 

mo M, MM, MMM MMMM M month 

wk   W week 

d d, dd dddd, d D day 

h h, H, HH h, H, hh, HH  hour 

min mm mm  minute 

sec  ss   

 

The table clearly demonstrates that manuals and guidebooks may prescribe 

“correct” versions, but these are left to the discretion of software producers and 

publishing houses. As such, multiple variants come into being, as is the case of the 

abbreviations for morning and afternoon: AM, PM, A.M., P.M., am, pm, a.m., and 

p.m., not to mention that these follow the hour either with or without space, and 

there are further rules referring to these abbreviations, detailed in the next section. 

3.3.2. Small Capitals and Uppercase 

The use of small capitals (small caps) also tends to be regulated. This is a typeface 

style, so these capitals are designed to have the height of lowercase letters, but all 

the letters take the shape of a capital letter. 

Manuals (AMA 2020, 1121) and scholars (Spiekermann 2013, 63) mention 

that small capital letters should be used with the previously presented morning 

and afternoon abbreviations, whose capitalized versions with no periods are 

exemplified: AM and PM, and further time-related small caps initialisms are also 

listed: AD, BC, BCE, and CE. As explained, “small caps rather than full capitals look 

more graceful” (CMOS 2024, 461). 

Certain authors may rely on small capitals, as they “mark an opening phrase” 

(Bringhurst 2004, 120), but they may also be used with currency abbreviations, 

country codes, or temperature symbols (USD, PL, 0°C, 32°F), as the same author 

exemplifies it (Bringhurst 2004, 46). 
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To obtain small caps while using word processors, the desired term should be 

typed as a lowercase word. In Word, after selecting the desired term, either the 

Ctrl+Shift+K shortcut changes the casing or through the menu: Home, click on the 

arrow in the Font section, and the Font tab of the appearing window offers Small 

caps as one of the Effects options, which may be selected with a tick (Word): 

 

Figure 64. Changing lowercase letters to small caps, Word 

Writer offers this via the same shortcut, or through the main toolbar: Format, 

Text, and the drop-down menu reveals Small capitals, displaying the shortcut as 

well: 
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Figure 65. Changing lowercase letters to small caps, Writer 

The more daring option is to set the whole word to fully capitalized, or 

UPPERCASE characters, which may be carried out via the previously described 

route in Writer, as visible in Figure 65 above. As for Word, this is possible via the 

drop-down arrow of the Aa icon in the Home panel: 

 

Figure 66. Changing the letter case to uppercase, Word 
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However, changing the letter case in all possible variants may be carried out 

with a shortcut as well: Shift+F3 (referred to as Cycle Case in Writer). This 

shortcut works in Word, Writer, Calc, and PowerPoint, while it is associated with 

other functions in MS Excel (from now on, Excel) and Impress. Nevertheless, fully 

capitalized words are often associated with shouting, so it is not recommended 

when using social media. 

3.3.3. Boldface 

Boldface, Italic, and Underline are readily available styles, which offer visible 

contrast with the standard Roman typeface. They are used very frequently, either 

with the help of their corresponding buttons on the main toolbar of word 

processors or with the help of well-known shortcuts: Ctrl+B, Ctrl+I, and Ctrl+U. 

However, only the first two typefaces are recommended to highlight part of a 

text, and the Underline option is strongly discouraged by typographers, publishing 

houses, and journals alike. In fact, a typical publication includes no more than 

seven styles, and none of them is Underline (AMA 2020, 1115): 

1. Roman capitals (uppercase letters); 

2. Roman lowercase letters; 

3. boldface capitals; 

4. boldface lowercase letters; 

5. italic capitals; 

6. italic lowercase; 

7. letters with small capitals. 

Boldface may be used for figures, tables, and headings 1 and 2 (AMA 2020, 

1119), but any important word (keywords, metaphoric meaning, headword, etc.) 

may also be boldfaced. The first punctuation symbol following the boldfaced word 

(Table 1., which …) is also highlighted, but a word in focus is followed by Normal 

typeface (CMOS 2024, 379). 

If boldfaced words are used only “sparingly,” they may be very effective 

(Bringhurst 2004, 56), and it is suggested that this type of contrast is for cases when 

“you really need it” (Bringhurst 2004, 103). 

3.3.4. Italic 

The definition of italic specifies that the characters slant “upward and to the right 

(italic) as opposed to Roman type” (AMA 2020, 1136), which is another type of 

contrast or highlight. 

Similarly to boldface, italic(s) may be used to “mark specific classes of 

information” (Bringhurst 2004, 57). When parts of a text are emphasized this way, 

no quotation marks should be used. Specific cases to italicize are listed below, 
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based on various sources (CMOS 2024; EC-DGT-RO 2021, 24; AMA 2020, 479; 

2020, 1119–21):66 

1. key terms (typically first occurrence only, then Roman); 

2. foreign words, except for frequently used Latin terms (ibid., et al., ca., 

passim); however, sic is always italicized, due to its special meaning 

(“intentionally so written”) when quotes are reproduced accurately, 

containing factual errors or improper spelling; 

3. personally highlighted terms in a direct quotation, in which case the 

italicized part is followed by [emphasis added] within square brackets 

(APA 2020, 275); 

4. titles and headings (mostly Heading 4), but not titles of book series (e.g., 

The Hunger Games series); 

5. titles of proceedings; 

6. names of legal cases; 

7. titles of plays; 

8. names of paintings; 

9. names of video games; 

10. names of musical compositions; 

11. movie titles; 

12. names of planes, ships, and spaceships; 

13. rhyme schemes (abab) or “similar patterns,” with no space between the 

lowercase letters; 

14. genera, species, and varieties; 

15. mathematical expressions, including statistical symbols, lines, variables, 

unknown quantities, and constants, test scores, except for trigonometric 

terms; 

16. anchors of a scale, with the associated number set in Roman (1 poor to 5 

excellent); 

17. periodical volume numbers; 

18. special explanations: when terms described terms and letters are 

discussed as letter (the letter n is used in mathematics);67 

19. alphabetic enumeration of items or topics, while the parentheses are set 

in Roman: (a), (b), (c). 

While this may seem a long list, italics should be restricted to a sentence the 

most, and not an entire passage or paragraph. Notable exceptions to this rule are 

 
66 EC is the initialism for the European Commission, while DGT-RO stands for the Directorate-General 
for Translation, Romanian-language unit. 
67 There are a few notable exceptions to this rule: Mind your p’s and q’s!; Dot the I’s and cross the t’s, 
the three R’s (CMOS 2024, 467). 
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prefaces, headnotes, sidenotes, block quotations,68 or epigraphs at the beginning of 

a book or chapter, in which case full italics are justified. 

It may happen that titles are needed in an already italicized text (e.g., title 

within a title), in which case reversed italicization should be used, and the title 

set in Roman (normal, nonitalic) typeface (APA 2020, 171). 

Interestingly, there are several restrictions regarding punctuation following 

the italicized parts. Manuals specify that in case the punctuation mark does not 

belong to the highlighted part, it should be set to Roman (APA 2020, 170). 

Nevertheless, Bringhurst mentions that “italic punctuation normally gives better 

letterfit and thus looks less obtrusive” (Bringhurst 2004, 60). 

There are a few further cases when no italic is needed: 

1. trigonometric terms: sin, tan, log (APA 2020, 171); 

2. chemical terms: H2SO4, CaO; 

3. Greek letters: α, β, γ; 

4. “naturalized” foreign terms, which already appear in the dictionary of the 

target language; in the case of English, these might be nacho, paprika, 

tableau vivant, or zucchini (as in this case they are linguistic examples, 

they are still in italics). 

While there is the possibility to combine the contrast of boldface and italic, 

resulting in bold italic, this is rarely accepted from a typographical point of view. 

3.3.5. Underline 

Underline font style may be considered the “black sheep” of typeface. Bringhurst 

mentions it only once, in a totally unrelated context (Bringhurst 2004, 83). There 

are very limited and special cases when Underline font style is not frowned upon: 

1. active hyperlinks in word processing programs (APA 2020, 299); 

2. the Track Changes function of word processing, while reviewing texts, or 

when it refers to editorial changes (CMOS 2024, 71); 

3. manuscript underlines to signal italicized parts for the editors (CMOS 

2024, 103). 

Typographical reasons against underlined text are clear: it interferes with the 

standard glyphs/characters by segmenting them, optical character recognition 

software programs might misinterpret them, and reading may become 

cumbersome. To put it simply, Underline is not recommended, even though it is 

readily available in word processing software programs. 

 
68 A passage that is longer than 40 words. Passages shorter than 40 words are referred to as direct 
quotations. 
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3.4. Font Ornament 

Font contrast may be carried out with the help of various character ornaments, 

which also function as text breakers. 

A blank line may be the simplest text breaker, but when a visible breaker is 

needed, either a set of asterisks (***) may be used between the paragraphs or 

relying on font ornaments might be an excellent choice. 

3.4.1. Fleuron 

Fleurons are stylish typographic ornaments in the shape of flowers or leaves “to 

flag text openings,” and they might be printed in red, which is “the typographer’s 

habitual second color” (Bringhurst 2004, 63). Some of them have been used for 

long, for instance hedera (a type of fleuron), the term stemming from the Latin 

name for ivy leaf (Parkes 1992, 61). 

While fleurons are stronger breaks than simply starting a new paragraph, they 

are weaker than a subheading (CMOS 2024, 35). Typographers rely on fleurons for 

ornamental separations of sections, being more graceful than the asterisks, and 

may choose from several variants: the reversed rotated floral heart bullet (☙, 

U+2619), the rotated floral heart bullet (❧, U+2767), or the floral heart (❦, 

U+2766), also presented by Bringhurst (2004, 311). These may be used to separate 

paragraphs, but the editors of the APA chose to place one next to each page number 

of the book. 

Fleurons have descriptive names and shortcut keys,69 but word processors 

might not display them correctly. For instance, Word can display the three 

fleurons mentioned above, but more modern ones—now part of the Unicode 

table70—are not displayed in Times New Roman when using Word unless they are 

set in Segoe UI Symbol font. Interestingly, Times New Roman in Writer displays 

all the symbols in the table below correctly, based on the provided codes: 

Table 3. Fleurons and Unicodes 

Description Symbol Unicode 

reversed rotated floral heart bullet ☙ 2619 

floral heart ❦ 2766 

rotated floral heart bullet ❧ 2767 

north west pointing leaf 🙐 1F650 

south west pointing leaf 🙑 1F651 

north east pointing leaf 🙒 1F652 

south east pointing leaf 🙓 1F653 

 
69 https://www.htmlsymbols.xyz/ornamental-symbols/fleurons, February 5, 2025. 
70 https://en.wikipedia.org/wiki/Fleuron_(typography), April 28, 2025. 

https://www.htmlsymbols.xyz/ornamental-symbols/fleurons
https://en.wikipedia.org/wiki/Fleuron_(typography)
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Description Symbol Unicode 

turned north west pointing leaf 🙔 1F654 

turned south west pointing leaf 🙕 1F655 

turned north east pointing leaf 🙖 1F656 

turned south east pointing leaf 🙗 1F657 

north west pointing vine leaf 🙘 1F658 

south west pointing vine leaf 🙙 1F659 

north east pointing vine leaf 🙚 1F65A 

south east pointing vine leaf 🙛 1F65B 

heavy north west pointing vine leaf 🙜 1F65C 

heavy south west pointing vine leaf 🙝 1F65D 

heavy north east pointing vine leaf 🙞 1F65E 

heavy south east pointing vine leaf 🙟 1F65F 

north west pointing bud 🙠 1F660 

south west pointing bud 🙡 1F661 

north east pointing bud 🙢 1F662 

south east pointing bud 🙣 1F663 

heavy north west pointing bud 🙤 1F664 

heavy south west pointing bud 🙥 1F665 

heavy north east pointing bud 🙦 1F666 

heavy south east pointing bud 🙧 1F667 

3.4.2. Drop Cap 

Drop caps (versals, lettrines) typically start a chapter or a section of a longer text, 

being in fact an initial capital letter dropping through three or four lines, “nested 

into the text” (Bringhurst 2004, 63). They are typically red and are typically 

followed by a few words with small capitals (see National Geographic articles). 

Certain alternatives exist, as the cap may be positioned in the margin (cap, cf. 

Ármeán 2017, 58) or elevated/raised above the main text line (elevated cap, AMA 

2020, 1119). 

Inserting a drop cap is simple with the help of word processors; Word offers 

it in the Insert menu, Drop Cap (options exemplified below), while Writer hides 

it in Format, Paragraph, Drop Caps tab: 
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Figure 67. Insert drop cap, Word 

 

Figure 68. Insert drop cap, Writer 
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The outcome reminds us of the origin of drop caps, which are the monastic 

manuscripts, exemplified in the next paragraph. 

 

LEURONS ARE BEAUTIFUL if they are used systematically, all through a book, 

starting a new chapter. When set in red, fleurons offer a unique ornament to 

the entire page, bringing joy to the eyes of the reader every time. However, 

inserting a drop cap might require further settings. 

Scholars explain that setting the drop cap in a typographically correct position 

requires expertise, as side bearing is preserved; hence, the stem of F in our case is 

not in line with the left margin, which is why, for instance, the text line should be 

set to a minus value (Virágvölgyi 2004, 6), and the area around the drop cap might 

need further adjustments. 

In certain cases, kerning the letter following the cap might be necessary—the 

top of the drop cap should be in line with the top of letters in the first line, while 

the bottom of the cap should match the bottom of the letters in the third line. 

However, this is left to typographers, and word processors can handle the task 

acceptably. 

3.4.3. Swash 

A final type of ornament is swash, which is a “letterform reveling in luxury” 

(Bringhurst 2004, 331), as they either occupy extra space or contain extra 

ornaments compared to the Roman typeface, and Bringhurst concludes that true 

italic capitals are typically swash. 

These ornamented glyphs are remarkable, and entire typefaces are readily 

available in both Word and Writer (e.g., Blackadder ITC, Brush Script MT, 

Edwardian Script ITC, or Vivaldi), and various sites offer further wonderful fonts, 

often inspired by beautiful handwriting.71 Ligaments and other symbols, most 

notably ampersands, add to the charm of a particular typeface (see, for instance, 

Caslon No 337 Italic or Sahara Bodoni). 

3.5. Font Effects 

Various font effects may be considered as a final font contrast option. 

Word offers seven font effects by accessing Home, Font section, bottom-right 

arrow (Strikethrough, Double strikethrough, Superscript, Subscript, Small caps, 

All caps, and Hidden), or through the Ctrl+D shortcut. On the other hand, Writer 

makes these effects accessible via Format, Text (with shortcuts), or Character: 

 
71 For instance: https://elements.envato.com/learn/best-swash-fonts-and-fonts-with-tails, February 5, 
2025. 

F 

https://elements.envato.com/learn/best-swash-fonts-and-fonts-with-tails
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Figure 69. Font effect available, Word and Writer 

Furthermore, various text effects may also be used. The Text Effects and 

Typography icon is available in Word next to the Superscript icon, while Writer 

offers them via Format, Character, and the Font Effects tab (Case, Relief 

Embossed/Engraved, with or without Outline, and Hidden/Shadow): 
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Figure 70. Text effects available, Word and Writer 

Naturally, Text Highlight Color and Font Color offer very vivid contrasts: 

 

Figure 71. Contrasting text and font color, Word and Writer 
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3.6. Modified Letters 

The most common alphanumeric characters are displayed on the keyboard, and 

non-English keyboards have language-specific characters available with a single 

stroke or by changing the input language via keyboard settings. 

However, there are thousands of glyphs, characters, letters, signs, symbols, 

pictograms, and (emot)icons that may be inserted with the help of keyboard 

shortcuts, either through word processors or some special ones from various 

online sources. 

A rather reduced list is the so-called Windows Alt Codes list (ASCII), which 

is a set of 128 signals divided into 33 control signals and 95 graphic signals (letters 

of the Latin alphabet, the punctuation signs, and mathematical signs) dating from 

the 1960s.72 The Windows-1252 system developed by Microsoft doubled it to 256 

characters, but then the Unicode character system (1991) has become the 

international character-encoding system containing “more than a 100,000 

characters.”73 

Given the abundance of these characters, Bringhurst warns us that “[s]everal 

analphabetic characters are notorious for poor design and should always be 

inspected when assessing a new font” (Bringhurst 2004, 76). Due to the immense 

number of characters, it is worth categorizing them such as alphanumeric 

characters, mathematical signs and operators, punctuation-related, or various 

dingbats. 

Certain codes may lead to non-standard alphanumeric characters, and by 

using key combinations, even the typeface may switch to another one (Times New 

Roman to MS Gothic, MS Mincho, Segoe UI Symbol, or Cambria)74 once the 

original one does not contain a particular character. We have categorized them as 

country and regional indicators, circled letters, modified letters with special 

meanings, letter-like currency signs, and logograms. There are also (modified) 

numbers, discussed in Chapter 4  and punctuation signs and symbols presented in 

Chapter 5  

3.6.1. Country and Regional Indicators 

Although the letters in the table below may look like regular letters, they are in 

fact special letters (compare: A 🇦), and combining them in twos will result in either 

country codes (🇳🇿 for New Zealand) or codes for the US states (🇫🇱 for Florida): 

 
72 https://degreessymbolsign.com/alt-codes-list-of-256-alt-alternate-key-codes-symbols/, August 8, 
2022. 
73 https://www.britannica.com/topic/Unicode, August 8, 2022. 
74 Further details https://www.adamdawes.com/windows8/win8_segoeuisymbol.html, https://www.a
rild-hauge.com/altcodes.htm, https://www.makeuseof.com/windows-alt-codes/, http://zuga.net/
articles/unicode-all-characters-supported-by-the-font-arial-unicode-ms/, February 7, 2025. 

https://degreessymbolsign.com/alt-codes-list-of-256-alt-alternate-key-codes-symbols/
https://www.britannica.com/topic/Unicode
https://www.adamdawes.com/windows8/win8_segoeuisymbol.html
https://www.arild-hauge.com/altcodes.htm
https://www.arild-hauge.com/altcodes.htm
https://www.makeuseof.com/windows-alt-codes/
http://zuga.net/articles/unicode-all-characters-supported-by-the-font-arial-unicode-ms/
http://zuga.net/articles/unicode-all-characters-supported-by-the-font-arial-unicode-ms/
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Table 4. Regional or country indicator letters 

Letter Char. Unicode 

regional indicator symbol letter a 🇦 1F1E6 

regional indicator symbol letter b 🇧 1F1E7 

regional indicator symbol letter c 🇨 1F1E8 

regional indicator symbol letter d 🇩 1F1E9 

regional indicator symbol letter e 🇪 1F1EA 

regional indicator symbol letter f 🇫 1F1EB 

regional indicator symbol letter g 🇬 1F1EC 

regional indicator symbol letter h 🇭 1F1ED 

regional indicator symbol letter i 🇮 1F1EE 

regional indicator symbol letter j 🇯 1F1EF 

regional indicator symbol letter k 🇰 1F1F0 

regional indicator symbol letter l 🇱 1F1F1 

regional indicator symbol letter m 🇲 1F1F2 

regional indicator symbol letter n 🇳 1F1F3 

regional indicator symbol letter o 🇴 1F1F4 

regional indicator symbol letter p 🇵 1F1F5 

regional indicator symbol letter q 🇶 1F1F6 

regional indicator symbol letter r 🇷 1F1F7 

regional indicator symbol letter s 🇸 1F1F8 

regional indicator symbol letter t 🇹 1F1F9 

regional indicator symbol letter u 🇺 1F1FA 

regional indicator symbol letter v 🇻 1F1FB 

regional indicator symbol letter w 🇼 1F1FC 

regional indicator symbol letter x 🇽 1F1FD 

regional indicator symbol letter y 🇾 1F1FE 

regional indicator symbol letter z 🇿 1F1FF 

 

More recently, further letter combinations have appeared such as related to 

airplanes: 🆘 (1F198), 🆗 (1F197), 🆔 (1F194), or 🆏 (1F18F). 

It is also worth noting that while Greek letters are often used in specific Latin-

based texts, they function as symbols or pictograms (see 5.11.2.). 

3.6.2. Circled Capital Letters 

There are various reasons to rely on circled (enclosed) letters, which have both 

capital and small variants. 

Circled Latin capital letters are presented in the table below, together with 

their extended Alt code or Unicode. In case the selected typeface lacks these 
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characters, the word processing software will switch to a typeface that contains 

these characters. 

Table 5. Circled Latin capital letters 

Circled Latin capital letter Char. Unicode Alt 

circled Latin capital letter A Ⓐ 24B6 9398 

circled Latin capital letter B Ⓑ 24B7 9399 

circled Latin capital letter C Ⓒ 24B8 9400 

circled Latin capital letter D Ⓓ 24B9 9401 

circled Latin capital letter E Ⓔ 24BA 9402 

circled Latin capital letter F Ⓕ 24BB 9403 

circled Latin capital letter G Ⓖ 24BC 9404 

circled Latin capital letter H Ⓗ 24BD 9405 

circled Latin capital letter I Ⓘ 24BE 9406 

circled Latin capital letter J Ⓙ 24BF 9407 

circled Latin capital letter K Ⓚ 24C0 9408 

circled Latin capital letter L Ⓛ 24C1 9409 

circled Latin capital letter M Ⓜ 24C2 9410 

circled Latin capital letter N Ⓝ 24C3 9411 

circled Latin capital letter O Ⓞ 24C4 9412 

circled Latin capital letter P Ⓟ 24C5 9413 

circled Latin capital letter Q Ⓠ 24C6 9414 

circled Latin capital letter R Ⓡ 24C7 9415 

circled Latin capital letter S Ⓢ 24C8 9416 

circled Latin capital letter T Ⓣ 24C9 9417 

circled Latin capital letter U Ⓤ 24CA 9418 

circled Latin capital letter V Ⓥ 24CB 9419 

circled Latin capital letter W Ⓦ 24CC 9420 

circled Latin capital letter X Ⓧ 24CD 9421 

circled Latin capital letter Y Ⓨ 24CE 9422 

circled Latin capital letter Z Ⓩ 24CF 9423 

 

It is important to mention that certain enclosed letters have been designed for 

special use, which are different than the ones in Table 5, so they are discussed in 

the next section. 

3.6.3. Circled Capital Letters as Logograms 

Signs in this category have gained all special meanings, mostly a particular 

logogram (symbol for a word) function: 
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- the copyright sign © marks that “an artistic or intellectual work is copy-
righted”;75 

- the ℗ symbol refers to copyright sound recordings; 
- the ® sign means that the trademark is registered or “all rights reserved”; 
- the circled CD letters are mostly seen on vehicles belonging to diplomatic 

agencies, as the letters stand for “Diplomatic Corps” in French: 

Table 6. Circled capital letters as logograms 

Sign Character Unicode Alt Remarks 

copyright sign  © 00A9 169 or type (c)+Space bar 

sound recording 

copyright symbol 
℗ 2117   

registered sign ® 00AE 174 or type (r)+Space bar 

circled CD (Corps 

Diplomatique) 
🄭 1F12D   

 

Although it is not a letter, there is a circled bullet as well. While editing the 

text, we can type its Unicode value (U+29BF), which changes the font to Cambria 

Math, resulting in this glyph: ⦿. 

3.6.4. Circled Small Letters 

Similarly to the circled capital letters, applying the codes to create circled Latin 

small letters may also change the typeface in case the character is not available in 

the default one. 

Table 7. Circled Latin small letters 

Circled Latin small letter Character Unicode Alt 

circled Latin small letter a ⓐ 24D0 9424 

circled Latin small letter b ⓑ 24D1 9425 

circled Latin small letter c ⓒ 24D2 9426 

circled Latin small letter d ⓓ 24D3 9427 

circled Latin small letter e76 ⓔ 24D4 9428 

circled Latin small letter f ⓕ 24D5 9429 

circled Latin small letter g ⓖ 24D6 9430 

circled Latin small letter h ⓗ 24D7 9431 

 
75 https://www.britannica.com/topic/copyright-symbol, February 7, 2025. 
76 Although not enclosed, there is a different type of e, functioning as the “estimated symbol” (℮, 
U+212E). This is rather widespread, found on various prepacked products, specifying content tolerance 
in Europe. 

https://www.britannica.com/topic/copyright-symbol
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Circled Latin small letter Character Unicode Alt 

circled Latin small letter i77 ⓘ 24D8 9432 

circled Latin small letter j ⓙ 24D9 9433 

circled Latin small letter k ⓚ 24DA 9434 

circled Latin small letter l ⓛ 24DB 9435 

circled Latin small letter m ⓜ 24DC 9436 

circled Latin small letter n ⓝ 24DD 9437 

circled Latin small letter o ⓞ 24DE 9438 

circled Latin small letter p ⓟ 24DF 9439 

circled Latin small letter q ⓠ 24E0 9440 

circled Latin small letter r ⓡ 24E1 9441 

circled Latin small letter s ⓢ 24E2 9442 

circled Latin small letter t ⓣ 24E3 9443 

circled Latin small letter u ⓤ 24E4 9444 

circled Latin small letter v ⓥ 24E5 9445 

circled Latin small letter w ⓦ 24E6 9702 

circled Latin small letter x ⓧ 24E7 9447 

circled Latin small letter y ⓨ 24E8 9448 

circled Latin small letter z ⓩ 24E9 9449 

3.6.5. Modified Letters as Abbreviations 

While discussing ligatures (see 3.2.6.), we have mentioned a few cases with two 

merged letters, thus creating new ones (e.g., æ). 

Another possibility is that the letters remain unmerged, but their combination 

refers to something else. A few well-known letter combinations function as 

abbreviations, listed in Table 8 below. As these form a single glyph, they are 

characterized by default kerning. 

When inserted in the main text, some of them respect the line height (℀), 

while others may be positioned in the superscript line (™): 

 
77 Another type of circled small letter i refers to Circled Information Source: 🛈 (U+1F6C8, Alt 128712). 
Typing the code might change the typeface. 
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Table 8. Enclosed signs or modified letters 

Sign Glyph Unicode Alt Remarks 

account of ℀ 2100   

addressed to the 

subject 
℁ 2101   

care of ℅ 2105   

Numero sign № 2116   

telephone sign ℡ 2121   

trademark sign ™ 2122 153 

typing the string tm within 

parentheses will automatically 

turn into the glyph: (tm) 

3.6.6. Letter-Like Currency Signs 

Exchanging currency is a basic financial activity, and most widespread currencies 

have their own symbols. These signs are hardly ever used by themselves, as they 

should be “accompanied by a numeral” (APA 2020, 187). 

The APA manual also suggests using “the name of the currency when a 

number is not given,” also prescribing the repetition of the required symbol for 

each quantity of currency (cf. the repetition of the degree belonging to values). 

Currency signs are very efficient, saving space on electric boards, in figure 

labels, tables, legends, and charts (APA 2020, 187). The dollar sign, pound sterling 

sign, Euro sign, and Yen sign come before the numeral, which might be “expressed 

as a decimal number or whole number” (AMA 2020, 956). However, smaller 

amounts than decimals may also be displayed. 

The dollar sign is used by many countries, so in international settings it is 

recommended that the country code should precede the dollar sign, and the 

calculated amount in U.S. dollars should be added in parentheses. Yet, there are 

some issues connected to spelling: 

1. the Canadian dollar has multiple abbreviations: C$, CA$, CAD$, Can$; the 

AMA Handbook uses CAD $ (AMA 2020, 958),78 so a space separates the 

letters and the sign (CAD $3,000); 

2. the New Zealand dollar has two alternatives: $NZ or NZ$;79 

3. while the APA Manual mentions the importance of these signs in 

conserving space in “table headings and in figure labels and legends” 

(APA 2020, 187), it does not discuss how to spell dollars preceded by 

country reference; nevertheless, the country is abbreviated with periods 

(U.S.); 

 
78 https://en.wikipedia.org/wiki/Canadian_dollar, February 8, 2025. 
79 https://en.wikipedia.org/wiki/New_Zealand_dollar, February 8, 2025. 

https://en.wikipedia.org/wiki/Canadian_dollar
https://en.wikipedia.org/wiki/New_Zealand_dollar


3. Fonts, Characters, Letters  ◼  117 

4. the ASA Manual uses Can$ for Canadian dollars; United States is 

abbreviated without periods, and there is no space between the country 

abbreviation and the dollar sign: US$500, Can$350, NZ$300 (ASA et al. 

2024, 7–01). 

Knowing that consistency is very important, we recommend the US version 

(we tend to use no periods in acronyms and initialisms), which saves space and is 

also favored in headlines and combined abbreviations (USPS for United States 

Postal Service). In a similar vein, the country code may precede the sign without 

a space, on a par with the ASA recommendation above. 

Table 9. Currency signs 

Currency Character Unicode Alt Remarks 

dollar sign $ 0024 36 

The sign precedes the value. 

It is available on US 

(Standard/International) 

keyboards (Shift+4) or other 

keyboards as well (RO: 

Shift+4, HU 101: AltGr+É). 

cent sign80 ¢ 00A2 
155 

0162 

Rarely used: $1.00 = 100¢, 

replaced by $0.25, $0.05. 

It is available on US 

(Standard/International) 

keyboards (Shift+AltGr+C). 

general 

currency sign 

(placeholder) 

¤ 00A4 0164 

Informally: louse,81 scarab, 

sputnik (English). 

It is available on US 

(Standard/International) 

keyboards (AltGr+4). 

pound 

(sterling), lira 

sign 

£ 00A3 
156 

0163 

The sign precedes the value. 

It is available on US 

(Standard/International) 

keyboards (Shift+AltGr+4). 

Euro sign € 20AC 0128 

The sign precedes the value. 

It is available on US 

(Standard/International) 

keyboards (Shift+AltGr+C) 

or other keyboards as well 

 
80 Although not in polished English, the reason for the disappearing ¢ sign is explained here: 
http://www.charlieanderson.com/centsign.htm, February 7, 2025. 
81 Louse refers to its “parasitic” nature, as it is only a placeholder: “it takes up space on the font but 
offers nothing in return” (Bringhurst 2004, 313). 

http://www.charlieanderson.com/centsign.htm
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Currency Character Unicode Alt Remarks 

(RO: AltGr+E, HU 101: 

AltGr+U). 

Yen sign ¥ 00A5  

The sign precedes the value. 

It is available on US 

(Standard/International) 

keyboards (AltGr+-). 

Florin 

(Dutch 

guilder, 

obsolete) 

ƒ 0192  

 

 

While these are globally used signs, there are rather limited ones as well such 

as the obsolete guilder or the less common florin (U+0192), which is the lowercase 

version of the Latin capital letter F with hook (Ƒ, U+0191). Nowadays, it is used as 

the Arubian florin (AWG). 

3.6.7. Logograms 

Logographic symbols are traditionally associated with Chinese and Japanese 

(symbols representing words). However, certain symbols came into being from 

Latin words and gained international fame, being included in character tables, as 

these typographic forms have been “tied to a certain word” (Bringhurst 2004, 327). 

3.6.7.1. Ampersand (&) 

The ampersand derives from the Latin et ‘and,’ and it is “one of the oldest 

alphabetic abbreviations” (Bringhurst 2004, 78), which is extremely useful in 

saving space in citations and tables (APA 2020, 203). 

Houston highlights that the ampersand symbol “earned a permanent place in 

type cases and on keyboards” (Houston 2013, 75), so its Unicode is little known 

(U+0026). 

The possibilities to illustrate the merged letters of the ampersand set the 

imagination of typeface creators on fire, and there are “sexy” ampersands82 or “I ❤ 

ampersands!” movements, collecting dozens of them.83 A few interesting ones are 

illustrated below: 

 
82 https://blog.spoongraphics.co.uk/articles/my-top-30-fonts-with-the-sexiest-ampersands, February 7, 
2025. 
83 https://github.com/cormullion/know-your-fonts/blob/master/i-love-ampersands.pdf, February 7, 
2025. 

https://blog.spoongraphics.co.uk/articles/my-top-30-fonts-with-the-sexiest-ampersands
https://github.com/cormullion/know-your-fonts/blob/master/i-love-ampersands.pdf
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Figure 72. Ampersand variants 

3.6.7.2. Section sign (§, 00A7) 

The section sign (silcrow, section mark, or paragraph mark) originates from the 

Latin double s (signum sectionis ‘section symbol’).84 

As explained, it is a “critical sign used to mark the beginning of a paragraph 

or section” (Parkes 1992, 305), and it is inevitable in legal documents, manuals, 

and guides, typically followed by a number, referring to a particular section or 

subsection. Multiple sections are referred to with double section signs (§§ 8–10).85 

The importance of the section sign seems to have fallen behind, as various 

keyboards can reproduce it via combinations only (US-International: 

Shift+AltGr+S, RO: AltGr+P, HU-101: AltGr+R), while it is part of both ASCII 

(Alt+0167) and Unicode (U+00A7), displayed in the bracketed part of the heading 

as well. 

Although the visual representation of the glyph might be “often stiff and 

bland” (Bringhurst 2004, 76) due to its reference, there are a few interesting 

versions: 

 

Figure 73. Section sign variants 

3.6.7.3. “At” Sign (@) 

The @ sign is “a shorthand notation for the word «at»” (Houston 2013, 79) or “at 

any rate,” so it is a logogram. 

Having been included in the ASCII table in 1963, it was possible to be used in 

modern accounting (“commercial a”), invoicing, and more recently in email 

addresses, X (Twitter) usernames. In fact, its worldwide fame is secured by the 

entire social media, the financial and technical use (e.g., describing processor 

speed), but handwritten boards may also invite you to the best c@ffee in town with 

the help of this sign. A more recent use might have already been spotted by Revolut 

customers, as usernames (Revtags) start with this sign.  

 
84 https://tinyurl.com/3aw998nd, February 7, 2025. 
85 https://straightforward.design/posters/silcrow/, February 8, 2025. 

https://tinyurl.com/3aw998nd
https://straightforward.design/posters/silcrow/
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US keyboard layouts position this sign on Key 2, so Shift+2 creates the sign, 

without thinking too much of its values: Alt+64 or U+0040. The Hungarian 

keyboard layout enables this sign by pressing AltGr+V. 

After discussing various letters, the next chapter presents numbers and 

numerals.



Chapter 4   

Numbers 

4.1. Disambiguation of Terms 

There are at least four terms in English related to number: number, numeral, figure, 

and digit, so a minimal disambiguation is needed.86 

Digit refers to one of the ten single numbers (0, 1, 2, 3, 4, 5, 6, 7, 8, 9), while 

number “is an amount of something,” 87 so it is formed of one or more digits. While 

the term number is an abstraction or idea, written numbers are referred to as 

numerals, which seem to “emphasize quantity more strongly than numbers 

spelled out as words,” so “they are generally preferable in technical writing” (AMA 

2020, 984). However, another source explains, “a numeral is a symbol or name that 

stands for a number,” admitting that people often use the term numeral instead of 

number.88 

Figure may also refer to a number,89 and its use is favored in arithmetical 

calculations (having in mind “digits”), statistics, and financial performances; as 

such, there are crime figures, unemployment figures, sales figures, a six-figure 

salary, and some are good at figures (calculations). However, figure may also refer 

to illustrations, diagrams, or shapes in geometry, and we use this term in this sense 

throughout the book. 

In the following, we try to use the terms number and numeral, except for the 

original terminology used in quotes. In our view, numbers are worth discussing 

starting with their form, completed with their types and spelling. 

4.2. Forms of Numbers 

The form of numbers may be standard, most notably the ten digits, but there are 

variants as well, such as circled (enclosed) digits and numbers, while others are 

raised (superscript) or lowered (subscript) compared to the middle of the text line. 

 
86 The term cipher is obsolete to refer to numbers. 
87 https://www.britannica.com/dictionary/eb/qa/digit-or-number, February 10, 2025. 
88 https://www.mathsisfun.com/numbers/numbers-numerals-digits.html, February 10, 2025. 
89 https://www.oxfordlearnersdictionaries.com/definition/english/figure_1?q=figure, February 10, 
2025. 

https://www.britannica.com/dictionary/eb/qa/digit-or-number
https://www.mathsisfun.com/numbers/numbers-numerals-digits.html
https://www.oxfordlearnersdictionaries.com/definition/english/figure_1?q=figure
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4.2.1. Enclosed Numerals 

All the digits and a few numbers have circled variants, which means black digits 

and numbers enclosed in a white circle (0–20) or their negatives (1–10): 

Table 10. Circled digits and numbers 

Digits, numbers Glyph Unicode 

circled digit one ① 2460 

circled digit two ② 2461 

circled digit three ③ 2462 

circled digit four ④ 2463 

circled digit five ⑤ 2464 

circled digit six ⑥ 2465 

circled digit seven ⑦ 2466 

circled digit eight ⑧ 2467 

circled digit nine ⑨ 2468 

circled number ten ⑩ 2469 

circled number eleven ⑪ 246A 

circled number twelve ⑫ 246B 

circled number thirteen ⑬ 246C 

circled number fourteen ⑭ 246D 

circled number fifteen ⑮ 246E 

circled number sixteen ⑯ 246F 

circled number seventeen ⑰ 2470 

circled number eighteen ⑱ 2471 

circled number nineteen ⑲ 2472 

circled number twenty ⑳ 2473 

circled digit zero ⓪ 24EA 

negative circled digit one ❶ 2776 

negative circled digit two ❷ 2777 

negative circled digit three ❸ 2778 

negative circled digit four ❹ 2779 

negative circled digit five ❺ 277A 

negative circled digit six ❻ 277B 

negative circled digit seven ❼ 277C 

negative circled digit eight ❽ 277D 

negative circled digit nine ❾ 277E 

negative circled number ten ❿ 277F 
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In case the typeface does not contain the desired glyph, it changes into a 

different one after the shortcut is typed (e.g., Cambria Math). 

4.2.2. Superscript and Subscript Numbers 

The use of superscript numbers is justified when extra information might be 

needed and the author wishes to “minimize interruption” (Bringhurst 2004, 69). 

As he explains, this strategy keeps them out of the main text, yet those who are 

interested in extra information can easily find them. 

Superscript numbers are smaller than the default numbers of the baseline text 

and are positioned partly above the baseline. They are created “automatically” 

when a footnote90 is inserted. This is possible with the help of a shortcut in Word 

(Ctrl+Alt+F) or References, Insert Footnote. The Writer variant is the Insert 

Footnote icon on the main menu or Insert, Footnote and Endnote, Insert Footnote: 

 

Figure 74. Insert footnote, superscript number, Word and Writer 

Mathematics also relies heavily on superscript numbers when they refer to an 

exponent. The most frequent ones are squaring (32) or cubing (23). 

Subscript numbers are smaller than the default numbers of the baseline and 

are positioned “partly below the baseline” (AMA 2020, 1145). Scientific 

descriptions abound in them: the number of atoms is subscripted in Chemistry 

 
90 Endnotes typically start with small Roman numbers: i, then ii, iii, etc. 
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(H2O), or they denote the base of the number system, the elements of a vector, or 

differentiating variables (A1, A2) in mathematics. 

The Word shortcut for Superscript is Ctrl+Shift++, while Ctrl+Shift+- 

triggers Subscript. The Writer variants are Ctrl+Shift+P and Ctrl+Shift+B, 

respectively. 

4.3. Type 

While numbers mostly express the idea of a particular amount, and they may have 

various functions (e.g., relative number, irrational number), we are interested in 

those which might appear in everyday communication. 

4.3.1. Cardinal & Ordinal Numbers 

The most commonly used numbers are probably cardinal numbers, while arranged 

items may be referred to with the help of ordinal numbers. Although both cardinal 

and ordinal numbers can be written with digits, ordinal numbers have two extra 

letters in the superscript part, which express the rank or order. 

When the typing language is set to English in Word or Writer, correctly 

suffixed ordinal numbers change when followed by space, more precisely the 

suffix is raised to the superscript level. There are four ordinal suffixes: -st for 1 

(first), -nd for 2 (second), -rd for 3 (third), and -th for the rest, but any integer 

number ending in 1, 2, or 3 has the corresponding suffixes: 1st, 2nd, 3rd, 4th, 31st, 43rd, 

95th. However, certain word processing programs may prevent this automatic raise. 

One of the sources considers that superscript ordinals “may appear jarring 

and interrupt the flow of the text,” and to avoid this, it is recommended to spell 

out “ the ordinals first through ninth” (AMA 2020, 966), and the same source does 

not favor the use of these suffixes as superscripts. Another guidebook accepts any 

of the versions as long as they are “consistent” (APA 2020, 179). 

Ordinal numbers above nine are written in numbers unless they start the 

sentence, title, subtitle, or heading (AMA 2020, 966). This manual also specifies 

that in case a sentence contains more than one ordinal number, but all of them are 

below ten, they may be spelled out or not, but when one of them is above nine, the 

numeral form should be used for all. 

However, there are a few exceptions, which are always spelled out, such as 

the Twenty-fifth Amendment, whatever the context. 

A final remark is that references typically contain ordinal numbers (3rd ed., 9th 

Annual Conference), in which case numeral versions or digits (either superscript 

or not) are preferred (ASA et al. 2024, 7–01). The APA manual (APA 2020, 179) 

offers the following examples: first, 3rd year, fourth grade, 10th grade, 75th trial, 

three groups, 3 years, Question 2, the second question, Table 2, the second table, 

the 12th chapter. 
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4.3.2. Fractions and Decimal Fractions 

Typographically viewed, fractions combine at least two digits, which are either 

separated by a fraction slash (Alt+8260, U+2044)—resulting in a more slanted 

version than the regular slash found on keyboard: ⁄ /—or a decimal point. 

The slashed fractions are commonly referred to as vulgar or common 

fractions, in which the fraction slash separates two whole numbers (the numerator 

and denominator, neither of which may be zero), and some of them are available 

in the form of a single glyph: 

 

Table 11. Vulgar fractions 

Fraction Glyph Unicode Alt 

vulgar fraction one seventh ⅐ 2150 8528 

vulgar fraction one ninth ⅑ 2151 8529 

vulgar fraction one tenth ⅒ 2152 8530 

vulgar fraction one third ⅓ 2153 8531 

vulgar fraction two thirds ⅔ 2154 8532 

vulgar fraction one fifth ⅕ 2155 8533 

vulgar fraction two fifths ⅖ 2156 8534 

vulgar fraction three fifths ⅗ 2157 8535 

vulgar fraction four fifths ⅘ 2158 8536 

vulgar fraction one sixth ⅙ 2159 8537 

vulgar fraction five sixths ⅚ 215A 8538 

vulgar fraction one eighth ⅛ 215B 8539 

vulgar fraction three eighths ⅜ 215C 8540 

vulgar fraction five eighths ⅝ 215D 8541 

vulgar fraction seven eighths ⅞ 215E 8542 

fraction numerator one ⅟ 215F 8543 

fraction slash, division slash, solidus ⁄ 2044  

vulgar fraction one quarter (or type 1/2, space) ¼ 00BC 0172 

vulgar fraction one half (or type 1/2, space) ½ 00BD 0171 

vulgar fraction three quarters (or type 3/4, space) ¾ 00BE 0190 

non-breakable division slash ∕ 2215  

 

However, some of them may be created by simply typing the digits and the 

regular slash (½, ¼, ¾). They may be spelled out in texts (AMA 2020, 962), such 

as two-thirds, while others may rely on an article: half an hour, a fifth, one-fifth, 

although scientific descriptions prefer numerals (AMA 2020, 963). Mixed fractions 

contain both whole numbers (integers) and vulgar fractions, in which case 

numerals are easier to use: 3½ (AMA 2020, 963). 
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Decimal fractions contain a decimal marker, pronounced as point, which is 

in fact a period (or dot glyph).91 Points accompany various measures: 25.8 (twenty-

five point eight), 1.05 (one point zero five), knowing that numbers after the decimal 

point “are pronounced in isolation.”92 

All manuals stress that decimal values below 1 should start with 0, as in 0.750, 

and this leading 0 should not be omitted if the value may be higher than 1 (e.g., 

AMA 2020, 930), but in case no higher value than 1 is possible, the leading 0 must 

be omitted (APA 2020, 180). 

Furthermore, “certain statistical values, such as α levels and P values, should 

be reported without the use of 0 before the decimal marker” (AMA 2020, 930) or 

“correlations, proportions” (ASA et al. 2024, 7–01). Bringhurst adds that when 

these types of numbers are listed, they should be “flush right or on the decimal” 

in the column (Bringhurst 2004, 71). 

4.3.3. Roman Numerals 

Although the use of Roman numerals is shrinking, we are advised to keep them if 

they “are part of an established terminology, do not change them to Arabic 

numerals” (APA 2020, 180). 

While centuries used to be referred to in Roman numerals, modern English 

relies on Arabic numbers, and capital Roman numbers are to be seen only in titles, 

outlines, or “supplements to journals” (AMA 2020, 974). Furthermore, denoting 

wars (World War I), kings (King George III), and legislative acts (Title XII) also need 

Roman numerals (Froke et al. 2024, 209), while page numbering for forewords, 

prefaces, and introductions uses lowercase Roman numerals. 

4.4. Numerals and Spelling 

There might be various issues with spelling numbers, as well as their form 

(numerals or words), as detailed below. 

4.4.1. Range of Numbers 

Ranges of numbers should be typically used with from and to in texts, in which 

case the dash is not recommended:93 from 5 to 6. 

Interestingly, AmE might differentiate to and through, as the first one does not 

include the final digit (from 7455 to 8698), while through includes the final digit 

(AMA 2020, 968). However, the same source admits that to may be used instead of 

 
91 AmE uses period, while BrE uses full stop. Nevertheless, dot is used in the case of webpages. 
92 https://jakubmarian.com/dot-period-full-stop-and-point-in-english/, September 20, 2022. 
93 https://tinyurl.com/3thfsc9j, September 20, 2025. 

https://jakubmarian.com/dot-period-full-stop-and-point-in-english/
https://tinyurl.com/3thfsc9j
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through when the context is clear (lifespan, academic year, page numbers, or 

historical periods). 

On the other hand, an en dash is suggested to express a range of numbers (ASA 

et al. 2024, 2–06). 

4.4.2. Plurals of Numbers 

The plural form of numbers should follow the standard plural form in English (by 

adding -s or -es), so no apostrophe is needed: to march in threes, fours, or sixes 

(APA 2020, 181). The same rule applies to the numeric form as well: in the 1960s. 

4.4.3. Figures and Spaces 

Although English uses commas to separate every three digits, this is generally not 

encouraged by manuals.94 Instead, they suggest the thin space for that, “starting 

from the right-most integer or, in numbers with decimals, from the left of the 

decimal point” (AMA 2020, 962). 

The thin space (AMA 2020, 456) is included in the International System of 

Units convention (SI), and it is applied in major European institutions as well. The 

elimination of comma to indicate large numbers of more than 4 digits has made it 

possible to avoid misunderstandings stemming from the different uses of period and 

comma. However, 4-digit numbers need no thin space, while more than 4-digit 

numbers need a thin space (U+2009) of “1⁄5 or 1⁄6 the width of an em dash” (AMA 

2020, 930). This thin space is detectable in the five-digit number in the following 

brackets (75 925), although it is slightly more complicated to produce it.95 The AMA 

manual offers a list comparing large numbers with thin space and comma: 

 

Figure 75. Preferred and to-be-avoided numbers 

 
94 Nevertheless, the APA Publication Manual recommends commas starting with 4 digits (1,000), 
mentioning exceptions as well (APA 2020, 180). 
95 Once any digit is typed, the string of 2009 followed by Alt+X will not yield the desired thin space, 

as it considers the digit before the string. Hence, a space is needed before the string, which may be 
deleted after the thin space is created. 
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When a string of digits longer than 4 serves other purposes as well, no spacing 

is needed, which is the case of postal codes, combinations of numerals with letters, 

page numbers, binary numbers, serial numbers, frequency, extreme temperature, 

or file numbers (APA 2020, 180). 

A rather disturbing image might be when line-end numbers are broken, and 

one part of the string ends the line, while the other part starts the new line. The 

application of thin spaces will prevent this, as it is in fact a non-breaking space. 

The improper use of large numbers produces a visually disturbing image, as 

illustrated in Figure 76, detected in an online source: 

 

Figure 76. Wrong line-end number (online source) 

A final remark is that no comma is needed in measures of the same unit, such 

as time or volume (AMA 2020, 456), as shown in the example: 1001 days is 2 years 

9 months and 1 day. 

4.4.4. Numbers Instead of Words 

Both text-editing manuals and subtitling guidelines typically state that “numbers 

10 and above”are written with digits (APA 2020, 178), while numbers less than 

10 should be written as words (APA 2020, 179) with a few exceptions: 

1. the combination of numbers and units such as 3 ℃ or 3 kg (EC-DGT-RO 

2021, 7); 

2. numbers in series, parts of books (APA 2020, 178), lists and tables;96  

3. numbers representing common fractions (two-thirds) or mathematical 

operations (APA 2020, 179); 

4. numbers deriving from quotes (AMA 2020, 962); 

5. “when two or more numbers are used and any of them are greater than 

nine” (ASA et al. 2024, 7–01); 

6. ordinal numbers from first through nine; 

7. numbers referring to “time, dates, ages, scores and points on a scale, exact 

sums of money, and numerals as numerals” (APA 2020, 178); 

8. the correct abbreviation of the word “number” is № (U+2116), and not the 

hashtag. 

Numbers starting a sentence, title, or heading also belong to the exceptions, 

as they are written as numbers, although it is generally recommended not to start 

sentences with numbers (AMA 2020, 964). 

 
96 D. M., Mitchell, and Royle E. M. Cochrane Style Essentials. June 2024. https://training. 
cochrane.org/online-learning/author-guidelines/essential-style-guidelines, May 9, 2025. 

https://training.cochrane.org/online-learning/author-guidelines/essential-style-guidelines
https://training.cochrane.org/online-learning/author-guidelines/essential-style-guidelines
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4.4.5. Words Instead of Numbers 

A list of cases when words replace numbers is offered in the previous section, to 

which we can add idiomatic expressions or metaphoric uses of numbers, as well 

as established expressions, where words replacing numbers should be preserved 

(The Ten Commandments, offer an example or two). 

The range of numerals from twenty-one to ninety-nine requires a hyphen, and 

spelling numbers greater than 100 requires neither commas nor and (AMA 2020, 

964). 

In fact, the word number “may be abbreviated No. in the body of tables … or 

in the text when used as a specific designator” (AMA 2020, 970), and it is not 

recommended to use the number sign (#) instead of this abbreviation (a No. 1 hit), 

as it is used extensively in social media. However, number should not be 

abbreviated when it is used as a proper noun (Social Security Number). 

One is often used as a noun or pronoun (on the one hand), in which case the 

word is used. Similarly, “large rounded numbers,” such as million or billion, are 

mostly spelled out (AMA 2020, 965). Million signifies the quantity 106, so digit 1 

is followed by six zeros, but billion might refer to either 109 (a thousand million) 

or 1012 (a million million), and the latter is the rarely used trillion97 (AMA 2020, 

967). As the British and American use of billion and trillion is ambiguous, they are 

to be avoided, although there is the assumption that billion is 109, while trillion is 

1012 “in all English-speaking areas” (Einsohn and Schwartz 2019, 204 Footnote 9). 

4.4.6. Numerals, Words, and Symbols 

Combining words and large numbers is logical (2 million birds, 3.5 million people), 

including “[d]ates, page numbers, percentages, time, numbers preceded by 

capitalized nouns, and numbers followed by units of measure” (ASA et al. 2024, 

7–01). 

However, monetary units may often rely on currency signs as well ($2, €3, £4, 

¥5), and when they refer to a range, the symbols should be used twice ($5–$9), 

even if it refers to the same currency (CMOS 2024, 176). Currencies not 

exemplified above are placed after the numbers. The percentage symbol follows 

the numeral without space (5%), and a range repeats the symbol (5%–10%). 

Understanding consecutive numbers is easier when words separate them. 

Rewording focuses on separating two numbers after each other, so instead of 

mentioning a class of 30, 15 boys and 15 girls, it is better to say a class of 30 pupils, 

with 15 boys and 15 girls (AMA 2020, 967). 

 
97 http://www.vendian.org/envelope/dir0/counting_by_tens.html, March 13, 2025. 

http://www.vendian.org/envelope/dir0/counting_by_tens.html
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4.5. Conclusions 

Chapter 2 and Chapter 3 present the elements described as the “framing and 

hanging a painting” (Bringhurst 2004, 23), because they offer the setup of pages 

and the typeface of texts, together with an impressive set of options to contrast and 

highlight various parts of any text. 

Nevertheless, we agree that everything described so far is a mere description 

and may be approached as suggestions at best, knowing that “there really aren’t 

any standards for type designers to follow” (Spiekermann 2013, 57). And it is not 

designers alone who do not follow these suggestions verbatim. 

If we take an inventory of page content, we should focus on titles, several 

headings, an epigraph, block quotations, equations, sidenotes, possible graphs, 

tables, illustrations with accompanying captions, as explained (Bringhurst 2004, 

102), because these elements offer the overall impression. 

In our view, less visible parts may also contribute to shape the overall image, 

such as the numbers and various symbols belonging to punctuation, reiterating our 

experience that “prescriptions” regarding numbers and numerals also seem to be 

created by publishing houses, and inconsistencies are inevitable across various 

publications and individual solutions. 



Chapter 5   

Punctuation and Spelling 

5.1. Definitions 

Punctuation ensures the “cadence of a sentence” (APA 2020, 153). The Modern 

Language Association of America Handbook (MLA) offers a more precise 

definition: punctuation “clarifies sentence structure by separating some words and 

grouping others” (MLA 2021, 16), and it governs “relationships within and 

between sentences” (CMOS 2024, 378), revealing where thoughts are intended to 

be paused. 

Punctuation is effective with the help of a set of signs and symbols, commonly 

referred to as punctuation marks. Manuals mention about a dozen of them, and 

we group them according to their various functions. As such, we consider it 

important to differentiate invisible (non-printable) and visible (printable) 

characters. While the former category contains only a few cases, the latter may be 

very diverse, ranging from common characters directly available from a standard 

keyboard (period, comma, or question mark) to mathematical operators and 

pictograms as well. However, it is clear that while a standard computer keyboard 

contains many useful characters, less frequent ones are also available directly 

(such as angle brackets), and more needed ones are not (e.g., en dash). 

All these signs may “resolve structural uncertainties in a text … signal 

nuances of semantic significance which might otherwise not be conveyed at all” 

(Parkes 1992, 1). This is possible once there are clearly set recommendations upon 

the meanings of punctuation signs, and the Webster’s Third New International 

Dictionary (1993), together with its major abridged version (Merriam-Webster’s 

Collegiate Dictionary) provides this for the majority of publication manuals, 

relying on AmE.98 

Two important remarks are that all punctuation marks should be set in the 

same font style as the main text unless they belong to the highlighted part (CMOS 

2024, 378), and no extra invisible characters (space or tab) should be left after 

sentence-end punctuation marks (CMOS 2024, 69). 

Notable exceptions to following punctuation guidelines are provided by users 

of various social media, which may be characterized by lacking certain 

punctuation marks (AMA 2020, 444) or overusing some of them. Yet, this type of 

 
98 Yet, the dictionary is not void of criticism, for instance, lack of recommendations or the use of ain’t. 
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communication is beyond the range of the present book. Proper punctuation is 

typically combined with correct language use, well-chosen font typeface with 

diacritical signs, word order, and lack of typographical errors, which is discussed 

in the next chapter. 

5.2. Non-Printing Characters 

Non-printing characters, together with special characters—abbreviated as NPSC 

(Dodlapati et al. 2010, 1)—offer a valuable insight into how characters were 

positioned in a document. Non-printing characters are typically disabled, and they 

may be enabled with the help of the pilcrow symbol both in MSO and LO. 

While MSO running on Windows displays non-printing characters in the 

same color as the font color (leading to eye strain), LO and MSO running on 

MacBooks offers blue non-printing characters to the users, which is more than 

welcome. Enabling non-printing characters offers the chance to observe typing 

errors such as multiple spaces, multiple tabs, or extra lines. 

In our view, there are three major categories of non-printing characters (the 

pilcrow sign, spaces, and breaks), detailed in the following sections. Less frequent 

ones are anchor (appearing when images or text boxes are inserted), end-of-cell or 

end-of-line symbol (louse), appearing in tables. Some headings end in a bracketed 

part, which contains those signs and their Unicode value that are not present on 

the standard US keyboard. 

5.2.1. Pilcrow (¶, 00B6) 

Experts recommend users to enable non-printing characters, which may be carried 

out by pressing the pilcrow button in both Word (Main tab, Show/Hide button) 

and Writer. The Word shortcut to enable/disable this function is Ctrl+Shift+*,99 

while Writer uses the Ctrl+F10 shortcut. 

The pilcrow sign is referred to as the “quintessential shady character” 

(Houston 2013, 3), and it may be inserted from the Character Map or with specific 

shortcuts (Alt+20, Alt+0182, or U+00B6). Its origin is well described by Houston, 

also taken over by the Smithsonian magazine.100 However, if the Show paragraph 

marks and hidden characters is enabled, pressing the Enter key results in a 

pilcrow sign, and the cursor jumps to a new line below, starting a new paragraph. 

Thus, it is a “proofreading symbol … of talismanic power” (Houston 2013, 21). 

 
99 Although MSO provides the Ctrl+* shortcut, this is not functional, and the Ctrl+Shift+* only works 

with the * sign on Key 8, while the * sign on the numeric keyboard is also non-functional. 
100 https://tinyurl.com/4sm363t4, February 7, 2025. 

https://tinyurl.com/4sm363t4
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5.2.2. Spaces 

There are spaces for various purposes, and the exact amount of (white)space 

between different characters is described in various manuals and guidelines 

(Spiekermann 2013, 193; CMOS 2024, 381), although Spiekermann admits that 

spaces in between letters may prove more time-consuming than “setting the type 

itself.” 

The CMOS states, “[t]he spaces that occur between words and other elements 

in running text … are not punctuation per se, but they play a supporting role,” as 

their primary function is separation (CMOS 2024, 430). The problem is that there 

are various spaces with different widths, and some of them are even non-breaking 

to keep certain strings of characters together. There are 13 types of spaces listed 

(CMOS 2024, 430), and the majority of whitespace characters are detailed below. 

5.2.2.1. Space 

The term space in text editing refers to the “regular” space created with the Space 

bar. Its Unicode value is U+0020, but it is part of the Alt value (decimal) as well 

(Alt+32). As explained, this is “as an invisible graphic rather than a control 

character” (Dodlapati et al. 2010, 1). 

Space is to be used between Arabic numerals and following quantities, 

although they might be “connected” with non-breaking spaces for intelligibility. 

Sentence-end punctuation marks are followed by space when another sentence 

starts. Similarly, initials of names are separated by a period followed by space, 

while abbreviations (more precisely, acronyms and initialisms) should not contain 

spaces (APA 2020, 154). However, there is no space before the percent and degree 

signs (AMA 2020, 929). 

Other types of spaces are also defined in Unicode, but they might not be 

functional on certain devices or in other applications unless they are “intended for 

print or PDF” (CMOS 2024, 431). 

5.2.2.2. Non-Breaking Space (00A0) 

The use of non-breaking space is recommended between numerals with spaces 

and numerals followed by measures of unit (except for numbers followed by the 

percent and degree sign). 

Non-breaking space is also recommended between the initials in a name 

(CMOS 2024, 431), or even parts of a book, such as chapter 1 or unit 2. This type 

of space may be referred to as hard space (Bringhurst 2004, 43), and it may be 

either inserted from the Character Map or relying on various shortcuts: 

Ctrl+Shift+Space bar (Windows) and Option+Space bar (macOS). It has a 

Unicode variant (U+00A0), but Alt+255 and Alt+0160 also result in a non-

breaking space. This type of space is widely supported in text editing. 
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Non-English languages also rely on non-breaking space to type large numbers 

(1 000 000), phrases/words followed by numbers, or various mathematical 

operations (EC-DGT-RO 2021, 7). 

Although hardly distinguishable from the non-breaking space, there is a 

narrow non-breaking space (U+202F), which is a fixed-width version (CMOS 2024, 

430). 

5.2.2.3. En Space (2002) and Em Space (2003) 

There are two types of dash-width spaces: 

1. an en space (or “nut”) offers the width of an en dash, hence they are wider 

than the standard space; 

2. an em space provides the width of an em dash. 

An en space may be half the width of an em space (CMOS 2024, 430). Their 

Unicode value is U+2002 and U+2003, respectively. 

5.2.2.4. Thick (2004) and Thin Space (2009) 

As explained, a thick space is a third of the width of an em space, while a thin 

space is a fifth or a sixth of an em space (CMOS 2024, 430). 

The CMOS recommends the use of thin spaces “between contiguous single 

and double quotation marks” (CMOS 2024, 431), and another source—relying on 

the SI convention—favors thin spaces to separate the digits beyond thousands 

(AMA 2020, 456), even if they are commonly separated by commas in English. 

Manuals might also mention a hair space (U+200A), which is thinner than a 

thin space (CMOS 2024, 430), but no explanation has been found when to use it. 

5.2.2.5. Figure Space (2007) and Punctuation Space (2008) 

As its name suggests, a figure space (U+2007) takes the width of a monospaced 

digit, whereas a punctuation space (U+2008) occupies the width of a period, colon, 

or exclamation point (CMOS 2024, 430). While figure space makes sense to use in 

telephone numbers or secure aligned columns filled with numbers, punctuation 

space is hardly ever used in everyday contexts. 

5.2.2.6. The Tabulator Character 

The tabulator has a standard width (as a nonprint character), although text editors 

tend to change it.101 

The tabulator key (tab key, tab space) should be used to divide a text into 

fields, ultimately having in mind the creation of tables by exporting the text into a 

spreadsheet. However, many users rely on this key to mark the beginning of a new 

 
101 https://tinyurl.com/5z45jfpm, April 3, 2025. 

https://tinyurl.com/5z45jfpm
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paragraph, functioning as a paragraph marker, often taking over the first line 

indentation feature of word processors (CMOS 2024, 73). 

Word can change tabbed text to a table by accessing Insert, Table, Convert 

Text to Table, Separate Text At with four options: Paragraphs, Commas, Tab, 

Other. Writer offers this via Table, Convert, Text to Table, Separate Text At, also 

offering four options: Tabs, Semicolons, Paragraph, Other. 

The following table displays the width of spaces discussed above: 

Table 12. Various spaces 

Name Unicode/Shortcut Alt Width 

Space 0020 32 Jack Sparrow 

Non-Breaking 

Space 

00A0 

Ctrl+Shift+Space 

bar 

255 

0160 
Jack Sparrow 

En Dash 2002 0150 Jack Sparrow 

Em Dash 2003 0151 Jack Sparrow 

Thick Space 2004  Jack Sparrow 

Figure Space 2007  123 456 

Punctuation 

Space 
2008  Jack Sparrow 

Thin Space 2009  Jack Sparrow 

Hair Space 200A  Jack Sparrow 

Tab Character102 – 09 Jack Sparrow 

5.2.3. Breaks 

Breaks are also nonprint features of a text. Major break types within a document are: 

1. page break (Ctrl+Enter) is used to start a new page within a document; if 

each new chapter is set to start on a separate page, then Page break before 

must be enabled; if separate ideas need to be presented, then Space after; 

2. column break (Ctrl+Shift+Enter) is used to start a new column within a 

document; 

3. line break (Shift+Enter) starts a new line in the document; the symbol for 

this type of break is signaled by a carriage return (↵);103 

4. section break starts a new section, which may be Continuous (on the same 

page), Next (starting on a new page), and there is the option for the new 

page to start an odd or even page; 

 
102 Seemingly, there is no Unicode for that, but there is Alt+09 for the tab character, resulting in a right 

arrow, when nonprint characters are revealed. 
103 The Unicode value for a carriage return (↵) is U+21B5, or the decimal is Alt+8629. 
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5. paragraph break: keep lines together; 

6. end of cell/row (louse). 

Word offers these breaks via the Layout tab, Breaks, while Writer users can 

access these features through Insert, More Breaks, Manual Break, and Page Style 

with the options for Line, Column, and Page break. 

A special type of nonprint break character marks the end of cells or rows in 

tables, referred to as the louse symbol (¤). 

5.3. Dashes 

Dashes are a set of printing characters and—together with hyphens—belong to 

“internal punctuation marks used for linkage and clarity of expression” (AMA 

2020, 459). 

As Houston explains, there are many types of dashes, some of which can 

easily replace the hyphen in modern word processors, “where once the hyphen-

minus ran riot” (Houston 2013, 112), knowing that the differences may be “subtle” 

(CMOS 2024, 414). The APA style uses two kinds of dashes: the em dash (long 

dash) and the en dash (midsized dash), which are different from the hyphen and 

the minus sign (APA 2020, 157). However, another manual mentions that 

alongside the em dash, there is a 2-em dash and even a 3-em dash, and dashes are 

used to “convey a particular meaning or emphasize and clarify a certain section of 

material within a sentence” (AMA 2020, 471). For instance, a small-state affair 

versus a small state-affair. 

The only dash directly available on the keyboard is the hyphen, although 

there are combinations for the em dash and en dash as well. In fact, Houston 

complains that dashes were neglected before the Unicode period, and the 

typewriter’s hyphen stood for the hyphen, en dash and minus sign as well, while 

present-day keyboards display a “hyphen-minus” sign, which is also inadequate 

(Houston 2013, 121). 

5.3.1. Hyphens 

A hyphen is primarily used to link syllables of the same word “which have become 

separated, especially at the end of a line,” and to “link compound words” (Parkes 

1992, 304). 

However, there are at least three types that should be mentioned: hard 

hyphen, soft hyphen, and non-breaking hyphen. As observed, hyphens and 

apostrophes apply to words (Greenbaum 1996, 505). 

5.3.1.1. Hard Hyphen 

A hard hyphen is typed (available on various keyboard layouts), becoming “a 

permanent part of the text stream” (Felici 2012, 90), and is one of the “the simplest 
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mark[s] of punctuation,” together with the period (Houston 2013, 121). In fact, it 

is a “connector” (AMA 2020, 459). 

The length of a hyphen is typically the quarter of an em, although there are 

cases when “a shorter hyphen is better” (Bringhurst 2004, 79). Its Unicode value 

is U+002D, but Alt+45 results in the same symbol. 

While it is impossible to list all the conceivable uses of hyphens, there are 

certain guidelines to clarify that, and words with or without hyphens should be 

checked in dictionaries. If not found in dictionaries, the general rule is to avoid 

the use of hyphen. As for line-end hyphens, they should be “hung in the right 

margin” (Bringhurst 2004, 79). Interestingly, a line-start hyphen followed by space 

is automatically turned into a bulleted list in Word, where bullets are replaced by 

hyphens (not recommended). This function is not implemented in Writer. 

Permanent hyphens are orthographic (AMA 2020, 460), signaling a strong 

bond between the components. The CMOS offers a lengthy table of how to use the 

hyphen properly (CMOS 2024, 477–91), and combined with further sources (AMA 

2020, 461–69; 2020, 968–69; APA 2020, 163–64; Thomas 2021, 464), online ones 

included,104 the following major uses are worth mentioning: 

1. compound words (brother-in-law); 

2. compounds in which the base word is capitalized (pro-Freudian); 

3. compound words with certain words such as self or ex (self-driven, ex-

wife); nevertheless, certain hyphenation rules change, as is the case with 

email, which used to be hyphenated, although other similar compounds 

still preserve the hyphen (e-cigarettes, e-commerce); 

4. multiple compound words (non-goal-oriented); 

5. compound serving as adjective or noun (a hands-on experience); 

6. telephone numbers with country codes; 

7. social security numbers; 

8. International Standard Book Number (ISBN) numbers; 

9. separating letters when letter by letter spelling is intended; 

10. avoiding awkward combinations of similar letters of prefixed or suffixed 

words (semi-independent, football-like), except for commonly used ones 

(coeducational, cooperation, coordination); 

11. identical interjections (blah-blah); 

12. marking syllables (without spaces on either end); 

13. connecting numbers (forty-five, 2024-25), sounds and abbreviations with 

suffix in foreign languages; 

14. ranges and dimensions (a 3-cm-diameter spot); however, non-modifier 

versions are more fluent (a spot 3 cm in diameter); 

15. tests, scales, diagnostic manuals (MMPI-2, DSM-S). 

 
104 https://tinyurl.com/mtr75upt, April 24, 2025. 

https://tinyurl.com/mtr75upt
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Naturally, there are rules when not to use hyphens (AMA 2020, 968; 

Bringhurst 2004, 80; Thomas 2021, 464): 

1. tables and graphs may use hyphens to indicate spans, except for when the 

minus sign is also included (−5.8 to −2.3 kg); on the other hand, texts 

should use the preposition to instead of the hyphen when dates or 

numerals are specified (5% to 10% of the people. 29 January to 10 

February); 

2. “closed compound words” that look like one word should not be 

hyphenated: (bookshop, earthquake, downstream, honeybee, keyword, 

makeup, notebook, online); 

3. Uniform/Universal Resource Locators (URLs), i.e. web page addresses or 

email addresses should not be broken relying on hyphens. 

The so-called suspended hyphens (APA 2020, 163; CMOS 2024, 477) should 

be used when “the second part of a hyphenated expression is omitted,” and the 

suspended hyphen replaces the similar part, followed by a space or comma: 

fifteen- and twenty-year mortgages, both over- and underfed cats, 2-, 3-, and 10-

min pauses. 

Temporary hyphens should “prevent ambiguity, clarify meaning, and 

indicate word breaks at the end of a line” (AMA 2020, 460), including the case 

when an “unhyphenated word would have a different meaning” (AMA 2020, 465) 

such as re-formation. 

5.3.1.2. Soft Hyphen 

Soft hyphens are automatically generated breaks at line-ends once Hyphenation is 

active in Word. Writer contains this feature under Tools, Language, Hyphenation. 

This type of hyphen is “added by a hyphenation program … and it will 

disappear when the word in which it occurs no longer needs to be broken at line’s 

end” (Felici 2012, 89). The CMOS explains that hard hyphens should be 

distinguished from “end-of-line hyphens,” that is soft hyphens, which are not 

permanent (CMOS 2024, 108–9). 

5.3.1.3. Non-Breaking Hyphen (2011) 

Interestingly, non-breaking hyphens are not mentioned in the major style guides. 

Nevertheless, they might be very important when we do not wish to break 

hyphenated words at line-ends, such as combined family names or certain 

numbers (e.g., twenty-five). 

Its Unicode value is U+2011 or Alt+Shift+-, but it may be inserted from the 

Character Map as well: the Main tab in Word contains the Symbol icon, and the 

drop-down arrow offers More Symbols with the Special Characters tab: 
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Figure 77. Special characters, Word 

However, the Ctrl+Shift+_ shortcut (displayed) results in superscript and not 

in the desired non-breaking hyphen. Word, running on Windows, can produce a 

non-breaking hyphen with the Alt code or the Unicode mentioned above. 

 

Figure 78. Special characters, Writer 
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Special characters in Writer may be inserted differently: Insert on the Main tab, then 

Special Character, and in the Search line the name of the character will filter the op-

tions to the desired one (although spaces are invisible in the white cells): see Figure 78. 

5.3.1.4. Word Division 

While soft hyphens are controlled by text-editing software, there are certain words 

that should never be separated resorting to hyphens. Although certain settings are 

available regarding when to split words at line-ends (e.g., by specifying the 

minimum number of characters or to make exceptions with specific words), this 

might not be enough. 

As recommended, division of words should take place after a vowel, knowing 

that diphthongs form a single vowel (e.g., aneu-rysm). Furthermore, single-syllable 

words should never be separated (CMOS 2024, 455–59), but pronunciation should 

be also considered (e.g., knowl-edge) and homonyms might have various divisions 

(proj-ect as a noun and pro-ject as a verb). 

Compound words, already hyphenated words, or affixed words (with prefix 

or suffix) should be divided at “the natural breaks” (CMOS 2024, 456), so where 

the hyphen is (e.g., mother-in-law) or separating the prefix/suffix from the root 

(e.g., un-happy, wonder-ful). 

Personal names should not be divided, except for after the initials, but not 

before the Jr. or Sr. abbreviations, which are not separated by comma before and 

after the names (Einsohn and Schwartz 2019, 174). 

A further issue is large numbers, which should never be divided, although 

online articles seem to break this rule, as illustrated in Figure 76 (Section 4.4.3.). 

Moreover, abbreviated units of measure should be next to the numeral with the 

help of a non-breaking space (CMOS 2024, 457). 

Finally, email addresses and URLs should not be hyphenated manually at the 

end of a line; they are typically broken after a punctuation sign or other symbol. 

5.3.2. En Dash (–, 2013) 

There are views that dashes “obscure” the meaning of a sentence (Houston 2013, 

154), and the en dash (or middle-length dash) is one of them, as its use is mixed 

with the hyphen and the subtraction sign. 

Although the keyboard contains a key with a sign similar to an en dash, that 

is the hyphen, while the combination of Shift+- results in the underscore (_). An 

en dash may be inserted via the Character Map or relying on shortcuts: U+2013 or 

Alt+0150. The en dash is “half the length of an em dash” (AMA 2020, 1131). 

Word can insert an en dash with the Ctrl key and the hyphen sign on the 

NumPad, while Writer turns two consecutive hyphens to an en dash. Furthermore, 

typing a hyphen, a space, and a word followed by another space will automatically 

turn the hyphen into an en dash. A notable exception is when the hyphen starts 
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the line, because Word will interpret it is as the beginning of a bulleted list, but 

bullets are replaced by hyphens (visually unappealing), in which case they are not 

converted into en dashes. 

The en dash is used to refer to ranges with digits (3–6) referring to times, page 

numbers, dates, house numbers (Ármeán 2017, 38), and no space should be 

inserted between the sign and the digits105 (Bringhurst 2004, 80; Thomas 2021, 

463). In order to prevent ending the line with an en dash, inserting the non-

breaking space before and after the dash is recommended (Word). While this 

method keeps the range together, it breaks the rule that no space should be on 

either side of the dash, so an interesting bridging solution is needed. As 

suggested,106 when the range is typed with the non-breaking spaces, selecting a 

space and pressing Ctrl+D triggers a window with the fonts, where the Advanced 

tab, Scale is found. The value should be set to 1%, which is an acceptable solution: 

 

Figure 79. Workaround for non-breaking en dash, Word 

 
105 BrE may use spaces before and after the en dash (Houston 2013, 145). 
106 https://darrengoossens.wordpress.com/2018/07/31/non-breaking-en-dash-in-word/, August 14, 
2025. 

https://darrengoossens.wordpress.com/2018/07/31/non-breaking-en-dash-in-word/
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Of course, this is not an ideal solution, as a non-breaking space set to Scale 

1% is invisible even if the Show/Hide is activated. 

There is a description for Writer:107 after typing the characters before the en 

dash, the :--: string should be typed (this will automatically turn to an en dash), 

and typing 2060 followed by Alt+X will turn the dash into a non-breaking word 

joiner, followed by the characters after the dash. The result is visibly better, as 

activating the nonprint characters reveals the non-breaking word joiner, while the 

standard view hides it: 

 

Figure 80. Workaround for non-breaking dash, Writer 

Tricking Word by creating this word joiner in Writer is not possible, as once 

the text is copied from Writer and pasted into a Word document turns it into a 

regular en dash. 

To facilitate clarity, in case any of the numbers is negative (-3 to 3), to is 

preferred instead of the dash (ASA et al. 2024, 2–06). As the en dash replaces the 

word to, it may refer to routes, directions, and distances as well (Paris–Roubaix 

bicycle race), where the en dash signals that the compounds are “of equal 

importance” (ASA et al. 2024, 2–06). 

However, when from or between is used, to is always required: from 5 to 6, 

between 5 and 6. The en dash also signals the link between compound words with 

hyphen: the post–World War II years (CMOS 2024, 417). More complex 

compounds may combine en dash and hyphen: North–North-West (Academia 

Română 2005, XLIII) or Winston-Salem–oriented group (AMA 2020, 471). 

A final use of en dash might be linked to censorship: “offensive or sensitive” 

words may offer only a letter completed with the en dash (Houston 2013, 145). 

 
107 https://ask.libreoffice.org/t/non-breaking-en-dash/27197/7, August 14, 2025. 

https://ask.libreoffice.org/t/non-breaking-en-dash/27197/7
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5.3.3. Em Dash (—, 2014) 

An em dash (or long dash) is double the length of an en dash, and it may be 

inserted via the Character Map or Choose Symbol from the Insert menu, then 

Special Characters tab, highlight the em dash, and click Insert.108 There are also 

two shortcuts for this sign: U+2014 or Alt+0151. Keyboards with numeric keypad 

have a further option: Ctlr+Alt+- (hyphen on the numeric keypad) will also result 

in an em dash, but only in Word. 

The non-breaking space before and after the em dash might work in the case 

of Word, but the workaround for Writer does not work (see Section 5.3.2.). 

The em dash seems to be an alternative to parentheses, commas, or a colon 

(CMOS 2024, 418), and certain expressions with that is, for instance, or namely 

might start with the em dash (CMOS 2024, 419). Thus, it indicates “an interruption 

or break in thought in a sentence,” also used “after introductory clauses and before 

closing clauses or designations” (AMA 2020, 1131). 

Appositions are typically separated from the rest of the sentence by commas, 

but em dashes are also possible (AMA 2020, 471), although it is better not to use 

them very often, as they might break the text too much (APA 2020, 157). 

Furthermore, it can replace an entire word or thought in case the author does not 

wish to reveal them (Greenbaum 1996, 511). 

Subentries in an index may also rely on the em dash, as well as blank or empty 

data may be signaled with it (CMOS 2024, 420). 

Non-English languages may signal dialogue lines with a sign slightly longer 

than the em dash, although in many cases they rely on the em dash directly 

followed by the first word, without a space (CMOS 2024, 420), which is also 

suggested by other authors (Bringhurst 2004, 81). 

The rise of the “dash” (both the em dash and the en dash) is mentioned by 

Lloyd,109 who offers a vivid characterization of them: “[t]he dash is brutal, 

unsympathetic, slashing, and impossible to be confused about — it takes you, 

frictionlessly, to the point. The dash invites no ambiguity and wastes no time. The 

punctuational equivalent of tearing a heart from a chest,” ending with the 

recommendation that it should be used instead of the semicolon. 

5.3.3.1. 2-Em Dash (2E3A) 

The previously discussed en dash and em dash might be used to indicate missing 

letters and words, although manuals mention longer dashes for these purposes. 

One of them is the 2-em dash (U+2E3A), which should mark “missing letters 

in a word” (AMA 2020, 472), in which case the first letter is provided (e.g., New 

 
108 https://www.techrepublic.com/article/four-ways-to-insert-an-em dash-in-a-word-document/, April 
24, 2025. 
109 https://unherd.com/newsroom/the-melancholy-decline-of-the-semicolon/, April 24, 2025. 

https://www.techrepublic.com/article/four-ways-to-insert-an-em%20dash-in-a-word-document/
https://unherd.com/newsroom/the-melancholy-decline-of-the-semicolon/
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A—— Hospital), and there is no space between the letter and the 2-em dash. Yet, 

an entire word may be replaced by this sign, in which case space is needed on both 

sides, unless a punctuation sign is used. 

5.3.3.2. 3-Em Dash (2E3B) 

The 3-em dash (U+2E3B) is recommended in bibliographies instead of repeating 

the author’s name (Bringhurst 2004, 81; CMOS 2024, 71), although it is typically 

applied by editors and publishers. 

However, another source recommends the use of the 3-em dash to stand for 

one or even more missing words (AMA 2020, 472), in which case space should be 

inserted on both ends, unless it is followed by a punctuation mark. 

5.4. Sentence-Stop Marks 

There are four generally accepted sentence-stop marks, or “terminal punctuations” 

(Einsohn and Schwartz 2019, 94): the period, the ellipsis, the exclamation point, 

and the question mark. 

5.4.1. Period 

The period (or full stop, dot)110 is considered to be “the most powerful punctuation 

mark” (Bălan et al. 2003, 57), which is “irreducible” (Houston 2013, 121). 

A period is used to end a declarative sentence (sometimes even an imperative 

one), and there is no space before the period (Academia Română 2005, XLIII). 

Furthermore, it never accompanies an exclamation point or a question mark, 

which “take precedence over the period” as they are “stronger” (CMOS 2024, 433). 

A period comes before the closing quotation mark, parenthesis or square 

bracket of a full sentence (AMA 2020, 448), thus no further period is required after 

the quotation, parenthesis, or square bracket. 

On the other hand, in case an abbreviation ending in a period finishes the 

sentence (etc.), a further period is needed for the “sentence as a whole, outside the 

parentheses (CMOS 2024, 383). When the sentence’s last word ends in an 

apostrophe, the period follows it. 

Further uses of the period: 

1. figure legends and captions (AMA 2020, 448); 

2. initials in names; 

3. after Latin or Arabic numerals representing ordinal numbers; 

4. dates in various languages; certain languages, such as Romanian, need no 

space after the period between the day, month, and year (Academia 

 
110 While AmE uses period, BrE uses full stop. 
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Română 2005, XLIV), while others require space after the periods, such as 

Hungarian; 

5. decimal indicator (AMA 2020, 449), although in these cases we refer to it 

as a point. 

While there are regulations when to use periods in abbreviations, these seem 

to be only recommendations, as there are variations. For instance, it is suggested 

that Latin abbreviations (a.m., e.g., i.e., p.m., vs.) should use periods without 

spaces (Thomas 2021, 456), but we can see variants as well (am, AM, A.M.). On 

the other hand, abbreviations functioning as adjectives (U.S. Navy) need periods. 

Reference abbreviations (APA 2020, 154) also need a period (Vol., Fig., ed.), 

although it is suggested that p for page and pp for pages should take no period 

(Bringhurst 2004, 88). 

Era designations also need periods with no spaces (B.C.E., C.E., B.C., A.D.), 

and all references take a period at the end, except DOI numbers and URLs (APA 

2020, 154), knowing that period in a URL is referred to as dot. 

Abbreviations of various measurements need no period, except inch (in.), as 

it might be misread (APA 2020, 154). 

Abbreviated items may take a period in AmE (Dr., Mr., Mrs., St., Rd., Ct.), 

while these have no period in BrE (Dr, Mr, Mrs, St  Street, Rd  Road, Ct  

Court). Lack of full stop in BrE abbreviations signals that the word ends in the final 

letter, making the full stop unnecessary. Non-English languages may have other 

rules regarding abbreviations and periods. 

A succinct list specifies cases when no period is needed: 

1. titles, subtitles, chapter titles, subhead, heading, figure or table titles 

(AMA 2020, 448); 

2. datelines, signatures, addresses (CMOS 2024, 384); 

3. scientific and technical measurement abbreviations (cm, kg, min, ml, s); 

4. abbreviations functioning as nouns or geographical names (US, USS, 

USA); 

5. fully capitalized acronyms (NASA); 

6. academic degrees such as PhD, PsyD, EdD, MD, or MA (APA 2020, 154); 

7. letters referring to the cardinal points (E, W, N, S); 

8. in case a sentence ends with an abbreviation that requires a period (etc.). 

Non-English languages might have further rules regarding the use or omission 

of period. 

5.4.2. Ellipsis (2026) 

Ellipsis is a “sequence of (normally) three periods” destined to stand for 

“omissions in quotations and for hesitation or suspense” (Greenbaum 1996, 516). 

It may be termed as ellipsis dots, ellipsis points, ellipsis periods, suspension dots, 

or suspension periods, a row of three baseline dots (Bringhurst 2004, 82), 



146  ◼   Basics of Word Processing for Thesis Writing 

informally dot-dot-dot,111 or simply dots, and it is known to have at least three 

formats (detailed below). 

5.4.2.1. Creating an Ellipsis 

The standard text-editing ellipsis (…) is a single glyph, resembling three dots close 

together, although the space between them is increased compared to three 

consecutive periods. 

By default, this type of ellipsis is used in Word or Writer when three periods 

are typed in a row with the Autocorrect function on. This glyph may be obtained 

in multiple ways: 
- the Unicode value is U+2026; 

- the Windows Alt code is Alt+0133; 

- the macOS shortcut is Alt+; 

- the Word shortcut is Ctrl+Alt+.; 

- a further option is the decimal code: Alt+8230. 

The Associate Press (AP) format ellipsis (...) is also three periods in a row, but 

when typed, the automatic change to the glyph is cancelled with the help of the 

Ctrl+Z keyboard shortcut, thus switching back to three standard periods in a row. 

The CMOS format ellipsis (. . .) is similar to the Associated Press (AP) format, 

but there is a non-breaking space on both sides of the middle period. A further 

source112 even recommends the use of a special space between the periods (U+202F), 

which is the narrow non-break space, and it is around ¹⁄₆ or ¹⁄₅ em wide (. . .). 

A final possibility is the ellipsis suggested by two authoritative sources, which 

is three periods separated by spaces between them and on both ends (APA 2020, 

275; MLA 2021, 272). 

5.4.2.2. Ellipsis After Words and Sentence Start 

There are views that the ellipsis joins the previous text without space, and if it 

starts the sentence, no space should be used between the ellipsis and the following 

word, also stipulated by English sources: “it’s generally acceptable to include no 

spaces between the ellipsis and the words directly adjacent to it.”113 

However, we would like to reserve the option of no space between the text 

and ellipsis for the ellipsis within a word (e.g., due to decency, censorship, 

crossword puzzles, etc.), in which case we agree that it should not be separated by 

spaces from the remaining letters (t…er). Yet, it is known that censored words 

typically rely on other options than ellipsis, such as the asterisk, plus sign (instead 

of T) or figures instead of letters (5 instead of S, 1 instead of I, 0 instead of O). 

 
111 Cf. the movie Mamma Mia! (2008). 
112 https://tinyurl.com/44933v3t, August 20, 2022. 
113 https://examples.yourdictionary.com/ellipsis-examples.html, August 20, 2022. 

https://tinyurl.com/44933v3t
https://examples.yourdictionary.com/ellipsis-examples.html
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Similarly, no space is needed when each syllable of a longer word is emphasized 

(She is beau…ti…ful!!!). 

On the other hand, we tend to think that in case the ellipsis replaces a word, 

it should be separated by a space on both ends from other words, an idea supported 

by non-English sources as well (Academia Română 2005, LXXVIII). 

As for the ellipsis at the beginning of a sentence, Bringhurst mentions that it 

is separated from the previous sentence with a period, followed by a space (. …), 

although there are two possibilities to continue the ellipsis (Bringhurst 2004, 82–

83): with or without space (. …the snow or … the snow). In this case, we would 

opt for the second version, namely a space between the ellipsis and the following 

word. 

Ultimately, whatever ellipsis is favored, the same type should be used 

systematically “to indicate the omission of a word or a group of words” (Thomas 

2021, 456), or “that data are not available” (AMA 2020, 1131). Furthermore, 

Thomas also recommends the use of an entire line with spaced period, which 

might stand for the “omission of one or more paragraphs or sentences” (Thomas 

2021, 456). 

A final remark refers to omissions in verse, in which case one line of em-

spaced dots are recommended “to indicate omission of a full line or several 

consecutive lines of verse” (AMA 2020, 485). 

5.4.2.3. Ellipsis at the End of the Sentence 

Rules regarding sentence-end ellipsis are rather confounding, as they are 

contradictory, and the most controversial of them is whether a sentence-end 

period is needed or not. 

Depending on which prescription we favor, there are three possible variants, 

which is doubled in case space before ellipsis is also accounted for:114 

Table 13. Sentence-ends with ellipsis 

Type Variant 1 Variant 2 

Sentence-ends with an ellipsis: She is… She is … 

Sentence-ends with a period: She is…. She is …. 

Sentence-ends with a spaced period: She is… . She is … . 

 

According to Bringhurst, sentence-end ellipsis (Bringhurst 2004, 82–83) 

requires a period without a space between them (….), while another source 

explains that no period should be used after the ellipsis,115 an opinion supported 

 
114 https://www.grammar-monster.com/glossary/ellipsis.htm, August 20, 2022. 
115 https://communications.unu.edu/mues-punctuation, August 20, 2022. 

https://www.grammar-monster.com/glossary/ellipsis.htm
https://communications.unu.edu/mues-punctuation
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by many authors, which solves the issue of space or not between the ellipsis and 

the period. 

Yet, we tend to think that in cases when an ellipsis replaces a single word, we 

should consider the ellipsis as such, so a space on either side of the ellipsis is 

needed. If this ellipsis ends the sentence or clause, a sentence-end punctuation 

mark (period, question mark, exclamation point) or a comma, semicolon, colon, 

etc. should follow it without space (Keszler 2009). This solution is also supported 

by most AmE and scholarly BrE writing (Greenbaum 1996, 519), and the rationale 

is that this is how a single word is treated. 

As explained, “a sentence break within omitted material, … when a quotation 

includes the end of one sentence and the beginning” (APA 2020, 275) is also 

indicated by four periods, namely a period followed by an ellipsis. Yet, there are 

views (e.g., TED Talk subtitlers) that any punctuation sign might follow the ellipsis 

directly, except for a period, to omit a row of four points. Similarly, the 

“suspension points” stand for partially expressed thoughts with more than one 

missing word, in which case only the ellipsis might be used.116 

A number of sources agree that sentence-end ellipsis (with or without period) 

is followed by space before the next sentence starts. 

A special case is when an entire quoted sentence is left out (suspense, 

multiple-choice tests), in which case the quotation marks should contain only the 

ellipsis, which replaces the entire sentence, period included. 

5.4.2.4. Ellipsis and Quotations 

The use of ellipsis is more complicated when quotations are involved, especially 

the ones which also contain ellipsis. 

Manuals suggest that scholarly work should not start with an ellipsis, as 

quotation marks signal that only a fragment is reused. Furthermore, the end of the 

quoted material may (MLA 2021) or may not (CMOS 2024) contain ellipsis.117 

The combination of ellipsis with square brackets indicates the omission of a 

fragment within the quote as well (Keszler 2009). The APA style discourages the 

use of ellipsis at the beginning or end “of any quotation unless the original source 

includes an ellipsis” (APA 2020, 275). 

Ellipsis is not the only option to indicate omission. As explained (Einsohn 

and Schwartz 2019, 113), this may also be indicated by an apostrophe (dropped 

letters), a period (abbreviations), dashes (excision of portion of word), comma and 

semicolon (ellipsis within a parallel construction). 

 
116 https://publications.europa.eu/code/en/en-4100100en.htm, August 20, 2022. 
117 https://www.thepunctuationguide.com/ellipses.html, August 20, 2022. 

https://publications.europa.eu/code/en/en-4100100en.htm
https://www.thepunctuationguide.com/ellipses.html
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It is also important that in case the capitalization of first letter from the 

quotation is changed, this should be marked with square brackets: [A] or [a], which 

means that the original letter case was different.118 

5.4.2.5. Conclusions 

It is worth highlighting that the more divergent recommendations there are 

regarding the “proper” use of ellipsis, the more the prescription element 

disappears, and various publishing houses and authors feel free to use the ellipsis 

at their whim. A logical approach to ellipsis might start when we consider this 

sign as replacing a word (or even more), and treat it like that, which is why we 

suggest the use of ellipsis with space before and after, unless it is followed by a 

punctuation sign, and this version is also supported by major text-editing software 

as well. 

Yet, we can find sources following their internal rules, and—for instance—the 

National Geographic’s Life textbook series (Stephenson et al. 2019, 25) uses only 

three periods for the ellipsis, wherever it is situated in the sentence, always 

separated by spaces on both ends, including trailing punctuation signs (… ? or … .). 

The final word is given to Bringhurst, who considers that “acute accent, 

midpoint and ellipsis, are nowhere to be seen” (2004, 90), even if they add specific 

meanings to various text types. We think that the more texts people produce, the 

more aware they should be when and how to use various punctuation signs 

correctly, or at least consider the suggestions of automatic proofing, not to lead 

typographers and proofreaders to despair. 

5.4.3. Question Mark 

The question mark is a basic punctuation mark, and the US keyboard layout 

displays it on the key left to the right Shift. As the question mark is above the slash 

sign, Shift+/ results in a question mark. 

Interrogative questions typically end in a question mark (Are you happy?), but 

indirect questions (She asked how old I was.) take no question mark (Greenbaum 

1996, 521; AMA 2020, 450). A question mark may also be used to express 

“surprise, disbelief, or uncertainty at the end of a declarative or imperative 

sentence” (CMOS 2024, 412). 

There are so-called “declarative questions,” in which case the grammatical 

structure does not indicate a question, but they end in a question mark: Perhaps 

you enjoy this? You think he’s back? (Greenbaum 1996, 520). As these belong to 

spoken English, they are not to be used in formal writing. 

Polite requests may end in a period (Will you kindly attach it before the 

deadline.) or a question mark: Would you help me? The difference in the 

 
118 https://tinyurl.com/44933v3t, August 20, 2022. 

https://tinyurl.com/44933v3t
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punctuation mark is explained with the intended style, as “official and business 

letters” seem to be “politely framed” when a request ends in a period: Would you 

kindly telephone the above number to make an appointment. In the meanwhile, 

may I just confirm a few administrative details. (Greenbaum 1996, 516). 

In case quotations contain a question mark, this is placed inside the quotation, 

and in parenthetical material it also comes before a closing parenthesis or end 

bracket (AMA 2020, 450), but only if it belongs to the quoted part or parenthetical 

fragment (CMOS 2024, 413). 

Similarly to other sentence-end or clause-end punctuation marks, the 

question mark cannot be combined with a period, exclamation point, comma, 

colon or semicolon, and situations of this should be obviated. However, more than 

one question mark may refer to a question combined with confusion (informal), or 

it may seem impolite and too demanding. 

Yet, it may happen that the question mark is combined with an exclamation 

point when the title of a piece of writing ends in any of these two signs: 

 

I’m a fan of Would I lie to you?! 

Do you like The Isley Brothers’ Shout!? 

 

However, it is obvious that these pieces are quoted, and reformulating the 

sentences will solve the adjacent punctuation marks. 

5.4.4. Exclamation Point 

The exclamation point (AmE) or the exclamation mark (BrE) is accessible on a 

standard US keyboard layout via a keyboard combination (Shift+1), but other 

layouts relocate it elsewhere (for instance, Hungarian layout uses Shift+4). 

Both the exclamation point and the question mark have a dual purpose: to end 

a sentence and signal that it is exclamation or question, respectively (Greenbaum 

1996, 520). 

The exclamation point may be used to end an emotional, declarative (But I 

have seen him!), an imperative (Go there!), an optative (May you be happy!), or an 

exclamatory sentence (How wonderful!), but they also mark “an outcry or an 

emphatic or ironic comment” (CMOS 2024, 413) or “forceful utterance” 

(Greenbaum 1996, 521), often introduced by What …! or How…! 

Sentences in the form of a “direct question” may sound rhetorical, in which 

case an exclamation point is used (Whyever do you need that!). 

The use of the exclamation point is not recommended in scientific 

manuscripts, so it is predominantly used in “less formal articles,” and it should be 

positioned within “the quotation marks, parentheses, or brackets only when it is 

part of the quoted or parenthetical matter” (CMOS 2024, 414). However, it is also 

used in mathematical expressions, indicating a factorial (AMA 2020, 451). 
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Another source also recommends not to overuse them, and periods may often 

replace them unless “the sentence is intended to be read as undoubtedly 

exclamatory in tone” (Greenbaum 1996, 516), expressing surprise, shock, wish, 

curse, warning, alarm, or a vocative (Jack!). Interjections are often accompanied by 

the exclamation point: Oh no! (Greenbaum 1996, 522). 

It is strong enough not to be combined with other sentence-end or clause-end 

punctuation marks, such as period, question mark, comma, semicolon, or colon, 

although sometimes multiple exclamation points are used (mostly three) to 

express shock, surprise, admiration, screaming, for instance, in comic books. 

Otherwise, more than one exclamation point is frowned upon, and Terry Pratchett 

stated, “Multiple exclamation marks are a sure sign of a diseased mind.” 

5.4.5. Interrobang (‽ 203D) 

A final sentence-end option is the interrobang (‽), which is the combined question 

mark and exclamation point, invented by Martin K. Specter in 1962. It was 

intended to express surprise, doubt, or rhetorical questions (Houston 2013, 28), 

but as grammar did not start to use it and there was a “cultural resistance” (Einsohn 

and Schwartz 2019, 90), the interrobang was sent “to an early grave” (Houston 

2013, 35). 

Nevertheless, today it is part of the Unicode (U+203D), is sort of “a cult 

punctuation mark” (Houston 2013, 37), and is available in Microsoft’s Wingdings2 

characters or more popular font types (Lucida Sans Unicode, Arial Unicode MS, 

and Calibri).119 

While it is mostly informal, it is also used in chess, referring to a “dubious 

move, one that is questionable but possibly has merits.”120 

5.5. Pause Marks 

Pause marks typically do not end a thought, only indicate a temporary break, or 

they might introduce a new element. Comma is the most used of them,121 whereas 

semicolons and colons are not frequently used. 

5.5.1. Comma 

As explained, a comma is “the least forceful of the 3 marks” (AMA 2020, 451), 

causing the “smallest break in sentence structure” (CMOS 2024, 384), and it is 

often optional, especially when the introductory phrase is short. 

 
119 https://en.wikipedia.org/wiki/Interrobang, April 19, 2025. 
120 https://en.wikipedia.org/wiki/Chess_annotation_symbols#Evaluation_symbols, April 19, 2025. 
121 See (Greenbaum 1996, 514–15). 

https://en.wikipedia.org/wiki/Interrobang
https://en.wikipedia.org/wiki/Chess_annotation_symbols#Evaluation_symbols
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Being the most widely used punctuation mark (46.8% in American texts, 

41.9% in British texts), closely followed by the period, they can be typed directly 

by standard keyboard layouts. Commas are “versatile,” “flexible” and can both 

isolate and separate units (Greenbaum 1996, 529). Its major uses are presented in 

the following sections. 

5.5.1.1. Oxford Comma 

The Oxford comma (also known as serial or series comma) is used when three or 

more items are listed (ASA et al. 2024, 2–04), and the last item joins the previous 

ones with and or or, preceded by a comma (The most typical car colors are grey, 

white, and black.). Yet, when the elements of a list form a term, unit or entity, no 

comma is needed (AMA 2020, 453). 

The Oxford comma is “strongly” recommended (CMOS 2024, 386), as “it 

prevents ambiguity,” although the inclusion of an ampersand prevents the use of 

a comma (Taylor, Taylor & Smith sounds good.). 

5.5.1.2. Comma and Latin Abbreviations 

A rather frequent Latin abbreviation is etc., mostly ending a list. As this 

abbreviation literally means ‘and others of the same kind,’ ‘and so forth’ or ‘and 

the like,’ it should be preceded by a comma (CMOS 2024, 387), and if the context 

requires it, it may be followed by another comma. 

However, this term is not recommended in scientific reports (AMA 2020, 520), 

except “parentheses, notes, and tabular matter” (CMOS 2024, 387), and another 

source considers that etc. should not be followed by a period unless it ends the 

sentence (AMA 2020, 520). Non-English languages might not use a comma before 

etc., such as Romanian (EC-DGT-RO 2021, 9). 

The conclusion is that no definite answer may be given regarding the “proper” 

use of this abbreviation although the CMOS (2024) guideline seems to be 

supported by the majority of users.122 

A further Latin abbreviation should be treated as etc., namely et al. ‘and 

others,’ which is often seen in references with multiple authors. This means that 

in case at least two authors are specified, et al. should follow them with a comma, 

but et al. preceded by a single author takes no comma (CMOS 2024, 387). 

The Latin abbreviations e.g. (exempli gratia ‘for example’) and i.e. (id est ‘that 

is’) should be always followed by a comma (Froke et al. 2024, 73; 2024, 115; CMOS 

2024, 387), adding that they should be confined to parentheses and notes (CMOS 

2024, 404), and no Latin abbreviation should be italicized (CMOS 2024, 623) 

unless it is the matter of discussion. While other sources agree with the last 

 
122 https://jakubmarian.com/comma-before-and-after-etc/, August 20, 2022. 

https://jakubmarian.com/comma-before-and-after-etc/
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statement, there are views (AMA 2020, 454) that no period is needed between the 

letters (ie, eg). 

While the automatic spellchecker of Writers seems not to know these 

abbreviations, the Microsoft Word spellchecker warns us to add a comma after 

them. 

5.5.1.3. Commas and Clauses, Phrases, Adjectives 

There are many prescriptions regarding commas with clauses, and various 

sources (AMA 2020, 454–57; APA 2020, 155–56; CMOS 2024, 387–94) list the 

following ones: 

1. independent clauses joined by coordinating conjunctions (and, but, or, so, 

yet) need a comma before the conjunctions unless the clauses are very 

short; 

2. supplementary, parenthetical clauses, questions are preceded by a comma 

(e.g., therefore, moreover, on the other hand, of course, nevertheless, after 

all, consequently, however); 

3. dependent clauses preceding the main clause are separated by a comma; 

4. dependent clauses following a main clause need no comma; 

5. restrictive relative clauses introduced by that (or by who/whom/whose) 

take no comma; similarly, restrictive words or phrases offering essential 

or relevant information about the noun are used without commas (Jack’s 

volume First Kiss is launched in June.); on the other hand, which 

introduces a nonrestrictive clause (adding non-essential information), and 

it is preceded by a comma (AMA 2020, 428); 

6. quoted sentences, direct dialogues, conversations introduced by reporting 

verbs need a comma (He said, “I will marry you.”); 

7. titles followed by descriptive nouns (novel, poem, story, or work) need no 

comma; commas are only needed when it is nonrestrictive (the noun 

remains clearly identifiable); 

8. the end of parenthetic or bracketed information may take a comma only 

after the parenthesis or bracket; 

9. introductory phrases may be separated by a comma from the rest of the 

sentence (After having arrived home, she took a shower.); if they are 

appositive, both ends need a comma; 

10. an introductory yes, no, OK, well, and similar words, as well as the 

exclamatory oh and ah are followed by a comma or an exclamation mark; 

in cases when exclamatory words belong to a phrase, no comma is needed 

(Oh boy. Ah yes.); 

11. compound predicates are not separated by a comma (Jack went home and 

watched TV.); 
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12. appositive clauses are mostly nonrestrictive, so they do not provide 

essential information; thus, they are “flanked” by commas on both ends 

(AMA 2020, 425); however, when they are restrictive, no commas are 

needed (AMA 2020, 452); 

13. when adjectives are asyndetically coordinated, it is possible to separate 

them with commas and inserting coordinators between them, and their 

order may be reversed: She is a nice, happy person.; if there is no 

asyndetic coordination, no comma is needed: a whole new level 

(Greenbaum 1996, 533–34). 

5.5.1.4. Commas and Names 

Proper names followed by Jr., Sr., II, or III are not separated by a comma, but when 

family name comes first, commas flank the first name (Smith, John, Jr.). 

Nevertheless, sentences including these names need a comma to separate Jr. 

or Sr. from the name (Meet John Smith, Jr.). Interestingly, not all guidebooks 

require a period after Jr or Sr (AMA 2020, 455). 

Degrees and other titles need a comma when they are placed after the name 

(John Smith, MD; Jane Smith, PhD).  

When addressed directly, names or similar words (girls, class) are set off via 

a comma, and letter-start greetings end in a comma. 

5.5.1.5. Commas and Numbers 

There are various rules when numbers need commas. The majority of rules specify 

the correct use of reference numbers, large numbers, dates, and measurements. 

Reference numbers refer to quotations, in which case the comma is placed 

inside the quotation marks and “before superscript citation of references and 

footnote symbols” (AMA 2020, 456). 

Contradictory rules try to regulate the correct form of large numbers. A source 

specifies that numbers starting from 1,000 should be separated in groups of three 

digits starting from the right with commas (APA 2020, 181), while another manual 

states that 4-digit numbers should be “set closed up,” and a thin space (U+2009) 

must be used for 5-digit numbers and up to separate groups of three digits, “starting 

from the right-most integer” (AMA 2020, 962). Naturally, in the case of large 

decimal numbers, the group count starts from the decimal point (1 207 985.45). 

Separating groups in large numbers is also regulated by the SI convention, 

which addresses differences in national regulations regarding large numbers. 

As such, thin space is stipulated in the case of large numbers (AMA 2020, 

456). Furthermore, when large numbers may be adjacent to unrelated numbers 

(e.g., dates), a rewording might be necessary to prevent this vicinity (AMA 

2020, 456). 
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Full AmE dates (month-day-year) need a comma between the day and year 

(April 21, 2025), including the case when the day of the week is provided as well 

(Monday, April 21, 2025). When no day is provided (September 2025) or a holiday 

precedes the year (Christmas Day 2025), no comma is needed (APA 2020, 155–56). 

BrE dates (day-month-year) need no commas “to set off the year” (CMOS 2024, 

398). ISO stipulates the use of “from-largest-to-smallest” version, and the year-

month-day is hyphenated (2025-04-21), which causes no troubles when imported 

to spreadsheets and other applications (CMOS 2024, 607). 

Measurement parts need no comma between the components if they are “of 

the same dimension” (AMA 2020, 456): 2 years 8 months 25 days are in fact 1 000 

days. He is 6 ft 2 in. tall. I need 4 lb. 6 oz. of rice. 

Commas are often used in addresses, as they separate the “elements” (AMA 

2020, 455). Thus, a comma should be used after the number and street name, after 

the city and state or country name, and the US and Canadian zip or postal codes 

are not set off by a comma from the state or city name (CMOS 2024, 399): 12 Ashton 

Rd., Apt. 5, Albion, IA 50005. 

5.5.1.6. Commas and Specific Expressions 

Certain expressions, such as for example, namely, or that is, may be flanked by 

commas at both ends in the middle of the sentence, although the CMOS 

recommends a preceding em dash (or flanking em dashes), a semicolon, or a 

parenthetical solution (CMOS 2024, 404). 

The conjunction or may be used to offer a synonymous term for the original 

one, in which case a comma is recommended: Corn, or Zea mays, is widely 

available. These are referred to as enclosing commas (Greenbaum 1996, 542–45), 

and they might separate vocatives from the rest of the sentence (Come here, Jane.), 

tag questions from the introductory part, appositive sentences, verbless or non-

finite sentences from the main clause, comment clauses (To be frank, this is 

difficult.), sub-clauses preceding the main clauses. 

No comma is needed before too and either with the sense of ‘also,’ although 

in mid-sentence position it is easier to interpret them (CMOS 2024, 405); however, 

the manual (CMOS 2024, 407) also accepts that a separating comma between two 

identical words may also help understanding (Let us march in, in twos). While this 

might not function in all cases (I think about ‘about.’), they might clarify meanings: 

If he enjoys that, it is good for us. If he enjoys that it is good for us, thank him. 
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5.5.2. Semicolon 

The semicolon may communicate “stops, pauses, reflections,” as explained by 

Lloyd.123 The primary—and almost single—use of a semicolon is to separate two 

main clauses, being stronger than a comma but less forceful than a period. 

While it obviously has a shortcut (U+003B), it is directly available from the 

keyboard, although there are views that its use is fading, and it is near 

‘extinction.’124 

A magazine article quotes Kurt Vonnegut, whose first rule of creative writing 

is “Do not use semicolons. They are transvestite hermaphrodites representing 

absolutely nothing. All they do is show you’ve been to college” (Blatt 2017).125 Blatt 

also reveals that the use of semicolons dropped about 70% between 1800 and 2000, 

and there is a Pulitzer winner who used no semicolon whatsoever (Cormac 

McCarthy, The Road). George Orwell called semicolons “an unnecessary stop,” 

and Lloyd concludes that the symbol leads to an inevitable “extinction,” similar 

to the dodo or the dinosaur, and is mostly replaced by the dash.126 

Guidebooks suggest that the semicolon is used “between two independent 

clauses not joined by a conjunction” (CMOS 2024, 407–9) or when the two 

independent clauses are joined by conjunctive adverbs (also, besides, furthermore, 

hence, however, indeed, nevertheless, then, therefore, thus, yet) or even 

coordinating conjunctions (and, but, for, nor, or, yet, so) if one of the clauses is 

long or contains internal punctuation. 

Furthermore, items of a series also containing internal commas (Team 1, 5 

points; Team 2, 3 points; Team 3, 1 point) may be separated by semicolons to 

enhance interpretation (AMA 2020, 457; ASA et al. 2024, 2–04). Similarly, 

multiple parenthetical citations, index entries, or statistics already containing 

commas are accompanied by semicolons (APA 2020, 156). 

A university webpage contains a collection of articles on punctuation, 

including the semicolon.127 In this article, Trask (1997) explains that only one 

major use may be attributed to the semicolon provided that three conditions are 

met: 1. closely related sentence not to be separated by a period; 2. no conjunctions 

are used which require a comma; 3. no colon may be used. He mentions a further 

function of the semicolon, namely when it becomes a “super-comma.” This way it 

replaces a comma in a very long sentence with many clauses and commas, “where 

the reader can pause to catch his breath.” Yet, he suggests rewording in these cases. 

Interestingly, Trask quotes Dickens’ famous sentence (“It was the best of times; it 

was the worst of times.” A Tale of Two Cities), arguing for its powerful meaning 

 
123 https://unherd.com/newsroom/the-melancholy-decline-of-the-semicolon/, April 24, 2025. 
124 Id. 
125 https://tinyurl.com/yc5hu9me, April 24, 2025. 
126 https://unherd.com/newsroom/the-melancholy-decline-of-the-semicolon/, April 24, 2025. 
127 https://www.sussex.ac.uk/informatics/punctuation/colonandsemi/semi, April 24, 2025. 

https://unherd.com/newsroom/the-melancholy-decline-of-the-semicolon/
https://tinyurl.com/yc5hu9me
https://unherd.com/newsroom/the-melancholy-decline-of-the-semicolon/
https://www.sussex.ac.uk/informatics/punctuation/colonandsemi/semi
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due to the semicolon. Unfortunately, various editions of this work offer this 

opening sentence with a comma, and no semicolon is present in the rather lengthy 

opening with many opposing ideas of the 614 characters with spaces (Dickens 

1983, 1). 

Finally, while the semicolon seems to lose ground, a writing expert confesses 

that it is “a particularly elegant piece of punctuation and doesn’t deserve its fate,” 

as the “elegance of the semi-colon lies in its ability to both join and separate.”128 

Munteanu also considers that it is an “under-used tool,” offering famous quotes 

containing semicolons (e.g., “I think; therefore I am.”—Rene Descartes). However, 

when checking the online versions of this quote, the semicolon is nowhere to be 

found, and it is the comma that joins or separates the two parts. 

Still, to finish this section with widespread uses of the semicolon, we should 

mention spreadsheets (Excel and Calc), where dates are instantly inserted with the 

Ctrl+;, and the semicolon is also used (followed by a closing bracket) to create a 

winking face emoji, working in Word as well (😉). 

5.5.3. Colon 

The name of the colon is due to the fact that “it was often used to indicate a major 

medial pause, or disjunction of sense, at the end of a colon” (Parkes 1992, 302). 

While it can be typed directly on a standard keyboard, its Unicode value is 

U+003A. 

A rather simplistic summary of use is presented by Greenbaum, who states 

that a colon has three main functions: to introduce identifications, to introduce 

examples, and to introduce quotations or direct speech (Greenbaum 1996, 523). 

However, further cases need to be specified, starting with the case when a 

colon introduces a list or examples. Greenbaum admits that “punctuation usage 

varies for ends of items,” mentioning that questions must end in question marks, 

but other lines may end in periods, semicolons (which he considers to be “less 

common”) or even no punctuation at all (Greenbaum 1996, 526). 

Returning to the colon, it indicates a much stronger break in thought between 

two main clauses, compared to the comma or semicolon (AMA 2020, 458). It 

typically marks the beginning of an illustrating, extending, amplifying second 

clause (CMOS 2024, 409–12), and in case it is a complete sentence, it starts 

capitalized (APA 2020, 156–57). However, this is different in BrE, as the first letter 

is only capitalized if it is an acronym (NHS for National Health Service) or a proper 

name (Greenbaum 1996, 523). 

Titles in formal communication may end in a colon (To whom it may concern: 

or Dear Manager:). The CMOS also offers examples when the colon is used in ratios 

(a 13:2 ratio), subtitles following the main title (John Doe: The Truth Behind the 

 
128 Dena Bain Taylor, quoted by her former student: https://ninamunteanu.me/2021/02/28/the-semi-
colon-is-dead-long-live-the-semi-colon/, April 24, 2025. 

https://ninamunteanu.me/2021/02/28/the-semi-colon-is-dead-long-live-the-semi-colon/
https://ninamunteanu.me/2021/02/28/the-semi-colon-is-dead-long-live-the-semi-colon/


158  ◼   Basics of Word Processing for Thesis Writing 

Mystery),129 indexes (main heading, followed by a colon and the first subheading), 

URLs (after the https part), place and publishing house in references, or 

mathematical expressions (CMOS 2024, 409–11). 

It often introduces a list, an enumeration (which can never start capitalized), 

mostly “after anticipatory phrasing such as thus, as follows, the following,” or it 

may introduce a “formal or extended quotation” (AMA 2020, 458). 

While it is typically followed by a space, no space is needed when it indicates 

time, for instance 7:30, especially in AmE (Greenbaum 1996, 526), ratio (1:2) or in 

biblical references separating chapter and verse numbers: Exodus 1:2 (AMA 2020, 

459). However, another source inserts space after the colon in biblical references 

and uses hyphen to express a range: Genesis 11: 1-9, 2 Kings 10: 12-25 (Greenbaum 

1996, 526). 

Similarly, volume and page numbers (in which case the abbreviation vol. is 

omitted) are separated by a colon only, except when parenthetical information 

intervenes, in which case a space is needed after the colon: Critical Inquiry 1, no. 

3 (Winter 1975): 479–96. In case the page number follows an issue number, the 

colon is replaced by a comma (CMOS 2024, 886). 

Finally, it is common knowledge that a colon followed by a closing bracket 

stands for a smiling face (smiley), or it may actually turn into a smiley while typing 

(e.g., in Word or Facebook Messenger:      ). 

5.6. Brackets as Detour Marks 

There are at least four types of brackets (or fences) used in non-mathematical texts: 

parentheses, square brackets, braces, and angle brackets. While they are used in 

pairs, the components (an opening bracket and an ending bracket) have their own 

Unicode values, even if all of them may be typed on a standard keyboard (directly 

or with the help of Shift). 

5.6.1. Parentheses 

Parentheses (or round brackets, brackets in BrE) are stronger than a comma and 

similar to the dash, disrupting the continuity of a sentence (Greenbaum 1996, 538). 

They may be typed with the help of Shift+9 (opening parenthesis) and Shift+0 

(closing parenthesis), while their Unicode value is U+0028 and U+0029, 

respectively. 

They delimit grammatically independent texts from the rest of the sentence 

(AMA 2020, 474–77; APA 2020, 159; CMOS 2024, 422–23; Greenbaum 1996, 537–

40), and the parenthetic reference may signal the following:130 

 
129 A notable exception is when the title ends with other punctuation (AMA 2020, 458). 
130 https://www.thepunctuationguide.com/parentheses.html, April 24, 2025. 

https://www.thepunctuationguide.com/parentheses.html
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1. a cited work; 

2. other places in a text (p. 3, below, Chapter 5, cf. 6.2); 

3. a table, illustration, figure; 

4. enumeration, letters, and numbers in a list embedded in the main text, 

especially when subsequent reference is intended; 

5. notes, remarks; 

6. the abbreviated form or acronym of an extended term, which is always 

used in its full form, then followed by the abbreviated form in brackets, 

after which the abbreviated form may be used by itself; 

7.  supplementary explanation, such as conversion (pound to kilogram), 

synonyms, glosses of specific terms; 

8. translations from other languages; 

9. additional or clarifying information; 

10. afterthought; 

11. around the letters s or es after nouns to indicate the plural option—

“parenthetical plurals” (Einsohn and Schwartz 2019, 139)—yet the verb 

is singular: The name(s) of the translator(s) or the subtitler(s) is unknown.; 

12. various mathematical expressions, detailed in Section 5.6.3. 

The punctuation of the parentheses is also important. It is highlighted that no 

punctuation is accepted before the opening parenthesis, except in enumerations 

(AMA 2020, 475). A closing parenthesis cannot be “preceded by a comma, a 

semicolon, or a colon,” while “[a] question mark, an exclamation point, and closing 

quotation marks” may come before the closing parenthesis “if they belong to the 

parenthetical matter” (CMOS 2024, 423). In other cases, these marks come after the 

closing parenthesis. Parentheses within parentheses are only acceptable in 

publications in law, while the CMOS might accept brackets within parentheses. A 

period only comes before the closing parenthesis if it ends a full sentence (APA 2020, 

159), in which case the sentence starts with a capitalized word (AMA 2020, 475). 

As for the style of parentheses, they should be set in the same font as the 

“surrounding text” and “not in that of the material they enclose” (CMOS 2024, 

380), although there are views that they should be always Roman and never sloped, 

“even if the context is italic” (Bringhurst 2004, 85). Yet, a possible exception is 

when they refer to part of a title. 

As explained (APA 2020, 159), multiple parentheses should be avoided, 

which is why reference items are separated by commas (e.g., Smith, 2024, 

explains …). 

A final warning is that parentheses must not be replaced by the slash symbol 

unless they signal verse lines. 
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5.6.2. Square Brackets 

Square brackets (or box brackets, brackets) are directly available on a standard 

keyboard, and their Unicode values are U+005B (opening bracket) and U+005D 

(closing bracket). 

Their use seems to be rather regulated (AMA 2020, 477–86; APA 2020, 159–

60; CMOS 2024, 423–25; EC-DGT-RO 2021, 7): 

1. in a quoted text, the current author or editor may make insertions, 

explanations, clarifications, translations, comments, corrections (She 

[Jane] wanted to escape.); in case the brackets are part of the quoted text, 

it should be stated clearly, to avoid confusion (e.g., brackets in the 

original); 

2. in a quoted text, the first letter of the first word may be enclosed in 

brackets to signal that the original was the other way around; 

3. bracketed text might offer the original words in a translated work; 

4. brackets replace parentheses within parentheses (nested parentheses) in 

bibliographies; 

5. ellipsis in brackets […] might indicate a missing word or a fragment in a 

quoted text; 

6. the European Union (EU) documents might contain ellipsis in brackets 

not to reveal commercial secrets; 

7.  phonetic transcriptions may be bracketed, although slashes might also be 

used in this case; 

8. the term [sic], always italicized in Roman brackets,131 signals incorrect 

grammar, punctuation, or spelling in the quoted text. 

However, square brackets are recommended to be used sparingly not to 

distract the reader too much. 

5.6.3. Braces 

Braces (or curly brackets) are available on a standard keyboard with the help of 

the Shift key combined with the two brackets keys. Their Unicode values are 

U+007B (opening) and U+007D (closing). 

While parentheses and brackets are typically used in common and specialized 

texts alike, braces are rare, unless in programming languages132 or mathematical 

equations. Mathematics expresses the necessary aggregation by using parentheses 

first, then brackets, and finally braces in equations (APA 2020, 188; ASA et al. 

2024, 7–02; Laczkó and Mártonfi 2025, 311), and they are altogether referred to as 

‘fences.’ 

 
131 The Latin abbreviation comes from sic erat scriptum, meaning ‘Thus it was written.’ 
132 For instance, square brackets are used for arrays or to create empty matrices, as explained here: 
https://www.mathworks.com/help/matlab/ref/squarebrackets.html, April 25, 2025. 

https://www.mathworks.com/help/matlab/ref/squarebrackets.html
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Advanced level in text editing also relies on fences. For instance, after 

pressing the Ctrl+H shortcut (triggering the Find and Replace window) in Word, 

we can type ([0‑9]{4}*) in the Find what: line, which finds all the 4-digit numbers; 

the <[A‑Z]{2,}> shortcut finds all the strings of at least two consecutive capital 

letters. As for Writer, this is possible by typing ([A‑Z]{2,}) in the search line in case 

the Use wildcards box is checked. 

5.6.4. Angle Brackets («, 00AB; », 00BB) 

Angle brackets (or chevrons) are not used in regular texts, unless the text is in a 

language that uses them for quotations (such as French; see 5.9.3., guillemets). 

They are available on a standard keyboard with the help of the Shift key combined 

with the comma (opening) and period (closing) keys, and their Unicode values are 

U+003C and U+003E. 

They are typically doubled, taking the form of << and >>, although there are 

different symbols for the doubled versions: « (U+00AB) and » (U+00BB). However, 

angle brackets used in mathematics have different symbols: ⟨ (U+27E8) and ⟩ 

(U+27E9), and there are pointing and dotted versions as well.133 

As known, in mathematics they refer to values “less than” (<) and “greater 

than” (>), often used in spreadsheet formulas as well. They also “enclose tags in 

XML and related markup languages,” might “set off URLs and email addresses,” 

or can “indicate missing or illegible material” (CMOS 2024, 425). 

While the CMOS discourages the use of angle brackets “in prose,” they find 

their spot in comic strips, movie and play scripts, online communication apps or 

data fields to be completed (the «TIME» show on «DATE»).134 

Manuals offer tables of signs with their Unicode values, split into various 

categories, often starting with mathematical symbols. A selection is provided 

below (Laczkó and Mártonfi 2025, 405)—see Figure 81. 

The relative importance of these punctuation marks may be deduced from 

Greenbaum’s summary (Greenbaum 1996, 514–15) regarding their frequency: 

commas (46.8%), periods 45%, dashes (2.2%), pairs of parentheses (1.9%), 

semicolons (1.9%), question marks (1%), colons (0.9%), and exclamation marks 

(0.3%). The data refer to an American corpus, but data from a British corpus reveal 

similar results. 

 
133 https://en.wikipedia.org/wiki/Bracket_(mathematics), April 25, 2025. 
134 https://www.grammar-monster.com/punctuation/using_brackets_parentheses.htm, April 25, 2025. 

https://en.wikipedia.org/wiki/Bracket_(mathematics)
https://www.grammar-monster.com/punctuation/using_brackets_parentheses.htm
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Figure 81. Mathematical symbols in Laczkó and Mártonfi (2025) 

5.7. Further Detour Marks 

5.7.1. Slash and Division Slash (∕, 2215) 

The slash has many alternative names: forward slash (AMA), shill (APA), shilling 

mark, slant, solidus, stroke, or virgule. However, the forward slash is directly 

available on a standard keyboard (/), while a more sloping slash is used for 

fractions, which should be the solidus: 

 

Figure 82. Slash and solidus 

The difference between them is visible when placed next to each other: / ⁄. 

The first one is the slash (U+002F or Alt+47), while the latter is the fraction sign 

(U+2044). 

The slash is automatically converted into the fraction sign when common 

fractions are typed in various text-editing software (½ or ¾), not to mention that 

there is a non-breakable division slash  (U+2215) as well, which looks exactly like 
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the fraction sign; algebraic expressions use the division slash (a∕b), while skewed 

fractions (¼) need the fraction slash, although when placed next to each other, the 

two signs look identical: ∕ ⁄. 

Before listing the uses of slash, it is important to mention the huge number of 

debates whether to use space before or after it. Lenient rules consider that the space 

may be optional on both ends of the slash, but there are very explicit rules stating 

that no blank space must be used either before or after the slash (Academia Română 

2005, XXXIX), which is obvious in the case of fractions,135 as they should never be 

broken at the end of the line. When a line break is needed, this comes after the 

slash, “never before” (CMOS 2024, 428), and no single character should be left 

after the slash to the next line. 

A single word versus a phrase or open compounds is “more legible” (CMOS 

2024, 426) if separated by a spaced slash (World War I / First World War), but when 

only two words are divided, there should be no space either before or after the slash.  

As for poetry, the slash indicates line divisions, and in this case space on both 

ends of the slash must be used. 

Our personal remark is that in case many slashes are used to refer to multiple 

options or when the slash divides two long words and the space is limited (e.g., 

tables or cells), a space after the slash can solve the displeasing view of alternating 

very long and very short lines. 

After discussing the issue of space before and after the slash, we should 

mention the cases when the slash is actually used. Bringhurst explains that the 

steeper slash is in fact “an alternative form of the comma” (Bringhurst 2004, 81), 

and these are the most common uses: 

1. offering or separating alternatives, meaning ‘and,’ ‘or,’ ‘if,’ ‘when’ 

expressing a connection or conflict between the two parts (AMA 2020, 

1114; Thomas 2021, 464), which is slightly “informal” (CMOS 2024, 426): 

Latino/a, He/she can do that with/without help. 

2. the alternative of a comma or parenthesis in texts providing further 

details, such as Tibetan Guest House / Thamel / Kathmandu (Bringhurst 

2004, 82); 

3. clarifying a comparison in a compound adjective, “especially when one 

of the elements is a hyphenated compound” (APA 2020, 160): hits/false-

alarms comparison; 

4. to represent per with abbreviated units of measure, when at least one 

element provides numbers (100 km/h, $100/day, 10 mg/d); however, in 

case a preposition is included, no slash is used: 5 g of sugar per kg (AMA 

2020, 473); 

 
135 https://www.cochrane.org/authors/handbooks-and-manuals/style-manual, August 14, 2025. 

https://www.cochrane.org/authors/handbooks-and-manuals/style-manual
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5. having the role of division, it may replace the division sign (÷);136 as such, 

ratios may be expressed with the help of the slash (ASA et al. 2024, 2–07), 

more precisely the numerator and the denominator (5/9) in fractions 

(AMA 2020, 472); however, a single glyph is recommended (CMOS 2024, 

427) when it is available (¾); 

6. forming dates, mostly used in tables and figures: full dates providing the 

month, day, and year (04/04/2025),137 two-year spans (2024/25, or 

completed with an en dash as well: 2023/24–2024/25); however, formal 

writing should be clearer (April 4, 2025); 

7. citations containing two different years typically start with the year of the 

original publication, and—depending on the context—may include the 

year of republication, translation: 2014/2024; 

8. abbreviations may also rely on the slash “in lieu of periods” (CMOS 2024, 

426): a/c (air-conditioning), c/o (in care of), n/a (not applicable), or w/o 

(without); 

9. URLs also make use of slashes, typically after the https and the colon, but 

further slashes may be included as well; long links should be left to be 

broken automatically at line-ends; 

10. poetry, song, or play lines embedded in texts are separated with the help 

of slashes, in which case a space placed on each side of a slash used to 

show line breaks (CMOS 2024, 427); in these cases, a comma may be used 

after the slash; 

11. pronounced letters (sounds), phonemes, and phonemic transcriptions are 

separated by slashes (AMA 2020, 478; CMOS 2024, 427): The letter /e/ 

may be silent. 

To sum up, while there are controversial recommendations regarding the 

space before and after the slash, clear-cut recommendations might help their 

justified and correct use in texts, involving dual variants (‘and/or’), dates, 

fractions, certain abbreviations, links, quoted lines, and transcriptions. 

5.7.2. Backslash (\, 0020) 

The use of backslash seems to be rather limited, compared to the forward slash. 

Nevertheless, it can be typed directly on a standard keyboard, and its Unicode 

value is U+0020. 

 
136 https://unicode-characters.fandom.com/wiki/Solidus, April 25, 2025. 
137 While the American date system uses the month-day-year style, the British version is day-month-
year. Other languages may have different ones, which is why the ISO standard date format may be used 
in international communication: year-month-day. Yet, imported spreadsheets created in various 
language settings may have issues recognizing various date formats. The actual date may be inserted in 

the open spreadsheet file based on the current language setting with the Ctrl+; shortcut. Set to AmE, 

this shortcut will insert the date, placing slashes between the current month and day and between the 
day and the year, without spaces. 

https://unicode-characters.fandom.com/wiki/Solidus
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It may be used by certain operating systems (CMOS 2024, 427) to refer to exact 

file locations. In this case, backslashes separate directories, sub-directories, and 

filenames. As there are no spaces adjacent to the slashes, long addresses should be 

broken automatically at line-ends. 

Computer coding also relies on backslash, and this is where the backslash 

signals a highly advanced level of mastering texts, as text-editing software may 

also need the backslash for special purposes. As it is used as an “escape 

character,”138 once a backslash is typed, the following character will have a 

different interpretation. For example, \n represents a new line character, \t a tab 

character (this is valid for both Word and Writer). In case the Regular expressions 

box is checked in Writer, \d+ finds all the digits in the document, or \(.*\) will 

find all the characters in brackets. 

5.7.3. Rare Detour Marks (|, 00C7; ‖, 2016; ·, 00B7; •, 2022) 

There are a few less frequently used detour marks as well. We have in mind the 

bar, the double bar, the pipe, and the midpoint. 

The vertical bar (or vertical line,139 pipe) is typically found on a standard 

keyboard on top of the backslash key (Shift+\), and its Unicode value is U+007C. 

It is used in mathematics (e.g., conditional probability, distance, divisibility), 

chemistry (cell notation), often accompanied by the double bar (‖, U+2016). The 

vertical bar is mostly referred to as pipe in computing. The double vertical bar is 

also used in music, where—accompanied by a colon—it marks the repetition of a 

particular section (‖: That’s right. :‖). As for linguistics, the vertical bar is used to 

“separate main elements of a clause, for example: subject, verb phrase and object” 

(Leech 2006, vi) while parsing: Subject | Verb | Object. 

Finally, a midpoint (or small bullet, mid dot, interpunct, interpoint, centered 

dot) is considered to be “one of the simplest, most effective forms of typographic 

punctuation” (Bringhurst 2004, 75), and the Unicode table refers to it as mid dot 

(U+00B7), but Alt+250 also results in the same glyph. The midpoint may start lists, 

letterheads, and signage. However, as it might look too small, there is a thicker 

midpoint, or thick mid dot (U+2022 or Alt+149) for this purpose. 

While the midpoint was once used in Classical Latin, today it may replace a 

hyphen, as it is shorter when signaling word-split options in dictionaries,140 or it 

may stand for the multiplication sign in mathematics (2 · 3 = 6). It is worth 

noticing that all spaces between the characters are non-breaking spaces or thin 

spaces, as stipulated in the case of mathematical operations, considering that signs 

function “as quasi verbs” (Einsohn and Schwartz 2019, 207). 

 
138 https://tinyurl.com/hedpk868, April 26, 2025. 
139 However, the term vertical line (U+02C8) should be reserved for the apostrophe-like glyph, marking 
the stress in syllables, discussed in Section 5.8.3. below. 
140 https://en.wikipedia.org/wiki/Interpunct, April 26, 2025. 

https://tinyurl.com/hedpk868
https://en.wikipedia.org/wiki/Interpunct
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5.8. Other Marks 

A few other marks help interpreting the text better or offer convenient 

abbreviations. Some of them are regularly used (e.g., the apostrophe), while others 

are rather rare (e.g., the per thousand glyph). 

5.8.1. Apostrophe (', 0027; ’, 2019) 

The proper use of apostrophe should start with the differentiation between the 

default apostrophe of text-editing software (') and the ‘smart’ apostrophe (’). While 

the former is not typographically accepted (U+0027), the latter (U+2019) is 

strongly supported by both Word and Writer, even if it is in fact the right single 

quotation mark sign. 

The previously mentioned two text-editing software convert the typed default 

apostrophe into the ‘smart’ one by default. In the case of Word, this may be 

checked here: File, Options, Proofing, Autocorrect Options, AutoFormat as You 

Type, Replace as You Type, and the box before "Straight quotes" with “smart 

quotes” should be checked. 

 

Figure 83. Autocorrect straight quotes with smart quotes, Word 

After the use of curly apostrophe is checked, a few cases are specified when the 

apostrophe is needed, as they apply to words or numbers (Greenbaum 1996, 505): 
- replacing missing letters: in fact, this case leads us to the essence of con-

traction, which is a type of abbreviation; in this case, two words are 
melted into one, and the omitted letter (he’s) or letters (can’t, we’ve, 
’cause) are signaled by the apostrophe (Parkes 1992, 302), a possibility 
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which is frowned upon is formal writing (AMA 2020, 433); the right single 
quotation mark is needed in case the missing letters would start the word: 
Find ’em or I love rock ’n’ roll. (CMOS 2024, 429); 

- replacing missing numerals (the ’80s), in which case the apostrophe is still 
a right single quotation mark (CMOS 2024, 429); 

- indicating the possessive case of English nouns (AMA 2020, 482–84) or 
referring to possessive adjectives related to units of time or monetary 
terms: an hour’s wait, a dollar’s bill, knowing that plural cases end in s, 
followed by the apostrophe (a few days’ rest); if the plural form does not 
end in s, ’s is needed: our brethren’s wish; 

- as explained (Greenbaum 1996, 550–51), there are alternatives with 
proper nouns ending in s: Dickens’s story or Dickens’ story, but Moses’ 
deed, Jesus’ help (as they already have two s letters), Socrates’ death 
(Greek names of at least two syllables ending in s); 

- the genitive form of pronouns is without an apostrophe: its walls, ours, 
yours, theirs; 

- indicating the plural form of special expressions may need an apostrophe; 
these may be words that do not normally have plural forms (a reminder of 
do’s and don’ts, extra and’s in a sentence) or letters and numbers, in 
which case only the letters, numbers, or signs are set in italics: Mind your 
p’s and q’s. There are two +’s here. The l’s are like 1’s. Two B’s are needed. 

The plural form of years (the 1980s), numbers (These cars are 4 × 4s.), or fully 

capitalized acronyms (IVs)141 take no apostrophe (Bringhurst 2004, 87). Yet, the 

same author mentions inconsistent expressions: the ayes have it but the I’s don’t; 

the ewes are coming but the you’s are staying home (Bringhurst 2004, 88). 

According to the Chicago style (CMOS 2024, 429), in case the word ends in 

an apostrophe, the period or comma comes after the apostrophe: The cat is the 

Joneses’. 

5.8.2. Various Primes (′ 2032; ″ 2033) 

The prime looks like the apostrophe (′), yet they are not interchangeable, and 

manuals warn against using improper symbols (AMA 2020, 484). Prime (′ U+2032) 

and apostrophe (’ U+2019) are different both in form and use although both may 

be inserted from the Symbols or the Character Map as well. 

The prime is used to express feet, minutes, or arcminutes, while the double 

prime (″, U+2033) refers to inches, seconds, or arcseconds, respectively (EC-DGT-

RO 2021, 192; CMOS 2024, 599). Thus, a degree or angle (1°) equals 60′ or 3 600″, 

while a person may be 6′3″ tall. 

Computer encodings also use reversed prime (‵, U+2035), reversed double 

prime (‶, U+2036), or modifier letter prime (ʹ, U+02B9). As reversed primes are not 

used in standard texts, we only highlight modifier letter prime, which is also used 

 
141 Short for intravenous. 
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in linguistics to indicate stress. Nevertheless, the next section refers to another 

glyph for that purpose,142 and there is a modifier letter double prime (ʺ, U+2BA), 

which is also beyond our interest. 

5.8.3. Modifier Letters (ˈ, 02C8; ˌ, 02CC) 

The modifier letter or vertical line (ˈ, U+02C8) is considered to be the sign of a 

stressed syllable (CMOS 2024, 427), which corresponds to the International 

Phonetic Alphabet (IPA) sign. 

This glyph indicates the primary stress,143 while the Unicode value U+02CC 

indicates a secondary stress (ˌ), as in the pronunciation guide of information: 

/ˌɪnfəˈmeɪʃᵊn/. 

However, we have already discussed a vertical bar or line (|, U+007C) in 

Section 5.7.3. 

5.8.4. Degree (°, 00B0), ℃ (2103), ℉ (2109) 

The degree sign is not directly available from the standard keyboard, but its 

Unicode value is U+00B0, and it has two Alt codes: Alt+248 and Alt+0176. 

As it is mostly used to indicate temperature, the degree Celsius or degree 

Fahrenheit signs have separate glyphs: ℃ (U+2103) and ℉ (U+2109). However, the 

International System of Units (SI) uses the Kelvin scale (kelvin, K) to refer to 

thermodynamic temperature, which needs no degree sign (ASA et al. 2024, 7–06), 

as the “degrees Kelvin” was abolished in 1967. It is also important not to confuse 

the degree sign with the superscript zero (ASA et al. 2024, 7–06): 0 ℃ and 100 rely 

on different glyphs. 

Angular arc also uses the degree sign: 30°, 45°, 60°, 90°, to mention the most 

common ones, and in these cases the sign directly follows the number. When 

minutes and seconds are added, space or non-breaking spaces are needed between 

the sexagesimal degree subdivisions: 30° 15′ 15″ (SI style), also supported in other 

languages as well (EC-DGT-RO 2021, 192; Laczkó and Mártonfi 2025, 313); 

nevertheless, this rule is controversial, and the Chicago style uses no spaces 

between them (CMOS 2024, 637). Further details are found in Section 5.14.5.4. 

Photography denotes logarithmic film speed grades with the degree sign as 

well: 21° DIN, 5° ASA, or ISO 100/21°.144 

A final thing to mention is the correct spelling of the degree sign. It is generally 

recommended that a space should be placed between the number and the following 

degree symbol when it expresses temperature, but publishing houses often leave out 

the space: 0℃ (CMOS 2024, 599), specified later as well (CMOS 2024, 631). 

 
142 https://en.wikipedia.org/wiki/Prime_(symbol), April 26, 2025. 
143 https://www.thefreedictionary.com/Word-Stress.htm, April 26, 2025. 
144 https://en.wikipedia.org/wiki/Film_speed, April 26, 2025. 

https://en.wikipedia.org/wiki/Prime_(symbol)
https://www.thefreedictionary.com/Word-Stress.htm
https://en.wikipedia.org/wiki/Film_speed
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5.8.5. Percent 

The adverb percent (meaning by the hundred or in, to, or for every hundred) and 

its accompanying sign (%) is used with Arabic numerals, but mostly in non-

technical texts (CMOS 2024, 599). The noun percentage is “a more general term 

for any number or amount that can be stated as a percent” (AMA 2020, 971). This 

means that percentage is used when no number is attached to it (a small percentage 

of a community). 

The percent is available on standard US keyboards (Shift+5), its Unicode value 

is U+0025, and it may be inserted from the Character Map as well. Similarly to the 

degree sign, the SI style adds a space between the number and the % sign, while 

major guidebooks (CMOS or AMA) join the numbers and the percent sign: 3%. 

In case a range is specified, both numbers are accompanied by the sign: 3%–

10% (APA 2020, 187; CMOS 2024, 599). The same source explains that the percent 

symbol is only used when accompanied by a numeral, and space limits make it 

necessary, such as table headings or figure labels. 

When the number and percent start the sentence, they are spelled out (Five 

percent of the people …), although rewording might be better, so as not to start 

with percentages, especially when ranges are involved (AMA 2020, 972). 

5.8.6. Per Thousand, Per Mille (‰, 2030) 

The per thousand (or per mille) sign (‰) is rarely used, except for mineralogy and 

oceanography references, expressing “isotope ratios relative to a standard and is 

dimensionless” (ASA et al. 2024, 7–09). 

The Unicode value for the symbol is U+2030. 

5.8.7. Hashtag 

The usage of the hashtag (or crosshatch, hash sign, numeral sign, octothorpe, 

pound sign) is “something of a problem child” (Houston 2013, 41), as it is used 

heavily, and its meaning depends on the particular context, earning the nickname 

“a jack-of-all-trades,” also reflected in its less formal nicknames: crunch, flash, 

grid, hex, pig-pen, square, or tic-tac-toe (Houston 2013, 47). 

It is available on standard keyboards (Shift+3), and its Unicode value is 

U+0023, while Alt+35 will also result in a hashtag. Its primary use is to replace 

the word number when a number follows (#2), although style guides suggest that 

number should be spelled out, and when the space is limited, the correct 

abbreviation is No. (with a full stop), and it also has an abbreviation for the plural 

numbers (Nos.).145 

 
145 https://docs.microsoft.com/en-us/style-guide/a-z-word-list-term-collections/n/number-sign, April 
27, 2025. 

https://docs.microsoft.com/en-us/style-guide/a-z-word-list-term-collections/n/number-sign


170  ◼   Basics of Word Processing for Thesis Writing 

As Houston explains, a further use is to refer to weight: 5# means “five pounds 

in weight” (Houston 2013, 41), but in chess it may stand for checkmate (Houston 

2013, 47). Furthermore, it may be used as a sharp symbol substitute in music 

(which should be ♯, available as a Unicode value: U+266F); proofreaders also use 

it to mark various mistakes in a text (e.g., missing spaces), while computer 

programmers rely on it to signal that what follows the hashtag in the line does not 

belong to the code, it is only a comment, and three hashtags in a row (###) mark 

“the end of a press release” (Houston 2013, 47). 

X (formerly Twitter) and Tumblr abound in hashtags to signal cross-references 

of content by topic, but virtually it is a favorite symbol of the social media, where 

keywords headed by a hashtag trigger huge social movements (#BLM, 2013; 

#jesuischarlie, 2015, or #MeToo, 2017). 

While manuals and guidebooks do not offer too much coverage on the hashtag, 

it is recommended to capitalize either the first word or every single word in a 

combination of words (#ThisIsTheEnd). Nevertheless, its use is rather 

discouraged, as it is “frequently too large for anything more interesting than chain-

store propaganda” (Bringhurst 2004, 77). 

5.8.8. Boxes, Check Marks, and Crosses 

While boxes, ticks, and crosses may not belong to standard text symbols, they are 

needed to create various questionnaires or multiple-choice tests. Occasionally, 

ticks and crosses may signal a list of do’s and don’ts. 

As they are not directly available on standard keyboards, they might be 

inserted either looking for them among the Wingdings font characters ( or ) or 

searching for their Unicode values. Some of them are listed below, knowing that 

once the shortcut is applied, the font will change to Segoe UI Symbol: 

Table 14. Ballot, check, tick box, mark, cross 

Description Symbol Unicode Alt 

ballot/check/tick box ☐ 2610 9744 

ballot box with check ☑ 2611 9745 

ballot box with X ☒ 2612 9746 

check mark ✓ 2713 10003 

thick check mark ✔ 2714 10004 

cross ✕ 2715 10005 

thick cross ✖ 2716 10006 

ballot box with check ☐ 2610 9744 
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5.9. Quotations 

The primary use of quotation marks is to signal that the words are “taken verbatim 

from another source” (AMA 2020, 479), including direct speech as well 

(Greenbaum 1996, 545). 

There are various types to quote someone’s words (direct or indirect speech) 

or writings (scientific statements): single quotation marks, double quotation marks, 

guillemets, and inverted commas. Quotations stand out of the general text style 

with the help of these marks, be they exact words of someone, technical words, 

slang, explanation, metaphorical meaning, or simply “words we want to draw 

attention on [sic]” (Bălan et al. 1996, 64). 

Their importance is also marked by the fact that Word can insert them either 

directly (Apostrophe key or Shift+Apostrophe key) or via Insert, Symbol and 

Special Characters, as illustrated below: 

 

Figure 84. Inserting quotes, Word 

As discussed before (see Apostrophe, 5.8.1.), modern word processors are 

automatically set to “smart” quotation marks instead of the straight ones (also 

known as neutral, vertical, typewriter, or dumb quotes). Once smart quotes are 

enabled, on pressing the double stroke key, the left (opening) quotation mark is 

displayed, and pressing it again at the end of a word, the right (closing) quotation 

mark will be shown. Smart quotes are also called typographic, curved, or curly 

quotation marks (CMOS 2024, 428). 

It is also important to mention that while English uses both quotation marks 

raised, other languages may start with a baseline opening quotation mark (e.g., 
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German, Romanian, or Hungarian: „…”) or even angle brackets or guillemets (e.g., 

Spanish or French: «…»). 

However, smart quotation marks may be disabled by accessing File, Options, 

Proofing, AutoCorrect Options and choosing the AutoCorrect dialog box, 

AutoFormat As You Type tab, Replace as you type and clearing the "Straight 

quotes" with “smart quotes” check box.146 

5.9.1. Double Quotation Marks 

While the double quotation marks are available from the keyboard (Shift+Double 

stroke key), they may be typed with Unicode values as well: U+201C (left) and 

U+201D (right). 

As explained, using straight double quotes (", U+0022) is a clear sign of 

amateurism (Spiekermann 2013, 115), and professionals always use smart quotes, 

which look like two commas, resembling 99). 

As for the proper use of double quotation marks, the following cases should 

be mentioned: 

1. when quoting someone’s words, in which case the exact “wording, 

spelling, and punctuation of the original” must be followed (AMA 2020, 

479), including the indication of omissions or italics; however, there are 

acceptable exceptions, such as the first letter of the first word, which 

might be changed, depending on the context, and signaled with the help 

of square brackets; the single quotation marks might turn double or the 

other way round; final punctuation marks of the quoted material might be 

changed if the meaning is preserved, while “footnote or endnote number 

callouts can be omitted” (APA 2020, 274–75); 

2. titles of various large publications (including albums) are mostly 

italicized, while smaller works (poems, chapters, articles) are mentioned 

in quotation marks; 

3. however, when titles or subtitles are required in quotation marks, these 

are double (AMA 2020, 18); 

4. specific words or phrases may be highlighted either with the help of 

quotation marks or italicized; 

5. metaphorical meanings, ironical remarks (meaning the opposite), coined 

words, slang, unfamiliar terms, nicknames may be rendered on their first 

use with the help of quotation marks, which are known as “apologetic” or 

“scare quotes,” not recommended in scientific writing (AMA 2020, 480–

81; CMOS 2024, 464): John Smith is a “rare” name in England.; 

 
146 https://tinyurl.com/3n7we75n, April 27, 2025. 

https://tinyurl.com/3n7we75n
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6. foreign words given in the original language are typically italicized, while 

their English explanation may be offered in brackets or between quotation 

marks; 

7. when a single word is highlighted as the word itself is under discussion 

(linguistic examples), the use of double quotation marks is suggested: the 

use of “I” versus “me” (APA 2020, 157; CMOS 2024, 464); however, these 

may be simply italicized in a Roman (normal) environment; 

8. direct quotes replicate the exact words of the speaker: John said: “You are 

right.”; 

9. when the reported sentence ends in a period, it is replaced by a comma in 

case it is followed by the reporting clause: “I am happy,” she said. 

(Greenbaum 1996, 546); sentence-end question marks or exclamation 

points remain: “Are you happy?” she asked.; 

10. quotations in block quotations require double quotation marks (APA 

2020, 277); 

11. file names, words, or strings of characters (CMOS 2024, 473) may also 

appear in quotes (Find “Insert,” then look for “index.html” and type “cd 

Desktop”), but non-prominent computer terms may follow the software’s 

use (Layout, Page, etc.). 

A further important remark is that run-in quotations are short ones (words, 

phrases, or no longer than two lines) and are embedded in the main text, matching 

in font and style, being differentiated from the main text only with the help of the 

quotation marks (CMOS 2024, 380). When the quoted material contains 

whatsoever mistakes, a bracketed [sic] is used. 

Quotations longer than two lines (some guidebooks recommend even more) 

should be separated from the main text, and they are referred to as block quotes, 

formatted with different font, different line spacing, or a wider margin, but they 

typically take no quotation marks. In fact, extra lead should be added “before and 

after block quotations” (Bringhurst 2004, 40), more precisely “9 pt lead before and 

after the quotation, and the text will realign” (Bringhurst 2004, 41). 

Block quotations are introduced by a colon, and in case a quotation is 

embedded in the block quotation, double quotation marks should be used (AMA 

2020, 482). 

Other cases when no quotation marks are needed: highlighting a key term or 

phrase which is under discussion (italics are recommended), numerals (APA 2020, 

158–59) or interview or discussion formats with set off speakers’ names: Joe: Who 

is happy? 

A further issue is the position of quotation marks when combined with certain 

punctuation marks. AmE prefers commas and periods within the quotation marks, 

which means that no double period or comma is needed (ASA et al. 2024, 2–04). 

However, these punctuation marks come after the closing quotation mark in BrE, 
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and this latter style is used in Romanian (EC-DGT-RO 2021, 9) and Hungarian as 

well (Laczkó and Mártonfi 2025, 353). 

Other punctuation marks (e.g., colons, semicolons, ellipses, asterisks, or 

superscripted footnote numbers) are typically outside the closing quotation marks. 

Question marks and exclamation points may be either within or outside the 

closing quotation mark, depending whether they are part of the quote or not. 

Interrupted quotations contain words not included in the quotation (AMA 2020, 

480): “I’m happy,” she confessed, “but we can’t be together.” However, in case the 

“medial reporting clause” splits two full direct speech sentences, the original 

punctuation marks are preserved and the reporting clause ends in a period: “Is she 

happy?” he asked. “Will she forgive me?” (Greenbaum 1996, 546). 

A final case is the quote within a quote, in which case single quotation marks 

are needed for the internal quote in English: Donkey said “Shrek is reading 

‘Christmas Preparations’ on the outhouse.” Non-English languages often use other 

punctuation marks for internal quotes, such as guillemets (Ármeán 2017, 38), to 

be discussed later (see 5.9.3.). 

5.9.2. Single Quotation Marks 

Single quotation marks (‘…’), or single inverted commas, are directly available 

from the standard keyboard (double stroke key), and their Unicode value is 

U+2018 (left) and U+2019 (right), the latter being identical with the apostrophe 

(see 5.8.1.). 

Single quotation marks (‘…’) are used to signal quotations within quotations 

in AmE (AMA 2020, 480), and a source specifies that this should be “fewer than 

40 words” (APA 2020, 277). However, BrE uses single quotes first and embedded 

quotes are double (Bringhurst 2004, 86), or at least this is the more “common” 

usage (Thomas 2021, 460). 

A further possible use is to replace parentheses for translations, when the 

foreign terms are italicized and the English rendition follows it in single quotation 

marks. As explained, headlines of newspaper articles may also use single 

quotations marks in AmE.147 

As for the punctuation, these are positioned “outside of the single-quote 

marks” (ASA et al. 2024, 3–05), and proofreading includes a very thorough check 

of apostrophes, single and double quotation marks to be smart or curly, and never 

straight, involving a lot of “eyeballing” (Einsohn and Schwartz 2019, 136). 

 
147 https://www.grammarly.com/blog/quotation-marks/, April 27, 2025. 

https://www.grammarly.com/blog/quotation-marks/
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5.9.3. Guillemets 

Guillemets (or angle quotes, chevrons, duck-foot quotation marks) are widely used 

for quotes (e.g., France, Spain, Italy, Hungary), and there are even two variants 

(Bringhurst 2004, 86): 

1. French, Italian, and Romanian typography (EC-DGT-RO 2021, 9) use 

“points out” types («…»); 

2. German and Hungarian typography (Laczkó and Mártonfi 2025, 352) use 

“points in” versions (»…«). 

Punctuation marks are either inside or outside the guillemets, depending on 

whether they belong or not to the quotation (Bringhurst 2004, 87). Further uses are 

presented as angle brackets discussed in Section 5.6.4. 

5.10. Mathematical Operations and Relations 

Basic mathematical operations and relations might be used in general texts as well, 

and professional text writers should never substitute any sign with a more 

convenient one, unless this is explicitly permitted (e.g., slash sign instead of the 

division slash or fraction sign in certain cases). 

Table 15 below—based on the (CMOS 2024, 664–65)—contains basic 

mathematical signs of general use, accompanied by their Unicode values as well. 

As these signs are to be interpreted as words, such as conjunctions or verbs (CMOS 

2024, 431), they are flanked by a non-breaking space on both sides,148 similarly to 

a sequence of words (APA 2020, 188), exceptions to which are presented below 

the table. 

Table 15. Mathematical operations and relations 

Sign Name Unicode Remarks For 

+ Plus (addition) 002B Shift+= operation 

− Minus (subtraction) 2212  operation 

± Plus-or-minus 00B1  operation 

× Multiplication149 00D7 Alt+0215 operation 

÷ Division 00F7  operation 

∕ Division slash, fraction, solidus 2215  operation 

∩ Intersection 2229  operation 

∪ Union 222A  operation 

= Equals 003D = key relation 

 
148 Still, there are views that only a thin space is needed to set off these operations and relations (AMA 
2020, 931). 
149 The Alt code works only with the NumPad. See https://www.pickupbrain.com/ms-word/

multiplication-symbol/, April 28, 2025. 

https://www.pickupbrain.com/ms-word/multiplication-symbol/
https://www.pickupbrain.com/ms-word/multiplication-symbol/
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Sign Name Unicode Remarks For 

≠ Unequal, Not equal to 2260  relation 

≈ Almost equal to 2248  relation 

≡ Identical to, congruent to 2261  relation 

> Greater than 003E Shift+. relation 

≥ Greater than or equal to 2265  relation 

< Less than 003C Shift+, relation 

≤ Less than or equal to 2264  relation 

∼ Tilde, similar to150 223C  relation 

⸦ Subset of 2282  relation 

⸧ Superset of 2283  relation 

∈ Element of 2208  relation 

∉ Not an element of 2209  relation 

√ Radical, square root 221A  other 

 

Although only a space is visible between the elements, all of them should be 

non-breaking spaces: 3 + 4 = 7. However, when a negative number is involved, 

there is no space between the negative sign and the number: −3 × −2 = 6. 

Certain signs accept no spaces before and after them such as the fraction sign, 

the square root sign, subscript or superscript letters and numbers, or signs 

“modifying a number or symbol”: −5, 73 (CMOS 2024, 432). The fraction sign may 

also be used to refer to standard abbreviations as well: ℀ (account of, U+2100), ℁ 

(addressed to the subject, U+2101), ℅ (care of, U+2105). The simple square root (√) 

suffices for a single item, while the professional version of more complex 

operations needs the extended root, which is available in Word via Insert, 

Equation: (√𝑏 − 4𝑎𝑐). 

Table ranges (number, age) involving comparisons with mathematical signs 

(<, >, ≤, ≥) do not need a space either: ≤50 (CMOS 2024, 176). 

Furthermore, mathematical variables (single letters) “are generally italicized” 

(CMOS 2024, 468): a + c = f, while both numerals and signs are set in Roman, 

except for advanced mathematical symbols, which are typically bold such as F for 

force, a for acceleration (CMOS 2024, 469). 

Notable warnings regarding the replacement of mathematical signs with 

similar ones are collected below: 

1. the minus sign (−, U+2212) should not be replaced by the en dash (–, 

U+2013); 

 
150 Tilde is different from a swung dash (~, U+007E), as the latter “indicates a relation between 
alternative forms of the same basic word or pattern” (Leech 2006, vi): boy ~ boys. Yet, hardly any 
difference is visible between them, unless they are next to each other: ~ ∼ (the first one is a swung dash, 

available on a standard keyboard, Shift+Grave key, which is below the Esc key). 
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2. slashes may replace fraction signs if no single glyph is found for a 

particular fraction; for instance, the Times New Roman font contains a 

series of fractions of single glyph (⅐, ⅑, ⅒, ⅓, ⅔, ⅕, ⅖, ⅗, ⅘, ⅙, ⅚, ⅛, ⅜, 

⅞), in which cases no substitution is accepted; however, 6/5 with a slash 

is acceptable, while non-English languages might use the colon to refer to 

division; 

3. small or capital letters (x or X) or the asterisk sign (*) should not replace 

the multiplication sign (×); 

4. when multiplication is involved or dimensions are given, the proper sign 

should be used: My fish tank size is 60 × 30 × 30, in which cases either 

non-breaking spaces are recommended or thin spaces may be used; 

5. the same symbol is needed to refer to areas, volumes, matrixes, or 

magnification (×10), in which case there is no space between the sign and 

the number (AMA 2020, 931); 

6. the ≥ and ≤ signs should not be replaced by >= or =<, unless they are 

spreadsheet logical operators; 

7. midline horizontal dots (⋯, U+22EF) or elided ellipsis (CMOS 2024, 765) 

should not be replaced with baseline ellipsis (…, U+2026); 

As for the layout of mathematical expressions, they may be broken at line-

ends before the signs (CMOS 2024, 457) or “another clear logical pause” 

(Bringhurst 2004, 43). A rather firm rule is that these signs should never start a 

sentence (CMOS 2024, 667). 

Finally, the correct order of mathematical parentheses should be remembered 

so as to make the “equation visually unambiguous” (APA 2020, 188), and also to 

obtain the correct result, we might add: {[()]}. 

5.11. Pictograms 

The majority of pictograms are rarely used, except for the asterisk. Nevertheless, 

they might have very special meanings or may adorn various texts. 

5.11.1. Asterisk, Dagger (†, 2020), and Double Dagger (‡, 2021) 

The asterisk is a pictogram available on standard keyboards (Shift+8), or it has a 

dedicated key on the NumPad. Its shortcuts are U+002A and Alt+42. 

It may be used for emphasis, in which case the highlighted word is between 

asterisks (*joy*), and in this case it corresponds to the boldface (CMOS 2024, 461). 

Expletives or swear words may be disguised with the help of one or more 

asterisks (CMOS 2024, 421). 

Footnotes may be marked with pictograms; if there is only one footnote on the 

page, this may be introduced by an asterisk (CMOS 2024, 788), followed by further 

footnotes. Nevertheless, the sequence of footnote symbols is only familiar to 
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typographers: dagger (†, U+2020), double dagger (‡, U+2021), section sign (§, 

U+00A7), double vertical line (‖, U+2016), and finally the paragraph mark (¶, 

U+00B6), as explained earlier (Bringhurst 2004, 68–69). The CMOS recommends 

doubling or tripling the first three pictograms if more than three footnotes are 

needed: ** †† ‡‡ (CMOS 2024, 800–801). 

Legal-style citations (CMOS 2024, 938–39) referring to an electronic database 

signal the page number with “at” (@), followed by space, asterisk, and the page 

number (Oral Surgeons, 2021 U.S. App. LEXIS 19775, at *4.) 

Significance levels or probability notes in tables may be marked with asterisks 

(*, **, ***) after the numbers and in the Note section below the table (CMOS 2024, 

174–75). While this practice is supported by other sources as well (APA 2020, 204), 

there are views that instead of asterisks exact P values should be provided (AMA 

2020, 129). 

An asterisk positioned before a linguistic example indicates that “the example 

is unacceptable as a piece of English” (Leech 2006, vi). Other sciences also make 

use of the asterisk (e.g., medicine, indicating metastable states, alleles, and genes 

with the help of asterisks), but this is beyond our scope. However, Houston 

observes correctly that the asterisk seen by the majority of people might be 

associated with some special footnotes, namely the “small print,” scaring the 

readers away from some unfavorable conditions (Houston 2013, 114). 

When a set of three asterisks occupies an entire line, they signal a break 

“stronger than a paragraph but not as strong as a subhead,” so they produce an 

ornamental or typographic break (CMOS 2024, 35). 

The choice of an asterisk or dagger may be a matter of life and death, as the 

asterisk preceding a date reveals the birth of a person (*2006), while a dagger 

followed by a year indicates the year of death (Houston 2013, 97). 

Daggers are rare views in printed materials, as they mostly introduce the 

second or fifth footnotes, as specified above. However, while the dagger before a 

year (†2019) indicates the year of death of a person, there used to be another way 

to indicate a person’s death before their article was published, namely in the 

byline, right after the author’s name. Today, this practice “has been discontinued” 

(AMA 2020, 26), but this may be specified in the Acknowledgement section, under 

the heading Additional Information. 

The single use of the double dagger in typography is to indicate the third or 

the sixth footnote on a page. 

5.11.2. Further Symbols, Greek Letters, and Special Typefaces  

Font typefaces designed for writing contain the basic characters, while others 

contain more ornamented fonts as well, including emoticons, pictograms, 

ideographs, logograms, and icons. In this respect, it is worth checking the 

Character Map of each font typeface, especially the following ones: 
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1. Arial Unicode MS (not among readily available font families);151 

2. Segoe UI Symbol; 

3. HoloLens MDL2 Assets (for newer glyphs); 

4. Webdings; 

5. Wingdings. 

It is known that the Times New Roman font typeface contains many 

characters, but the above-mentioned ones contain further ones as well. Accessing 

the Character Map enables us to select very special symbols (glyphs), whose 

Unicode value is also displayed. For instance, the No smoking sign (🚭) is available 

in Webdings (character code: 0x7a), but changing the font to Webdings, no sign is 

displayed, as various codes may have no signs attached in different typefaces or 

have different ones. For instance, the No smoking sign in Webdings turns to “z” if 

the typeface is changed to Times New Roman. It is also available in Unicode 

(1F6AD), but the pictogram is colored:      . 

Symbols for specific purposes might enhance the visibility of any text, for 

instance when designing workbooks on language: 

Table 16. Possible workbook symbols 

Activity Symbol Unicode 

Read 📄 1F4C4 

Listen 🔈 1F508 

Listen 👂 1F442 

Speak 🗢 1F5E2 

Write 🖎 1F58E 

 

Works using Greek letters should use their Unicode values. Greek letters 

should be set in Roman, not italics, and their size might be adjusted to the 

surrounding text (CMOS 2024, 723). Some of them are listed below: 

Table 17. Greek letters 

Name Character Unicode Alt 

Greek small letter alpha α 03B1 
224 

945 

Greek small letter beta β 03B2 
225 

946 

Greek capital letter delta Δ 0394 916 

Greek capital letter omega Ω 03A9 234 

 
151 https://online-fonts.com/fonts/arial-unicode-ms, (Microsoft), February 7, 2025. Freely available 
through the Linux Software Manager. 

https://online-fonts.com/fonts/arial-unicode-ms
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Name Character Unicode Alt 

937 

Greek capital letter sigma Σ 03A3 
228 

931 

Greek capital letter phi Φ 03A6 934 

Greek small letter phi φ 03C6 966 

Greek capital letter psi Ψ 03A8 936 

Greek small letter psi ψ 03C8 968 

Greek small letter mu (micro) µ 00B5 

230 

0181 

956 

Greek small letter pi π 03C0 
227 

960 

 

Various shapes or arrows may also be useful such as the black hexagon (⬢, 

U+2B22), the black down-pointing triangle (▼, U+25BC), the black right-pointing 

pointer (►, 25BA), the rightwards arrow (→, U+2192), the leftwards arrow (←, 

U+2190), the upwards arrow (↑, U+2191), the downwards arrow (↓, U+2193), or 

the up-down arrow (↕, U+2195). 

Various publications may use thousands of so-called dingbats152 inserted in 

texts or page border areas for ornamental purposes, and the Wingdings font family 

might be among the most appreciated ones, covering contacts, time, 

communication, warning, technical, work, history, religion, zodiac, music, chess, 

cards, animals, vehicles, or even weather. 

The Webdings font family, emojis and emoticons153 only come to extend this 

vast library of non-alphabetic symbols, while hundreds of flags (religious, 

political, movements)154 may cheer up the reader. Although these symbols might 

be far away from scientific texts, some of them are available in the Times New 

Roman font family as well, they may be found in word processing software 

(typically by accessing Insert and Symbol), and modern articles published online 

often rely on newly available icons. 

Let us finish this section with our favorite, which is the Hololens MDL2 Assets 

typeface, available in both Word155 and Writer, as it is part of Windows 10 and later 

versions of the OS. Although it may be downloaded for Linux or macOS, it is 

designed by Microsoft Corporation, so its signs and symbols might not be 

 
152 https://www.monotype.com/resources/expertise/dive-dingbats-part-1, April 29, 2025. 
153 https://www.monotype.com/resources/expertise/dive-dingbats-part-2, April 29, 2025. 
154 Further details on inserting flags may be found here: https://www.alt-codes.net/flags, or here: 
https://commons.wikimedia.org/wiki/Category:Emoji_One_v1, April 29, 2025. 
155 https://learn.microsoft.com/en-us/typography/font-list/hololens-mdl2-assets, April 29, 2025. 

https://www.monotype.com/resources/expertise/dive-dingbats-part-1
https://www.monotype.com/resources/expertise/dive-dingbats-part-2
https://www.alt-codes.net/flags
https://commons.wikimedia.org/wiki/Category:Emoji_One_v1
https://learn.microsoft.com/en-us/typography/font-list/hololens-mdl2-assets
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displayed correctly on other operating systems. What we particularly appreciate 

in this typeface is that it provides many new technical icons: 

 

                      

 

                  

5.12. Spelling 

It is beyond the reach of the present book to delve into the details of spelling. 

However, the suggestions and recommendations presented so far might offer an 

insight into the correct way of using letters, numbers, and further signs and 

symbols to create a visually appealing and linguistically correct text. 

Details on spelling are available in printed and online guidebooks, but part of 

the rules might change over time and are language-dependent (e.g., AmE or BrE). 

While ample explanations may be found upon the correct uses of hyphen 

(Greenbaum 1996, 551–55), the reader also has to consider whether these rules are 

still valid three decades later and compare them to a newer source (CMOS 2024, 

474–91). 

We tend to think that the combination of automatic spell checker will help in 

the majority of cases, with notable exceptions such as proper names, rare terms, 

foreign words, or atomic typos. 

The atomic typo is labelled as a “typographical error in a published work, 

such as a misspelling or missing letter” (AMA 2020, 1146), but it is important to 

add that these are otherwise meaningful words that do not fit in the context (e.g., 

from instead of form), and there is even a shortlist of the most mistyped words.156 

It is of utmost importance to set the proofing language of word processors, and 

it should be checked whether the language pack for the desired language is 

installed. Windows provides this information in Settings, Time and Language, 

Language, and the Preferred Languages part displays abc with a check below the 

letters in fortunate cases: 

 

Figure 85. Proofing language installed 

The next step is to check if this is also the case within Word and Writer after 

the document is opened. Word offers this information either by accessing Review, 

Language, Set Proofing Language, which displays a window showing the used 

languages with or without the same icon, or this may be also checked by double 

 
156 https://centrediting.com.au/2013/03/23/atomic-typo-yes-thats-really-a-thing/, April 29, 2025. 

https://centrediting.com.au/2013/03/23/atomic-typo-yes-thats-really-a-thing/
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clicking on the displayed language at the bottom toolbar, which triggers the same 

window: 

 

Figure 86. Proofing language for current document 

As Figure 86 shows, in our case the proofing language is English (United 

States), and the icon preceding the language signals that the dictionaries for the 

selected language are installed. To be on the safe side, the installed language may 

be checked by accessing File, Option, Language, and see whether the proofing 

language is installed or not: 

 

Figure 87. Installed proofing languages, Word 

Further spelling options are available by accessing File, Options, Proofing, 

including Grammar Settings: 
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Figure 88. Grammar settings, Word 

Writer offers this feature via Tools, Language, For Selection, More, and a click 

in the Language options will display the selected language, showing an ab with a 

green tick below in case the dictionaries are installed: 

 

Figure 89. Language for Selection, Writer 
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Figure 90. Installed languages, Writer 

Similarly, this may be accessed by a single click on the language name on the 

Bottom Toolbar, then clicking on More. 

A wavy red line below the word might indicate a spelling mistake, a 

typographic error, while two parallel blue lines below the word might indicate a 

grammar (Figure 91) or formatting issue (Figure 92): 

 

Figure 91. Spelling Issues, Word 

 

Figure 92. Grammar issues, Word 

Writer seems to have different options. By accessing Tools, Options, 

Languages and Locales, Writing Aids will offer Available Language Modules, User-

Defined Dictionaries and Options such as Check spelling as you type or Check 

grammar as you type. More than that, there is a separate Sentence Checking 

possibility for the installed languages. In the case of English, these are the options: 
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Figure 93. Options, English sentence checking, Writer 

While Writer underlines misspelled words with a red wavy line, other types 

of (grammatical) errors are underlined with one wavy blue line (e.g., double space 

or missing capitalization). AutoCorrect Options in the Tools tab, then Autocorrect 

may offer further refinements with Replace, Exceptions, Localized Options, or 

Word Completion. 

However, it is important to highlight that these two word processor 

applications will find different mistakes and offer suggestions based on different 

dictionaries: Word uses its own spell checker, while LO, Mozilla Firefox, and 

Thunderbird use the freely available Hunspell157 as their primary spellchecker. As 

such, it is worth checking a text with both spellcheckers. 

Spelling and grammar should be associated with style and proper register as 

well, detailed in the next section. 

5.13. Text Style and Word Choice 

Text style may imply the proper selection of words, making a clear difference between 

formal words versus informal ones, but we should consider abbreviations as well. 

Language exam difficulty implies both grammar and vocabulary, and the latter 

is obvious in the writing part, where candidates must pay attention to using a formal 

register while drafting an essay, knowing that no abbreviations are to be used. 

Formal texts tend to be straightforward, and they should contain commonly 

known terms and phrases depending on the topic and the target readers. This also 

entails the avoidance of the following types of words and phrases: 

 
157 https://hunspell.github.io/, August 14, 2025. 

https://hunspell.github.io/
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1. slang (e.g., cash), which is a “very informal kind of vocabulary, used 

mostly in speech by people who know each other well” (Swan 2005, 526); 

2. idioms, which are expressions whose words result in a new meaning, 

specific to a language (e.g., bite the dust); 

3. colloquialisms, which are terms understood only in specific geographical 

areas (ain’t), although these “informal expressions” are used in “everyday 

speech and writing” (APA 2020, 116); 

4. phrasal verbs, in which the combination of the verb with a particle or 

preposition results in a new meaning (e.g., take up “start”); 

5. jargon, which should not be overused as is “specialized terminology,” and 

is “the opposite of clarity” (Froke et al. 2024, 36), understood only by 

experts in the specific field; by far, “[b]ureaucratic jargon has had the 

greatest publicity,” and writers should “define on first use any specialized 

terms” that are relevant to the topic (APA 2020, 116); 

6. euphemisms, which are “indirect terms used to express something 

unpleasant” (AMA 2020, 440) in a more positive way; scientific writing 

prefers “directness”; 

7. clichés, about which the AP Stylebook considers that are the “junk food 

of the literary pantry, much loved by lazy writers” (Froke et al. 2024, 36), 

illustrated by crystal clear or first and foremost; 

8. taboo and swearwords, which are never to be used in formal writing 

unless it is the case of study. 

Particular attention must be paid to the use of we. The editorial we may be 

used by writers, but in scientific writing the use of “passive voice construction” is 

preferred, “which is less direct,” unless “writers are describing their work or their 

observations” (AMA 2020, 426–27). 

It is part of the style to use consistent grammar, linking words expressing 

transitions, contrast, addition, comparison, or signaling summaries (AMA 2020, 

1135), and authors should “[a]void beginning more than two consecutive lines 

with the same word” (Bringhurst 2004, 43). 

The visual appearance is more appealing if long paragraphs may be broken 

with the help of paragraphs, subtitles, headings, tables, illustrations, footnotes, 

lists, or quotes, knowing that English uses no first-line hanging indent. 

5.14. Abbreviations 

5.14.1. Topicality of Abbreviations 

Abbreviations may be discussed under various headings (e.g., pronunciation, 

spelling, or capitalization), but—based on earlier studies on the topic (Imre 2022a–

b)—they also belong to text style, given that recent (mostly medical journals) ban 

their use in scientific papers (to be discussed in the following). 
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Abbreviation is an “umbrella term” (Imre 2022a, 379), which includes any 

string of characters shorter than the original word of phrase, so acronym, 

initialism, truncation, alphabetism, single- and multi-word shortening, clipping, 

contraction, blend, and their combinations are all varieties of abbreviation. 

Discussing them is indispensable, as their use has reached staggering scales, 

although corpuses still underrate their frequency (Izura and Playfoot 2012, 869). 

Studies warn about “a proliferation of initialisms” (Bloom 2000, 3), and “the 

proportion of acronyms in titles increased from 0.7 per 100 words in 1950 to 2.4 

per 100 words in 2019,” while “the proportion of acronyms in abstracts also 

increased, from 0.4 per 100 words in 1956 to 4.1 per 100 words in 2019” (Barnett 

and Doubleday 2020, 1). As for their presence in dictionaries, Cannon estimated 

decades ago that “the number of initialisms in numerous languages worldwide has 

exploded from tens of thousands to perhaps 800,000 recorded in dictionaries, 

besides those that are still unrecorded” (Cannon 1989, 104–5). There are various 

reasons for this phenomenon, as “they accelerate communication” (Panajotu 2010, 

160), and scholars also think that “human languages are very prone to the creation 

of acronyms” (Sánchez and Isern 2011, 311), as their graphic image captures the 

attention by their shorter form or full uppercase letters, and today they are “part 

of our everyday vocabulary” (Izura and Playfoot 2012, 862). 

Moreover, they have become even more widespread in scientific writing, as a 

“need for a more efficient vocabulary in … medicine, politics, law, and 

commerce… advances in computer science and technology” (Mattiello 2013, 64). 

While authors need to “conform to space limitations” (Soyer 2018, 589) or “save 

time and space” (Ribes et al. 2009, 269), today the popularity of certain initialisms 

(e.g., US ← the United States of America; MIT ← the Massachusetts Institute of 

Technology) has long “superseded the full forms” (Cannon 1989, 103), becoming 

“highly familiar to the language user” (Izura and Playfoot 2012, 862) or “often used 

without our knowing what the letters stand for” (Quirk et al. 1972, 1582). 

Nevertheless, scholars are less enthusiastic about their popularity, often wording 

their dissatisfaction. 

Negative approaches to abbreviations typically mention that their frequent 

use in “scientific communication” is “mostly unnecessary,” as they can be 

alienating, ostracizing (Hales et al. 2017, 22), or difficult to read (Thomas 2021, 

467). A further aggravation is that a single initialism might refer to hundreds of 

terms. For instance, CCC may have nearly 500 extended definitions, ranging from 

military terms to pop culture (Imre 2022a, 379).158 As a result, abbreviations were 

soon labeled as “confusing and imprecise” (Baue 2002, 489), and some 

abbreviations are unknown even among experts (Dróth 2008, 24–25), turning 

scientific texts “unpleasant and even more difficult” (Soyer 2018, 589), leading to 

the conclusion that an editor compares them to an “epidemic,” publishing his 

 
158 https://www.acronymfinder.com/CCC.html, April 22, 2022. 

https://www.acronymfinder.com/CCC.html
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editorial entitled Zero tolerance for acronyms (Begg 2017, 561). While we consider 

that it is untenable not to use any abbreviation, it is worth discussing types of 

abbreviations stemming from various definitions and their possible uses. 

Whatever the case, the created abbreviations, acronyms, or initialisms are 

considered as the “most peripheral to word formation” (Carter and McCarthy 2006, 

482), labeling them as a sort of “nonword with meaning” (Izura and Playfoot 2011, 

864), which resemble “irregular” words (Laszlo and Federmeier 2007, 1161) 

characterized by “iconographic independence” (Alonso 2008, 16). Authors are 

often discouraged to create new abbreviations, but in case they still do that, the 

newly created string of characters should be definitely different from the familiar 

or highly used ones such as the units of measure. 

5.14.2. Forming Abbreviations 

A dictionary definition of abbreviation states that it is perceived as “a reduced form” 

or “a shortened form of a word, phrase, or symbol” (Trumble and Stevenson 2002, 

3), and other sources also mention “a shortened form of a word or a group of words” 

(Thomas 2021, 467), or simply “a shortened form of a term” (Soyer 2018, 589). 

While the majority of scholars do not make a clear distinction between one-

word and multi-word shortenings—resulting in ambiguous definitions—a 

thorough analysis seems to indicate that it is worth discussing separate origins of 

these words, which partially solves the issue of overlapping terms. A similar 

distinction is also found in Mattiello (2013, 72), although no clear-cut categories 

exist, as detailed in the following. 

The left column of the table below contains all the available processes that 

shorten a single word, while the right column labels ways to shorten phrases or 

multiple words: 

Table 18. Ways to shorten single- and multiple words 

Single-word abbreviations Multiple-word abbreviations 

- shortening (abbreviation) 
- clipping 
- truncation 
- single-word contraction 
- hybrid 

- acronym 
- initialism 
- alphabetism 
- blend 
- multiple-word contraction 
- hybrid 

 

The extreme abbreviation of a single word is in fact the shortening of the original 

(full, expanded) word to a single letter (e.g., p. ← page), but typically more letters are 
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preserved. A source considers that shortenings never “include the last letter of a 

word.”159 However, shortenings may be labeled differently, as explained below. 

In case more initial letters are preserved, this may be referred to as truncation 

(e.g., teach ← teacher), during which the final part is deleted. However, according 

to Mattiello (2013, 72), truncation is only a type of clipping, which may be defined 

as a procedure during which the middle or end part of the initial word is preserved 

(e.g., flu ← influenza, burger ← hamburger). 

Terms such as Dr. (← Doctor) or Prof. (← Professor) are always “expanded in 

pronunciation,” so they should be labelled as “graphic shortenings” (Mattiello 

2013, 13). Yet, as the final part is deleted in Prof., the word is in fact truncated, 

while Dr.160 is considered to be a “conventional abbreviation” (López Rúa 2004, 

115), and even if they appear in writing in their shortened form, they are 

pronounced as a full word (Deme 1955, 399). Still, informal speech might accept 

the shortened version (e.g., Prof.). 

The term contraction is applied to cases when the first and last letters of a 

word are preserved (Thomas 2021, 409), so the previously exemplified Dr. falls 

into this category, together with Mr. (← Mister), but contractions preserving middle 

letters might also belong here (km ← kilometer; Bld. ← boulevard). 

Hybrid cases might combine the previously mentioned abbreviation methods: 

Dem (← Democrat) or Jan (← January) may be pronounced either in their expanded 

or unexpanded form, so they are “clipping and graphic abbreviations” (Mattiello 

2013, 72); or there are cases when the shortened form disregards the original letters 

(lb ← pound) or mix uppercase and lowercase letters (kWh ← kilowatt-hour). 

To sum up, as there are various approaches to shortened words, these terms 

might be confusing, so the term abbreviation seems to cover all these terms in 

everyday use. 

However, abbreviations deriving from phrases and multiple words should be 

discussed separately, as they are referred to as acronyms, initialisms, sometimes 

alphabetisms or contractions of two words, knowing that the term acronym “has 

remained maddeningly ill-defined for its entire existence” (Zimmer 2010)—

actually ever since it “was coined” (López Rúa 2004, 110). This is partially due to 

the imprecise definitions formulated in dictionaries and mainstream grammar 

books, which mix the terms. 

The majority of scholars agree that a prototypical acronym derives from a 

multi-word sequence (e.g., the name of the institution) and the initial capital letter 

of each word forms the newly created word, which is still pronounceable as a word 

(Barnett and Doubleday 2020, 4; HaCohen-Kerner et al. 2013, 2133; Hales et al. 

2017, 22), exemplified by RAM (← Random Access Memory). However, hybrid 

terms exist, such as JPEG (← Joint Photographic Experts Group), in which ‘j’ is 

 
159 https://tinyurl.com/yc2ehbjy, May 9, 2025. 
160 This term is used without a period in BrE. 

https://tinyurl.com/yc2ehbjy
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pronounced as a letter and the string p-e-g is pronounced as a word, or acronyms 

created not only from the initials of the expanded version (ASPEN ← Automated 

Survey Processing Environment). 

Initialisms also stem from the initial letters of a multi-word sequence 

containing capitalized words, but the newly formed uppercased word is 

“pronounced as separate letters” (Thomas 2021, 467), not as a single word, such 

as CIA (← Central Intelligence Agency). Naturally, less central cases exist, as 

initialisms may skip the first letter of certain words, especially prepositions or 

conjunctions (e.g., FBI ← Federal Bureau of Investigation); in other cases, they 

could be pronounced as words, yet letter-by-letter pronunciation is needed: WHO 

(← World Health Organization) or GOP (← Grand Old Party). Less prototypical or 

hybrid cases may pose further challenges, for instance terms containing both 

uppercase and lowercase letters (CoS ← Chief of Staff). To make matters worse, 

initialisms may include numbers (AK47 ← Avtomat Kalashnikova), signs or 

symbols (AT&T ← American Telephone and Telegraph Company), and social 

media abounds in these types (ELI5 ← Explain like I’m 5; F2F ← Face to face; Gr8 

← Great, L8 ← Late).161 

Although some scholars consider that alphabetism is a superordinate term for 

both acronyms and initialisms (López Rúa 2004, 117; Mattiello 2013, 67; Scarpa 

2020, 66), or initialism encapsulates acronyms and alphabetisms (Kortmann 2020, 

70), the term is not widely used. 

Blends preserve various parts of multi-word sequences (Kortmann 2020, 70), 

most typically the first letters or syllables (Interpol ← International Police; 

infotainment ← information + entertainment; motel ← motor + hotel), but other 

options are also possible (blog ← web + log; frenemy ← friend + enemy). 

Contractions involving two words are extremely popular, both in (informal) 

speech and in writing. In this case, the second word usually implies an auxiliary 

word dropping its first letter(s), replaced by an apostrophe, and joining it to the 

preceding word: we’re (← we are), you’ve (← you have).  

As for the popularity of these terms, even if initialism is the older term, “it 

has never caught on in wider usage” (Zimmer 2010), so acronym may be 

considered the covert term for the entire category, and the latter has captured the 

attention of computer programmers as well, who designed various codes 

(algorithms) to detect acronyms and initialisms in texts, together with their 

possible expanded forms, as it was observed that these are usually found within 

the range of less than 20 words distance from the acronym (Cannon 1989, 106; 

Koelsch 2016, 80). 

In the following, we use the umbrella term abbreviation for all possible types. 

 
161 https://buffer.com/library/social-media-acronyms-abbreviations/, May 8, 2025. 

https://buffer.com/library/social-media-acronyms-abbreviations/
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5.14.3. Using Abbreviations 

Although a few abbreviations may sound professional, there is a general consensus 

among scholars that they are rather informal, belonging to the “conversational use” 

(Soyer 2018, 589). 

Some sources are slightly more receptive to them, stating that their choice is 

“a process without any semantic consequences, but with a change in the stylistic 

value” (Mattiello 2013, 69), although “their overuse is to be avoided” (Panajotu 

2010, 165). Nevertheless, the author acknowledges on the same page that this is 

hardly tenable. The strictest guidelines simply recommend their complete 

avoidance (Ribes et al. 2010, 68), but this rarely seems to have any effect on the 

authors, which is often due to the fact that English language is “very prone to using 

and creating new words like acronyms” (Díaz Cintas and Remael 2020, 138), 

entailing that translations from English also borrow many of these terms. 

Unfamiliar abbreviations in a text inevitably lead to confusion, so only 

conventional ones should be used, and the readers are “likely to be more familiar 

with the abbreviation than with the complete form,” leading to considerable space 

savings (APA 2020, 172). 

Authors relying on any kind of abbreviation in the main text should spell out 

the expanded form first, even if they might be familiar to the potential readers, 

followed by the abbreviation in parentheses (Koelsch 2016, 6; Ribes et al. 2010, 69; 

Thomas 2021, 467), after which the abbreviation may be used by itself, especially 

when “the original word or words are repeated numerous times, are long and 

cumbersome to read, or cause the prose to be awkward” (AMA 2020, 556). Once 

the abbreviated form is provided, this should be used consistently thereafter, and 

not the expanded form. 

Common abbreviations and symbols may be used in labels and explained “in 

a key or in the caption” (CMOS 2024, 155) but are restricted in titles and 

abstracts.162 However, when a particular abbreviation is found in standard 

dictionaries (e.g., AIDS), no extended form is necessary. The problem is that even 

though they are included in dictionaries, this is not an automatic indicator that the 

target readers will know it. Other sources suggest that whenever an abbreviation 

is used in tables and figures, their expanded form should be included in a note or 

the legend of each table and figure, even if they were defined before (APA 2020, 

173), which seems redundant, but it respects the rule that every single table should 

be understood out of the context as well. 

Furthermore, in extensive scientific publications, the Abstract section should 

be followed by a list of abbreviations and symbols used in the text. This is provided 

in alphabetical order, including their expanded form as well, except for the 

common abbreviations (also found in standard dictionaries) and units of 

 
162 For instance, see De Gruyter Brill’s Open Linguistics, Instructions for Authors, a downloadable 
guideline, available at https://www.degruyterbrill.com/journal/key/opli/html, May 8, 2025. 

https://www.degruyterbrill.com/journal/key/opli/html


192  ◼   Basics of Word Processing for Thesis Writing 

measurements, which need not be included. This list may be placed at the end of 

the text as well. 

Thus, abbreviations and acronyms used in texts almost always require 

disambiguation (Jacobs et al. 2020, 527), which is “critical to the proper 

understanding of various types of texts” (HaCohen-Kerner et al. 2013, 2133), and the 

expanded form of an abbreviation is given in lowercase letters, unless it contains a 

proper noun, it is a formal name, or it begins a sentence (AMA 2020, 556). 

The plural form of abbreviations is signaled by a lowercase “s” at the end of 

the term, without an apostrophe (APA 2020, 173): DOIs (← Digital Object 

Identifiers), Eds. (← Editors), or even vols. (← volumes), although the plural of p. 

(← page) is pp. (← pages). 

The plural forms of single-character abbreviations and symbols might also 

cause confusion, or when they end in a superscript or subscript character, in which 

case an apostrophe before the plural “s” is needed: A’s or F2’s. 

The possessive form of abbreviations might be confusing, so manuals mostly 

recommend rephrasing to avoid the apostrophe form followed by an s. However, 

when the use of possessive forms is relevant, this should not be on the first 

occurrence of the abbreviation or acronym (AMA 2020, 602). A possible example 

is the CEO’s decision versus the CEOs’ decision, which is why rewording might be 

more felicitous. 

Articles preceding abbreviations follow the rule of pronunciation. The proper 

indefinite article (a or an) is selected depending on “how the term is pronounced” 

(CMOS 2024, 454) or “according to the sound following the article” (AMA 2020, 

603). Although this is simple, it might still vary, for instance, when it starts with 

an h: a HAZMAT case or an HBO subscription. 

Periods may signal an abbreviation (Greenbaum 1996, 517), but rules whether 

certain abbreviations should be followed or not by a period are rather 

controversial. Hence, alternatives are guaranteed, such as the variants for the Latin 

abbreviations of morning and afternoon: am, a.m., A.M., or AM (← ante meridiem) 

and pm, p.m., P.M., or PM (← post meridiem), knowing that the CMOS prefers a.m. 

and p.m., while Microsoft products set for the United States predominantly use 

AM and PM. Similarly, there are alternatives for exempli gratia: e.g., followed by 

a comma (CMOS 2024, 5), e.g. without a trailing comma,163 or eg, without periods 

and a trailing comma (AMA 2020, 454). Further remarks regarding the use or lack 

of periods are provided when discussing types of abbreviations below. 

It is suggested that BrE tends to omit the periods in symbols, acronyms, and 

initialisms (Greenbaum 1996, 518), while it preserves them in shortenings or 

clippings (e.g., Capt. ← captain, Co. ← company, ft. ← feet, Inc. ← Incorporated, 

or Rev. ← Reverend) unless they are units of measure or belong to the international 

 
163 https://training.cochrane.org/online-learning/author-guidelines/essential-style-guidelines, May 9, 
2025. 

https://training.cochrane.org/online-learning/author-guidelines/essential-style-guidelines
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system of abbreviations (e.g., kg ← kilogram, s ← second, Hz ← hertz, or O ← 

oxygen). 

In case an abbreviation with a trailing period ends the sentence, no further 

period is necessary to mark the end of the sentence (CMOS 2024, 432). 

Acronyms and initialisms are typically full uppercase words, and there are 

neither spaces nor periods between the letters (Mancuso 1987, 124; Wallwork 

2014, 106), as they are “more direct part of the vocabulary” (Cannon 1989, 111), 

and it results in a “cleaner typography” (Díaz Cintas and Remael 2020, 138). 

Space after shortenings and clippings (either with or without a trailing period) 

is needed to separate them from the following word, but there may be space or not 

between the letters forming an acronym or initialism. 

Bringhurst advises the following: “[a]dd little or no space within strings of 

initials… A normal word space follows the last period in the string” (Bringhurst 

2004, 30), who also suggests spaced small caps for acronyms, “except two-letter 

geographical acronyms and acronyms that stand for personal names” (Bringhurst 

2004, 48). He also considers that acronyms tend to become regular words, so there 

is a shift from full uppercase words to an initial capital letter followed by 

lowercase letters (e.g., Fortran). 

To make matters worse, a few authors remind us that multiple ways of 

spelling are possible (HaCohen-Kerner et al. 2004, 59; Mattiello 2013, 83), having 

in mind uppercase letters (no periods, no spaces), uppercase letters (periods, no 

spaces), only first letter uppercase followed by lowercase letters (as a word), or 

fully lowercase letters in a single word. 

Others consider that an acronym is “a word in which half or more of the 

characters are upper case letters” (Barnett and Doubleday 2020, 1), or “consisting 

of an uppercase letter, followed by 1–4 more uppercase letters, or by the & 

character and by a single uppercase letter” (Dannewitz Linder 2016, 253), knowing 

that the typical length of an acronym or initialism ranges from 2 to a maximum of 

10 characters (Sánchez and Isern 2011, 313). 

Finally, initialisms may include a hyphen, a slash, an en dash, or even an em 

dash (Bloom 2000, 1), and the string may contain numbers too. 

While it is beyond doubt that journals will not accept manuscripts 

disregarding the instructions referring to abbreviations, few of these 

recommendations are applied elsewhere. Subtitling is a clear example for this, as 

translated subtitles often rely on borrowing abbreviations from the original 

transcript, forcing the viewers to learn the frequent ones while watching and doing 

background research on less frequent ones. 

Although the BBC Guidelines specifies that symbols for units of measurement 

should never be used (Williams 2009, 34), and “most companies recommend the 

avoidance of abbreviations” in subtitles, unless “they should be known by the 

target audience or not cause any confusion” (Díaz Cintas and Remael 2020, 137), 

these remain pure recommendations. A well-informed viewer might rely on the 
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mass media providing many fashionable abbreviations connected to current affairs 

in politics, economics, or health, but subtitles often contain abbreviations which 

puzzle the viewers. Yet, subtitles seem to be in a desperate need for abbreviations 

due to constraints of space: number of characters per line, and no more than two 

lines at once. 

Ultimately, subtitlers can hardly do anything to replace abbreviations with 

their extended forms when multiple abbreviations are at stake: DARPA of DOD (← 

the Defense Advanced Research Projects Agency of the United States Department 

of Defense) or an unforgettable line in this respect in Designated Survivor (Season 

2, Episode 3): “Look, we have the CDC, HHS, NIH, FEMA…,” referring to the 

Centers for Disease Control and Prevention, the United States Department of 

Health and Human Services, the National Institutes of Health, and the Federal 

Emergency Management Agency. 

5.14.4. Extended Forms Instead of Abbreviations 

While the popularity of abbreviations is increasing, there are voices that “writing 

is generally easier to understand when most words are written out rather than 

when overflowing with abbreviations” (APA 2020, 172). 

To minimize the use of abbreviations, they should not be used in titles, section 

headings, and very rarely in abstracts (with at least three occurrences) or in the 

References section, where common book title abbreviations, such as APA or the 

CMOS, are always in the expanded form: American Psychological Association or 

The Chicago Manual of Style.164 

Furthermore, authors should not create new abbreviations (AMA 2020, 556; 

Nicoll 2016, 6), having in mind that more than one “novel abbreviation per paper 

burdens the reader” (Bloom 2000, 4). Consequently, they should be used 

“sparingly” (APA 2020, 172), and there are cases when their use is actually 

discouraged: 

1. in titles and subtitles; 

2. in abstracts; 

3. in headings unless they were previously used or are found in dictionaries; 

4. at the beginning of sentences (APA 2020, 174), such as lb (← pound) or α 

(← Alpha); 

5. when the abbreviation is more popular than the extended form; 

6. when there are fewer than three occurrences in the main text (APA 2020, 

172); however, very long terms with standard abbreviations (e.g., DNA 

versus deoxyribonucleic acid) are an exception to this rule; 

 
164 https://proofreading.org/blog/abbreviations-in-academic-writing/, May 9, 2025. 

https://proofreading.org/blog/abbreviations-in-academic-writing/
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7. in case the extended form is easier to understand, such as chemical 

symbols and formulas, or when the extended form is not considerably 

longer: water versus H2O (AMA 2020, 637); 

8. for stylistic reasons. 

5.14.5. Types of Abbreviations 

There are various types of abbreviations based on their meaning, most of which 

are presented below. 

5.14.5.1. Abbreviating Names and Collectives 

Names, titles, and honorifics may be abbreviated. In the case of names, letters 

standing for abbreviated first and middle names are always followed by a period: 

John F. Kennedy, J. J. Thomson. The term St. (← Saint) should take a period when 

it precedes a person’s name, but not in geographical names: St Louis, Missouri 

(AMA 2020, 449–50). 

People’s name may be combined with their either honorific or academic 

degrees but not both: Jane Doe, PhD, or Dr Jane Doe. Further titles are Prof., BA, 

MA, BSc., and fellowship designations, or honorary degrees are “generally not 

listed in bylines or elsewhere” (AMA 2020, 556). The term editor is abbreviated as 

Ed. in case it is singular, while the plural form is Eds. (APA 2020, 287). 

There are cases when the period might differentiate AmE and BrE spelling. 

According to the CMOS, period is needed in Dr. (← doctor), Mr. (← Mister), Sr. (← 

Senior), or Jr. (← Junior). Other sources contradict this, and Bringhurst urges us to 

“use a period only when the word stops prematurely” (Bringhurst 2004, 88), which 

seems to be a logical advice, entailing that Dr, Jr, Mr, or Sr take no period, and this 

is also recommended by others as well (AMA 2020, 572), and BrE also disregards 

periods in these cases. On the other hand, Prof. (← Professor) or Capt. (← Captain) 

take a period. 

Differences between BrE and AmE punctuation are highlighted by others as 

well (Milinković 2019, 156), but a more optimistic observation suggests that 

punctuation changes over time (Thomas 2021, 469). 

Depending on the writing style, first names of authors are also abbreviated 

(capitalized first name followed by a period), while group authors may be 

abbreviated to preserve the first capital letters into an acronym of initialism with 

no periods between: APA ← American Psychological Association (APA 2020, 268). 

This style may be extended to agencies, foundations, or various organizations as 

well (APA 2020, 287). 
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5.14.5.2. Abbreviating Time 

Dates and periods of time are also often abbreviated, although there are variants 

in certain cases. For instance, eras may be capitalized with periods (B.C., A.D.) or 

set in small capitals, no periods: BC ← before Christ, AD ← Anno Domini or ‘in the 

year of the Lord,’ CE ← common era (AMA 2020, 563). 

Months shorter than five letters are not abbreviated (May, June, July), while 

the rest may be abbreviated with the first three letters followed by a period (except 

for Sept. ← September, which is a four-letter abbreviation) in full dates, tables, and 

references, but not when only the month is in question (ASA et al. 2024, 7–06). 

However, another source considers that months may be abbreviated with the first 

three letters and no periods (AMA 2020, 563), similarly to the days of the week. 

Hours, minutes, and seconds may have different abbreviations as well: h ← 

hour, m ← minute, s ← second, but m may stand for meter as well, so there are 

views that the abbreviations for time should be doubled: hh:mm:ss, knowing that 

they are not included in the international system of abbreviations. Non-technical 

contexts might use abbreviations with periods (CMOS 2024, 669): h., hr., min., and 

sec. There is a space between the preceding number and the abbreviated hour, 

minute, or second (APA 2020, 176). 

However, there are versions without periods as well (sec, min, hr),165 and 

informal variants replace the letters with the prime symbol for minutes (′, U+2032), 

while the double prime expresses seconds (″, U+2033). Yet, careless versions might 

replace prime and double prime with apostrophes (’) or straight apostrophes ('). 

BrE uses periods between the hours and minutes, while AmE relies on colons: 

10.49 versus 10:49. A more visible difference is the AmE Month-Day-Year format 

(May 21, 2025), where the year is separated by a comma from the rest, compared 

to the BrE Day-Month-Year format (21 May 2025), knowing that the day may be 

written as an ordinal number (21st May) or a cardinal number (21 May), and no 

period is needed after the ordinal (Greenbaum 1996, 518). However, the numbers 

replacing the month, day, and year may be separated by periods, slashes, and 

dashes as well (e.g., 05/21/25, 5-21-25). 

5.14.5.3. Abbreviating Locations 

The abbreviation of capital directions is always uppercase, and no period follows 

them: N (← North), E (← East), S (← South), and W (← West), including their 

whatsoever combinations (NE, S–SE). 

Geographical coordinates make use of the degree, the prime, and double 

prime signs to refer to directions, latitude, and longitude values: 44° 4' 5.5308'' N 

and 114° 44' 31.3548'' W are the coordinates for Idaho, USA; as both coordinates 

 
165 https://www.yourdictionary.com/articles/sec-min-hr-abbreviations-conversions, May 21, 2025. 

https://www.yourdictionary.com/articles/sec-min-hr-abbreviations-conversions
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are given, no lat and long abbreviations are needed (ASA et al. 2024, 2–02), and a 

few geographical abbreviations are commonly used, such as Mt ← Mount. 

Countries typically have their established abbreviations, although there are 

multiple variants. For instance, the ISO codes may be Alpha-2 or Alpha-3 codes, 

thus both US and USA refer to the United States of America, while GB and GBR 

stand for the United Kingdom of Great Britain and Northern Ireland. 

While these codes contain no periods, The Washington Post consistently uses 

U.S. and not US (← the United States of America), although manuals recommend 

US (AMA 2020, 565). US states and Canadian provinces should be spelled out, 

except for postal addresses, tables, and figures, where their established abbreviated 

version is recommended (AMA 2020, 565–69). Another source explains that USA 

is a noun, while U.S. is an adjective, as in U.S. Cotton Belt (ASA et al. 2024, 2–01). 

States, provinces, territories, counties, and cities also have abbreviations, and 

users should respect the established ones: MB ← Manitoba, LA ← Louisiana or Los 

Angeles, and postal addresses also contain abbreviations for Avenue (→ Ave), 

Boulevard (→ Blvd), Drive (→ Dr), Highway (→ Hwy), Lane (→ Ln), Road (→ Rd), 

Square (→ Sq), Street (→ St), or even Building (→ Bldg), Place (→ Pl), Suite (→ 

Ste), or Terrace (→ Terr), but the list is not complete (AMA 2020, 564–65). 

However, in case the “street number is not given,” or plural form is needed (e.g., 

Main and Summer streets), there is no abbreviation, and room, department, or 

division should not be abbreviated either (AMA 2020, 565), even if their 

abbreviations are widespread (R, Dept, Div., respectively). Interestingly, Number 

is abbreviated as No., ending in a period. 

Commercial firms may contain abbreviations in their names Co. (← 

Company), Corp. (← Corporation), Inc. (← Incorporated), Ltd. (← Limited), and 

manuals either recommend periods (CMOS 2024, 402) or not (AMA 2020, 573). 

Our recommendation is to use periods. 

5.14.5.4. Abbreviating Units of Measurements 

Units of measurements typically take no period unless they end a sentence, as SI 

unit symbols contain no periods. Unit abbreviations in the SI system are not 

capitalized. 

Furthermore, units of measurements take no plural forms when they follow 

numbers (7 cm, 2 hr), as explained (AMA 2020, 928), and are followed by a verb 

in singular. Overall, avoiding plural forms in abbreviations is a reasonable advice, 

at least not on their first occurrence.166 

Interestingly, liter is abbreviated with an uppercase L to distinguish it from 

the digit 1, which is similar to the lowercase l (AMA 2020, 927). 

 
166 https://tinyurl.com/mr3udjjt, May 8, 2025. 

https://tinyurl.com/mr3udjjt
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Style guides recommend the full form of measurements when they start the 

sentence, belong to the title or the subtitle, or are not accompanied by numeric 

values, while less common units should be spelled out first, accompanied by the 

abbreviated form in parentheses, and the abbreviated form may be used later on 

(AMA 2020, 928). Other sources consider that no extended form of common 

measurements, time, chemical elements, Latin and statistical abbreviations is 

needed, and they should not be defined in tables or figures either (APA 2020, 173). 

Nonmetric units may be preserved in idioms, proverbs, and sayings (Give him 

an inch and he will take an ell.); otherwise, it is recommended to be converted to 

the metric system (AMA 2020, 932), including length (feet, ft to centimeters, cm or 

meters, m), area (square feet, sq ft, sq. ft., ft2 to square meters, sq m, m2), mass 

(ounce, oz to gram, g; pound, lb to gram, g or kilogram, kg), and volume (fluid 

ounce, fl oz to milliliter, mL; teaspoon, tsp to milliliter, mL; pint, pt to liter, L; 

gallon, gal to liter, L, etc.). Preserving nonmetric values is considered less formal 

and nonscientific. While units of measurements take no period, the abbreviation 

of inch is an exception (in.), not to be misunderstood. It is also important to 

mention that units and numeric values are separated by a space (APA 2020, 175), 

but further remarks are necessary in the case of the degree sign. 

Temperature values (AMA 2020, 933) in degrees Fahrenheit (℉, U+2109) 

should be converted to degrees Celsius (℃, U+2103), but there are different views 

whether these signs follow the numeric values with or without a space. The SI 

style (AMA 2020, 933; APA 2020, 175) recommends space (3 ℃), while another 

style (CMOS 2024, 651) uses no space (3℃) between the degree sign and the 

number. On the other hand, angle values take no space: a 30° angle. Further details 

are found in Section 5.8.4. 

There are contradictory rules regarding repeated quantities as well: ranges 

with units of measurements should display the unit only once (APA 2020, 176), 

as in 5–9 kg, while the CMOS recommends doubling them: 1%–2% (CMOS 2024, 

599). In our view, the en dash refers to a range, and in case the measurement unit 

is the same, there is no need to signal it twice. 

5.14.5.5. Military Abbreviations 

There is an entire “arsenal” of military abbreviations, which—interestingly—are 

less “regulated” (Panajotu 2010, 164), as some acronyms are used without period, 

although periods are frequent. Panajotu also acknowledges, “it is extremely 

difficult to change or modify a way of spelling already embedded in modern use” 

(Panajotu 2010, 164). 

Frequent abbreviations derive from military titles (grades or ranks) as well as 

services, which may be fully capitalized or not: COL or Col. ← Colonel (AMA 2020, 

561). As mentioned above, they might also end or not in a period. As such, the 
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correct abbreviation depends on the country, army division, and which version 

the editor favors. 

5.15. Summary and Recommendations 

Proper text style was discussed as the combination of word choice and good 

knowledge of abbreviations. 

Abbreviations are mostly considered informal, and there are many 

contradictory recommendations on their use. A major rule might be that the 

extended forms should be provided on their first use, followed by the abbreviation 

in parentheses, thereafter using the abbreviation only. A complimentary one is that 

no abbreviation is needed if there are fewer than three occurrences, except for 

when they are under discussion, as in this book. 

However, certain abbreviations are far more popular than their extended form, 

and prescriptions of style guides are contradictory, leaving prospective authors 

puzzled. As such, the editors’ choices remain the only clue, which should be 

followed consistently. These include seemingly obvious abbreviations as well, 

such as Latin abbreviations or time-related ones, but, unfortunately, there are 

variants in these cases as well, depending on uppercase/lowercase options, the use 

of periods or not, or whether to use space between the abbreviated terms and 

numbers or not. 

5.16. Writing Emails 

While it may look strange to insert a section on writing emails, it is important to 

present some basic know-how of email etiquette. 

Experts consider that in a professional environment, an email must be 

answered in a 24–48-hour window, and in case this is not possible, a quick reply 

should be sent to let the sender know when a full response is possible. Expected 

quick responses should also consider cultural sensitivity, as based on cultural 

differences, emails should be replied only during working hours of the target 

company. 

Whether replying or sending an email, the subject line should never be empty, 

and its brief words should cover the content. While texting or contacting someone 

via the social media requires no professional greeting, this is different in the case 

of emails, resembling letter writing. The style of the email should be professional 

and respectful, void of slang, concise, clear, and no longer than necessary. Special 

formatting with various fonts and highlighting should be avoided, being as close 

to an unformatted text as possible to ensure that the recipient will see the same 

message. As explained, legible lines “should be shorter than 75 characters, and 

many email applications automatically wrap lines at around that mark” 

(Spiekermann 2013, 175). Spiekermann also suggests that replies should not 
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contain the sender’s entire message. Similarly, circular emails do not always need 

Reply All emails. More recently, emails may contain a footnote warning regarding 

the confidentiality of the email, discouraging forwarding it to other recipients. 

As it is possible to add a signature block at the end of each email sent, this 

might look more professional, including the name, job title, company, and further 

contact information, paying attention to the language format as well or providing 

the same information in multiple languages. 

Email service providers (such as Mozilla Thunderbird)167 offer proofreading 

features in multiple languages, and they help eliminate typographical errors and 

occasionally grammar mistakes as well. 

In case attachment is announced, failing to include it is unprofessional, 

knowing that they are relevant; however, attachments should not be excessively 

large. The effect of these recommendations is unquestionable: “A little 

consideration for the recipient of your messages goes a long way” (Spiekermann 

2013, 175). 

 
167 https://tinyurl.com/4yp3x3ck, August 22, 2025. 

https://tinyurl.com/4yp3x3ck


Chapter 6   

Insert 

There are many technical options to insert layout-related or text-enhancing 

features in a text, which may provide either a better insight into longer documents 

(e.g., page numbers) or break the text into more visible parts (e.g., enumerations). 

Focusing on a manuscript, standard requirements for publication mention the 

title (style) and further formatting prescriptions regarding page headers, page 

numbers, (reference) lists, footnotes, tables, figures, and appendices (APA 2020, 

29). As all these may be added in various forms of insertion, they are all discussed 

in this chapter. 

6.1. Headers and Footers 

The top of a page often includes data regarding the document title, date, chapter 

number, page number, or author’s name, which are repeated on consecutive pages. 

This part of a standard page is referred to as a running head or header (AMA 

2020, 1142) or page header, which should contain fewer than fifty characters (APA 

2020, 37) and is mostly flushed left in uppercase letters, although in case the page 

number is included, this is flushed right (APA 2020, 44). 

Footer, or running foot, is placed at the bottom of pages, which may typically 

contain the similar information as the header, completed with various notes (e.g., 

Footnotes). The style of footnotes is predefined or “standardized” (AMA 2020, 

1132) in word processing software; for instance, the font size is smaller than the 

main text. 

No header or footer should be used on pages containing the title, copyright, 

dedication, table of contents, preface, foreword, or chapter openings (CMOS 2024, 

8), and publications may omit headers or footers on blank pages or pages 

containing only tables or illustrations. 

Student papers are simpler, typically containing the page number only, which 

may be either in the header or in the footer. While reference works, conference 

publications, anthologies make use of elaborate headers, books on “unified 

subjects” or “strong authorial voice” need no headers (Bringhurst 2004, 166). 

Inserting a header or footer in a Word document is possible via selecting the 

Header on the Insert tab, offering various options (Edit Header), which make it 

easy to include the author, file name, document properties, or page number, as 
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well as set the height of the Header from the top of the page or the height of the 

Footer from the bottom of the page: 

 

Figure 94. Inserting header and footer, Word (rearranged in 2 columns) 

Many publishing houses prefer to use different types of content of recto and 

verso pages, such as the title on recto pages, chapter names on verso pages, or the 

author’s name on recto and the title of the work on the verso pages. This is possible 

in Word if the box next to Different Odd & Even pages is selected. Inserting the 

proper information starts from Insert, Cross-reference, where Heading content can 

be selected (Heading number for chapter number and Heading text for chapter 

heading). The Show Next button moves to the header or footer of the next chapter, 

and the Link to Previous button can break the link between the current header and 

footer from the previous ones.168 

Furthermore, there is a Different First Page option, which treats the 

introductory pages differently when enabled, where no headers and footers must 

be displayed. 

Writer offers various predefined data to add to either the Header or the Footer 

via the Insert, Field available in the Main tab: see Figure 95. 

Clicking on the More Fields… (Ctrl+F2) at the bottom, an extra window 

opens, offering further options, such as File name, Path, Statistics, or Cross-

references, and options which are beyond our interest, such as Functions, 

DocInformation, Variables, and Database. 

 

 
168 https://tinyurl.com/ybc9sa48, July 6, 2025. 

https://tinyurl.com/ybc9sa48
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Figure 95. Insert header and footer, fields, Writer 

6.2. Page Numbers 

In our view, all documents longer than one page should contain page numbers, at 

either the top or bottom of the page. 

Manuals specify that Arabic page numbers are traditionally flushed right, and 

while the title page is considered as page 1, it is not numbered (APA 2020, 44). 

Word processors offer easy access to insert page numbers. In Word, this is 

found under the Insert tab and selecting Page Number, which offers various 

options: top or bottom position, Page Margins, Current Position, but further 

formatting is also possible (Format Page Numbers). Clicking on this last option 

enables the choice of Number format (number or letters), whether or not to include 

chapter number, the option of hyphenated separation or starting the page number 

from a specific number or continue from the previous section. 

It is obvious that extra settings regarding page numbers are necessary, as 

introductory pages are not numbered. In this case, we can access Layout, Breaks, 

Section Break, Next Page in Word, which makes sense after the pages containing 

the title page, cover pages, table of contents, and abstract. After having inserted a 

new page with section break, we should go to the Footnote (double click) and 

disable the Link to Previous button. This way the numbering in the footnote may 

start from any number. Then we can return to any of the previous pages and delete 

the Footnote without affecting the numbering of the next section. 

Writer also offers straightforward page numbering via Insert, Page Number…, 

opening a new window with various setting options: 
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Figure 96. Insert page number, Writer 

Certain pages (treated as different sections) might need no numbering, while 

the so-called “front matter” (the introductory pages) is usually numbered with 

lowercase Roman numerals (CMOS 2024, 7). The same source suggests that a page 

is understood as “one side of a leaf,” and the side of the leaf that is on the right 

side of an open book is the recto, while the back of it (the left side of an open book) 

is called the verso. Recto pages are always odd numbered (flush right), and verso 

pages are always even numbered (flush left). 

Student papers are simpler, so page numbering may be set in the footer and 

centered. However, in this case, page numbers should start after the front matter 

as well, which is formatted as a separate section, and the page numbering should 

not continue from the previous section, which typically contains the Cover page, 

Title page, and the Table of Contents (optionally completed with a List of 

Tables/Illustrations). The last numbered page includes the Reference section, 

while the Appendix section needs a Section Break, as it should use Roman page 

numbers. 

6.3. Notes 

As notes tend to offer extra information on the main issue, they are subordinate, 

so are set in smaller font size (Bringhurst 2004, 68), often 2–3 points smaller 

(Ármeán 2017, 54). We can distinguish footnotes, endnotes, and sidenotes, 

knowing that they may be easily converted from one form to another. 
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6.3.1. Footnotes 

Footnotes are “an ancillary piece of information” (AMA 2020, 1132) connected to 

the topic in discussion on a particular page, or they may offer copyright or 

translation data regarding the text, table, list, or illustration on a particular page. 

While they seem to be marginal, they should not contain “complicated, 

irrelevant, or nonessential information” (APA 2020, 40). However relevant 

information they might contain, footnotes should be as brief as possible and used 

sparingly (Bringhurst 2004, 68). Actually, the MLA Handbook (MLA 2021) 

disregards them and uses only endnotes, while there is an article entitled Elegy for 

Excursus: The Descent of the Footnote by Betsy Hilbert (1989).169 Still, footnotes 

are found in scientific papers and books alike. The present book includes all the 

links to websites that have been used in the Footnote section for obvious reasons: 

due to their length in the form of a string of characters, they can hardly fit in the 

main text, unless hyphens are not included in the links. Still, links longer than a 

line in paper size A4 are shortened with the help of TinyURL. 

Footnotes may be inserted at the bottom of the page even if no footer is set 

previously. This is possible because they are available via References, Insert 

Footnote, and they may be positioned either at the bottom of the page or below the 

text. The layout may either match the selection or not, and various formats are 

available.170 However, the most common option is to use Arabic superscript 

numerals, and—similarly to page numbers—they may start at 1 or not, and the 

numbering may be continuous or not. The number and the footnote text are 

separated by a space. As footnotes might contain phrases, sentences, or hyperlinks 

with date of access, they should have the same line spacing as the main text (CMOS 

2024, 74), even if the font size is smaller, but they can be “hung to the left” 

(Bringhurst 2004, 69). A particular attention should be paid to setting the footnote 

language to avoid spelling mistakes, and proper language setting also provides 

correct date formats when adding them to hyperlinks. 

The standard style of a footnote is automatically set to Hanging indent in 

Word171 and Writer alike. In Word, it may be changed by accessing the Home tab, 

Styles, and clicking on the arrow for further options. This Style window may also 

be triggered by the Ctrl+Alt+Shift+S shortcut key, then the Manage Styles button, 

enabling us to change the font, font size, reference style (numbers), spacing, or 

language. However, the possible standard option to set footnotes is accessing 

References on the Main tab and then clicking on the southeast arrow at the bottom 

of the Footnotes section that opens a window illustrated in Figure 97 below. 

 
169 https://www.jstor.org/stable/377528, May 22, 2025. 
170 Arabic numeral, lowercase or uppercase letters, Roman numerals or symbols with a clear order: 
asterisk, dagger, double dagger, paragraph symbol, but Bringhurst admits that using symbols for 
footnotes is outdated (Bringhurst 2004, 68). 
171 https://tinyurl.com/3wy9fbta, May 22, 2025. 

https://www.jstor.org/stable/377528
https://tinyurl.com/3wy9fbta
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Figure 97. Footnote and endnote settings, Word 

As for Writer, a right click on the inserted footnote offers the following 

options: 

 

Figure 98. Setting footnotes and endnotes, Writer 
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Footnotes are restricted to the main text, so headings should not contain 

footnote callouts, and in case a particular footnote should be referred to again, this 

is possible via Insert, Cross-reference, and the label and number (APA 2020, 40). 

In case a footnote refers to the previous one containing a reference, the Latin 

abbreviation ibid. may be used and a particular page number may be added,172 

although other sources rule this out (MLA 2021, 290). 

Whatever the layout, footnotes should always end in a period (EC-DGT-RO 

2021, 9; AMA 2020, 125). 

6.3.2. Endnotes 

Endnotes are inserted at the end of documents or sections, and their default 

numbering is set to lowercase Roman numerals: i, ii, iii, iv, etc. 

By default, inserting endnotes in Word is possible via References, Insert 

Endnote, and the arrow at the right bottom of the tab reveals various options, 

similarly to footnotes. The major advantages of endnotes over footnotes are that 

their length is not limited, and they do not break the continuity of the main text 

while reading the page, being more economical regarding the layout. 

The obvious disadvantage of endnotes is that those interested in endnotes 

constantly have to swap between the main text and the end of the document (or 

section and end of section) to find the particular endnotes (Bringhurst 2004, 68). 

While authors may have personal preferences regarding footnotes or endnotes 

during the writing process, should the editor require the opposite, conversion from 

endnotes to footnotes and backwards may be carried out by accessing References, 

then clicking on the bottom right arrow on the Footnotes tab, and clicking on the 

Convert… button: 

 

Figure 99. Convert footnotes and endnotes, Word 

Changing the footnote line position and length is also possible.173 As described 

in Footnote 173, the View tab offers a Draft view option, then References, Show 

Notes, Footnotes drop down list, which lists a Footnote Separator, revealing the 

 
172 https://libguides.murdoch.edu.au/Footnote, May 22, 2025. 
173 https://tinyurl.com/35erfvbp, June 3, 2025. 

https://libguides.murdoch.edu.au/Footnote
https://tinyurl.com/35erfvbp
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separator line, which may be modified by adding or deleting further em dash 

symbols. 

6.3.3. Sidenotes 

Sidenotes should not be mistaken for inserting 

comments. Although the latter is placed on the right side 

of the page, it contains the reviewer’s name and personal 

remarks on the content. 

Sidenotes are similar in function to footnotes and 

endnotes, and they may be positioned anywhere on the 

page. The font size of sidenotes may even be the same as 

that of the main text (Bringhurst 2004, 68), and they may 

be marked with asterisks, as in our example. They may 

extend over various parts of a page, but they should be 

used sparingly as well. 

A possible way174 to insert sidenotes in Word is to activate the Developer on the 

Main tab. This is possible via the File tab, Options, Customize Ribbon, and then 

ticking the Developer box and clicking OK places the Developer on the Main tab. 

Clicking on it, the Legacy Tools will become available within the Controls tab. One 

of the options of Legacy Tools is Insert Frame, and selecting it changes the mouse 

pointer to a cross, and then any part of the page can be selected to create a Frame. 

Frames have various options: their size may be easily changed by placing the 

pointer over the border, upon which the cursor changes to a four-sided arrow 

symbol, and a left click shows the actual borders, which may be changed by the 

indicated moving points. Furthermore, any side of the frame may be visible or not 

by a right click when the pointer displays the four-sided arrow sign: the Format 

Frame enables us to set the size (width, height), horizontal and vertical position, 

while the Borders and Shading option offers various frame styles (including no 

frame on any side) and color styles. 

6.4. Tables and Captions 

Tables and figures belong to infographics, which is in fact a system of structured 

raw data, relying on the visual aspect of gridlines, color, icons, symbols, or 

graphical representation (Ármeán 2017, 114). 

Another source discusses tables and figures as “non-text elements” 

(Bringhurst 2004, 21) that can break monotonous texts easily, and both a table and 

a figure should be designed to “be understood on its own,” without the 

accompanying text (APA 2020, 196). A general rule is that they should be 

 
174 https://www.simuldocs.com/blog/how-to-insert-frames-into-microsoft-word-documents, May 23, 
2025. 

* Sidenotes “may give 
more life and variety to 
the page” 
(Bringhurst 2004, 68). 

https://www.simuldocs.com/blog/how-to-insert-frames-into-microsoft-word-documents
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“announced” in the preceding text with a “callout” (APA 2020, 198), and labeled 

with a caption, which is set in a different font and size than the main text. 

As for their alignment, there are various suggestions. Some sources 

recommend centering them, while others recommend to have them positioned to 

the left margin, and ideally they are shorter and smaller than one page (APA 2020, 

198), separated from the surrounding text by visible space (e.g., a double-spaced 

blank line). Unless they are created by the author, table notes or figure notes should 

specify their sources. 

Inserting a table in Word starts with Insert, Table, and the drop-down list 

offers a few sizes of rows and columns. 

The left-most column is called the “stub,” containing “the list of topics, 

variables, or instances to which the values in the table body apply” (AMA 2020, 

1144). A detailed description of basic table components is available in the APA 

Manual (APA 2020, 200). 

Tables contain data in a visual form, relying on “alphanumeric text,” so they 

are “usually typeset along with the text rather than produced separately as images” 

(CMOS 2024, 132). The contents of the table should be easy to understand “on its 

own,” without duplicating the details (CMOS 2024, 156). This also entails that 

abbreviations in tables should be spelled out first (even if they have already been 

used before, lest the reader should check the meaning elsewhere in the text (ASA 

et al. 2024, 5–01). 

A special attention must be paid to a consistent style of tables, including 

“column heads … content layout … line spacing, indentation, fonts, rules, and 

other distinguishing features” (CMOS 2024, 158). The simplest way would be to 

insert a simple table, then format it according to the provided styles, which are 

available once a table is inserted; by clicking on the table, Table Design and Table 

Layout appears at the end of the tabs in Word, and clicking on the Table Design 

reveals many styles, which may be further modified. 

Although a table is easily recognized from its gridlines, they should “not look 

like bars on a prison cell window” (Spiekermann 2013, 89), so lines of tables might 

be restricted to a minimum, as white space can effectively “divide elements” as 

well, and “[a] vertical line is wasteful because it needs precious space on either 

side” (Spiekermann 2013, 165). Overall, a text should contain a minimum of 

“guiderails … and a maximum amount of information” (Bringhurst 2004, 70–71). 

As such, the use of table edges is discouraged, although other sources recommend 

a border at the top and bottom of the table, beneath column headings, the row with 

summary or totals (APA 2020, 205), leading to the conclusion that vertical borders 

are mostly unnecessary, as are shading or colors. There are many tips how to create 

and modify tables,175 or cell gridlines,176 depending on personal needs. 

 
175 https://edu.gcfglobal.org/en/word/tables/1/, June 7, 2025. 
176 https://tinyurl.com/2vjxwds4, June 7, 2025. 

https://edu.gcfglobal.org/en/word/tables/1/
https://tinyurl.com/2vjxwds4
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Tables should have a caption, numbered automatically, by clicking on the four 

arrows icon on the top left corner area of the table. This selects the entire table, 

and a right click on it displays the Insert Caption (Word) window with multiple 

options: 

 

Figure 100. Insert tables, Word 

Word offers to place the caption (label) Table above the selected item, also 

recommended by various manuals, specifying that it should be “in bold font” (APA 

2020, 199), which is not compulsory. The label is typically followed by a period 

and the title, although it might be positioned below it as well (APA 2020, 199). 

This “descriptive title” should be “written as a phrase rather than as a sentence” 

(AMA 2020, 117). Well-formed tables are labelled with proper captions, enabling 

the creation of a list of tables, which might be placed after the table of contents or 

in the appendix section by accessing References, Insert Table of Figures and 

selecting Table from the Caption label options in the General section. 

When reference is made to the table, their number should be specified, as 

close to the table as possible (CMOS 2024, 159), adding that tables on a single page 

are positioned either at the top or bottom of the page (hardly tenable), while tables 

that break over pages “should be presented broadside across facing pages.” 

However, splitting a table should be the very last resort, as it might be split into 

smaller tables, with smaller font size, or in landscape format (AMA 2020, 117). 

Cross-reference in Word is found on the Insert tab, selecting Table from Reference 

type options, while the Insert reference to offers to insert Entire caption or Only 

label and number, among others. Writer offers Cross-reference via the Insert tab. 

However, subsequent changes in the document (before the first cross-

reference) make it necessary to update the cross-references before publishing the 
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final version. Instead of doing this one by one, there is the possibility to select the 

entire document (Ctrl+A), and then pressing F9 function key updates all fields in 

a Word document. Writer, on the other hand, seems to update caption numbers 

automatically once a new one is added or an inserted one is deleted. 

As for the contents of tables, number ranges should be precise, explaining that 

they refer to “up to” or “up to including,” which is also possible with the correct 

symbols: >, <, ≥, ≤ (CMOS 2024, 176). In case percentages are specified, the 

recommendation (AMA 2020, 129) is to use only digits in the denominator (17%) 

and no decimals (17.5%), while statistical data need exact values, even three or 

four digits to the right of the decimal point. Total at the foot of the stub should be 

highlighted with further indent or other typographical option. 

All columns of a table should include column headings (APA 2020, 199), set 

in font: “bold” and “sentence case … similar to axis labels in figures” (AMA 2020, 

119), and except for questions, no end punctuation is used (CMOS 2024, 164). 

Similarly to heading, fields or data cells are also capitalized in sentence style 

(AMA 2020, 122), and tables written in Latin alphabet should contain horizontal 

text (rarely oblique), never vertical (Bringhurst 2004, 70). 

Alignment in tables is also relevant, as justified margins might endanger 

readability due to uneven word lengths. Simple tables and lists (two columns) 

might be aligned against each other (Bringhurst 2004, 72), so flushed right (left 

column) and left (right column), while larger tables might be flushed left (AMA 

2020, 124) or center, and “numbers may also be aligned on the decimal” (APA 

2020, 202) or flushed right (Bringhurst 2004, 72), especially when no decimals are 

provided. Different kinds of numbers are to be aligned on the most frequent ones, 

while no data cells containing an ellipsis or an em dash are centered (CMOS 2024, 

169). If long lines must be broken in a cell, indentation is typical. 

To save space in the table, slash could help in the case of dates (if the local date 

format is clear: month/day/year, day/month/year, or international), while hyphens 

when ranges are needed and no negative number is implied, otherwise the particle 

to is compulsory to be used between the numbers (AMA 2020, 128–29). 

Table row spacing may also be variable: “single-spaced, one-and-a-half-

spaced, or double-spaced,” depending on table length and the type of information 

(APA 2020, 202). 

Space before the table is not an issue, as the line above the table is the caption, 

whose style might be set any desired space from the previous line. However, the 

space after the table is troublesome, and two alternatives are recommended.177 One 

of them is to leave an extra row at the end, set to No border, as this is invisible 

when saved to PDF or printed. Another option might be to create a new Normal 

text style with 12-, 18-, or 24-point spacing before and after. 

 
177 https://wordribbon.tips.net/T013012_Space_after_a_Table.html, June 4, 2025. 

https://wordribbon.tips.net/T013012_Space_after_a_Table.html
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Table notes may contain the source (italicized Source or Sources followed by a 

colon), definition of abbreviations178 (unless they are standard ones), explanation of 

symbols, copyright attribution, acknowledgement, reprint information when needed 

(APA 2020, 199), introduced by the italicized word Note, followed by a period, 

knowing that specific notes may refer to a single cell, row, or column by superscript 

lowercase letters (APA 2020, 203). These notes are placed below the table and are 

numbered separately from footnotes (CMOS 2024, 164). Arabic numerals may be 

replaced by a set of specific symbols (limited to six) this way: asterisk (*), dagger (†), 

double dagger (‡), section mark (§), parallels (‖), and the number sign (#). 

A final issue is table conversion, which might be needed when data derives 

from a different document (PDF, spreadsheet, or online sources), amply described 

in an authoritative source (Csernoch 2015, 9–42), or when textual information 

might be converted to table, available in word processing software. 

Word offers table conversion via Insert, Table, Convert Text to Table once the 

text is selected, with various options: number of columns and rows, width, and 

how to separate the text (Paragraph, Commas, Tabs, or Other), knowing that a 

single item of a large array of symbols may be inserted in the box next to Other, as 

illustrated in Figure 101 below: 

 

Figure 101. Convert text to table, Word 

 
178 The abbreviation for number is not a hashtag (number/pound symbol) but ‘No.’ with a trailing period. 
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The Writer version is simple: a click on Table on the Main tab reveals a drop-

down list, containing Convert, Text to Table with the following options: 

 

Figure 102. Convert text to table, Writer 

A table may be converted to text by selecting the table, then accessing Table 

Layout, Convert to Text and providing the separator character in Word. Once a 

table is selected in Writer, clicking in Table reveals the drop-down list with 

Convert, but this time the other option is available: Convert Table to Text. 

Applying separate styles for captions and titles is possible with the help of 

Style Separator, discussed in 2.7. 

6.5. Figures and Captions 

As explained, “all types of graphical displays other than tables are considered 

figures” (APA 2020, 225), which present “information or data, including statistical 

graphs, maps, matrixes, algorithms, illustrations, digital images, photographs, and 

other clinical images” (AMA 2020, 130), so possible synonyms are chart, drawing, 

graph, illustration, image, photograph, or picture (AMA 2020, 1132; APA 2020, 

195). However, pie charts should be avoided in scientific publications, unless they 

are intended for “lay audiences” (AMA 2020, 137). 
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Figures may be colored or not, depending on the source, personal preference, 

or specific reasons. Icons, pictograms also belong here, and while some of them 

may be inserted as symbols directly from the word processing software, others may 

have Unicode values or may derive from screenshots, which capture various parts 

of the computer screen. 

While Windows has Snipping Tool with five options (four for images), these 

may be triggered with a single shortcut: the Windows logo key ( ) combined with 

Shift and the key S: Shift+ +S. 

Table 19 below presents various screenshot options for other operating 

systems.179 

Table 19. Screenshot options 

Area Linux Mint macOS 

Full screen PrtSc Shift+command+3 

Rectangle  Shift+ PrtSc Shift+command+4 

Window Left Alt+ PrtSc Shift+command+4+Space bar 

 

Changing multiple open windows is possible with Alt+Tab (Windows/Linux 

OS). 

Similarly to tables, figures should be preceded by a callout, closely followed 

by the figure as soon as possible, which should be horizontal. A caption 

accompanies them (right click on the figure and select Insert Caption), typically 

below the figure. The figures are numbered (Arabic numerals), and the label, the 

number, and the trailing period might be in bold (flush left), followed by the title, 

either in regular or italic title case (APA 2020, 7), which is capitalized sentence-

style (APA 2020, 227; CMOS 2024, 155). Nevertheless, the same source adds that 

titles of works mentioned or cited are “usually capitalized in headline style” 

(CMOS 2024, 568). As titles are mostly incomplete sentences, no punctuation is 

needed to finish the caption (CMOS 2024, 143), but their content should be 

specific enough. 

Captions of figures and tables are considered to be exceptions to paragraph 

indentation, as figure and table numbers should be flush left and their font size is 

smaller than the main text, while their length is ideally shorter than “half a basic 

column” (Spiekermann 2013, 161). 

A list of figures or illustrations may be placed after the table of contents (Word: 

References, Insert Table of Figures) or as an appendix, relying on various formats, 

visible in Figure 103: 

 
179 https://support.apple.com/en-us/102646, June 8, 2025. 

https://support.apple.com/en-us/102646
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Figure 103. Insert table of figures, Word 

Subsequent reference to figures makes use of the figure number and label, 

with or without the title. The term figure or Figure should not be abbreviated, 

except for parenthetical uses (fig.). Abbreviations in figures should be either 

consistent with the ones used in the text or defined in the title, legend, or key 

(AMA 2020, 163), and the words percentage and number may be abbreviated as % 

or No., respectively (APA 2020, 227). 

The legend or key explains the “symbols, line styles, or shading or pattern 

variants used in the image portion of the figure,” and they are placed either “within 

or below the image” (APA 2020, 229). Furthermore, figure notes may accompany 

the figures, which may complete them with general (abbreviations not found 

elsewhere, acknowledgement, source, copyright, color, design elements), specific, 

and probability information. Sources may be referred to in a so-called “credit line” 

(CMOS 2024, 149–50), which may be in parentheses or in a different typeface. 

Photographs of identifiable people might also require permission. The creator of a 

commissioned work should also be mentioned in the credit line out of 

“professional courtesy” (CMOS 2024, 152). In a similar vein, figures or images 

created with artificial intelligence (from now on, AI) software should be specified 

with the date of creation. 

In case figures need accompanying text, these should be in “sans serif fonts 

that are large enough to be read without magnification” (APA 2020, 196). Also, 

figures should be clear enough to understand them on their own, and authors 

should refrain from too much distractive decoration (APA 2020, 196). It is also 
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recommended to use original figures, but when taken from other sources, “written 

permission to reproduce it must be obtained from the copyright holder” (AMA 

2020, 137), although this may be replaced by specifying the source properly. 

Well-formed figures may be cross-referenced easily: Insert, Cross-reference 

(in Word), with various options (entire caption, label and number, caption only), 

as illustrated in Figure 104 below: 

 

Figure 104. Insert figures, Word 

Applying separate styles for captions and titles is possible with the help of 

Style Separator, discussed in 2.7. 

6.6. Text Box 

There are various options to insert text boxes in Word or Writer, offering various 

built-in styles. 

The boxes may offer layouts that break the main text, and might be visually 

more attractive for specific kind of information such as quotes, a thesis statement, 

or a description. It might also offer the introduction to a new chapter, being the 

only text area on the page. 
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Predefined text boxes are positioned automatically on the page (top, bottom, 

middle, or sides), and the sample content may be changed easily. As they are 

formatted differently, a new label may be created for them and referenced 

accordingly, with caption and number as well. Inserting a Text Box in Word is 

illustrated in Figure 105 below: 

 

Figure 105. Insert text box, Word 

6.7. Horizontal Line 

Inserting a horizontal line across the page, cell, or column makes sense when the 

content should be visually separated. While there are stylish font ornaments (see 

3.4.), a horizontal line only splits the section. 

The Horizontal Line in Word is available in the Home tab, Paragraph group, 

Borders button, and the drop-down menu offers Horizontal Line, which is inserted 

below: 

 

Writer can also insert a Horizontal Line via the Insert tab. 

6.8. Enumerations 

Enumerations are often found in longer texts, and they are separated from the main 

text by “spatial positioning and pointing, usually done with bullets, dashes or 

numerals” (Bringhurst 2004, 71), and the list should contain at least two items 
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(Sabin 2011, 463). In case they are “embedded” in a sentence, they are referred to 

as seriation or run-in lists. 

6.8.1. Seriation 

Seriation presents “a related set of key points within a sentence or paragraph” 

(APA 2020, 189), and it typically contains at least three items. While they are 

separated by commas, semicolons might also be used in case the items already 

contain commas. These run-in lists may be signaled by the following: 

1. commas; 

2. numerals, which may be italicized and either followed by a period or 

enclosed in parentheses, and items may be separated by commas; 

3. letters, which may be either enclosed in parentheses or simply followed 

by a closing parenthesis (CMOS 2024, 435), and items may be separated 

by commas (AMA 2020, 969). 

Whatever type is chosen (bullets, dashes, or numbers), a frequent issue is end 

punctuation. As explained, sentence fragments need no end punctuation, but 

complete sentences should end with proper end punctuation marks. In case there 

is a mixture of complete and incomplete sentences, their ending should be 

consistent, and the last item of any enumeration should end in a period (AMA 

2020, 448–49). 

When the enumeration or list functionally belongs to the introductory 

sentence, it is in fact a seriation; thus, commas or semicolons are needed at the 

end of each entry, and “a final period, just as you would if the sentence had no 

line breaks” (ASA et al. 2024, 2–04). 

The text after the enumeration may express another idea, in which case first-

line indentation is recommended, but if it continues the same thought as the 

enumeration, no indentation is needed (CMOS 2024, 74). 

6.8.2. List Style 

All lists should have their special style. The two primary styles should be for 

bulleted and numbered styles, but further styles may be created to include dashed 

or lettered lists alike, paying attention to the separation of lists from the main text 

above and below, as well as to their indentation, knowing that to make them 

visually distinctive, a minimum of 0.5 in or 1.27 cm of left indentation is 

necessary. 

6.8.3. Bulleted List 

Except for seriation, the other types of enumeration need a specific style, and how 

they are introduced, their end punctuation, and the text following them should be 

discussed. 
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As for their introduction, a “grammatically complete sentence” (CMOS 2024, 

436) ending in a colon is the standard way, and short items may be set in two or 

more columns. 

While major text editors typically offer pre-formatted styles for bulleted and 

numbered lists, their format may be changed, or new multilevel lists or new list 

styles might be defined. Furthermore, the bullet icon may be changed to another 

symbol (such as arrows or ticks). The basic idea of every bulleted, dashed, 

numbered, or lettered list is the left indent and hanging indent (CMOS 2024, 74), 

and a right indent is also recommended. Adding shortcut keys to each list style 

will boost productivity as well (e.g., Alt+B for a bulleted list and Alt+Shift+3 for 

a numbered list). 

Inserting a built-in bulleted list in Word is simple: on the Home tab, there is 

a three-bullet icon in the top left corner of the Paragraph group. A click on it 

inserts a pre-formed style, while these settings may be changed by clicking on the 

drop-down arrow next to the icon.180 

In case the bullet items are full sentences, they should start with an uppercase 

letter and end in a sentence-end mark, while sentence fragments start with a 

lowercase letter (except for proper names) and may end with a semicolon or 

nothing, except for the last one, which ends in a period (AMA 2020, 969; CMOS 

2024, 454). Another source favors the lack of punctuation after the bulleted items, 

including the last one as well (APA 2020, 190), especially when “the items are 

shorter and simpler.” 

The difference between bulleted lists and numbered lists is visible: while 

bulleted lists lack the importance of order (hence it is also referred to as unordered 

list), chronology, or priority in a series, numbered or lettered lists typically involve 

the importance of ordinal position (APA 2020, 190). 

6.8.4. Dashed List 

Interestingly, while Bringhurst mentions the dashed list, no other sources specify 

it, except for a Romanian one, which explains that em dash (—) may be used for 

listing items, in which case the items should be separated by semicolons (EC-DGT-

RO 2021, 10). 

Creating a dashed list is simple, as a line starting with a hyphen followed by 

a space is interpreted as the start of an automatic bullet list. Naturally, a hyphen 

may be replaced by an en dash (U+2013) or em dash (U+2014), but when they are 

followed by a space, they are also turned into an automatic list, and if this is not 

desired, the Ctrl+Z shortcut reverts the automatic change. 

 
180 https://tinyurl.com/yj9phuvc, June 20, 2025. 

https://tinyurl.com/yj9phuvc
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6.8.5. Numbered List 

Inserting a numbered list in Word is similar to the insertion of a bulleted list: it is 

the second top left icon with the vertical numbers 1, 2, and 3 in the Paragraph 

group on the Home tab. In case the pre-formatted list style is not suitable, this may 

be changed by clicking on the drop-down arrow, which reveals various number 

formats (Arabic, Roman, lettered), but further number formats are also available 

(Define New Number Format). 

The standard numbered list uses Arabic numerals followed by a period, not 

enclosed by parentheses, and not followed by a closing parenthesis (APA 2020, 

190), with capitalized first letter of each item, and sentence-end punctuation is 

only needed in the case of full sentences. 

The layout of bulleted and numbered entries is similar: the runover lines 

should align with the first word after the bullet or numeral, which are typically 

separated by the text with a tab (CMOS 2024, 438). 

6.8.6. Lettered List 

Lettered or bulleted lists are recommended (APA 2020, 189) in case the items are 

phrases, knowing that lettered lists draw less attention than numbered lists. 

Lettered lists may be created by initializing a numbered list (as described 

above), and then the numbers can be easily changed to lowercase letters, enclosed 

in parentheses, followed by a closing parenthesis or a period. 

6.8.7. Outline 

Outlines might be needed when list items contain further subdivisions, in which 

case both numbers and letters may enhance clarity. 

The most elaborate list may contain seven levels. They may start with 

uppercase Roman numbers (I., II., III., IV., …) followed by uppercase letters (A., 

B., C., …), numbers (1., 2., 3., …), lowercase letters (a, b, c, …) followed by a closing 

parenthesis, numbers enclosed in parentheses, lowercase letters enclosed in 

parentheses and lowercase Roman ordinals (i, ii, iii, iv, …) followed by an 

enclosing parenthesis (CMOS 2024, 439). 

Whatever option is favored, it is of utmost importance to use them 

consistently within a list (AMA 2020, 969; CMOS 2024, 439), which includes (or 

not) the punctuation mark after the symbol (number, letter, bullet, dash, or other), 

the tabbed start, uppercase or lowercase first letter, item-end punctuation, 

indentation (first line hanging and right). In case the numbering needs more than 

one digit, it is always vertically aligned on the last digit (CMOS 2024, 439). 
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6.8.8. Sort (A–Z) 

Enumerating items offers a better visual aspect, and when they are formatted 

correctly, a subsequent rearrangement is possible with the help of the Sort 

function. 

The Sort button is also found in the Paragraph group on the Home tab, 

enabling the alphabetical or numerical order of the previously selected section. 

The selection may contain or not a header row, as illustrated in Figure 106 below: 

 

Figure 106. Sort, Word 

As the figure shows, sorting is possible either in ascending or in descending 

order, depending on the type of information. Field delimiters may be tabs, 

commas, or other symbols, which are available within the Options tab (left bottom 

corner). 

6.9. Index Entry and List 

Index entries are often required for scholarly books. An alphabetical index offers 

a list of all discussed topics in a book, and word processors can produce an 

automatic index list provided the terms are already marked. Marking them is 

possible either while drafting the text or during proofreading. 

Marking an entry for indexing purposes in Word is possible via the References 

tab, Index group, Mark Entry. This offers the possibility to insert either a Main 

entry or a Subentry with further options, such as Cross-reference or selecting 
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various pages. In case the key entry is highlighted, clicking on the Mark Entry 

already displays the term. If the Mark Entry is clicked on first, the Main entry and 

Subentry lines are empty and the proper key term must be typed. 

Once the document terms are all marked for indexing, the Insert Index button 

creates the list, once again offering various formats (e.g., Classic, Fancy, Modern, 

Bulleted), number of columns or page number position. 

While a multilevel table of contents can offer an insight into major topics, an 

Index list can pinpoint every single term discussed in a document, hence it is 

positioned at the very end of books, extending over many pages. For instance, the 

AP Stylebook (57th edition) contains 80 pages of Index out of 502 numbered pages, 

which is more than 15% of the entire book (Froke et al. 2024, 423–502). 

It is also mentioned that in case more than one index is needed, they should 

be differentiated by their names, for instance “Index of Names” and “Index of 

Subjects” (CMOS 2024, 10). 

6.10. Comment 

Inserting comments might be useful when reviewing documents. This function is 

available on the Review tab of Word by clicking on the New Comment icon. 

An inserted comment box will appear on the right side of the page, indicating 

the author’s name and specifying the time of the insertion, offering space to type 

the comment. The right bottom side of the box has two further options: Reply and 

Resolve: 

 

Figure 107. Insert comment, Word 

The Comment group of the Review tab enables the user to delete the current 

or all comments, and it is possible to jump to the Previous or Next comment, as 

well as to Show Comments or hide them. 

6.11. External Hyperlink 

Inserting hyperlinks in a document is of two types: external and from another part 

of the document. 

External hyperlinks may be copied from the internet and pasted in the 

footnote section, which should be followed by a comma and date of access. Once 

the comma and the space are placed after the hyperlink, it turns into an active 

hyperlink. They may be turned off one by one with the help of a right click on the 

active link, which displays the option of Remove Hyperlink. However, a more 
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effective way is to remove all of them by pressing Ctrl+A in the footnote section 

(thus selecting all footnotes) and then pressing the Ctrl+Shift+F9 shortcut. 

A particular issue is the date. In case the footnote language is set, adding the 

date is almost automatic; after the first characters are typed, the current date is 

offered in Word, which should end in a period. 

A further type of hyperlink may direct toward a file, a place in the document, 

or an email address, as shown in Figure 108 below: 

 

Figure 108. Insert hyperlink, Word 

6.12. Link 

Certain documents might need further supporting documents, which contain proof 

or more detailed information on a particular topic. In these cases, the main 

document offers a kind of summary that unifies the bulk of links to the details such 

as the lead-in document or the final report to an accreditation file of a university 

course program. 

After stating something or offering statistics on a particular issue, a hyperlink 

to a further document with more detailed data may be inserted in Word this way: 

Insert tab, Links group, Link button, which opens a new window to look for the 

particular document. However, this is only worth doing when the referred 

document is not moved later, so the most secure option is to place it in the same 

folder with the main document. 

However, the Link button also offers the option to create a bookmark to a 

particular place within the document. 

Writer offers the same options by accessing Insert, Hyperlink, which opens a 

window with multiple possibilities: hyperlink from the internet, mail, document, 

or a new document. 
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6.13. Bookmark 

Inserting a bookmark is sensible in the case of large documents, as it offers the 

possibility to jump with the help of a hyperlink to a selected part of the document. 

Both Word and Writer make this available via Insert, Bookmark. 

As explained, inserting a bookmark in Word consists of three parts: first the 

content should be selected to which a hyperlink is inserted, followed by the 

insertion of the bookmark, then adding the hyperlink to it. This feature is logical 

when recurrent issues are discussed or a relevant part may be necessary to refer to 

further sections. 

6.14. Cross-Reference 

Cross-references enable the author to insert links to bookmarks, endnotes, 

equations, figures, footnotes, headings, numbered items, tables, or even newly 

created labels (e.g., Illustration, Photo, Picture, etc.). 

Both Word and Writer offer this option via Insert, Cross-reference, which 

opens a window where the desired type may be selected. 

 

Figure 109. Automatic update of fields before printing, Word 
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Cross-reference may contain the entire caption or only the label and number, 

which should be updated when the writing process is over, as subsequent 

insertions before any cross-reference impacts the entry number. The final update 

of cross-references should be done before creating the automatic tables: table of 

contents, table of figures, list of tables, etc., which is possible with the Ctrl+A, 

then F9 or Fn+F9 shortcut, depending on the setting of function keys. However, 

an automatic update of all cross-referenced fields is possible in Word before 

printing via File, Options (thus opening Word Options), then Display, and check 

the box next to Update fields before printing, as shown in Figure 109. 

Automatic update of fields in also possible in Writer by accessing Tools, 

Options, LibreOffice Writer, General, where the boxes belonging to Automatically 

Update (Fields, Charts) should be checked: 

 

Figure 110. Automatic update of fields, Writer 

6.15. Quotations 

Using quotations from relevant sources is indispensable in scholarly work. 

However, proper reference to other sources is vital, as the lack of it leads to ethical 

issues such as plagiarism, discussed in Section 12.1. 

Quotation marks should not be used to signal “common expressions or figures 

of speech (including slang),” as their basic function is to specify the beginning and 

end of “phrases borrowed verbatim from another context” (CMOS 2024, 465). 

Proper quoting from other sources should always be signaled by opening and 

closing quotation marks, whose position depends on the selected language: AmE 

uses double quotation marks, both above the line (“…”), while BrE uses single 

quotation marks in the same manner (‘…’). Non-English languages might have 

different ways to signal quotes, such as Romanian and Hungarian („…”). 

As for their form, all quotation marks should be smart (not straight), and no 

space is used between the opening quotation mark and the first word and between 

the last word and the closing quotation mark. While sources explain that the 
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punctuation mark is inside the quotation marks only if it is part of the quotation 

(APA 2020, 271), the reality shows that AmE inserts sentence-end punctuation 

marks (periods, commas, question marks) before the closing quotation mark, while 

BrE the other way around. However, footnote reference numbers come after the 

closing quotation mark. 

Quotations no longer than two or three lines may be embedded in the main 

text, their start and end are signaled by double quotation marks, and this typically 

means “fewer than 40 words” (APA 2020, 271). In this case, parenthetical 

quotations are standard, which means that the author(s) and the year of publication 

are in parentheses, and more detailed quotation references should include page 

number(s) as well. Narrative citations embed the name of the author in the main 

text, while the parenthesis only contains the year and page number. A special case 

is when the source is referenced in another work (secondary source), in which case 

the author and year is specified, followed by the “as cited in” phrase, completed 

with the author and year (and page) of the work containing the secondary source. 

While short mottoes, signs, or notices might be “capitalized in title case in 

running text,” longer notices should be treated as quotations (CMOS 2024, 465). 

Foreign words or phrases are quotes per se, yet they tend to be “italicized and 

only the first word capitalized” (CMOS 2024, 466). 

Other types of quotations may be pullout quotes, longer quotes (block quotes), 

or scare quotes (a word or a phrase with different meaning), detailed in the 

following sections. 

6.15.1. Pullout Quote 

Pullout quotes are brief, and capture the attention of the reader by their 

emphasized form: “usually bolder and larger than the original text, used to 

emphasize content, improve design, or fill white space” (AMA 2020, 1141). 

Thus, the use of pullout quotes may be justified when an extremely important 

piece of information is quoted or the exact wording is relevant. While it is not 

specified, the author of the pullout quote should be clear, mentioned either in the 

main text or at the end of the pullout quote. 

6.15.2. Manual Citation 

The length of a citation is often restricted to the minimum necessary. As such, it 

may happen that one particular word is quoted, while in other cases more than 

two or three lines. 

The APA style recommends that a quotation longer than 40 words should be 

treated as a block quotation (APA 2020, 272), which means that this part is visually 

separated from the main text by extra spaces above and below (or double space), 

and the text of the quotation is typically indented from the left margin. In this case, 

no quotations marks are used, and various sources recommend smaller font size 
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compared to the main text. A block quotation is referred to in the previous 

sentence of the main text, usually followed by a colon. 

The author of the citation may be used in the narrative part, or may end the 

quotation in parentheses, which is not followed by a period (APA 2020, 272). 

As it is a word-for-word citation, nothing is changed or “improved” in the 

original wording (CMOS 2024, 432), and in case the quotation contains a spelling 

or factual mistake, the Latin word [sic] (meaning ‘thus’) should warn the reader 

about it, which is italicized (CMOS 2024, 463; 2024, 766), without resorting to this 

possibility too many times. 

The serious drawback of manual citations is that after the closing quotation 

mark the source should be typed manually in parentheses (author, year, and page 

number), and special care must be paid to note somewhere that this source is used 

and offer the details in the References section at the end of the document (author, 

year, title, edition, publishing house, place). Knowing that the order of referenced 

items might be different depending on the reference style, and a manual change of 

both in-text quotation sources and references is an aching task, this is not 

recommended for books, as the sheer number of references might lead to errors. 

6.15.3. Zotero Citation 

While manual citation is prone to errors (the quoted source may be left out from 

the references or the references may contain entries which were erased from the 

main text during the writing process), various applications are available to deal 

with them. 

Our recommendation in this respect is Zotero, which is a free application 

(“Your personal research assistant,” according to their slogan), and it can be 

embedded in both Word and Writer upon installation, available for any operation 

system. It is in fact a frame for a database of sources, offering various built-in 

source types (e.g., book, book section, journal article, manuscript, thesis, etc.) with 

proper accompanying details for each source, which may be organized in folders 

and subfolders. 

Zotero also has extensions for browsers, and once installed, it can directly 

export the details of a source from specific websites, such as Amazon or major 

publishing houses, as all sources must be added to the database first and then may 

be referred to while drafting the text. 

However, before the first use of the reference, its details should be checked in 

the Zotero database, as it may happen that they are not retrieved correctly or in the 

proper slot. 

The embedded Zotero tab offers six options needed to handle Zotero while 

typing the text, displayed in Figure 111: 
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Figure 111. Zotero tab, Word 

1. Add/Edit Citation, which—being the most frequently used—might be 

added to the Quick Access Toolbar in Word; 

2. Add/Edit Bibliography, which is the huge advantage of this type of 

software, as it can insert the entire bibliography used in a document where 

the cursor is placed, in alphabetical order; once inserted, it can 

automatically update the list in case further work is referenced in the main 

text or deleted, in which case it disappears from the list; 

3. Insert Note at the current cursor position; 

4. Document Preferences, which offers major reference styles (e.g., APA, 

ASA, CMOS, Elsevier, IEEE, MLA, or Nature), with the possibility to add 

further ones, as well as to change the style format of the entire document 

at any time; 

5. Refresh, which can check manually changed entries and update or correct 

them; 

6. Unlink Citations, which cuts the live links of the document with the 

Zotero database, so no subsequent change will update in the references 

section in case new entry is placed in the main text; this feature may be 

useful when the final version of the document is sent for publication. 

While drafting the text, the Zotero application must be opened, where the data 

can be retrieved from and new entries might be added to. New entries may be added 

automatically from the website in case the Zotero Connector is downloaded and 

activated for the particular web browser and it has access to the selected site. If 

access is granted, different Zotero icons become active, depending on the type of 

source (e.g., book, book section, journal article, etc.), and a click on the icon saves 

the entry into the Zotero database in the folder which is currently open in Zotero. 

6.15.4. Scare Quotes 

Scare quotes warn the reader that the standard meaning of the word or phrase is 

altered, so it is intended to be metaphoric, doubtful, or ironic (often the opposite 

meaning). 

In these cases, the quotation marks express that “This is not how the term is 

usually applied.” (CMOS 2024, 464-65), but they might be used only sparingly. In 

case the term so-called is placed before the word or phrase in question, the 

quotation marks are not necessary (CMOS 2024, 465). 
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6.15.5. Quotation Style 

Documents containing quotations should have a separate quote style, which may 

stem from the normal style. 

A separate quote style may format pullout quotes (formatted as desired, as per 

discussed above in Section 6.15.1.), while block quotations may be indented from 

the left and right margin alike (typically 0.5 in., or 1.27 cm, but no more than 1 in., 

or 2.54 cm). 

6.16. Automatically Generated Lists 

When discussing how to insert index entries (see Section 6.9.), inserting the Index 

List was already described. 

Further lists may be inserted in case the document is created accordingly: a 

table of contents, a list of tables, and a list of figures or illustrations. Furthermore, 

with the help of Zotero, a list of references is also possible to generate (see Section 

6.15.3.). 

6.16.1. Table of Contents 

Longer documents with various headings and page numbers typically have a table 

of contents (TOC). Shorter student papers might also have a table of contents, 

considering that even presentations tend to have one. 

The presence of a well-formed table of contents displays professionalism—

Bringhurst considers that an incomplete or a missing table of contents “is usually a 

sign of typographic desperation or of disregard for the reader” (Bringhurst 2004, 73). 

Inserting a table of contents is usually at hand. In Word, this is available in 

the References tab, the first group: Table of Contents, and the button subtitled 

similarly. This inserts a table of contents where the cursor is placed, offering 

various built-in table formats (e.g., From template, Classic, Modern, etc.), which 

may include or not the page numbers (they should be included); pages may be 

right-aligned, and the number of levels (Heading 1, 2, 3, 4) may also be set. 

Once the table of contents is generated, the combination of the Ctrl key and a 

click on a particular heading should position the cursor to the particular heading 

in the main text. However, while creating the table of contents, there is a Web 

Preview option, which turns all headings into hyperlinks: 
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Figure 112. Table of contents, Word 

While Anglo-American books place the table of contents at the beginning of 

books, Romanian and Hungarian books have it at the end. 

There are cases when bilingual table of contents is needed, in which case the 

original-language table of contents must be copied, translating the headings in the 

desired language. When ready, the style of the original table of contents should be 

applied to it, and then a new style should be created on the translated headings, 

after which the new table of contents can be created with the new style. 

6.16.2. Table of Figures 

Inserting a table of figures is typically required when more than ten figures are 

included in the document. 

As in the case of table of contents, inserting a table of figures is available in 

Word via References, and in the Captions group a click on Insert Table of Figures 

will open a window with similar setting options as in the case of table of contents: 

showing or not page numbers, right alignment or not, various style formats, with 

or without labels or the use of hyperlinks instead of page numbers, as illustrated 

in Figure 113: 
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Figure 113. Table of figures, Word 

6.16.3. List of Tables 

In case there are more than ten tables, a list of tables might be inserted as well. 

While the table of contents is front-positioned (after the title pages and possible 

introduction or foreword), the table of figures and the list of tables may be 

positioned either after the table of contents or in the Annexes section at the end of 

the document. 

Inserting a list of tables starts in the same way as inserting a table of figures, 

and once the corresponding window appears, the Caption label must be changed 

to Table. 

6.16.4. References 

References may be inserted manually when drafting the text, paying attention to 

the desired style and type of reference. 

While manual insertion (typing) requires a lot of time, attention, and effort, a 

bibliographic management software can effectively speed up the process, not to 

mention that the style may be changed automatically at any time, and it reduces 
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the risk of omitting references or not formatting them in the same style. As 

specified before, our recommendation is Zotero, which also provides 

documentation and support for proper use.181 

Relying on a reference manager will also enable the user to insert (generate) a 

list of bibliographic items instantly, in alphabetical order, as well as to create a 

database that may be reused for other documents or shared with fellow researchers. 

After having a reference list inserted, it is worth checking its format, as the 

entries should have a hanging indent of 0.5 in., or 1.27 cm. 

6.17. Object 

There are cases when multiple documents need to be merged into a single one, for 

instance the transcripts of various episodes of a season in the case of TV shows. 

A possible option is to open a new document and then click on the drop-down 

arrow of the Object button found in the Text group on the Insert tab (Word). This 

reveals the Text from file option, triggering a new window, where we can search 

for the file. After locating the document, a click on the file name and then the 

Insert button will copy and paste the entire content of the document, starting from 

where the cursor is placed. 

In case the source document format is different, a click on the Object button 

displays further options such as spreadsheet or presentation formats. While Word 

offers insertion from OpenOffice document formats as well, this is not 

recommended due to formatting differences. Instead, these documents should be 

opened in LO or OpenOffice, saved in a native MSO format, and inserted into the 

desired Word document as an Excel file or a PowerPoint presentation. 

Writer offers similar options by accessing Insert, Text from file. However, this 

inserts text from text-based files (both DOCX and ODT formats), while inserting an 

OLE Object enables the user to insert content from spreadsheet (Calc or Excel) and 

presentation (LO Impress or PowerPoint) document files. 

In case we wish to merge various types of documents into one, there are online 

applications to support this, although this entails that those documents are first 

fully uploaded, and so their content might become available for unintended 

public.182 

6.18. Appendix 

Scholarly work may contain various types of appendices, positioned at the end of 

the document. 

 
181 https://www.zotero.org/support/, June 25, 2025. 
182 https://ilovemerge.com/word, https://products.fileformat.app/word-processing/merger/docx, June 
27, 2025. 

https://www.zotero.org/support/
https://ilovemerge.com/word
https://products.fileformat.app/word-processing/merger/docx


6. Insert  ◼  233 

It is prescribed that the appendix title appears recto, while the Appendix 

appears verso (CMOS 2024, 10), which might contain accompanying databases to 

the main text, transcripts, or summarizing tables. 

6.19. Signature Line 

Both Word and Writer offer the possibility to insert a Signature Line via the Insert 

tab, which creates a text box as seen in Figure 114: 

X

 

Figure 114. Signature line 

6.20. Symbols and Special Characters 

There are thousands of symbols not available directly from the keyboard, which 

may be inserted in multiple ways. 

In case the symbol is frequently used, it is worth memorizing its Unicode or 

Alt Code value. For instance, the value for the circled number 1 is U+2460, which 

might be faster to type than first looking for this symbol under the Insert tab, 

clicking on the Symbol icon, and then searching for it, as not all font families 

contain the symbol ①, leading us to the second option, which is looking for it in 

the Symbols with various subsets (e.g., Greek). 

A third option is look up the symbol on the internet and download it as a 

symbol, while a fourth option is to find the symbol anywhere and take a screenshot 

of the icon, in which case it is an image in fact. 

Some of the symbols and special characters are widely used and accepted in 

specific text types, while others have specific use such as musical or mathematical 

symbols, not discussed in the present work. 

6.21. Date and Time 

Inserting date and time is available in all major word processors, including texts, 

spreadsheets, and presentations. 

If the language is properly set, the date format specific to that language may 

be inserted, which is rather different in the case of AmE and BrE. As known, AmE 

uses the Month-Day-Year format, where the year is separated by a comma, while 

BrE relies on the Day-Month-Year format without commas between them. 

Romanian date format is similar to BrE (EC-DGT-RO 2021, 25), specifying that 
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single-digit figures may not be preceded by a leading zero in the case of dates. Both 

English and Romanian use capitalized month names, while this is not the case in 

Hungarian, which uses the Year-Month-Date format, without capitalized month 

names. However, online transactions requiring the validity of credit cards seem to 

be unified, requiring MM/YY, that is two digits for the month and the last two 

digits for the year. Nevertheless, the standard abbreviations for months in English 

are: Jan., Feb., Mar., Apr., Aug., Sept., Oct., Nov., and Dec., while May, June, and 

July “are never abbreviated” (ASA et al. 2024, 2–08). 

In case only Arabic numerals are used in the date format, certain sources 

specify the presence of periods between the units with or without space, while 

others rely on slashes or even dashes between them. 

Manuals recommend that the months should be spelled out unless they are in 

a table cell, and American sources use 12-hour time format accompanied with the 

small capitals AM and PM, although all possible combinations might be used (am, 

a.m., AM, A.M.).183 Capitalized versions are more formal, and they should be 

preceded by space.184 The Wikipedia guide regarding time is rather lenient,185 

explaining that “both the 24-hour and 12-hour notations are used in the United 

Kingdom,” although the 12-hour format is more common, while legal documents 

favor the 24-hour format. 

A further note is that the American time format uses colon between the hours 

and minutes (The Washington Post, The New York Times), while some British 

publications prefer the period (dot), recommended by Oxford publications and 

prestigious newspapers (The Guardian or The Times), although the BBC uses the 

colon. Furthermore, military time uses the 24-hour format without colons or 

period (1530 instead of 3:30 PM). 

Units of time may be abbreviated this way: min for minute, h for hour, d for 

day. While the 2021 version of a handbook accepted wk for week, and yr for year, 

the newer version states that week, month, and year should be spelled out (ASA et 

al. 2024, 7–06). 

Inserting date and time in Word is possible via the Insert tab and the Date & 

Time button, which offers multiple formats and the possibility to select the 

language as well, with subsequent automatic updates. Writer can do that via the 

Insert tab and then Field, which offers fixed and variable date and time formats. 

Spreadsheet files (both Excel and Calc) can insert the current date in a single 

cell with the Ctlr+; shortcut, while Ctrl+Shift+; inserts the current time. If both 

are needed in the same cell, a space or a comma and space might separate them. 

PowerPoint presentations have the option to insert the date on any slide 

where the author wishes (Insert, Date & Time) or set it in the Footer, which may 

 
183 These are Latin abbreviations for Ante Meridiem ‘before noon’ and Post Meridiem ‘after noon’. 
184 https://brians.wsu.edu/2016/05/16/am-pm/, June 25, 2025. 
185 https://en.wikipedia.org/wiki/Date_and_time_notation_in_the_United_Kingdom, June 25, 2025. 

https://brians.wsu.edu/2016/05/16/am-pm/
https://en.wikipedia.org/wiki/Date_and_time_notation_in_the_United_Kingdom
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be automatically updated to the current date. LO Impress documents can insert the 

date and time similarly to the way Writer does: Insert, Field, fixed and variable 

Date and Time, or setting it in the Footer section. 

If needed, time zones may be added (e.g., Eastern European Time or its 

abbreviated form, EET). 





Chapter 7   

Modifying the Text 

7.1. Find and Replace 

After browsing through inserting options, it is important to check the find and 

replace options of word processors. 

7.1.1. Navigation Sidebar 

7.1.1.1. Navigation Sidebar in Word 

On opening a Word document, it is worth enabling the Navigation sidebar with 

the Ctrl+F shortcut, which appears on the left side by default. This sidebar offers 

a convenient search option bar, containing three more options (Headings, Pages, 

and Results): 

 

Figure 115. Navigation pane, Word 

The Headings tab displays the structure of the document by showing all the 

headings in a hierarchical organization. This way the required chapter or 

subchapter is easy to find. Furthermore, there are multiple options to add or delete 

headings, as well as to expand or collapse the view and choose Heading Levels to 

show from All to Heading 9: 
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Figure 116. Expand, collapse, show heading, Word 

The Pages tab changes the view to display a miniature version of the pages, 

where scrolling in much faster—and this view offers an idea about page layout as 

well. 

The Results tab makes sense when a string of characters is searched for, as it 

can display the results if no more than 99 matches are found. In this case, the 

results are listed, and a single click on any of them positions the cursor to that 

particular part in the document. 
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7.1.1.2. Navigator Sidebar in Writer 

Triggering the navigation sidebar (Navigator) in Writer is available via View, 

Navigator, or by pressing the F5 function key, which opens a vertical window on 

the left side of the document, offering many options and categories: 

 

Figure 117. Navigator, Writer 

The available buttons enable the user to jump to any heading, header, or 

footer, as well as promoting and demoting levels. Furthermore, it offers categories 

to explore, such as tables, images, hyperlinks, comments, footnotes, or endnotes, 

and in case multiple documents are opened, there is the possibility to switch from 

one document to the other, as all of them have one unified Navigator, listing active 

and inactive documents. 

7.1.2. Complex Find and Replace 

More complex Find options may be carried out with the Ctrl+H shortcut, upon 

which a new window pops up: Find and Replace. This possibility is important 

when multiple character strings are to be found in large documents and need to be 

replaced. In this case, the Find what bar should contain the original character 

string, while the new version is typed in the Replace with bar. 
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Although this is suitable for character strings, the More button in Word offers 

more complex options, such as Match case (this might be important when 

uppercase and lowercase strings should be differentiated), Find whole words only, 

or Use wildcards. 

The Ctrl+H shortcut in Writer opens a window containing many possibilities, 

including Regular expressions instead of Use wildcards, and offering further 

options as well. 

7.1.2.1. Find and Replace in Word 

Ticking the Using wildcards box enables the user to make non-text-based 

operations. For instance, in a selected fragment, it is possible to change paragraph 

breaks into line breaks if we type a caret and letter “p” (^p) in the Find what bar 

and a caret and letter “l” (^l) in the Replace with bar. 

 

Figure 118. Find and replace, Word 
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Further possibilities are listed in Table 20 below, but before carrying out these 

operations, the Use wildcards box must be selected:186 

Table 20. Complex find and replace, Word 

Action Find what Replace with 

Find any digit (and 

remove) 
[0-9]  

Find one- or two-digit 

numbers (and remove) 
([0-9]{1,2)  

Find all 4-digit 

numbers 
([0-9]{4}*)  

Find at least 2 

consecutive capital 

letters 

[A-Z]{2,}  

Find words longer 

than 10 characters 
[A-Za-z]{10,}  

Remove double space Type two spaces. 

Type one space. 

(Press the Replace 

All button at least 

once or until 0 

replacement is 

carried out.) 

Remove characters 

within brackets 

depending on the type 

of brackets 

\(*\) 

\[*\] 

\{*\} 

\<*\> 

 

 

Remove characters 

within any bracket 

type 

(\[*\])|(\{*\})|(\(*\))|(\<*\>)  

Bold characters within 

brackets 

\[*\] 

\(*\) 

Click Format, 

Font, Bold 

Bold all uppercase 

words 

([A-Z]{2,}) 

Tick Match case 

$1 

(Click Format, 

Font, Bold.) 

Reversing currency 

symbols, adding space 
$([0-9.,]{1,}) \1^s$ 

 
186 http://translationjournal.net/journal/15msw.htm (2001), June 27, 2025. Many thanks to Tibor 
Környei for this invaluable source of information. 

http://translationjournal.net/journal/15msw.htm
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Action Find what Replace with 

Reversing currency 

symbols, changing to a 

word 

$([0-9.,]{1,}) \1^sdollars 

Change currency 

symbol after the 

number before the 

number 

([0-9]) ([0-9]) \1^s\2, then 

([0-9])[ ^s]$ 

(space before caret) 
\1$$ 

([0-9.,^s]{1,})$$ $\1 

Replacing and 

reverting Section sign 
([0-9]{1,}).[•^s]§ Section^s\1 

Changing the 

separator comma in 

English numerals to 

non-breaking space 

format 

([0-9]),([0-9]) \1^s\2 

Changing the decimal 

comma of non-English 

numbers to English 

numerals 

([0-9]),([0-9]) 

\1.\2 

(Change to 

decimal point.) 

([0-9])^s([0-9]) 

\1,\2 

(Change non-

breaking space to 

comma.) 

Changing both non-

breaking spaces and 

regular thousands 

separator 

([0-9])[•^s]([0-9]) \1,\2 

 

Further options might be considered: for instance, the opening and closing 

arrow brackets (< and >), which “specify that you want a single whole word, not 

parts of a word.”187 

7.1.2.2. Find and Replace in Writer 

Generally, all basic and advanced find and replace functions available in Word are 

also available in Writer, presumably. 

Advanced functions entail that the box in front of Regular expressions is 

selected. 

 
187 https://tinyurl.com/449vbenu, June 27, 2025. 

https://tinyurl.com/449vbenu
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Figure 119. Find and replace, Writer 

However, the syntax to induce similar results will probably be different in 

Writer. For instance, a paragraph mark may be replaced by space if the Find line 

contains a dollar sign ($), while the Replace line contains a space. A new line 

created with the Shift+Enter combination is found with a backslash followed by 

letter “n” in the Find bar (\n), which may be replaced with a paragraph mark in 

the Replace bar—interestingly—with the similar characters (\n).188 

Uppercase words may be changed to bold by typing [A-Z]{2,} in the Find bar: 

the Match case needs to be selected, then $1 is typed in the Replace bar, formatted 

as bold, and the Current selection only may be selected or not. 

7.1.3. Find in Other File Formats 

There are further file formats containing texts, and the standard shortcut to look 

for character strings in them is Ctrl+F. 

 
188 https://tinyurl.com/3saeh62w, June 27, 2025. 

https://tinyurl.com/3saeh62w
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Finding chunks of texts is possible in various file formats, such as .pdf,189 .txt, 

.rtf, .wpd, .pages, .html, as well as spreadsheets, knowing that .pdf or .html file 

formats display only the found character strings and—depending on the PDF 

application (see Chapter 0)—can count the number of occurrences, while other 

formats offer the possibility to modify them (add, change, or delete). 

7.2. Delete and Remove 

Word processors in Windows and Linux OS may rely on both the Backspace and 

Delete keys to delete text fragments in an open document before or after the cursor. 

MacBook keyboards have either a Backspace or a Delete key (depending on 

the model) to erase characters to the left (sometimes a backward arrow), which 

may be combined with the Fn (Function) key to turn it into a delete or backspace 

key to delete characters to the right. 

However, further types of erasures are possible, depending whether a 

particular document is open or not. 

7.2.1. When the File Is Open 

In case the document is open, the entire content may be deleted: Ctrl+A selects 

the entire main text, and then the Delete key erases it, except for the elements in 

the header and footer. 

Various parts of an open document may also be deleted, with the 

understanding that anything inserted in a document may be erased: 

1. parts of a document before or after the cursor with the help of specific 

keys (Delete and Backspace); 

2. table rows and columns: 

3. if the cursor is placed on the left side of the row, a click highlights the 

particular row in grey and the Ctrl+X shortcut removes the row; if needed, 

the Ctrl+V shortcut may place it elsewhere; in case only the cell contents 

should be deleted, the Delete key is pressed; 

4. if the cursor is placed above the top of a particular column and changes 

to a black down arrow, a click selects the particular column and the 

Ctrl+X shortcut removes the column; if needed, the Ctrl+V shortcut may 

place it elsewhere; in case only the cell contents should be deleted, the 

Delete key is pressed; 

5. entire tables may be removed if the cursor is placed in the top left corner, 

until the cursor changes to a four-sided arrow; a click highlights the entire 

table in grey, and Ctrl+X deletes the entire table; in case only the cell 

contents should be deleted, the Delete key is pressed. 

 
189 This refers to searchable PDF files. 
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6. hyperlinks may be removed individually by a right click on the link and 

selecting Remove Hyperlink; 

7. in case all hyperlinks need to be removed, first the entire document needs 

to be selected (Ctrl+A), and then the Ctrl+Shift+F9 shortcut erases all the 

hyperlinks in the document, preserving the characters; 

8. hyperlinks in the footnote may be selected as well by placing the cursor 

anywhere in the footnote, then Ctrl+A (which selects all footnotes), and 

Ctrl+Shift+F9. 

9. footnotes may be deleted by selecting the footnote number in the main 

text and deleting it; 

10. comments in a document may be deleted one by one: a right click on the 

comment will offer the Delete Comment option; however, all comments 

may be deleted at once: in Word, the Review tab contains a Comments 

group, within which a click on the drop-down arrow reveals this option, 

illustrated in Figure 120 below. 

 

Figure 120. Delete all comments in a document, Word 

Other types of erasures involve the selection of a particular part of the text 

first. Double click in a word selects the entire word (highlighted in grey in Word 

and light blue in Writer), after which it may be deleted with the Delete or 

Backspace keys. 

A triple click in the text selects the entire paragraph in Word, while it selects 

the entire sentence in Writer; a rapid sequence of four clicks in Writer selects the 

entire paragraph. After that, the highlighted part may be deleted with one of these 

two keys: Delete or Backspace. 

A more radical delete option requires to hold down the Left Alt key, and while 

dragging the cursor, a rectangular text block is highlighted that might be deleted. 

This works in both Word and Writer. 
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Another option is to hold down the Ctrl key, position the cursor to the left 

side of the text until it displays an I-beam, after which the dragging selects the 

adjacent lines.190 Once lines are selected, while still holding down the Ctrl key, the 

cursor might be moved to the end of a line, and dragging it backwards may deselect 

parts of the selection, even across lines. 

It may happen that the entire formatting of a text should be cleared. Once the 

entire text or part of it is selected, Word offers a Clear All Formatting button on 

the Home tab, Font group. A similar button is found on the main toolbar in Writer 

called Clear Direct Formatting, and Ctrl+M is the shortcut for that. 

 

Figure 121. Clear all 

formatting, Word 

 

Figure 122. Clear direct 

formatting, Writer 

While these buttons will clear or delete major formatting, such as bold, italics, 

or indentation, some formatting types are outside this range: heading, footnote, or 

table form. 

Copying the content of a document into another document may also rely on 

getting rid of the original formatting. This is possible after copying the text, and 

before insertion, a right click where it should be inserted offers the Keep Text Only 

option in Word or the Paste Special, Unformatted Text option in Writer. 

7.2.2. When the File Is Closed 

The delete or remove options are simpler when the document (file) is closed. 

In the majority of cases, the contents of a file cannot be altered unless the 

registry setting is modified or relying on a Visual Basic (VB) code, neither of which 

are intended for regular text writers. 

A right click on a closed file on Windows OS offers to check its Properties, 

some of which might be deleted by accessing the Details tab and clicking on 

Remove Properties and Personal Information at the bottom of the window. This 

opens another window, and thus certain information, such as the author, last saved 

by, revision number, or content type, might be removed. This might be carried out 

when the reviewer of an article wishes to remain anonymous to the author. 

Selecting the file title with a single click followed by pressing the Delete 

button is enough to place (purge) the document in the Recycle Bin (Windows OS), 

 
190 In case the Ctrl key and mouse click selects the entire text, it means that the cursor is not close 

enough to any line, displaying a northeast-pointing white arrow. 
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Rubbish Bin, Trash (Linux OS), or Trash (macOS). The macOS option is to select 

the document and press the Command+Delete keys. 

All operating systems offer to delete the document with the help of a right 

click, which offers the Delete option. A right click on the document on a MacBook 

also offers the option to Move to Trash. A third option is to drag the document to 

the bin directly. 

However, files may be recovered from the bin by opening it, and a right click 

on a file offers the Restore option. The other option is to empty it from the bin as 

well, in which case it is not recoverable any more, as it disappears from the disk. 

A more direct way to delete the file from the disk is with the help of the 

Shift+Delete shortcut, which offers no more chance to recover the file. Yet, there 

are dedicated data recovery software offering various file recovery potential, such 

as EaseUS, Stellar, DMDE, or Recuva, some of which have free versions and are 

cross-platform. 

The Restore and Empty the bin options may refer to all the files in the bin 

when all of them are selected. 

7.3. Review 

Quality assurance while drafting a text entails proper layout, formatting, and 

spelling alike, which might be completed with Review. 

A thorough review should spot all the typographical errors (mistyped 

characters) as well as atomic typos (correct words in improper context). 

While we can distinguish layout errors (visible in open documents) from 

typographical ones (visible in printed format), neither of them are accepted. Once 

layout is configured, text editors must check the language of the document, and 

the reviewing phase should rely heavily on the Review tab options. 

The Review tab in Word contains Spelling & Grammar, Language 

preferences, inserting New Comments, or deleting them one by one or all at once. 

Proofreading in any language should include spelling errors, word breaks 

(hyphenation), capitalization, typeface, font style and size, numbers in the main 

text, page numbers, caption numbers, heading numbers, illustrations and tables, 

considering both meaning and overall appearance. 

In case changes must be carried out, the Tracking group offers Track changes, 

Accept, and Reject, which can effectively show all the changes (strikethrough and 

colors) while correcting the text. 

Writer also offers various review options: the Tools tab contains Spelling and 

Automatic Spellchecking, as well as Language Setting for a selection, a paragraph, 

or the entire document. Hyphenation and AutoCorrect are also in the Tools tab, 

while the Track Changes and Comment options are placed in the Edit tab. The 

View tab contains the Show Tracked Changes, while a Comment may be inserted 

from the Insert tab or with the Ctrl+Alt+C shortcut key. 
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A rather thorough review is often necessary when content is copied from 

another document, especially from PDF documents, as formatting is usually below 

expectations, starting from line breaks, but basically everything except for the 

characters proper. 

It is worth remembering that the review process is effectively helped by 

enabling the Show/Hide option in Word or the Toggle Formatting Marks in Writer, 

thus displaying non-printable formatting symbols as well. 
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Creating a Template 

Creating a template document is sensible when multiple documents are to be 

created in the same style or a longer document with multiple settings is needed. 

In these cases, a template document can ensure quality by providing a unified 

outlook, in which default settings are provided, including shortcuts as well.  

8.1. New Template 

A template document contains data on various setup options involving the page, 

font types and sizes for the normal text and headings, paragraph style, language, 

header, footer, footnotes, page number, or autocorrect. 

While word processors contain certain default settings for a Normal template 

(text, spreadsheet, and presentation), creating further templates is also 

recommended. 

The standard template in Word is found here: 

 

C:\Users\user name\AppData\Roaming\Microsoft\Templates 

 

However, instead of modifying this, a completely new template should be 

created by opening a document, performing all the changes needed, then saving it 

as a template with a different name to a different location. Thus, whenever a new 

document is opened, it will still show the settings of the Normal.dotm extension 

file. The new template can be easily attached to it by accessing the Developer tab 

and clicking on the Document Template, which opens a new window. This offers 

the possibility to attach any template to the currently opened document and even 

Automatically update document styles, as shown in Figure 123. 

Writer also offers a default template, and creating a new one is similar: after 

opening a new document and performing all the settings, it should be saved as a 

template with a new name: File, Templates, Save as Template. It is generally 

recommended to save our templates in the My Templates category, with the option 

to Set as default template or not. 
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Figure 123. Attaching a template, Word 

 

Figure 124. Creating a new template, Writer 
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Writers offers easy access to templates to be edited or even managed later: 

File, Edit Template, or Manage Templates. The importance of this management is 

signaled by a shortcut button as well: Ctrl+Shift+N, which triggers the following 

window: 

 

Figure 125. Creating a template in Writer 

8.2. Setting Up a Template 

Having in mind a thesis, a template should be created with the settings detailed in 

the following. 

8.2.1. Document Language 

On opening a new document, the language of the entire document should be set 

to the desired language. This includes the main text and the text in headers, 

footers, footnotes, and comments as well. 

In case multiple languages are used in the document, the most often used one 

may be the default language, whereas text in other languages should be selected 
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and set to the corresponding language for proofing purposes, even though this may 

extend from one word to a paragraph. 

8.2.2. Page Layout 

The standard Page layout is Size A4, Orientation Portrait, Margins Normal, which 

is 1 in., or 2.54 cm. In case the document is printed and bound, the left Margin 

may be set to 1.18 in., or 3 cm. 

8.2.3. Styles 

The most frequent style of a text is Normal. This is typically set in a serifed font 

family such as Times New Roman, font size 12, line spacing 1.5, set Left 

(recommended by typographers) or Justify (popular option). 

The first line of the Normal style is typically indented (0.5 in., or 1.27 cm), 

except for the first paragraph after a heading, in which case the indentation is not 

preserved, as it is obvious that it is a separate paragraph. So, the cursor should be 

placed at the beginning of the indentation, and pressing the Backspace makes the 

indentation disappear. 

The Normal style should have no spacing before and after, and the 

recommended shortcut for the template is Alt+N. 

 

 

Figure 126. Table properties,  

Word 

 

Figure 127. Table positioning, 

Word 
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In case the main text follows a table, a different Normal style should be set, 

which is identical to the Normal style, but spacing before is set to 12 points, and 

the recommended shortcut is Alt+T. The other option in Word is to select the 

entire table, then a right click triggers a drop-down menu with Table Properties; 

this offers Text wrapping on the Table tab, and changing None to Around activates 

the Positioning button; this way, the Distance from surrounding text may be set to 

the desired distance (for instance 0.4 in., or 1 cm). 

The lowest Heading style may start from the size of Normal style (12), but it 

is numbered hierarchically (containing the numbers of the higher levels it belongs 

to), and it is often italicized. 

As higher Heading styles should be visibly different from lower ones, there 

should be at least two points difference between the font sizes. While the Normal 

style belongs to a serifed font family, headings tend to be sans serif such as Arial. 

Some authors might change the color of heading, using red, magenta, or blue, 

and all headings are followed by Normal style; in case line spacing is 1, the 

following headings might be set: 

1. Heading 1 style may be Arial Bold Capitalized, 18 points, spacing 24 

before and 18 after, and page break before; the recommended shortcut is 

Alt+1; 

Figure 128 below illustrates the setting for Heading 1, as Heading 1 is the only 

heading requiring Page break before. 

2. Heading 2 style may be Arial Bold 16 points, spacing 18 before and 12 

after; the recommended shortcut is Alt+2; 

3. Heading 3 style may be Arial Bold Italic 14 points, spacing 12 before and 

6 after; the recommended shortcut is Alt+3; 

4. Heading 4 style may be Arial Italic 12 points, spacing 6 before and 0 after; 

the recommended shortcut is Alt+4. 

The main text might contain quotations; while quotations shorter than two 

lines are typically embedded in the main text, longer ones are separated from the 

main text by space before and after (at least 12 points), are indented from the left 

(0.5 in. or more), and some prefer indentation from the right as well (0.5 in. or 

more). More than that, in case the main text is 12 points, the quotation may be set 

smaller, e.g., 10 points, typically ending in the source. The recommended Quote 

style shortcut is Alt+Q. 

Illustrations, images, pictures, photographs, and figures might also be inserted 

in the document, which can be positioned center or left. Space before and after is 

recommended (12 points), and both figures and tables are recommended to be 

“announced” or mentioned before they are inserted, which—occasionally—might 

be felt redundant. The recommended shortcut is Alt+P. 
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Figure 128. Settings for Heading 1, Word 

Reference to the figure is possible either in the caption (in case it is not too 

long) or in the footnote, followed by a comma and the date of access in the format 

of the chosen language. Once a figure is inserted, cross-reference helps referring 

back to it (e.g., Figure 1 or Fig. 1). 

Tables might also need a specific style, and they might be inserted via Insert, 

Table, Insert Table (simple ones), or built-in table styles can be chosen. In case a 

simple table is inserted, the Table Design tab becomes visible in the main tab, 

which contains many Table Styles, and a separate Table Layout tab is also 

available. Similarly to figures, tables should also be “announced” beforehand, 
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according to manuals. For instance, The table below presents facts about …. The 

source of the tables should be mentioned accordingly, either in the caption or the 

footnote section, once again followed by a comma and the date of access in the 

format of the chosen language. If it is an own table, it should be mentioned in the 

text before the table, or the wording of the text should entail this logically. 

Once a table is inserted, there is no space below the table and the first Normal 

text line below it, but this may be solved, as specified above, regarding Normal 

styles. In case the table properties are modified, copying the table will preserve its 

settings, so it might be reused. 

While captions accompanying figures are positioned below them, captions of 

tables are positioned above the table. Captions, figures, and tables might be set 

center or left, depending on the requirements, but Caption style differs from the 

main text in size (e.g., 9 points compared to 12 points in Word), color (e.g., gray 

versus black) and might be italicized. The recommended caption shortcut is 

Alt+C. 

Two list styles should be added to the template: a bulleted one, which might 

rely on the pre-defined bullet list provided by word processors, checking the 

indentation and the spacing before and after (at least 12 points). The recommended 

shortcut is Alt+B. A numbered list style is also recommended with similar 

settings, and a possible shortcut is Alt+Shift+3. However, in case a subsequent 

numbered list is created, it might happen that the numbering continues the 

previous list, but a right click on the selection or the first numbered line offers the 

possibility to restart from 1. 

In case a footnote is inserted, the built-in settings are acceptable, although the 

indentation might be changed to hanging indent (0.15 in., or 0.4 cm) in case more 

than ten footnotes are expected to be in the document and they might be longer 

than a line. The recommended shortcut is Alt+F. 

8.2.4. Headers and Footers 

While a template cannot contain many possibilities regarding the content of 

headers, the Header might be set at a specific space from the Top, and it might be 

populated with various information such as the document title and chapter title 

on the first verso and recto page (see 6.1.). 

The Footer should contain the page number (centered or odd number on the 

recto and even number on the verso), knowing that the template does not contain 

the introductory pages. When these are inserted before the main text, the header 

and footer should be unlinked (see 6.1.). 

8.2.5. Summary 

A template file starts with setting the major language, Page Size A4, Orientation 

Portrait, Margin 1 in., and deciding upon the font family for Normal (serif) and 
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Heading (sans serif) styles. These may be Times New Roman (TNR) and Arial, 

respectively. 

The table below contains all recommended settings to create a template file, 

including style, font size, line spacing, alignment, spacing before/after, and 

recommended shortcuts. 

Table 21. Template recommendations 

No. Style Font Size Line 
spacing 

Align Space 
before/after 

Shortcut 

1 Normal TNR 12 1.5 Left/Center 0/0 Alt+N 

2 NormalAT 
(after table) 

TNR 12 1.5 Left/Center 12/0 Alt+T 

3 Caption TNR 
(bold/italics, 
grey) 

9 1 Left 12/12 Alt+C 

4 Heading 1 
(page break 
before) 

Arial Bold 
Capitalized 

18 1 Center 24/18 Alt+1 

5 Heading 2 Arial Bold 16 1 Left 18/12 Alt+2 

6 Heading 3 Arial Bold 
Italic 

14 1 Left 12/6 Alt+3 

7 Heading 4 Arial Italic 12 1 Left 6/0 Alt+4 

8 Quote TNR 10 1 Indent 
left/right 
0.5 

12/12 Alt+Q 

9 Table (+1 
row) 

TNR 12/10 1 Left 12/12 Alt+T 

10 Figure - - - Left 12/12 Alt+P 

11 List Bulleted TNR 12 1.5 Left 12/12 Alt+B 

12 List 
Numbered 

TNR 12 1.5 Left 12/12 Alt+Shift+3 

13 Footnote TNR 10 1 Left automatic Alt+F 



Chapter 9   

Spreadsheet Basics 

There are many books, tutorials, and descriptions on spreadsheet files, functions, 

and shortcuts for both Excel and Calc. They offer vast possibilities to handle large 

data, carry out background calculations, and combine values of various cells. 

However, since the advent of AI, there are various posts and YouTube videos 

stating, “MS Excel is dead.”, similarly to classical presentation formats to be 

discussed in the next chapter. Yet, we tend to think that classical spreadsheet tools 

are still vital in processing data, and advanced users can produce more complex 

outputs in a faster way, possibly combined with AI (generating formulas and data 

analysis), but with every single entry carefully checked. 

When creating a spreadsheet, the user should consider whether its contents 

will be printed or saved in PDF format, in which case page settings are relevant. 

Excel offers this in Page Layout, where Size, Orientation, and Margins can be set 

easily to A4, Portrait or Landscape (depending on the data), with 

Normal/Wide/Narrow margins. Calc offers the same settings via Format, Page 

Style, Page. 

Occasionally, the Header and Footer sections (divided into three parts) may 

be populated with various data such as Sheet Name, File Name, Page number, Date 

and Time, or external data may also be inserted (e.g., a logo or the name of an 

institution). 

While spreadsheets contain predefined fonts, narrower-than-normal typefaces 

are suggested by Spiekermann: Axel, Frutiger Condensed, New Gothic, or Univers 

57—“[f]or maximum legibility with added space economy” (Spiekermann 2013, 

169). However, none of them are directly available by default in Word or Writer: 
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Figure 129. Recommended fonts for spreadsheets 

Nevertheless, Arial Narrow, Font Size 10 is a built-in option in both Excel and 

Calc, which might be a very good choice to economize on space. Font-related 

settings are available in the Home tab, Font group of Excel, while Calc offers them 

in the Main tab. 

However, spreadsheets offer a Freeze option, which can block both rows and 

columns. In many cases, Row 1 or Column A needs “freezing,” as these cells 

contain information about what kind of data the other cells contain. Excel offers 

this option in View, Freeze Panes, and the drop-down menu offers to freeze the 

top row, first column or freezing the rows and columns left and top from any 

selected cell. Calc offers these options in the Main tab. The icons are similar: 

 

Figure 130. Freeze icons, Excel and Calc 

Adding data to cells (text or numbers) might be carried out manually or 

automatically, if taken from an external source. However, this only makes sense in 

case the data is organized in a way to fit into the columns and rows of the 

spreadsheet file properly. 

9.1. Populating Cells 

An initial operation in spreadsheets is to populate cells with numbers. Adding 

numbers and letters to cells is possible manually, but “automatically” filling cells 

with incrementing numbers and letters in alphabetical order is not entirely 

straightforward. 
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In the case of numbers, once numbers 1 and 2 are typed to two adjacent cells, 

selecting both cells and dragging them will auto-populate further cells with 

incremented numbers. 

Populating cells with letters in alphabetical order is more complicated in 

Excel, but possible: if cell A1 contains A, then cell A2 needs a formula: 

=CHAR(CODE(A2)+1), which places letters in alphabetical order once the cell is 

selected and dragged. 

Calc offers a different approach to incrementing letters, by accessing Tools, 

Options, LibreOffice Calc, Sort Lists. Clicking on the New button in the upper 

right corner offers the possibility to type the alphabet (one letter per line), and 

saving it (Add, OK) will result in the desired function: typing letter a in a cell, then 

selecting and dragging it will offer further letters of the alphabet and populate the 

corresponding cells. 

Naturally, cells may be populated with the help of various formulas as well 

or based on mathematical operations. 

9.2. Importing Data from Tables 

Text created in Word and Writer can easily fit into spreadsheets if they are 

formatted properly. 

A possible option is to separate data in the text with the help of the tabulator 

key (Tab), which is interpreted in spreadsheets as cells in separate columns. The 

other option is the copy of tables, whose cells fit into the cells of a spreadsheet. 

However, in case the tables contain merged cells, the content should be double-

checked after pasted into a spreadsheet, as cell alignment might be adjusted. 

9.3. Cell Alignment, Wrap, and Merge 

Cell Alignment means at least six possibilities. By default, data interpreted as text 

is aligned left, while data interpreted as number is aligned right in a cell. 

Data in a cell may be changed easily: aligned left, center, right, top, middle, 

and bottom. This is possible in Excel in the Home tab, Alignment group, which is 

completed with further options: indentation might be increased or decreased, text 

may be wrapped (Wrap Text) or in case more cells are selected, they may be 

merged and centered (Merge & Center). A final option is to change the orientation 

of the cell content: angling clockwise, angling anticlockwise, vertical, rotate text 

up, or rotate text down. 

Calc offers similar functions on the Main tab, some of which are only active 

when these tasks can be carried out. For instance, the Merge and Center button is 

only active when at least two cells are selected, in which case it offers more options 

than Excel, which can preserve the data only from one cell, offering a warning: 
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Figure 131. Merging cells, Excel 

Calc can preserve all data or discard the contents of the hidden cells, as 

illustrated in Figure 132, which is a real asset: 

 

Figure 132. Merging cells, Calc 

9.4. Handling Numbers 

As the basic idea of spreadsheets is to manage data, it is used with numbers or 

strings of letters, which may be later analyzed with the help of various formulas, 

functions, and calculations (number of occurrences, frequency, percentage, etc.). 

Any spreadsheet user should know how to use the basic math formulas 

(addition, subtraction, division, and multiplication), knowing that a formula starts 

with the equal sign in the cell, followed by the cell references involved in the 

calculation. For instance, provided that cells D3 and D4 contain numbers, typing 

 

=D3+D4 

 

in a different cell will add the numbers from these two cells, offering the sum. 

Changing the plus sign to a minus sign 
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=D3−D4 

 

results in the difference between them. The forward slash 

 

=D3/D4 

 

offers the quotient, and the asterisk sign gives the product: 

 

=D3*D4. 

 

The next step is to calculate sums, differences, quotients, and products from 

a range of cells, either in rows or in columns. In this case, the cell containing these 

results must be modified this way: 

 

=SUM(D3:D18), 

 

which calculates the sum in this range, while subtraction is possible these ways: 

 

=D3−SUM(D4:D18), 

 

in which case the sum of the range from cell D4 to cell D18 is counted and 

subtracted from cell D3; 

 

=SUM(D3:D4)–D18 

 

subtracts the value of D18 from the sum of D3 and D4, while 

 

=SUM(D3+D4) – SUM(D5:D18) 

 

calculates the difference between the sum of ranges D3:D4 and D5:D18. Similarly, 

divisions and multiplication may be carried out with ranges as well. 

The next stage is to check that numbers may be interpreted differently in 

spreadsheets. Whenever a cell is highlighted, the Ctrl+1 shortcut opens a window 

displaying how the content of the cell is interpreted. This may be a number, 

percentage, accounting, currency, date, time, scientific, fraction, text, or 

custom/user-defined. Numbers may be negative (easily visualized in red), 

thousands separator may be added, as well as leading zeroes: 
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Figure 133. Cell format, Excel 

 

Figure 134. Cell format, Calc 

The AutoSum button in Excel and the sigma icon in the formula bar of Calc 

(Σ) can easily sum a range of cells, which might be preselected as well to sum the 

desired cells. If no cells are selected, the spreadsheet offers the most logical range 

adjacent to the sum cell. 

Natural numbers can be used to number cells automatically. In case an Excel 

cell contains a natural number, selecting the cell and positioning the cursor in the 

bottom right corner turns the cursor into a black plus sign. Holding it and dragging 

down or to the right fills the range of cells with the same number. The same 

operation in Calc fills the cells with numbers in ascending order (down or 

rightwards). If the cursor is dragged to the left or upwards, it will decrease the 

value one by one. 

However, in case an Excel or Calc cell contains text and the adjacent cell 

contains a natural number, dragging both cells will repeat the text in every odd 

cell, while every even cell will contain ascending numbers. 

The Data tab, Statistics, Descriptive Statistics in Calc offers values on cells 

containing numbers, without calculating them separately. As this chapter is about 

the basics, we only highlight the following values: Mean, Minimum, Maximum, 

Sum, and Count (the number of cells with data). 
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The Excel version for this is slightly more complicated, as it is possible only 

via the Data Analysis button in the Data tab, but only if it is activated first: File, 

Options, Add-Ins, Manage, where the Excel Add-ins should be selected, then Go 

and check the Analysis ToolPak. The Data Analysis will offer a list, where 

Descriptive Statistics is shown. 

More complicated numbering is beyond the purpose of this chapter, unless it 

is connected to automatic count referring to the cells themselves. For instance, 

when a range is selected, the status bar at the bottom can offer various statistics, 

such as the number of cells selected. Excel will count only the cells containing 

values (Count), their sum and average, while Calc will count all the selected cells, 

their sum and average. 

9.5. Find, Select, Replace, Delete 

Finding data in a spreadsheet of thousands of entries may be a challenging task, so 

there are multiple options to search. 

The simplest one is similar to the one discussed in word processing, as the 

Ctrl+F shortcut opens a search window, enabling the user to find character strings 

or numbers within the sheet or the entire workbook, and the search may be by 

rows or columns. Furthermore, the format may also be chosen, which refers to the 

cell content, which may be a particular one, custom/user-defined, or general. 

Furthermore, matches may be shown one by one (Find Next), or in case the Find 

All is selected, a pop-up window will display a list of all matches, specifying their 

exact location (book, sheet, column and row number). 

The Ctrl+H shortcut offers to change numbers or strings of characters to 

something else. In case empty cells should be populated with data, the Find bar is 

left empty. In case cells with specific content should be deleted, the Replace bar 

is left empty. 

Deleting all data from a range of cells (Clear) in Excel is possible in case the 

cells are selected and the Delete button is pressed. While this works in Calc as 

well, selecting the range of cells and pressing the Backspace button displays a 

window, enabling to delete certain types of data (Text, Numbers, Date & Time, 

Formulas, Comments, Objects, Formats, or Objects), as illustrated in Figure 135 

below. 
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Figure 135. Delete Contents, Calc 

Excel offers similar options via the drop-down button of Find & Select in the 

Editing group on the Home tab: 

 

Figure 136. Find & Select, Excel 

This contains a Go To Special option, which can find all the blank cells in a 

sheet, without trying to select all of them before the operation: 
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Figure 137. Go to special, Excel 

As illustrated in Figure 137 above, cells containing specific content are found, 

and may be changed or deleted (cleared) easily. 

9.6. Sort and Filter 

Arranging data in spreadsheets is facilitated by the Sort and Filter possibilities. 

The most common Sort function in the case of cells containing numbers is 

Sort from Smallest to Largest or Sort from Largest to Smallest, while cells 

containing text may be arranged with Sort A to Z or Sort Z to A. 

Custom Sort options may include different columns and rows, cell values (cell 

color, font color, conditional formatting), including or not headers. These are 

possible in both Excel and Calc. 

Filter options are only available when filters are added to certain columns. 

Excel offers this option via the Home tab, Sort & Filter, Filter. In case the first row 

is selected of any column, when pressing the Filter button, all columns get a Filter 

button. A click on any Filter button reveals the content of all the rows of the 

column in alphabetical order, offering the chance to select any one or more of 

them, including blank cells as well. Filtering the column to only one type of 

content will display at least one row or as many rows as there are with that 

particular content. A more powerful search option is also available within the filter 

option, which can search for character strings in all cells: 
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Figure 138. Insert filter, Excel 

Pressing the Filter button in cell A1 offers three options, and selecting, for 

instance, the string aaa will display four rows (2, 5, 8, 11), as the cells of these 

rows contain that string of characters: 

 

Figure 139. Start filtering in Excel 

 

Figure 140. Filter string “aaa,” Excel 

In case Column E is filtered, the option to filter the empty (blank) cells is 

offered, as this column contains empty cells: 
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Figure 141. Filter options including blanks, Excel 

Unchecking the box for Select All, then checking the box for Blanks will result 

in three rows (2, 12, 13): 

 

Figure 142. Filter blanks in Column E, Excel 

As filtering displays only rows that fulfill certain conditions, the rest of the 

data remains invisible. A further method to highlight certain cell content is to 

format them differently, to be presented in the next section. 

9.7. Conditional Formatting 

This function offers the possibility to highlight cells containing either numbers or 

text. 

In the case of numbers, the Conditional Formatting button offers to Highlight 

Cells Rules containing Greater Than, Less Than, Between, or Equal To values, 

which may be highlighted either with different cell or font color. 

In the case of text, Text that Contains may be used, and the particular 

character string given in quotation marks, in which case the cell background 

and/or the font may be changed to light red, yellow, or green by default, with 

further options as well: 
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Figure 143. Conditional formatting, Excel 

Dates may also be highlighted with this function: A Date Occurring…, which 

is shown in Figure 144: 

 

Figure 144. Highlight a date occurring, Excel 

This function may come in useful when deadlines are approaching and the 

particular spreadsheet is used on a daily basis. Otherwise, other online calendars 
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or various computer or cell phone software may remind us of an upcoming event, 

so this spreadsheet function might become obsolete, similarly to other date-related 

formulas (e.g., calculating days left until the end of month or year). 

A rather important function is to spot duplicate values in a spreadsheet. In 

case of large databases, it may happen that similar data is found in multiple cells, 

and if this is not needed, the Conditional Formatting, Duplicate Values… can 

highlight these cells with Light Red Fill with Dark Red Text by default. However, 

a possible drawback of this function is that all duplicates are highlighted this way, 

so in case two cells are found with the aaa string and three cells with the aac 

string, five cells will be highlighted similarly, which might be puzzling. 

Interestingly, removing duplicates is possible even without highlighting 

them. A spreadsheet function can find all of them. Excel offers this via Data, 

Remove Duplicates, which can work either on the current selection or expanded 

to the entire worksheet. Calc offers this function via Data, Duplicates, after which 

a Handle Duplicate Records window opens, offering to compare rows or columns, 

with or without headers, followed by Select or Remove options: 

 

Figure 145. Handle duplicates 

While there are much more advanced functions and formulas to analyze data 

in spreadsheets, these are beyond the range of the present book. However, it is 

worth mentioning that creating pivot tables may summarize data from various 

spreadsheet tables, and the XLOOKUP function can look for values in a particular 

range and return corresponding values from another range both horizontally and 

vertically. 
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9.8. Page Layout 

Although data in spreadsheets may extend over thousands of columns and rows, 

they may be exported to Word and Writer, or they may be printed as well. 

Before exporting or printing, it is worth checking Page Layout in Excel or 

Format, Page Style, Page, Page Format in Writer, which can set the page to the 

desired size, such as A4. In case spreadsheets are not exported but saved as PDF 

or printed, a narrow font type, smaller font size (10 instead of 12), and narrow page 

margins may help in placing more data per page. 

9.9. Text to Columns 

Data may be imported to spreadsheets in various forms. However, data organized 

in column-like view might not always fit into the desired cells, in which case the 

Text to Columns option can help. This is available in the Data tab, and the text 

may be sectioned into columns based on various delimiters such as tab, semicolon, 

comma, space, or other, which may be a specific sign or symbol. 

This option is useful when data is saved from external sources such as online 

lists, enumerations separated by commas and so on. 

9.10. Creating a Multiple-Choice Test 

A specific functionality of spreadsheets is their mailing function. Having in mind 

well-designed multiple-choice tests (with A, B, C, and D variants), we can combine 

Word and Excel to obtain the desired outcome. For the time being, this is not 

possible with LO. 

The first step is to place raw data in an Excel file in at least five columns: 

1. Column B (Heading: Sentence) contains the sentences, e.g., Look! She …. 

2. Columns C–F (Headings: A, B, C, D) contain the four choices, e.g.: is 

crying, has crying, was crying, will cry; 

3. Optionally, Column A may contain numbering (No.), as the hashtag 

symbol will not be interpreted correctly when the file is attached to the 

Word document, while Column G may contain the answers (Key), after 

which the spreadsheet file should be closed. 

The next part is to create a Word document which contains a specially 

designed table in the desired format; the characters enclosed between guillemets 

stand for the data to be extracted from the spreadsheet columns labeled this way: 

 

Figure 146. Horizontal options, multiple choice 
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or 

 

Figure 147. Vertical options, multiple choice 

When ready, the data from the spreadsheet can be attached to this table in the 

following way: Mailings, Start Mail Merge, Directory, then Select Recipients and 

Use an Existing List, which opens a window to search for the desired spreadsheet. 

When found and selected, there is a button displaying ABC Preview Results, 

which can show the first option. If it is displayed correctly, further data will be 

correct as well, presumably: 

 

Figure 148. Preview mailing results 

In case the first option is displayed correctly, we should finalize the test this 

way: Finish & Merge, Edit Individual Documents, and select All in the newly 

opened window. 

 

Figure 149. Merge all records to new document 
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This will create a new Word document populated with the desired data: 

 

Figure 150. Multiple-choice test through Mailings 

Before saving this document, it is worth selecting the entire table and 

removing all borders: Paragraph tab, Borders icon, and from the drop-down menu 

the No Border option should be selected, after which the document may be saved. 

However, as this document contains the key, when saving the file, the term key 

should be included in the title, whereupon a copy may be created from this file, 

and on opening it, the Key column may be deleted. The name of the second Word 

document should not contain the word key, and this might be printed directly or 

saved as a PDF to have it printed or forwarded to students. 

Comparing this way of creating a multiple-choice test has a steeper learning 

curve than creating one with tabs and constantly copying data from an existing 

database, but the template for the multiple-choice Word is saved and can be re-

used subsequently with further databases that are formatted similarly and have the 

same headers. 

A final remark is that Unicode values working with the Alt+X shortcut in 

Word or Writer will work in Calc as well, while many of them are non-functional 

with the values in Excel, in which case inserting the sign or symbol is the available 

option. 
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Presentation Basics 

Creating presentations with MSO PowerPoint (from now on, PowerPoint) used to 

be the staple for decades, while there are voices that it has turned obsolete over 

the past few years. Although LO contains Impress to create presentations, it has 

never really become popular on a large scale. 

PowerPoint has the advantage of being well known, with good built-in 

features. Once MSO is installed on the computer, PowerPoint is also provided, so 

it makes sense to offer certain guidelines. 

First, being a presentation, its time limit is one of the most important factors. 

For instance, students typically have presentations varying between 10 and 20 

minutes, which means that the number of slides should be more or less equal to 

the number of minutes plus a maximum of two extra slides: the title slide and the 

Thank You slide. This also entails that a standard slide should contain six to eight 

lines with no more than six words per line, which stand for the gist of the thoughts 

to be presented, and they are not fully formed sentences. 

The monotony of slides with texts may be broken only with various 

illustrations, graphs, statistics, pictures, photos, or tables. Occasionally, short 

soundbites or videos might be embedded, which should be typically no longer 

than 30 seconds. Adding text boxes, shapes, arranging and coloring them is rather 

intuitive, while modern versions of PowerPoint can easily accept soundbites and 

videos: Insert, then there are options for Table, Pictures, Screenshot, Photo 

Album, Shapes, Icons, Chart, Text Box, Header & Footer, WordArt, Date & Time, 

Object, Equation, Symbol, Video, Audio, and Screen Recording. 

As for the colors, a subtle presentation should contain no more than three 

colors, and it is worth choosing large contrast colors, not close hues of the same 

color. Many guides highlight the importance of great contrast between the 

background and the text (especially in case of direct sunlight), leading to the 

obvious conclusion: the most traditional presentation is set in white background 

and black text, while a more modern version is the other way around: black 

background with white text. 

A repetitive logo on each slide emanates stability and—in our view—the 

slides should be numbered, except for the title slide, to offer a guide on the passing 

of time while presenting. Changing the default slide layout is possible by accessing 

the Master slide view: View, Slide Master, and then scrolling up to the first slide 
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offers the possibility to modify it: delete unwanted elements, add logos, or 

rearrange various sections. 

Although there is a possibility to add notes invisible to the public, it is worth 

putting words on the slides that can remind the speaker effectively what to say, 

without relying on whatsoever notes. 

Arguably, the greatest challenge of PowerPoint is linearity, which is why one 

of its first contenders was Prezi,191 already offering to create a presentation with 

the help of AI. Its huge advantage was its non-linear presentation style and became 

fashionable quickly. 

Present-day PowerPoint challengers all promise a presentation within 

minutes, all powered by AI, and there are even LinkedIn posts stating, “Microsoft 

PowerPoint is dead!”, offering various alternatives: Dectopus AI, Gamma App, 

Tome App, Beautiful AI, Presentations AI, or Pitch.192 At present, it is questionable 

whether PowerPoint, LO Impress, or Apple’s Keynote are competitive enough 

compared to Canva193 or even Google Slides. 

Although there might be more than 500 million PowerPoint users creating 30 

million presentations every day,194 it is under constant scrutiny and criticism, as it 

is not interactive, slides need time to be created, and it hinders the presenters. 

Alternatives, such as Plus AI, Claude, Gamma, or Canva, offer non-traditional 

approaches with simple designs and brainstorming options, but ultimately it is the 

customer who has to make the choice—considering the investment in time, energy, 

and finances—to create visually more appealing presentations or to rely more on 

information, mostly on words. 

 
191 https://prezi.com/, July 31, 2025. 
192 https://tinyurl.com/4ed8332m, July 31, 2025. 
193 https://www.canva.com/, July 31, 2025. 
194 https://tinyurl.com/bde27m6x, July 31, 2025. 

https://prezi.com/
https://tinyurl.com/4ed8332m
https://www.canva.com/
https://tinyurl.com/bde27m6x


Chapter 11   

PDF Files 

11.1. Types of PDF Files 

Portable Document Format (PDF) was introduced by Adobe in 1992 as a new file 

format with the .pdf filename extension, and it became a standard format in 2008. 

This file format is platform independent, and all devices can display the content 

of this file type correctly. 

Both MSO and LO can save their standard files as PDF files, which is 

recommended before printing, especially when images, hyperlinks, tables, or 

multimedia content is found in the original document. As PDF files preserve the 

exact formatting and layout, they are also recommended for archiving purposes. 

There are many companies providing PDF-related software, and there are two 

major PDF file types: one of them is similar to photographs, as the characters are 

not recognized, so the PDF is basically non-searchable. The other type is a 

searchable file (usually there is a search button, or the Ctrl+F shortcut should 

work), which means that character strings are found when searched for them, 

including case sensitivity options. 

Naturally, when Word, Excel, and PowerPoint documents or Writer, Calc, and 

Impress documents are saved as PDF files, they will be searchable. Thus, it is 

similar to a DOCX or an ODT document, except for that its content cannot be 

changed. Furthermore, selecting, copying (with the Ctrl+C shortcut) fragments 

and pasting them into a DOCX or an ODT file is also possible. 

In case more lines are copied from a searchable PDF file, when pasting the 

text into a Word or Writer document, the lines will end where the original PDF file 

lines end, so the text needs formatting. If lines end in paragraph marks (¶), pressing 

Ctrl+H opens the Find and Replace window. In order to delete unnecessary 

paragraph marks, ^p should be typed in the Find what line, and then a space in 

the Replace with line will replace all paragraph breaks with spaces. If lines end in 

Manual Line Breaks (a carriage return arrow: ↵), ^l should be typed in the Find 

what line, and also replaced with a space in the Replace with line, and then 

Replace all changes all the occurrences in the selected area. 

The following text is copied from a PDF format book on translator’s 

invisibility (Venuti 2004, 30), and pasting it into a Word document will result in 

this view: 
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Figure 151. Inserting a fragment from a PDF document 

After taking the steps suggested above, the paragraph marks will change to 

spaces, which changes how the paragraph looks: 

 

Figure 152. Reformatted paragraph 

Writer needs different commands for the same changes. In the case of 

paragraph marks, the dollar sign ($) is needed in the Find line, paying attention to 

the Regular expressions, which must also be selected. As for the manual line 

breaks, \n is needed in the Find line. Interestingly, if manual line breaks are to be 

replaced with paragraph marks, both the Find and the Replace line should have 

\n. 

11.2. Saving as PDF File 

Saving LO documents as PDF files is easy, as there is an Export Directly as PDF icon 

displayed on the Main tab. However, when not the entire document is needed as a 

PDF file, we can rely on File, Export As, Export as PDF, which opens a window 

where the required pages can be selected and further options may be also set. 

Writer can also create fillable PDF files: View, Toolbar, Form Controls, which 

makes it possible to add new fields to the document, including text boxes, options, 

or checkboxes. After this step, the document is exported as a PDF file, which 

allows adding information to the file or select various options and tick checkboxes. 

There are at least two possibilities to save or export MSO documents into PDF 

file format. The longer version is File, Save As, choose the location, which opens 

a window where to store the file and offers to add a file name and its format. The 

drop-down list of Save as type will display PDF (*.pdf), and it also offers Options 
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where the needed pages may be selected. In case the full document is required in 

PDF format repeatedly, it is worth placing a shortcut on the Quick Access Toolbar 

situated above the Main tab, which has a drop-down arrow, and clicking on it 

offers customization options (see 2.1.). 

In case the Publish as PDF or XPS command is added to the Quick Access 

Toolbar list, saving Word documents as PDF files will be straightforward, as it will 

instantly open a window where to save it, with the possibility to change the name 

and providing the Options for extra settings. 

11.3. Handling PDF Files 

As mentioned in Section 11.1., searchability is a basic requirement for a PDF 

document. This means that any character string in the file should be found when 

searching for it, and there are further typical activities users require from a PDF-

handling software, either online or offline. 

Conversion from non-searchable PDF file to searchable is typically not 

provided for free, as optical character recognition (OCR) means a lot of investment. 

However, there are web-based applications that promise free conversion (for 

instance PDF24 Tools or iLovePDF),195 and the results are best when the language 

of the document is English, while language-specific characters are more difficult 

to render correctly. 

There are many freely available PDF file readers, including Adobe Acrobat 

Reader (for Windows OS and macOS), whose icon is generally associated with PDF 

files, or Evince for Linux OS. 

As a PDF file may consist of multiple pages, there are a few tools required 

regarding these pages: 

1. splitting; 

2. merging multiple PDF files; 

3. rotating; 

4. removing; 

5. extracting; 

6. rearranging; 

7. adding page numbers; 

8. adding watermark; 

9. adding text-boxes and notes; 

10. cropping margins; 

11. annotating; 

12. highlighting parts; 

13. editing; 

14. creating editable forms; 

 
195 https://tools.pdf24.org/en/ or https://www.ilovepdf.com/, August 2, 2025. 

https://tools.pdf24.org/en/
https://www.ilovepdf.com/
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15. redacting; 

16. recognizing characters; 

17. signing; 

18. password protection; 

19. flattening.196 

Converting PDF files to HTML, DOCX, XLSX, PPTX, ODT, ODS, or ODP files 

might be a valuable asset, and converting images to PDF and vice versa also adds 

to the value of the software. 

Opening other file formats than PDF is also becoming more and more 

important, so free software like Foxit PDF Editor, PDFgear, or Sumatra PDF are 

worth considering. Sumatra PDF can handle e-book formats, such as DjVu, MOBI, 

or EPUB files, while PDFgear has a built-in OCR function, which enables the user 

to either select a section and recognize the text on that page in certain languages 

(including Hungarian and Romanian) or convert the opened PDF file to MSO file 

formats and PNG, JPEG, TXT, HTML, or XML files. The tested files were in English, 

Hungarian, and Romanian, and the application produced very good results 

provided the original PDF files were of good quality. 

 

☙ 

 

The twelve chapters discussed so far have tried to offer a more or less 

comprehensive view on how to handle files, characters, major punctuation, and 

spelling-related remarks, completed with insert and modifying options while 

creating a text based on a template, followed by ancillary knowledge on 

spreadsheet, presentation and handling PDF files. This knowledge is more than 

enough to draft a thesis, whose structure is detailed in the following chapter. 

 
196 Flattening is needed when the PDF file contains added items, such as highlighting, text-boxes, or a 
signature, and after flattening it will have a single, non-editable layer, ready to archive or print. 



Chapter 12   

Thesis Structure 

12.1. Ethical Considerations 

Before delving into the proper structure of a thesis, a few ethical considerations 

must be mentioned. 

The digital age seems to have intensified certain illegal acts, including 

intellectual property theft. There are four types of intellectual property protection: 

copyrights, trademarks, patents, and trade secrets,197 and the first one includes 

written texts as well. 

Copyright encapsulates all drafted texts by an individual, and in case the 

author’s credit is not mentioned, it is labeled as plagiarism. The term refers to “the 

act of presenting the words, ideas, or images of another as one’s own,” and this act 

“violates ethical standards in scholarship,” so “[a]uthors who try to publish 

plagiarized work face rejection from publication” (APA 2020, 21). Regardless of 

this rejection in case the act is revealed, more and more writers seem to trust that 

their act of plagiarism is not discovered, deploying even translations from 

languages of limited international circulation and/or combined with dedicated 

software to reword texts. Thus, anti-plagiarism software is trained to spot these 

attempts, and plagiarists should also consider that publicly available texts may be 

checked by many people for many years retrospectively, so any act of plagiarism 

may be revealed at any time.198 

A similar act of misconduct is self-plagiarism, which is also unethical, as the 

authors try to present their own “previously published work as original” (APA 

2020, 21). There are institutions considering that students handing in a paper 

already submitted for another assignment may also “violate the academic integrity 

policy, honor code, or ethics code of the university” (APA 2020, 256). An 

exception would be the incorporation of an earlier work into a more ample later 

work, such as a dissertation. 

A further term is contract cheating, which is the case when an individual is 

hired to write a paper for another person, and the latter will “take credit for work 

that they did not do themselves” (APA 2020, 256), also violating the previously 

mentioned codes. 

 
197 https://tinyurl.com/4v28p5s7, August 3, 2025. 
198 Notable cases of plagiarism are often associated with individuals who earned their PhDs under 
questionable circumstances before entering politics. 

https://tinyurl.com/4v28p5s7
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Ghostwriting is a special case, as famous people (politicians, celebrities, 

corporate executives) hire talented people who can formulate ideas that sound 

appealing when presented publicly. While this may be frowned upon, it is 

generally known that the wording of these speeches (spoken or written) does not 

belong to the one who presents them. However, there are data that in biomedical 

publication ghost authors may be junior researchers or statisticians whose identity 

is not revealed (AMA 2020, 180). 

To counteract unethical behavior, detailed descriptions offer guidelines how to 

refer to cited work, both in the running text (quotations) and in the References section. 

While there are many types of sources (ranging from personal communication to very 

clear journal articles, including various types of multimedia), a good reference 

management application, such as Zotero, can automatically handle the majority of 

them. As this application is presented in Section 6.15.3., it is only important to 

highlight that Zotero entry types should be categorized properly, as the basic idea is to 

be able to identify the sources used in a paper correctly. This typically includes the 

author, year of publication, type of publication, publishing house, and exact page 

numbers. However, additional details depending on the source might also be needed: 

the edition number, the original title of the translation with the translator’s name (APA 

2020, 301), whether it is a reprint, the time stamp of audiovisual work, album name, 

artist name, recording studio, canonical reference to religious and classical works, 

plays with act, scene and lines, or the name of the social media site. 

A further remark is that embedded citations (citations within quotations) 

should not be included in the reference section, unless that work has been used as 

a primary source elsewhere in the paper (APA 2020, 277). 

All the same, questions still remain regarding how ethical it is to rely on AI to 

generate scientific texts, and whether texts created this way are traceable or not. For 

the time being, it has been observed that generated texts contain bogus references, and 

non-native speakers “produce” texts in English that it is highly unlikely to be their 

own work. Yet, AI is improving day by day, and there are options to ask for less 

polished versions, so it depends a lot on the attitude of the author how to deal with 

the temptation. It is conceivable to ask for a brief summary on major issues regarding 

a topic in the brainstorming phase, which should be replaced by personal effort and 

own research to master a field, being able to replace AI content with tested 

information. 

12.2. Length of Writing 

The length of scientific articles is usually limited by journals, similarly to student’s 

papers. 

The length of theses might be different, as universities might restrict their 

length, whereas PhD dissertations might be as many pages as it takes. While the 

length of books may be rarely limited, Bringhurst explains that there are octavo 
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signatures, which are multiples of 16: 32, 48, 64, 80, 96, 112, 128, 144, 160, 176, 

192, 208, 224, 240, 256, 272, 288, 304, 320, 336, 352, 368, 384, 400, etc.—so, the 

majority of the books should be of these lengths. This includes ancillary parts such 

as title pages, table of contents, list of illustrations, preface, appendices, 

bibliography and index, referred to as “paraphernalia” (Bringhurst 2004, 73). 

Page number may be replaced by character count, for which both Word and 

Writer offer ample calculation methods. The status bar in Word offers information 

on page and word number, but a click on the part where word number is displayed 

will open a more detailed window (see Figure 153 below), including character 

number with or without spaces, completed with number of paragraphs and lines: 

 

Figure 153. Word count, Word 

Writer offers the number of words and characters in the status bar as well, and 

a click on this section will display a similar window to Word, offering the number 

of characters including and excluding spaces and the number of comments as well, 

as visible in Figure 154: 

 

Figure 154. Word count, Writer 
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A right click on the Word Status Bar offers further details, including 

customization options. Thus, it is possible to add Column, Line and Character 

Count (with spaces) to the status bar, as shown in Figure 155: 

 

Figure 155. Customize status bar, Word 

Furthermore, when the document is closed, a right click on it can reveal its 

properties, including the number of pages, words, characters, lines, and 

paragraphs, as shown in Figure 156: 

 

Figure 156. Document properties, Word 
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In conclusion, the length of a work is greatly affected by its type and purpose, 

and in the following we will try to draft the possible structure of a thesis, which 

might be developed to be published as a book. 

12.3. Structure of a Thesis 

The structure of a thesis is often available on university websites, and we present 

the one provided by Columbia University,199 completed with information from other 

sources as well (Ármeán 2017, 104–7; Bringhurst 2004, 73; CMOS 2024, 4–44). 

The following parts might constitute the structure of a standard thesis: 

1. Title pages with pre-defined content: university, faculty, department, 

title, author, supervisor, place, year; if needed, in another language as 

well; 

2. Table of contents (optionally: list of figures, list of tables); if needed, in 

another language as well; 

3. Abstract with keywords; 

4. Body; 

5. References; 

6. Appendix (if needed). 

These parts form the front matter, covering all the pages before the main text 

starts, followed by the pages of the main text (the body), ending in the back matter, 

which are detailed in the following. 

12.3.1. Front Matter 

The front matter contains the title page, which may be split into a standard half-

title page and a title page, and the title page may be translated into another 

language as well, especially when the language of the work is different than the 

official language. 

The title page should suggest “poise,” which “consists primarily of 

emptiness” resulting in a “symbol of the dignity” (Bringhurst 2004, 61). In his 

view, this means “a modest line or two near the top, and a line or two near the 

bottom, with little or nothing more than taut, balanced white space in between.” 

Unless stated otherwise in guidelines, a thesis title page includes the affiliation 

(university name and department), followed by the title. Many prefer to set the 

title in title case, bold and centered and in the upper half of the title page, and it 

may have a subtitle as well (APA 2020, 32). 

The author’s name is positioned below the title (aligned right), below which is 

the supervisor’s name (aligned left), specifying the supervisor’s academic ranks: 

(Full) Professor, Associate Professor, Assistant Professor, Reader/Senior Lecturer 

and completed with Dr. and/or PhD), followed by the place and year of handing in 

 
199 https://www.ldeo.columbia.edu/~martins/sen_sem/thesis_org.html, August 4, 2025. 

https://www.ldeo.columbia.edu/~martins/sen_sem/thesis_org.html
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the work (cf. (APA 2020, 30). English theses should have the names according to the 

English standard: first name, middle initial(s), and last name (APA 2020, 33). 
In special cases, the title page may be followed by the epigraph, which is in 

fact a quotation relevant to the thesis, set before the first line, like a block quotation 

(APA 2020, 277), although it is rather characteristic to books. Books also have an 

extra Copyright page with the name of the editor, translator, illustrator, publishing 

rights, and the ISBN number (Ármeán 2017, 97). 

The next pages should contain the table of contents, and—in case their 

occurrence is significant—a list of illustrations and a list of tables might follow. 

All lists and tables should be inserted automatically, the way word processors offer 

them with the help of the built-in options, discussed in Section 6.16. 

The Columbia guide considers that the Abstract page (recto) precedes the 

table of contents and other lists, while others position it after the tables. Whatever 

the case, the abstract starts with the section label Abstract (APA 2020, 38), it 

consists of one or two paragraphs, and its length may vary between 250 and 400 

words. It should not contain citations or URLs, figures or tables, and an abstract 

typically covers the objective, hypotheses, design, methods, results, and summary 

of the contents (AMA 2020, 31), without evaluating or commenting the body of the 

paper, using verbs rather than passive voice (APA 2020, 73–78). 

The abstract might be followed by 3–5 (sometimes up to 7) keywords covering 

major aspects of the thesis, which are relevant, as indexing is carried out based on 

these keywords. The term Keywords is set in italic, one line below the abstract, 

and only proper names are capitalized (APA 2020, 38–39). 

In case the thesis contains many abbreviations, a table of abbreviations might 

follow,200 although CMOS explains that this may be part of the back matter, following 

the Appendices section. Similarly, the Acknowledgements section might be placed 

after the tables (Bringhurst 2004, Ármeán 2017), but it may start the back matter, 

preceding the References section (AMA 2020, 40). The Acknowledgements section 

may specify the “financial and material support for the research,” completed with 

grant or contract numbers together with “the complete name of the funding 

institution or agency” (AMA 2020, 47). Other contributions should be also 

mentioned: advice, statistical review, assistance, guidance, review, data collection, 

data analysis, data interpretation, supervision (AMA 2020, 52). 

The Preface ends the front matter section, followed by the main text. 

Numbering the front matter pages depends on the university requirements, but 

title pages should not be included in the numbering, and Page 1 is either the first 

page of the table of contents page or the first page of the Introduction. The front 

matter of books uses lowercase Roman numerals. 

 
200 There are a few options to create a table of acronyms. An online suggestion is found here: 
https://www.youtube.com/watch?v=bfSoMWdBoTM&ab_channel=Ga%C3%AbldeMondragon, 
August 20, 2025. 

https://www.youtube.com/watch?v=bfSoMWdBoTM&ab_channel=Ga%C3%AbldeMondragon
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12.3.2. Body 

The structure of the main text or body should not be very complicated, knowing 

that “only the most complicated works need more than three levels” (CMOS 2024, 

34), adding that a section “ideally” should have at least two subsections, and 

paragraphs should have no extra space between them. 

The introductory part of the thesis usually contains a literature review, the 

importance of the research, its hypotheses, aims and objectives. As the first 

paragraphs of a thesis are “understood to be introductory,” the heading 

Introduction is not recommended (APA 2020, 47), followed by the methods, 

results and discussion (APA 2020, 39), followed by possible conclusions, 

recommendations and future research. 

12.3.3. Back Matter 

Each part of the back matter starts on a recto page, and it must contain at least the 

References or Bibliography201 and Appendices, if needed, although there are 

sources considering that Appendices may precede the References. 

As explained, the Reference list “provides a reliable way for readers to locate 

the works authors cite to acknowledge previous scholarship” (APA 2020, 39), and 

hanging indent should be applied for the entries: “the first line of each reference 

is flush left and subsequent lines are indented by 0.5 in” (APA 2020, 40). Words 

referring to the type of legal corporate entity the publisher is should be omitted: 

Company (Co.), Corporation (Corp.), Incorporated (Inc.), Limited (Ltd.), just as 

initial articles (The), while the words University Press may be abbreviated as UP. 

Reference entries may be numbered and arranged in an alphabetical order, and 

works cited in English being translations of non-English publications should 

contain the original title after the English with the date of original publication 

(AMA 2020, 68). 

Once again, we reiterate the importance of using a reference management 

software (BibTex, EndNote, ProCite, Reference Manager, RefWorks, Zotero), as 

these can also check whether URLs are still valid (AMA 2020, 96).202 Website 

citations should contain the author’s name if available, the organization behind 

the source, the website name, and the date of access (cf. AMA 2020, 98). 

The Appendix section may contain transcripts of recordings, larger tables of 

the collected material, titles, the entire lyrics, or other ancillary material 

considered relevant enough to support the main text, respecting proper copyright 

attribution, accurate data, and “protection of human participants” (APA 2020, 41). 

 
201 References are explicitly cited in the main text, while Bibliography also contains secondary sources 
not cited. 
202 For instance, this freely available website was valid in 2024: https://sites.google.com/a/ngs.org/ngs-
style-manual/. However, in August 2025, it contained a top bar specifying that the National Geographic 
Style Manual had moved to in.disney.com, requiring signing in with a company email or ID. 

https://sites.google.com/a/ngs.org/ngs-style-manual/
https://sites.google.com/a/ngs.org/ngs-style-manual/
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Appendices should be labeled with capital letters or numbers in the order they are 

referred to in the main text, and once they are named, they should be referred to 

in the main text at least once. 

Books may have further sections such as Endnotes, Afterword, Glossary (less 

familiar terms, explained in alphabetical order), Index, and abstracts and tables of 

contents in other languages. The glossary may precede or follow the Notes or Reference 

list (CMOS 2024, 37), and the entries should begin on a new line and separated from 

the definition with a period, a colon, or an em dash; the definition ends with a period, 

and the use of multiple columns is discouraged (CMOS 2024, 75). 

The index also begins on a recto, and there might be a separate name and a 

subject index, in this order. Index text is usually set in smaller types and in two 

columns (CMOS 2024, 40). 

Books must also have a Colophon section regarding information on book 

production: publishing house, emblem, editor, typographer, illustrator, designer, 

place of printing, book format, book pages, number of copies printed, paper type, 

font name, and date of publication (AMA 2020, 1127; Ármeán 2017, 106–7), 

although not all publishing houses reveal all this information. After all, 

descriptions regarding thesis structure are no more than recommendations, and it 

depends on the supervisor and the institution to what extent they specify 

guidelines and demand implementation. 

12.4. Summary of Quality Assurance 

The author of a thesis should aim to produce a high-quality work. This may be 

possible relying on a solid background of setting, editing, and spelling skills 

connected to word processing, which might be completed with basic spreadsheet 

knowledge while handling hundreds of data bits and skills to produce effective 

presentations. 

Setting up a document entails page setup, including page size, header, footer, 

and paragraph, followed by proper styles for the body text, headings, quotes, 

footnotes, lists, tables, and figures. 

Editing skills involve proper insertion of a table or figure with captions, 

creating numbered and bulleted lists and consistency in referring to linguistic 

examples, translations, and cross-reference to various items. 

Spelling and punctuation should rely on both automatic spell checker in the 

language(s) of the document, hyphenation, capitalization, and proofreading (to 

spot atomic typos, for instance), considering hyphenation options, proper 

insertion of signs and symbols and disambiguation of all abbreviations before their 

first use unless they are widely popular. Creating a checklist might help, which 

should include typical mistakes of the author, also paying attention to consistency 

(e.g., formatting, term choice). While it is stipulated that proficiency in major 

applications and systematically following technological developments is a must 
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for editors (Einsohn and Schwartz 2019, 4), this has also been the case for students 

as well, although questions arise in the age of AI regarding the extent of this 

knowledge. 

By way of encouragement, we might finish with a sobering quote: “You’re not 

expected to be perfect … 95 percent accuracy is the best a human can do.” (Einsohn 

and Schwartz 2019, 5), and everybody should aim at this level. 





APPENDIX. Shortcuts 

A. Word/Writer Shortcuts 

Alt+X Turn Unicode Value to Glyph/Character and Vice Versa 

Ctrl+A Select All Content of Document 

Ctrl+B Bold Font Style 

Ctrl+C Copy Selected String of Characters 

Ctrl+D Font Settings (Word) 

Ctrl+E Text Alignment, Center (Selection/Line) 

Ctrl+End Jump to Document End 

Ctrl+Enter Page Break 

Ctrl+F Find/Search 

Ctrl+H Open Find and Replace Window 

Ctrl+Home Jump to Document Start 

Ctrl+I Italic Style 

Ctrl+J Text Alignment, Justify (Selection) 

Ctrl+K Insert Hyperlink 

Ctrl+L Text Alignment, Left (Selection) 

Ctrl+Left Arrow Jump to the Beginning of Previous Word 

Ctrl+N Open New Blank Document (as the Active One) 

Ctrl+O Open Options 

Ctrl+P Open Print Window 

Ctrl+R Text Alignment, Right 

Ctrl+Right Arrow Jump to the Beginning of Next Word 

Ctrl+S Save 

Ctrl+U Underline Style 

Ctrl+V Paste Previously Copied Selection 

Ctrl+W Close Window 

Ctrl+X Cut Selection 

Ctrl+Y Redo the Last Action Performed 

Ctrl+Z Revert/Undo Last Change/Action 

Ctrl+Shift+_ Nonbreaking Hyphen 

Ctrl+Shift+End Select All the Document After the Cursor 

Ctrl+Shift+Enter Column Break 
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Ctrl+Shift+Home Select All the Document Before the Cursor 

Ctrl+Shift+K Change Casing 

Ctrl+Shift+Left 

Arrow 
Select Previous Word 

Ctrl+Shift+Right 

Arrow 
Select Next Word 

Ctrl+Shift+Space Nonbreaking/Hard Space 

End Jump to End of Line/Far Right of Field/Screen 

Home Jump to Beginning of Line/Far Left of Field/Screen 

PgDn Moves Document or Dialog Box Down One Page 

PgUp Moves Document or Dialog Box Up One Page 

Shift+End Highlight From Current Position to End of Line 

Shift+Enter Insert Soft Break 

Shift+F3 
Toggle Case (Press Multiple Times: Uppercase, Capitalize, 

Lowercase)  

Shift+Home Highlight From Current Position to Beginning of Line 

 
B. Word Shortcuts 

F10 Activates Menu Bar Options 

Shift+F1 Shows All Formatting of Selection, Word 

Ctrl+1 Single Line Spacing 

Ctrl+2 Double Line Spacing 

Ctrl+5 1.5 Line Spacing 

Ctrl+Alt+. Insert Ellipsis, Word 

Alt+= Insert Equation 

Ctrl+Alt+Enter Style Separator 

Ctrl+Alt+F Insert Footnote, Word 

Ctrl+Alt+Num - Insert Em Dash, Word 

Ctrl+Alt+Shift+S Display List of Styles, Word 

Ctrl+Shift+8 Toggle Show/Hide (Formatting Marks) 

Ctrl+Shift+- Insert Subscript, Word 

Ctrl+Shift++ Insert Superscript, Word 

Ctrl+Shift+< Decrease Font Size 

Ctrl+Shift+= Superscript 

Ctrl+= Subscript 

Ctrl+Shift+> Increase Font Size 

Ctrl+F 
Enable Navigation Pane with Heading, Pages, Results and 

Find 
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Ctrl+Shift+F9 Remove All Hyperlinks in Footnote 

Ctrl+G 

Find and Replace Options/Go To (Page/ Section/ Line/ 

Bookmark/ Comment/ Footnote/ Endnote/ Field/ Table/ 

Graphic/ Equation/ Object/ Heading) 

Ctrl+Shift+L Start Default Bullet List 

Ctrl+M Increase Paragraph Indentation 

Ctrl+Num - Insert En Dash 

Ctrl+Q Remove Paragraph Formatting 

Ctrl+Space 
Remove Character Formatting, Return to Default Style 

Format 

Ctrl+Tab Insert Next Tab 

 
C. Writer Shortcuts 

Ctrl+Shift+B Insert Subscript, Writer 

Ctrl+Shift+N Access/Create/Edit Template, Writer 

Ctrl+Shift+P Insert Superscript, Writer 

Ctrl+Alt+C Insert Comment, Writer 

Ctrl+G Go to Page 

Ctrl+M Clear Direct Formatting, Writer 

Ctrl+F2 More Fields to Insert in Header and Footer 

Ctrl+F10 Show Formatting Marks 

Ctrl+Q *Quit Active Document with Save Option 

 
D. Spreadsheet (*Calc only) 

Alt+= AutoSum (Selection or from First Number of Range) 

Alt+Enter New Line Within Current Cell 

Ctrl+- Delete Cell 

Ctrl+; Insert Current Date 

Ctrl+` Show Formulas 

Ctrl+1 Modify Cell Content 

Ctrl+Shift+; Insert Current Time in Spreadsheet 

Ctrl+Space Select Column 

Ctrl+Tab Moves Through Tabs 

F2 
Edit Cell/Place Cursor at the End of Text/Formula in 

Current Cell 

Shift+Space Select Row 

*Ctrl+Q Go to Next Empty Cell 

*Ctrl+Q Quit Active Document with Save Option 
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E. US International Keyboard 

AltGr+; Insert ¶ 

AltGr+0 Insert ’ 

AltGr+4 Insert ¤ 

AltGr+6 Insert ¼ 

AltGr+7 Insert ½ 

AltGr+8 Insert ¾ 

AltGr+9 Insert ‘ 

AltGr+C Insert © 

AltGr+M Insert µ 

AltGr+S Insert ß 

AltGr+Z Insert Æ 

AltGr+Shift+= Insert × 

AltGr+Shift+4 Insert £ 

AltGr+Shift+C Insert ¢ 

AltGr+Shift+S Insert § 

 
F. Windows OS (it may work on other OSs as well) 

F5 Refresh Current Window 

F6 Refresh Current Window 

Alt+F4 Quit/Close Current Window/Application 

Ctrl+(drag) Copy File 

Ctrl+Esc Open/Bring Up Start Menu 

Ctrl+F4 Close Window in Program 

Ctrl+Shift+(drag) Create Shortcut (= right click + drag) 

Ctrl+Shift+Esc Open Task Manager 

Ctrl+Shift+N Create New Folder 

Ctrl+Alt+Del 
Open Security Options (Lock/Switch User/Sign Out/Open 

Task Manager) 

Alt+Esc Switch Between Applications on Taskbar 

Alt+Shift+Tab Cycles Backwards Between Open Applications 

Alt+Tab Cycle Between Open Applications 

Shift+Win+S Enables Snipping Tool/PrintScreen/Take a Screenshot 

Win+- Zoom Screen 

Win+. Open Emoji Panel 

Win++ Zoom Screen (Start Screen Magnifier) 

Win+A Open Action Center 

Win+D Show Desktop/Bring Desktop to the Top of Other Windows 
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Win+E Open File Explorer (Home) 

Win+H Start Voice Typing 

Win+I Open Settings 

Win+L Lock Computer Screen 

Win+Left Arrow Move Current Window to the Left Side of Screen 

Win+M Minimize All Open Windows on Desktop 

Win+number key 
Open Corresponding Application Pinned on Taskbar After 

Windows Start Button 

Win+P Switch Display Mode for Additional Screens 

Win+R Open the Run Dialog Box (Terminal) 

Win+Right Arrow Move Current Window to the Right Side of Screen 

Win+S Search 

Win+Shift+Left 

Arrow 
Move Current Window to Another Screen 

Win+Shift+M Undo Minimize All Windows 

Win+Shift+Right 

Arrow 
Move Current Window to Another Screen 

Win+Space Change Keyboard Layout 

Win+T Activate Taskbar 

Win+Tab Cycle Through Open Programs on Taskbar 

Win+U Open Accessibility/Settings in Windows 

Win+Up Arrow Maximize Current Window to Full Screen 

Win+V Open Clipboard History 

Win+X Power Menu 

Win+X, M Open Device Manager 

Win+X,B 
Open Windows Mobility Center (Brightness, Volume, 

Battery Status, External Display, Presentation) 

Win+X,U,I Instant PC Sign Out 

Win+X,U,R Instant PC Restart 

Win+X,U,S Instant PC Sleep 

Win+X,U,U Instant PC Shut Down 

 
G. Other Applications 

Alt+E Edit Options in Current Program 

Ctrl+P Open Preferences 

Esc Cancel Last Function 

F1 Help 

F11 Toggle Full Screen 
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Alt+E Edit Options in Current Program 

 
H. Files 

Alt+Enter Opens Properties Dialog of Selected File 

Alt+Space System Menu for Current Window 

F2 Rename Selected File/Object 

Shift+(drag) Move File 

Shift+certain 

keys 
Insert the Upper Symbol on Keys with 2 glyphs 

Shift+Delete Delete from Disk (= Empty Recycle Bin) 

Shift+F10 Simulate Right Click on Selected Item 

Alt+Enter Opens Properties Dialog of Selected File 

 
I. Browser 

Alt+Left Arrow Back 

Alt+Right Arrow Forward 

Ctrl+H History List 

Ctrl+J Downloads List 

Ctrl+N Open New Window in Browser 

Ctrl+T Open New Tab 

Ctrl+D Bookmark Page 

Ctrl+F Find on Page 

Ctrl+Shift+Delete Clear Browsing Data 

Ctrl+Shift+T Reopen Last Closed Tab 
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Kivonat 

Szövegszerkesztési alapok a szakdolgozat írásához 

 

A kötet tizenkét fejezete szerkezeti, tipográfiai és szerkesztési tudnivalókkal se-

gíti elő a szakdolgozat készítését. A szerző szerint a tipográfiai és szerkesztési 

szabályok megszegése csak a kiadványszerkesztés alapjainak ismerete után lehet-

séges, beleértve az operációs rendszerek, billentyűzetkiosztás és a fájlok elneve-

zését is. Ezt követi a Microsoft Office Word és a LibreOffice Writer szövegszer-

kesztők alapvető beállítási lehetőségei, tárgyalva a betűtípusok, karakterek és 

betűk megkülönböztetését, valamint azok megfelelő használatát is. A negyedik 

fejezet a számjegyek és számok használatát taglalja, melyek után az írásjelek és a 

helyesírás alapjai következnek: nem nyomtatható karakterek, kötőjelek, mondat-

záró jelek, zárójeltípusok, idézőjelek, piktogramok és rövidítések. A hatodik fe-

jezet a beszúrás típusait ismerteti, melyet szövegmódosítási tippek követnek. A 

nyolcadik fejezet a sablonokról szól, és egyéni sablon készítését ajánlja. A követ-

kező három fejezet a táblázatokat, bemutatókat és pdf-fájlok kezelését tartal-

mazza, kiegészítve azzal, hogy miért érdemes ezekről tárgyalni a mesterséges in-

telligencia korában. A záró fejezet a szakdolgozat felépítéséről szól: az etikai 

bevezető után a terjedelmet boncolgatja, majd a minőségbiztosítással zárul. A fe-

jezetekben bemutatott anyagot több mint 150 ábra és 21 táblázat illusztrálja, míg 

a Függelék általános és szoftverspecifikus gyorsbillentyűk listáját tartalmazza. A 

könyvet szakirodalom és tárgymutató egészíti ki. 





Rezumat 

Noțiuni de bază privind procesarea textelor și redactarea tezelor 

 

Lucrarea de față își propune să ofere o perspectivă asupra redactării unei teze bine 

concepute, conținând observații structurale, tipografice și de editare, organizate în 

douăsprezece capitole. Autorul susține că încălcarea regulilor tipografice și de 

editare este posibilă numai după cunoașterea noțiunilor de bază ale publicării 

asistate de calculator, adică a sistemelor de operare, a configurațiilor tastaturii și a 

organizării fișierelor cu denumiri corespunzătoare (Capitolul 1). Urmează toate 

opțiunile importante de configurare atât în Microsoft Office Word cât și în 

LibreOffice Writer, completate cu diferențierea fonturilor, caracterelor și literelor, 

precum și utilizarea corectă a acestora. Capitolul 4 tratează numerele și este urmat 

de noțiunile de bază privind punctuația și ortografia: caractere neimprimabile, 

liniuțe, semne de oprire și pauză, tipuri de paranteze și alte semne, completate cu 

citate, pictograme și abrevieri. Urmează tipurile de inserții și sfaturi pentru 

modificarea textului. Capitolul 8 explică importanța șabloanelor, oferind un ghid 

pas cu pas pentru crearea unui șablon propriu. Următoarele trei capitole tratează 

foile de calcul, prezentările și gestionarea fișierelor .pdf precum și motivele pentru 

care acestea merită încă discutate în era inteligenței artificiale. Capitolul final 

tratează structura tezei cu considerații etice, lungimea lucrării și asigurarea 

calității. Peste 150 de figuri și 21 de tabele ilustrează materialul prezentat pe 

parcursul capitolelor, iar Anexa oferă diverse scurtături generale și specifice, 

urmată de bibliografie și index. 
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name, change, 42 
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title, 246 
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special, 178 

warning, 200 
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foreword, 126 

form 

extended, 199 
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text, 246 
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show all, 85 
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decimal, 126 
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greeting, 154, 199 

guidelines, 26, 29, 280 

publication, 64 

guilder, 118 
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saving PDF, 276 
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URL, 140, 158, 161 

US, 117 

UTF, 92 
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Basics of Word Processing  
for Thesis Writing

Basics of Word Processing for Thesis Writing is a practical guide designed 
to take students and researchers from the fundamentals of digital 
writing to the polished completion of an academic thesis. Beginning 
with essential concepts such as operating systems, file organization, 
and keyboard layouts, the book builds a strong foundation before 
guiding readers through document setup, styles, and formatting. Then 
it dives deeply into the often-overlooked details that define professional 
writing—fonts, characters, numbers, punctuation, and spelling—
offering clarity on conventions that can significantly impact readability 
and academic credibility. With step-by-step coverage of inserting and 
managing elements like tables, figures, citations, and automatically 
generated lists, readers learn how to structure documents efficiently. 
Further topics such as text modification, template creation, and working 
with spreadsheets, presentations, and PDFs ensure a well-rounded 
command of modern academic tools. The book ends in a structured 
approach to thesis writing itself, including ethical considerations, 
document organization, and quality assurance—equipping readers not 
just to write but to present their work at a professional standard.

Ideal for students, educators, and anyone engaged in academic writing, 
this guide transforms word processing from a basic skill into a powerful 
instrument for precise and effective scholarly communication.
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